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1. Introduction
This section introduces common M-Files terminology, a getting started guide for new users as well as
information about this user guide.
®

M-Files intelligent information management software helps you easily store, organize, and access
all kinds of documents and information. Our revolutionary approach organizes content based on what
something is (and what it relates to) instead of where it is stored.
Instead of the traditional folder-based method you have instant access to all of your content with search
or dynamic views. It is simple, dynamic, and flexible. From managing a wide variety of content to ensuring
regulatory compliance, M-Files has you covered.

Figure 1: M-Files organizes content based on what something is (and what it relates to) instead of where it is stored.

You can deploy M-Files on-premise, in the cloud, or a hybrid of both. For more information, see System
Overview.
Opening the user guide
You can open this user guide when M-Files is active by pressing the F1 key on your keyboard. When you
open the user guide via F1, you can directly see a topic that is related to what you do at the moment in MFiles.
You can also open the user guide via the M-Files icon on the Windows notification area, as well as via help
buttons in the M-Files user interface.

The user guide is also available as a PDF version. You can download it from the PDF
upper right corner of the web user guide.
Additional documentation
For more information, refer to:

icon in the
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•
•
•

M-Files knowledge base
M-Files Support Center
M-Files Community

If you are a developer or an M-Files system administrator, you can also refer to:
•
•
•

M-Files API
M-Files Web Service
M-Files UI Extensibility Framework

In this chapter
•
•
•

About This User Guide
M-Files Terminology
Getting Started with M-Files

1.1. About This User Guide
This user guide contains a number of typographic and writing conventions as well as visual elements that
will help you to better understand information and to do tasks.
Convention

Description

<version>

Indicates that you must replace the text enclosed in angled brackets
with information specific to your installation or environment. For
example, in the registry path HKEY_CURRENT_USER\SOFTWARE
\Motive\M-Files\<version>\Client, replace <version> with
the version number of your specific M-Files installation.

File > Save

The > symbol indicates that you need to select an item from a menu.
For example, Settings > Applications indicates that you must open
the menu bar and select the Applications item from the Settings
menu.

Optional

Indicates that a step in a task is optional and up to the users to
decide if they will complete the step.

Info

Highlights important information related to a specific step in a task.
This information is always under the related step.

Example

Highlights an example of how a given step is completed. This
information is always under the related step.

Result

Highlights a description of the expected results after you have
completed a task step.

Bold

Bolded text indicates user interface elements, such as buttons, menu
items, and dialog names.
Examples:
Click OK to continue.
The Object Type Properties dialog is opened.
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1.2. M-Files Terminology
The following table describes daily M-Files terminology.
Term

Definition

M-Files software

The M-Files document management software consists of the following components:
M-Files Desktop, M-Files Admin, M-Files Desktop Settings, Show Status and M-Files
Server. You can also use M-Files with a web browser (see Accessing M-Files Web) or
a mobile device (see Accessing M-Files Mobile).

File vs. document An example of a file is a memo created using Microsoft Word and saved on the C:
drive. The file becomes a document only after you have associated metadata with it.
Once you have installed M-Files and start transferring existing files to M-Files, you
add metadata to the files to make them documents.
In addition to documents, an M-Files vault can also store other types of objects, such
as customers, assignments, or project data.

Multi-file
document

A multi-file document is a special M-Files document type that can contain more than
one file. The files share one set of metadata.
Typical uses include linking of an electronic document with its signed and scanned
counterpart, an email and all its attachments, or any such case where files need to be
linked together and treated as one unit.

Metadata

Metadata consists of information about the document's properties, such as the parties
of a contract or the recipient of a letter. Metadata is used to, for example, search for
and organize documents.

Document
and object
permissions

Each document can be assigned permissions to specify the access rights of a user or
user group. The permissions can be either allowed or denied separately.
One user can have allowed or denied permissions in two different ways: the
permissions have been specified for that particular user, or the user belongs to a
user group for which the permissions have been specified. If no permissions have
been specified for a user, the user cannot view the document or access it in any
way. If certain permissions have been allowed, the user can perform the procedures
determined by these permissions.

Vault

A vault is a centralized storage location for documents and other objects. Its physical
location is on the server running M-Files Server. Regardless of the physical location,
all users see the document vault as a directory on their local computer's M-Files drive.
This means that using a document vault is similar to using a local hard drive.
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Term

Definition

View

Views are locations in which the documents and other objects are listed based on the
metadata they contain.

Virtual folder

The objects and documents in the views include virtual folders (property folders).
Virtual folders enable sorting documents in the view into categories.

Traditional folder

You can create traditional folders in M-Files. These folders do not have the additional
properties provided by views. Traditional folders are comparable to, for example,
folders on your C: drive and can be used for importing files to M-Files. Traditional
folders allow you to retain the original folder structure of the imported files.

Client

A client is the regular M-Files user's computer or mobile device and the software
installed on it. The regular user performs operations like creating documents and
exploring the document vault.

Object type

By defining object types, you can create different types of objects. Document is one of
such object types, one that every vault contains. In addition, the M-Files administrator
can create other object types for the vault, such as customer, contact, and project.
This way, you can use M-Files to, for example, store the company's customer and
project databases.

Object

The term object refers to instances of various object types – that is, individual objects
created using object types. For example, one contact person in the document vault is
an object.
Most functions are identical for documents and for other objects. This user guide often
represents operations as being performed on documents, but the same operations
are available for document sets and other objects. An individual document can
therefore also be thought of as an object.

Document
collection

Document collections are collections of individual documents in the document vault.
Each collection member document has its own metadata. In addition, the document
collection has a collective set of metadata independently of member documents
(compare with multi-file document).
Each document in the collection can still be accessed as an individual document but
also through the document collection.

Relationships

You can also define the relationships between objects. Using relationships you can,
for example, indicate that two documents are related. Relationships enable easy
tracking of all documents related to an issue.
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Term

Definition

Template

You can use another object as a template for creating a new object. When you select
a template from the list, the metadata card adjusts itself to the specifications of the
template object.
Specify an object as a template by setting its Is template property to Yes.

Workflow

The M-Files Workflow feature enables modeling object lifecycles according to real
world processes. The workflow is grouped into states that correspond to the working
stages of the document or other object. The M-Files administrator can easily define
workflows to meet company requirements. For more information on workflows, see
Configuring Workflows.

Server

M-Files Server runs on a server computer. Clients connect to the server and retrieve
data so that the contents of the document can be viewed on the clients. The server is
the physical location of the document vault.

Login account

Login accounts are server-level (or in some cases vault-level) accounts that are used
for authenticating users to M-Files Server. A login account can be associated with
multiple users, but only one user per vault. Compare with users.

User

Users are vault-level objects that store user-specific settings and user history and that
have permissions to perform specific operations in a vault. A user is linked to one and
only one login account. Compare with login accounts.

Intelligent
Metadata Layer

Intelligent Metadata Layer, abbreviated as IML, is a repository-neutral approach to
intelligent information management that unifies information across the enterprise
based on context, not on the system or folder in which the information is stored.
In addition, IML categorizes documents and records automatically and provides
metadata suggestions with the aid of artificial intelligence.
See Intelligent Metadata Layer for more information.

Managed object

A managed object is either an internal M-Files object stored in a document vault or
a promoted external repository object. Managed objects have metadata in M-Files
and can be managed using various M-Files functionalities, such as version history or
workflows. A managed external repository object can be demoted to an unmanaged
object by removing its metadata.
Compare with unmanaged object and see Unmanaged and Managed Objects.
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Term

Definition

Unmanaged
object

An unmanaged object in M-Files represents a file in an external repository. An
unmanaged object does not have M-Files metadata and it cannot be managed via
M-Files version history or workflows. An unmanaged object can be promoted into a
managed object by adding metadata to it.
Compare with managed object and see Unmanaged and Managed Objects.

Repository

A repository is any accessible place where information can be stored and accessed,
such as an M-Files document vault, or an external location such as a network folder
or a SharePoint site.
Compare with external repository.

External
repository

A repository that is other than an M-Files vault and the contents of which are
displayed and can be edited via the M-Files user interfaces.
Compare with repository.

Connector

A vault application that enables an external repository to be displayed and accessed
via the M-Files user interfaces.
See Connectors for more information.

Intelligence
service

An intelligence service is a vault application that attempts to understand vault content
the way humans do. They can, for instance, be used to analyze file content and
existing metadata for automatically categorizing content or for providing end users
with metadata suggestions.
See Intelligence Services for more information.

Vault application

Vault applications are pieces of software that are installed to a document vault to
extend the functionality of the vault. See Installing and Managing Vault Applications
for more information.

Home screen

The screen shown when you first open an M-Files vault, or when you click the M-Files
logo in the top left corner of the user interface.
For more information, see Home screen.

Quick view area

The area on the left side of the home screen, containing a number of quick views,
such as Recently Accessed by Me, Assigned to Me, and Checked Out to Me.
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1.3. Getting Started with M-Files
This section helps you to get up to speed with M-Files. If you are new to M-Files, it is recommended that
you read the entire section before you start using M-Files.
This section assumes that M-Files is already installed and ready to use. For instructions on installing MFiles, see Installing and Upgrading M-Files.
There are three ways you can use M-Files:
•
•
•

M-Files Desktop is a desktop application available for the Microsoft Windows operating system.
M-Files Web is a web application that runs natively in most web browsers.
M-Files Mobile is a mobile application available for iOS and Android devices.

M-Files Desktop
The M-Files desktop application is the premier tool for using M-Files. It is equipped with all the features and
functions available in the M-Files ecosystem, and therefore it is the go-to choice for power users whose
day-to-day M-Files activities typically involve creating and editing documents.
M-Files Desktop is a native Microsoft Windows application that runs on all the latest Windows versions. For
a complete list of compatible Microsoft Windows versions, see Operating System Requirements.
To get yourself started and comfortable with M-Files Desktop, complete these quick tutorials:
1. Opening M-Files Desktop and Accessing a Vault
2. Getting Familiar with the M-Files User Interface
3. Searching for Documents
4. Getting Familiar with Using Metadata
5. Getting Familiar with Documents and Other Object Types
6. Creating New Objects and Saving Documents to M-Files
7. Using Document Templates
8. Saving Emails from Microsoft Outlook to M-Files
9. Getting Familiar with Views
10.Working Offline
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M-Files Web
M-Files can also be accessed using a web browser. M-Files Web aims to offer a similar user experience
as M-Files Desktop, and as such, it offers most of the same features as the desktop application. For more
information, see Accessing M-Files Web.
M-Files Mobile
The M-Files mobile applications allow you to use M-Files and access document vaults on your mobile
device. Many of the features of M-Files Desktop are also available in the mobile applications. For a feature
comparison between M-Files Mobile and M-Files Desktop, see Can I do the same stuff with M-Files Mobile
as with M-Files Desktop?
More information
For additional introductory information, refer to the videos section on our website. Once you are familiar
with the basics of M-Files and want to know more, this user guide is a great reference to the features and
benefits of the M-Files software.

In this chapter
•
•
•
•
•
•
•
•
•
•

Opening M-Files Desktop and Accessing a Vault
Getting Familiar with the M-Files User Interface
Searching for Documents
Getting Familiar with Using Metadata
Getting Familiar with Documents and Other Object Types
Creating New Objects and Saving Documents to M-Files
Using Document Templates
Saving Emails from Microsoft Outlook to M-Files
Getting Familiar with Views
Working Offline

1.3.1. Opening M-Files Desktop and Accessing a Vault
You can open M-Files Desktop via the shortcut icon on the Microsoft Windows desktop, via the M-Files
icon on the Microsoft Windows notification area, or by accessing the M-Files drive via File Explorer.
Do the following steps to open M-Files Desktop:
1. Either:
a. Double-click the shortcut icon on the Microsoft Windows desktop:

or
b. Double-click the M-Files icon on the Microsoft Windows notification area:
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or
c. Open File Explorer, and then double-click the M-Files drive:

2. Optional: Double-click the document vault that you want to access. If you have only one document vault
connection, you are taken to the vault login prompt or home screen automatically.
3. Optional: Depending on your vault connection, you may need to provide your M-Files credentials to log
in. Enter your username and password, and then click OK to continue:

You are now greeted with the home screen of the vault. You can quickly access different areas of the vault
via the home screen.
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Now that you have succesfully opened M-Files Desktop and accessed a vault, the next logical step is to
get accustomed to the M-Files user interface. Proceed to Getting Familiar with the M-Files User Interface.

1.3.2. Getting Familiar with the M-Files User Interface
The M-Files Desktop user interface bears a close resemblance to Microsoft Windows File Explorer. If you
are a seasoned Microsoft Windows user, you will feel right at home using M-Files.
The M-Files Desktop user interface is composed of four main parts:
•
•
•
•

The task area (A) on the left contains frequently used commands and shortcuts.
The right pane (B) displays the Metadata, Preview, Filters, and Pinned tabs.
The quick search bar (C) on the top allows you to search for documents and other objects in M-Files.
The listing area (D) in the center lists views, objects, and your search results.
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Task area
The task area contains frequently used commands and shortcuts divided into separate sections. You can,
for example, create a new document or other object by clicking the appropriate command under the Create
section in the task area. You can customize the task area to better suit your needs.
For more information, see Task area.
Tip: If the task area is not visible, you can display it by clicking the gray, vertical tab on left edge of
the user interface.
Right pane
In the right pane, you can alternate between the Metadata, Preview, Filters, and Pinned tabs.
The Metadata tab displays the metadata card of the currently selected object. Every object in M-Files is
associated with metadata, which allows objects to be organized and located on the basis of subject terms
describing a document or any other object. The metadata card is a tool for viewing and modifying object
metadata. For more information, see Metadata Card.
The Preview tab allows you to preview the contents of the currently selected document. For more
information, see Preview Tab.
The Filters tab contains options for narrowing or broadening your search. The tab is automatically opened
whenever you activate the search bar. For more information, see Filters Tab.
The Pinned tab allows you to collect items that you frequently use into a single tab. The Pinned tab is
a visual collection of shortcuts that provides quick access to resources, such as objects in the vault. For
more information, see Pinned Tab .
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Quick search
The quick search at the top of the user interface allows you to search for documents and other objects in
M-Files. For a quick tutorial on using M-Files search features, see Searching for Documents. For a more
thorough description of the different search functions, see Searching.
Listing area
The listing area normally contains views and objects. The area functions very similarly to the one in File
Explorer in Microsoft Windows. In M-Files Desktop, however, users can expand or collapse objects to view
and hide, for instance, the content of a multi-file document. For more information, see Listing Area.
For more information on the M-Files Desktop user interface, see Using M-Files Desktop User Interface.
Now that you are familiar with the M-Files Desktop user interface, proceed to Searching for Documents for
a tutorial on using the search functions of M-Files.

1.3.3. Searching for Documents
Quick Search at the top of the user interface allows you to search for documents and other objects in MFiles. Use multiple keywords in your search to limit your search results: instead of searching for the word
proposal, try proposal followed by the customer name:

You can use the search options and the Filters tab in conjunction with Quick Search to narrow or broaden
your search. You can display the search options by clicking the search options button (
) and the search
filters by clicking the Filters tab. Enter the appropriate search options and then click the search button
(

), or use the the search filters in the right pane, to refine your search.

For more information on M-Files search functions, see Searching.
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Now that you are familiar with the search functions of M-Files, proceed to Getting Familiar with Using
Metadata to familiarize yourself with using metadata in M-Files.

1.3.4. Getting Familiar with Using Metadata
Metadata is used to further describe documents and objects in M-Files. Typical metadata properties are,
for instance, Class, Customer, and Project. Metadata properties, in turn, have their own property values.
The value of the Class property, for example, can be Proposal or Employment Agreement. Every object in
M-Files has a metadata card, which can be used for viewing and modifying the metadata of an object.
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Notice that metadata properties are class-specific in M-Files. Some properties are mandatory and some
optional. Your administrator can configure the metadata structure of your M-Files document vault using the
M-Files Admin tool.
All documents in M-Files are tagged with metadata. Metadata makes it easier to find the information you
are looking for in the vault. Regardless of the way documents are saved to M-Files, you always have to fill
in the metadata card prior to saving the document.
If you have the appropriate permissions, you may edit the property values on the metadata card by clicking
the desired property value field. After you have made the necessary changes, click Save on the metadata
card to save them.
For more information on using the metadata card, see Metadata Card. Additionally, Shortcuts for the
metadata card explains how you can use keyboard shortcuts to enter the required metadata even faster
and more easily.
Now that you are familiar with how metadata is used in M-Files, proceed to Getting Familiar with
Documents and Other Object Types for a quick tutorial on the different object types in M-Files.

1.3.5. Getting Familiar with Documents and Other Object Types
The Document object type is perhaps the most basic object type in M-Files. Documents in M-Files consist
of files and metadata.
Documents vs. files
A document in M-Files is an object type that can contain zero or more files. A single-file document contains
one file and metadata associated with the file.

Multi-file documents can contain multiple files, but all files share the same metadata.

Files in a multi-file document can be expanded by clicking the arrow icon to the left of the multi-file
document in the listing area.
Other object types
You can manage all kinds of data objects in M-Files, not just documents. Typical object types are
customers and projects, for example. Documents are often associated with customers and projects, and
with these object types, you can manage additional information related to these objects, such as the
address details of the customers, and project deadline dates.
For more information on object types, see Object Types.
Now that you are familiar with the different object types in M-Files, proceed to Creating New Objects and
Saving Documents to M-Files for a quick tutorial on how you can create and save new documents in MFiles.
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1.3.6. Creating New Objects and Saving Documents to M-Files
Creating new documents or other objects in M-Files, or saving documents from other applications to MFiles, is very simple and straightforward. This quick tutorial shows you how it is done.
Creating New Objects in M-Files
You can create new objects by clicking the Create button, or by clicking the desired button under the
Create section in the task area:
1. Either:
a. Click the Create (

) button and select the desired object type from the context menu.

or
b. In the task area, under the Create section, click the desired object type.

If you chose to create a new document, the New Document dialog is opened. Otherwise the
metadata card for the new object is opened.
2. Optional: If you are creating a new document, select a class and a template, and then click Next.
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3. Fill in the necessary metadata and then click Create.

The object is added to the vault with the metadata details that you have provided.
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Saving Documents to M-Files from Other Applications
M-Files supports all file types and you can save documents from any application to M-Files. Documents
are saved to a document vault and then described with metadata. You do not have to save documents
into a particular folder or location as M-Files organizes content automatically into relevant views based on
document metadata.
Certain applications, such as AutoCAD, Microsoft Word, Microsoft Excel, or Microsoft PowerPoint, have an
M-Files ribbon that you can use to easily save new documents to M-Files. If the application you are using
does not have the ribbon, you can still use the Save As... function of the application to save your document
to M-Files.
Complete the following steps to save a document to M-Files from another application:
1. Either:
a. If you are using an application that is equipped with the M-Files ribbon, open it and then click Save
to M-Files. If you have more than one vault connection, select the appropriate vault from the context
menu.
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or
b. If the application does not have the Save to M-Files feature, select File > Save As... from the menu
bar, select M-Files as the location, and if necessary, select the appropriate vault. Finally click Save.

The metadata card for the new document is opened.
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2. Fill in the appropriate metadata and then click Create.
The selected document is saved to the vault with the metadata that you have provided.
For more information on creating objects and saving documents in M-Files, see Adding Content to Vault.
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Now that you are up to speed with the ways documents are created and saved to M-Files, proceed to
Using Document Templates for a tutorial on how to take advantage of document templates when creating
new documents.

1.3.7. Using Document Templates
Complete these steps to create a new document with a document template:
1. Click the Create (

) button and then select Document.

The New Document dialog is opened.
2. Select a class.
The available document templates for the selected class are shown. If there is more than one
template available and you have used some of them before, the last used template is listed in
the Default template section.
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3. Select a document template and click Next.
The metadata card for the new document is opened. Some of the properties can be prefilled.
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4. Enter values for the necessary remaining properties.
5. Click Create.
The document is opened in the editor associated with the file format. M-Files has used the
metadata that you have specified to prefill document contents.
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6. Optional: Edit the document contents.
7. Complete one of these steps:
a. Open the M-Files tab and click Check In.
or
b. Close the document. When you are prompted to check in the document, click Yes.
8. Optional: If you are prompted to save your changes, click Yes.
The document is saved to the vault.
Creating a New Document Template
You can convert any document in an M-Files document vault to a document template that can then be
used for creating standardized documents for a specific purpose.
Complete the following steps to convert a document in M-Files to a document template:
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1. Locate and select the document that you want to use as a template.

2. On the metadata card, click Add property.
A new property field is added to the metadata card:

3. Use the drop-down menu to select the property Is template.
4. Check the Is template check box.

5. Click Save to save your changes.
The selected document is now a document template in the vault. You may modify the template at any time
by right-clicking the document and selecting Open from the context menu.
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Adding Automatically Filled Fields to a Template
You can add to your document template fields that are automatically filled when you create a new
document based on the template. The fields are filled with values of predefined properties specified in the
metadata of the new document.
Complete the following to add an automatically filled field to your document template:
1. Right-click your document template and select Open from the context menu.
2. If you are prompted to check out the document, click Check Out.

3. Click the position in the template where you want the automatically filled field to appear.
4. Open the M-Files tab and click Insert Property.

The Insert M-Files Property dialog is opened.
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5. Select the metadata property that you want to fill the field with and then click OK.
Now, when you create a new document based on the template, the predefined field in the document is
filled with the property value that you have specified in the metadata of the new document.
Now that you are familiar with document templates, proceed to Saving Emails from Microsoft Outlook to MFiles for a tutorial on how you can easily save e-mail messages in Microsoft Outlook to M-Files.

1.3.8. Saving Emails from Microsoft Outlook to M-Files
M-Files is integrated with Microsoft Outlook and it creates a folder in Microsoft Outlook for every document
vault. You can save emails with or without attachment files simply by dragging messages to the desired
vault folder in Microsoft Outlook.
Tip: You can also drag and drop an email message directly to the M-Files user interface, and
for instance, add the message file to an existing multi-file document by dropping it on top of the
document object in the listing area.
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When a message is added to M-Files, it is automatically tagged with the correct customer and contact
person in M-Files, based on the domain of the sender's email address.
If, for example, the document vault contains the M-Files Inc. customer object and the email address of the
customer is set to pr@m-files.com in the customer object metadata, all emails from the m-files.com domain
are automatically associated with the customer when the messages are added to M-Files.
Do the following steps to save an email message in Microsoft Outlook to M-Files:
1. In Microsoft Outlook, drag and drop a message to a vault folder under the M-Files section.
The metadata card for the new document is opened.

2. Use the Class drop-down menu to select an appropriate class for the message.
3. Fill in any other metadata properties that you want, and then click Create.
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The email message is saved to the selected vault with the metadata that you have provided.
For more information on M-Files functions in Microsoft Outlook, see Functions in Microsoft Outlook.
Now that you are up to speed with saving email messages to M-Files, proceed to Getting Familiar with
Views for a tutorial on using views in M-Files.

1.3.9. Getting Familiar with Views
Views are essentially locations in which the objects are listed based on their metadata. In addition to the MFiles search functions, well-defined views allow you to quickly and easily locate the information you need.
M-Files gathers the contents of a view based on 1) the view filter, which defines the criteria that the object
must fulfill to be displayed, and 2) the grouping level settings, which define the categories in which the
objects are grouped in the view. As views are based on various metadata-specific criteria, objects can
appear in several views at once.
As a very simple example, let's look at the view called Documents by Class. This is a view where the
filter simply states that the object type must be Document. As a result, all the documents contained in the
vault are listed in this view regardless of their class or any other properties they might have. However, as
the name of the view implies, its settings also define a grouping level that categorizes the documents into
various virtual folders based on the value of their Class property. This way, we end up with a view like the
one shown in the image below.

Figure 2: A view where documents are categorized by class.

Now, as you can see from the image, views can be further divided in to subviews if need be. Virtual folders
can also be converted into views, if you so wish. For more information, see Converting a Virtual Folder into
a View.
For instructions on creating a new view and adjusting its settings, see Creating a View.
Now that you have familiarized yourself with views, proceed to Working Offline for a tutorial on how you
can use M-Files offline.

1.3.10. Working Offline
You can access and modify documents stored in an M-Files vault without a network connection – as long
as they have been marked to be available offline. There are two ways to do this: you can 1) explicitly
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mark individual documents to be available offline or 2) create offline filters to make sure documents with a
defined set of properties are always available regardless of your network connection.
Mark for offline availability
To mark a single document available in offline mode, right-click it and select Offline Availability > Mark
for Offline Availability from the context menu.
Offline filters
With offline filters, you can mark documents to be available offline according to certain criteria. You can,
for example, choose to have all the documents you have read or modified within the last two weeks, or
all the documents related to a certain customer, to be available whether you are online or not. This is a
dynamic way to define offline availability for documents: M-Files periodically checks whether there are new
documents that fulfill the criteria of your filter, and then makes sure they are all at your disposal when you
do not have a network connection available.
You can create a new offline filter by right-clicking an existing view in the vault and by then selecting
Mark for Offline Availability from the context menu, or by creating a new offline filter from scratch. For
instructions on how to do that, see Offline filters.

Figure 3: Marking an existing view to be available offline.

Accessing and editing documents in offline mode
You can access the offline mode by clicking on your username in the upper-right corner of the user
interface and selecting Go Offline from the context menu.
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Figure 4: The Go Offline command.

When you are in offline mode, you can find the documents available to you via the built-in view called, you
guessed it, Offline. You can read and edit documents the same way as when you are online. The only
difference is that when you are offline, you cannot check in any objects once you have checked them out
for editing. They can be checked in as soon as you are online again.
You can find the
the offline mode.

command above the listing area or via the same menu you used to activate

2. Daily Use
This section explains the day-to-day use of M-Files for vault users.
This section tells you how to access M-Files, use the M-Files Desktop user interface, and manage, share,
and find content in M-Files. In addition, you can find information about the user settings in M-Files Desktop.

In this chapter
•
•
•
•
•
•

Accessing M-Files
Using M-Files Desktop User Interface
Managing Content
Sharing Content
Finding Content
User Settings
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2.1. Accessing M-Files
Before you use your M-Files vault, make sure that your M-Files system administrator has done these
operations:
•
•

The M-Files system has been set up.
A vault connection or vault connections have been added for you.

You can access M-Files with M-Files Desktop, M-Files Web, and M-Files Mobile.

In this chapter
•
•
•

Accessing M-Files Desktop
Accessing M-Files Web
Accessing M-Files Mobile

2.1.1. Accessing M-Files Desktop
When M-Files Desktop is installed and your vault connections are set up, you see all the vault connections
on your M-Files drive in File Explorer. To use M-Files, click the icon on your desktop. You can also use the
Microsoft Windows start menu or the M-Files drive in File Explorer.
Logging in
To log in, double-click a vault on the M-Files drive. To log in as a different user, right-click the vault and
select Log In as. If M-Files cannot use your Windows credentials for the login, the system asks you for
your credentials when you open the vault.
Logging out
To log out, click your username in the top-right corner of the user interface and select Log out.

2.1.2. Accessing M-Files Web
You can go to M-Files vaults also with M-Files Web. M-Files Web is a browser-based M-Files client that
lets you use the basic M-Files functions.
There are two versions available: the classic M-Files Web and the new M-Files Web. The user interfaces
for the two versions are almost the same as in M-Files Desktop. With the classic M-Files Web, see the
Using M-Files Desktop User Interface section for more information about the user interface components.
The new M-Files Web has its own user guide.
Note: For the new M-Files Web, the M-Files Online license is necessary.
You can get the address of M-Files Web in your organization from your system administrator.
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Logging in to classic M-Files Web
1. In your web browser, go to the M-Files Web address given by your system administrator or an M-Files
consultant.
If the name of your vault is Sales Tracker, the address can be https://sales-tracker.cloudvault.mfiles.com for cloud-based deployments or http://sales-tracker.mydomain.com for on-premises
vaults. In your corporate network, the connection protocol can be HTTP instead of HTTPS.
2. Enter your login credentials or select Log in with current Windows credentials.
3. Optional: If you have access to many vaults, select the vault that you want to connect to.
If you have access to only one vault, you are automatically connected.
You are now logged in and you see the M-Files home screen.

2.1.3. Accessing M-Files Mobile
M-Files is also available as a mobile application for iOS and Android devices. With the mobile applications,
you can see vault content, mark your assignments complete, and create and share objects.
You can download the latest version of the mobile applications from your application store:
•
•

M-Files for iOS (iPhone and iPad)
M-Files for Android (phones and tablets)

Application language
M-Files mobile applications use the language settings of your device.
Logging in to M-Files Mobile
1. Contact your vault administrator or an M-Files consultant to get the login information of the vault.
2. Open the M-Files mobile app on your device.
3. On the login screen, enter the full server address, your username, and password.
If the name of your vault is Sales Tracker, the address can be https://sales-tracker.cloudvault.mfiles.com for cloud-based deployments or http://sales-tracker.mydomain.com for on-premises
vaults. In your corporate network, the connection protocol can be HTTP instead of HTTPS.
For cloud vaults hosted in M-Files Cloud, M-Files recognizes the server address even if you only
enter the sales-tracker part. However, to make sure that the correct protocol and address are
used, we recommend to always use the full server address.
4. Tap Log in.
5. Optional: If you have access to many vaults, select the vault that you want to connect to.
If you have access to only one vault, you are automatically connected.
You are now logged in and you see the M-Files home screen.
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2.2. Using M-Files Desktop User Interface
This section is about the M-Files Desktop user interface. Click on different parts of the screenshot below
for a description of the areas in the user interface.

1. Task area
2. Searching
3. Listing area
4. Metadata card
5. Creating objects
6. Filters
7. Preview
8. Connection status
9. User settings
10.Favorites
11.Right pane
12.Pinned
13.Navigation path
14.Assigned
15.Recent
16.Home screen
Assigned
Click the Assigned tab to see the documents that are assigned to you.
Connection status
The connection status icon ( ) shows the status of your connection to the vault. The connection is
measured with the round-trip time to the server that hosts the vault. The icon has five statuses:
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•

The round-trip time to the server is less than 50 milliseconds.

•

The round-trip time to the server is from 50 to 149 milliseconds.

•

The round-trip time to the server is from 150 to 299 milliseconds.

•

The round-trip time to the server is 300 milliseconds or more.

•

You have no connection to the server.

Click the connection status icon ( ) to see more information about your connection. This opens the
Connection Status dialog. If your connection is slow or there is no connection to the server, contact your
M-Files system administrator. Click Refresh to refresh the information of your connection status. Click
Analyze Connection to see more details about your connection status.
Creating objects
Click Create to create a document or an object. For more information on how to create documents and
objects, see Creating a Document and Creating Non-Document Objects.
Favorites
Click the Favorites tab to see a view of the documents and objects that you have added there. You can
add objects to your favorites and remove them in the context menu or in the metadata card of an object.
Note: You cannot delete favorites with the Delete command.
You can also click the Favorites shortcut in the task area to go to your Favorites view.
Filters
When you search for an object or a document, you can use the advanced search features on the Filters
tab. In the Filters tab, you can give more specific search criteria for your search. For more information, see
Filters Tab.
Home screen
When you log in to M-Files Desktop, the Home screen opens in the listing area. To go to the Home screen
from other views, click the Home tab or the M-Files logo.
Listing area
The listing area in M-Files Desktop usually contains views and objects. For more information, see Listing
Area.
Metadata card
To see and change the metadata of the selected object, use the metadata card. For more information, see
Object Metadata and Metadata Card.
Navigation path
The navigation path next to the M-Files logo shows you the current view and all its parent views. For
example, the path can be Sample Vault > Documents > By Customer > A&A Consulting.
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Pinned
The Pinned tab lets you collect items that you frequently use into a single tab. For more information, see
Pinned Tab .
Preview
In the preview mode, you can browse and copy the content of the selected document. For more
information, see Preview Tab.
Recent
Click the Recent tab to see a view of the documents and objects that you have recently accessed.
Right pane
The contents of the Metadata, Preview, Filters, and Pinned tabs are shown in the right pane. To hide the
right pane, click the gray vertical tab on the left edge of the right pane.
Searching
Use the search bar in the top of the user interface to find your documents and other objects. For more
information, see Searching.
Task area
In the task area, you can see shortcuts to different M-Files Desktop operations. For more information, see
Task area.
User settings
Click your username in the top-right corner to see these options:
•
•
•
•
•
•
•
•
•

About M-Files
Set a default tab for an object
Notification Settings
Substitute Users
Shared by Me
Change Language
Go Offline
Log Out
External Repositories

In this chapter
•
•
•
•
•
•
•

Task area
Listing Area
Metadata Card
Preview Tab
Pinned Tab
Customizing M-Files Desktop User Interface
Keyboard Shortcuts in M-Files Desktop
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2.2.1. Task area
In the task area, you can see shortcuts to different M-Files Desktop operations. Click the gray vertical tab
on the left side of the user interface to show or hide the task area.
Click...

To...

Create

Create a new object with a quick link. For more information on how to
create objects, see Creating Documents and Other Objects.

Go To

See a list of predefined links to the most commonly used views.

When you have selected an object in the listing area, you can see also the sections View and Modify and
State transition in the task area.
Click...

To...

View and Modify

Do object-specific operations, for example Check Out and Check In.

State transition

Change the state of the selected object. For more information, see
Changing the Workflow State in the Task Area.
Note: The Change State command is shown in the task area
only if the object has a workflow and you have the permission to
change the workflow state.

Customizing the task area
You can customize the shortcuts of the View and Modify and Go To sections.
To...

Do this:

Add or hide shortcuts in View and Modify.

Right-click an empty space in the task area and select or
unselect a shortcut from Commands.

Add an object shortcut to the Go To
section.

Select the object, open the menu bar with the Alt key, and
select Operations > Add Shortcut to Task Area.

Add a view or virtual folder shortcut to the
Go To section.

Right-click on a view or virtual folder and select Add
Shortcut to Task Area.

Rename, remove, or move shortcuts in the
Go To section.

Right-click a shortcut and select a command.

2.2.2. Listing Area
The listing area in M-Files Desktop usually contains views and objects. The listing area and Windows File
Explorer operate almost in the same way. One difference is that for an object in M-Files Desktop, you can
use the expand or collapse arrow buttons to show and hide all the related objects. The related objects are
grouped with metadata.
Note: If an item name in the listing area is shown in gray text, the full item path is too long for
Windows (more than 259 characters). It is thus necessary to rename parts of it to make sure that
the content operates properly. If you use Microsoft Windows 10 or later, you can ask your system
administrator to enable longer item paths.
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Note: If the Size column for an object is empty, the size of the object is temporarily unknown.
When the object is opened, the size of the object is updated in the Size column.
Sorting objects in the listing area
To...

Do this:

Change the sort order of the objects in the
listing area.

Click a column heading in the listing area.

Change the sort order to ascending or
descending.

Right-click a column heading and select a sort order.

Select secondary, tertiary and other sort
orders.

Hold down the Ctrl key and click another column
heading.

Add more columns to the listing area.

Right-click on the column heading area and select
Choose Columns.

For information on how the search results are grouped, see Search result grouping.

2.2.3. Metadata Card
Click the different parts of the screenshot for a description of the metadata card sections.
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1.
2.
3.
4.
5.

Metadata card option ribbon
Object metadata
Object permissions
Object workflow
Object comments

Metadata card option ribbon
The option ribbon contains options related to the selected object and the metadata card.
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Click this icon:

To do this:
Set the object as followed or unfollowed. When the object is set as followed,
you get an email notification when someone changes the document. For more
information on notifications, see Editing Notification Settings in M-Files Desktop.
Note: The person who changed the object will not get a notification.

Pin the object to the Pinned tab, or to unpin the object.
Add the object to your Favorites view, or remove it from the view.
Open a list of options. The list includes options that change the metadata card
location.
Hide or show the title area of the metadata card.
Object comments

) to see the comment view. In the comment view, you can see and add
Click the comments icon (
comments to the object. For more information, see Object Comments.
Object permissions
Click the permissions area to open the Permissions dialog. In the dialog, you can change the permissions
for the object. For more information, see Object Permissions.
Object metadata
Metadata helps you to find objects in M-Files. Metadata is the information related to an object. For more
information, see Object Metadata.
Object workflow
Use the workflow options select a workflow and a workflow state for an object. For more information, see
Workflows.

2.2.4. Preview Tab
In the preview mode, you can browse and copy document content. Click the Preview tab on the right pane
to open the document preview. If you cannot see the pane, right-click an empty space in the listing area
and select Display Mode > Right Pane > Normal.
Note: To see the preview, the software that supports the file format must be installed on your
computer and chosen as the default application for that file format. For example, Microsoft Office
2013 or later is necessary to see a preview of Microsoft Office documents, and Adobe Acrobat
Reader is necessary to see a preview of PDF files.
To zoom PDF files on the Preview tab, right-click and select Zoom In Tool. Right-click again to use the
different zoom tools.
On the Preview tab, you can see the content of these file types:
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•
•
•
•
•
•
•
•
•
•
•

Email files (eml, emlx, msg)
HTML and web archive files (htm, html, mht, mhtml)
Image files (tif, tiff, jpg, jpeg, bmp, gif, png)
Microsoft Excel files (xlsx, xlsm, xltx, xltm, xlsb, xls, xlt)
Microsoft PowerPoint files (pptx, pptm, ppsx, ppsm, potx, potm, ppt, pps, pot)
Microsoft Word files (docx, docm, dotx, dotm, doc, dot)
OpenDocument files (odt, ott, ods, odp)
PDF files
RTF files
Text files (txt)
Visio drawings (vsd, vdx, vss, vsx, vst, vtx, vdw)

2.2.5. Pinned Tab
The Pinned tab lets you collect items that you frequently use into a single tab. Click the Pinned tab on the
right pane to see your pinned items.
Click an item on the Pinned tab to see it in the listing area, or double-click it to do the default action of the
object. For example, double-clicking a document that you can edit would open the checkout prompt for the
document. To move a pinned item in the pinned tab, drag and drop the item.
Pinning an item
To pin an item to the Pinned tab:
1. In M-Files Desktop, find and select the item that you want to pin.
2. Complete one of these steps:
a. Drag and drop the item from the listing area to the Pinned tab.
or
b. Right-click the item and click Pin.
or
c.
Click the Pin icon (

) on the option ribbon of the metadata card.

The selected item is pinned to the Pinned tab. To unpin an item, right-click it on the Pinned tab and click
Unpin.
Renaming a pinned item
You can rename a pinned item on the Pinned tab. This changes the name of the shortcut but not the name
of the item.
To rename a pinned item:
1. In M-Files Desktop, click the Pinned tab.
2. Right-click a pinned item and select Rename.
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3. Enter a new name.
The name is automatically saved.

2.2.6. Customizing M-Files Desktop User Interface
You can change display settings with the Display Mode options. Right-click an empty space in the listing
area and select Display Mode to see the settings.
With the Display Mode options, you can do these things:
•
•
•
•
•
•
•

Select if the objects are shown as icons or as a details list.
Move the metadata card to the right side of the user interface or to the bottom.
Select if the Windows File Explorer navigation pane is shown or not.
Select if the task area, the right pane, and the bottom pane are shown as usual, minimized, or not at all.
Show or hide annotations.
Enable or disable the options of grouping objects by object type, and grouping views and folders.
Select a normal or a compact layout for the user interface.

You can also set the Metadata card or the Preview tab as a default tab in M-Files Desktop. For more
information, see Setting Default Tab for Object.

2.2.7. Keyboard Shortcuts in M-Files Desktop
Shortcuts in the listing area
Use these shortcuts when the listing area is active:
Quick Search

Ctrl + F

See Quick Search.

New Document

Ctrl + N

See Creating a Document.

Refresh the object listing

F5

Updates only the objects that
have changes.

Fully refresh the object listing

Shift + F5

Updates all the objects in the
listing area.

Shortcuts for the selected objects
Use these shortcuts when an object is selected in the listing area:
Check Out

Ctrl + O

See Checking Out a Document.

Check In

Ctrl + I

See Checking In a Document.

Check in with comments

See Checking In a Document.

Relationships

Ctrl + ⇧ Shift + I
Ctrl + L

See Object Relationships.

Collection members

Ctrl +⇧ Shift + L

See Managing Document
Collections.

Comments

Ctrl + M

See Object Comments.

Subobjects

Ctrl + J

See Subobjects.

History

Ctrl + H

See Version History.
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Shortcuts for the metadata card
Use these shortcuts on the metadata card:
Tab ↹

Move to the next property field.

⇧ Shift + Tab ↹
Ctrl + I

Insert a new value field for a property.

Ctrl + D

Delete the selected property field.

Ctrl + N

Add a new value to the value list and set it as the property value.

↑/↓

Move between available property value options.

Ctrl + S

Save metadata.

Move to the previous property field.

2.3. Managing Content
This section tells you how to manage content in M-Files Desktop.

In this chapter
•
•
•
•
•
•

Adding Content to Vault
Removing and Archiving Content
Editing Content
Object Relationships
Document Collections
Using M-Files Desktop Offline

2.3.1. Adding Content to Vault
This section tells you how to add content to your M-Files vault.

In this chapter
•
•
•
•
•

Saving to M-Files
Creating Documents and Other Objects
Creating and Completing Assignments
Making a Copy of an Existing Object
Functions in Microsoft Outlook

Saving to M-Files
When you save files to your M-Files drive, the information is not usually stored on your personal hard drive.
In M-Files Desktop, you see the M-Files drive in File Explorer like other hard drives.
To save files to your M-Files drive, use one of these:
•
•
•
•

Drag and drop
Copy and paste
Save As function in an application
Import Files and Folders dialog
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When you save a file to M-Files, M-Files asks you to add metadata. For more information, see Object
Metadata.
Saving many files to M-Files
You can save many files to M-Files with drag and drop, copy and paste, and the Import Files and Folders
dialog.
Tip: To save many files with the same metadata, enable Use these values as defaults for the
next document.
Tip: Use Skip This to select not to save a file to M-Files. You can do this when you save many
files to the vault.
Detecting duplicate file contents
If you try to save a file that is already in the vault, M-Files lets you know. M-Files shows you the duplicate
documents to which you have permissions. For information on how the detection is done, see the How
does the duplicate detection feature work? page.
Duplicate file content is shown in the listing area and when you add new content to the vault:
•
•

Listing area: To see the documents with duplicate file content, expand the object. The duplicate
documents are shown under the Duplicate File Content node.
When you add new vault content: If M-Files detects documents with duplicate file content in the vault, it
shows the Duplicate File Content dialog.

If the Duplicate File Content dialog is opened, select one of these options:
Select the option...

If you...

Do Not Create

Do not want to add the document to the vault.

Create Anyway

Want to add the document to the vault.

In this chapter
•
•
•
•

Dragging and Dropping Files to M-Files
Copying and Pasting Files to M-Files
Saving to M-Files from Application
Saving Folders to M-Files

Dragging and Dropping Files to M-Files
To add content to the vault with drag and drop:
1. In File Explorer, find the file that you want to save.
2. Drag and drop the file to an empty space in the listing area in M-Files.
The New Document dialog opens.
3. Select a class for the file from the Class drop-down menu.
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4. Enter other optional property values.
Click Add property to add more properties.
5. Click Create.
Copying and Pasting Files to M-Files
1. In File Explorer, find the file that you want to save.
2. Right-click the file and select Copy.
3. Go to the M-Files window, right-click on an empty space in the listing area, and select Paste.
The New Document dialog opens.
4. Select a class for the file from the Class drop-down menu.
5. Enter other optional property values.
Click Add property to add more properties.
6. Click Create.
Saving to M-Files from Application
For information on how to save your work from a Microsoft Office application (Office 2013 or later) to MFiles, see Example: Saving a Microsoft PowerPoint Presentation to M-Files with the M-Files Tab. For
information on how to save your work from other desktop applications to M-Files, see Example: Saving a
Microsoft PowerPoint presentation to M-Files.
Example: Saving a Microsoft PowerPoint Presentation to M-Files with the M-Files Tab
1. In Microsoft PowerPoint, create a new presentation or open one.
2. Make changes to the document.
3. Open the M-Files tab in the Microsoft PowerPoint ribbon.
4. Click Save to M-Files.
5. Click the vault where you want to save your presentation.
The New Document dialog is opened.
6. Select a class for the file from the Class drop-down menu.
7. Enter other optional property values.
Click Add property to add more properties.
8. Click Create.
Your presentation is saved to M-Files.
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Example: Saving a Microsoft PowerPoint presentation to M-Files
1. In Microsoft PowerPoint, create a new presentation or open one.
2. Make changes to the document.
3. Click File > Save As > Computer > Browse.
The Save As dialog is opened.
4. In the left pane of the Save As dialog:
a. Click the Computer location and, in the right pane, double-click M-Files.
or
b. Click the arrow next to Computer to expand the location and click M-Files.
5. Double-click the vault where you want to save your presentation.
6. In File name, enter a file name for your presentation.
7. Click Save.
The New Document dialog is opened.
8. Select a class for the file from the Class drop-down menu.
9. Enter other optional property values.
Click Add property to add more properties.
10.Click Create.
Your presentation is saved to M-Files.
Saving Folders to M-Files
Note: Your administrator can use external repository connectors to import files from a network
drive. Before you import files or folders, make sure that the same content is not already in the vault.
When you save a folder with subfolders or many individual files together, M-Files can keep the old folder
structure. If you want the folder structure to stay the same, M-Files organizes the saved contents into
traditional folders. To do this:
1. In M-Files Desktop, press the Alt key to open the menu bar.
2. Select Create > Import Files and Folders.
3. Click ... to select the folder you want to import.
4. Select:
a. Do not preserve old folder structure to discard the folder structure.
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or
b. Preserve old folder structure to keep the folder structure. To import the content, select a folder for
it in M-Files. To create a new folder, click New Folder.
5. Optional: If you do not want to add metadata for the imported content, disable Prompt for metadata.
6. Click OK.
If you checked the Prompt for metadata check box, do the steps from 7 to 9 for each file you import.
7. Select a class for the file from the Class drop-down menu.
8. Enter other optional property values.
Click Add property to add more properties.
9. Click Create.
The folder is imported to M-Files. If you chose the Preserve old folder structure option, the imported
folder appears as a new traditional folder in M-Files.
Creating Documents and Other Objects
This section tells you how to create new objects in the vault. For information on differences between
documents and other object types, see the definition of an object.

In this chapter
•
•
•
•
•
•

Object Metadata
Creating a Document
Creating Non-Document Objects
Adding Content via Scanner
Replacing the Content of a Document File
Object Permissions

Object Metadata
Metadata helps you to find objects in M-Files. Metadata is the information related to an object. For
example, the creation date, the class, and the name of an object are all metadata. The more you enter
metadata for an object, the easier it is to find the object when you need it.
Editing the metadata
You can edit the object metadata on the metadata card:
If you want to...

Do this:

Edit property values.

Click a property. Mandatory fields show an asterisk (*).

Add properties.

Click Add property at the end of the property list.

Remove added
properties.

Select a property and click the

icon on the left of the property name.
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If you want to...

Do this:

Change the workflow
state.

See Changing the Workflow State on the Metadata Card.

Change permissions of
the selected items.

See Editing object permissions.

Click Save to save the changes and create a new version of the object.
Tip: You can use keyboard shortcuts when you edit object metadata. For more information, see
Shortcuts for the metadata card.
Metadata suggestions
When Intelligent Metadata Layer and intelligence services are set up, M-Files shows metadata suggestions
for a new document.
Click a suggestion to add it as a value for the property above the suggestion. If there is a plus sign (+) on
the left of the suggested value, the value is added as a new object or value list item. Some property types
let you add more than one of the suggested values.
Note: Metadata suggestions are not available if the metadata card is in the bottom pane.

Using the metadata card toolbar
Click a property to activate the metadata card toolbar. The toolbar is available for properties that use a
value list. The toolbar can include five options:
Click the icon...

If you want to...
Add a field to a multi-select property. This way, you can make a link between a
document and many property values, such as many different projects.
Remove a field from a multi-select property.
Refresh the values of the property.
Open a dialog to create a new property value.
Open a dialog to edit the selected property value.

Editing the properties of many objects
To select many objects in the listing area, select one of these options:
If you want to...

Do this:

Select a list of objects.

Click the first object, hold down the ⇧ Shift key, and
click the last object. You can also click and drag a
box around the objects that you want to select.
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If you want to...

Do this:

Select many individual objects.

Click the first object, hold down the Ctrl key, and
select the other objects.

Select all objects.

Use the shortcut Ctrl + A.

The metadata card shows all the properties of the selected objects. See this table for descriptions of the
special property values used when you have selected objects that have a different value for the same
property:
Property value

Description
The values of the selected objects are different.
None of the selected objects have the value selected.

Some of the selected objects have the value selected.

All the selected objects have the value selected.

Note: When you edit a value, you change the value for all the selected objects. For example, if you
replace (varies) with a new value, it is set for all the selected objects.
Creating a Document
You can create documents just like before and save them directly to the M-Files drive. You can also create
other types of objects, such as customers or assignments. See Creating Non-Document Objects and
Creating and Completing Assignments for more information.
Start creating a new document by first clicking the Create button and then selecting Document... from the
context menu, or by pressing Ctrl + N in the M-Files user interface. The new document dialog helps you
select the right template and class for the new document. Templates can also be searched by typing a
search term. The search displays all templates and file formats that match the search criteria, and highlight
the results.
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Figure 5: The new document creation wizard.

Selecting All displays all templates and file formats that are defined for the vault in question. The Recently
Used option shows all the templates you have recently accessed. Recently used templates are also shown
by default when you open the template selection wizard. The Blank option shows all the file formats that
can be selected for a new document.
These predefined options are followed by a list of classes that can also be used for the template selection.
Selecting a class displays the templates that are available for that class.
After you have selected a template or a blank document, a metadata card for the new document opens and
you can start editing the properties. Properties marked with an asterisk (*) are mandatory.
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Tip: You can use keyboard shortcuts when you edit object metadata. For more information, see
Shortcuts for the metadata card.

Figure 6: The metadata card of a new document.

Clicking Create saves the document and adds the object to the vault. Selecting Open for editing makes
sure that the document is checked out to you for editing until you manually check it in, and opens the new
file in a suitable application for editing. If you have selected Check in immediately, the document will be
available for others right away. Clicking Cancel discards all the changes and closes the dialog.
When you create a document in some other application, you fill in the metadata card only when you save
the document in the document vault on the M-Files drive.
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Tip: When filling in the metadata card, you can specify the permissions for the document in the
Permissions field. This way, you can specify who can view, open, or edit the document.
Converting a temporary local file to a document
The Convert to Document operation is available for files that are imported to M-Files with an unusual
procedure, for example with command prompt. M-Files shows these temporary local files with a gray icon.
To convert a temporary local file to a M-Files document, right-click the file and click Convert to Document.

In this chapter
•
•
•

Example: Creating A New Document
Using Document Templates
Single-File and Multi-File Documents

Example: Creating A New Document
1. Open M-Files Desktop and go to a vault.
2. Click Create (

).

3. Click Document.
The New Document dialog is opened.
4. To choose a template:
a. Enter a search term to the search field and select a template.
or
b. From the Select class drop-down menu, select a class and select a template from the selected
class.
or
c. Select a template from the Recently Used, All, or Blank quick lists.
5. Click Next.
6. In the Name or title field, enter a name.
7. Enter the object metadata. Mandatory fields are shown with an asterisk (*).
To add more metadata fields, click Add property below the last metadata property on the list.
8. Optional: Click the permission options at the bottom of the dialog to set permissions for your document.
For information on how to set document permissions, see Object Permissions.
9. Optional: Click the workflow options to select a workflow and a workflow state for the document.
10.Select one of these options:
a. Select Open for editing to change the content before you check in the document.
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or
b. Select Check in immediately to add the content to the vault after you click Create.
11.Click Create.
Your document is added to the vault.
Using Document Templates
You can create a new document by using a predefined template. When you select a template in the new
document creation wizard, the metadata card is populated with the data contained in the template. You can
also edit and add metadata. The new document contains the contents of the template.
Examples of useful templates include Proposal template, Order template and PowerPoint presentation
template.
To specify a document or other object as a template, add the property Is template and set it to Yes.
Templates are class-specific, but you can specify the template to affect several classes by adding the
Additional Classes property for the object.
Note: When you want to save a document as a document template to be used in M-Files, save the
document as an Microsoft Office document, that is, in the format .doc(x), .ppt(x), .xls(x) or similar.
Do not use the template formats offered by Microsoft Office applications (for instance the Word
template, .dotx).
For more information, see New Class, as well as Automatic Values for information on using document
templates with automatic values.
Single-File and Multi-File Documents
In M-Files, you can create single-file documents and multi-file documents.
A single-file document contains only one file. For example, a PDF or a Word document.
A multi-file document (
) usually contains many files. For example, you can include a proposal and its
attachments, which are single-file documents, in the same multi-file document. You can double-click the
multi-file document to see its content.
Converting a multi-file document to a single-file document
When a multi-file document contains only one file, you can convert it to a single-file document: Right-click a
multi-file document and click Convert to Single-file Document.
Converting a single-file document to a multi-file document
To convert a single-file document to a multi-file document, right-click a single-file document and click
Convert to Multi-file Document.

In this chapter
•

Adding New Files to Multi-File Documents

Adding New Files to Multi-File Documents
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The Add File function can be used for creating new document files for a multi-file document.
Note, however, that a multi-file document in M-Files does not equal to a folder in Windows. A multifile document is a single document that contains zero or more document files and one common set of
metadata. A document file is a fixed component of a multi-file document. For example, a contract scanned
from a paper copy can be a multi-file document and its pages can be the document files.
Note: Use the Import File... function to add an existing file to the multi-file document. Alternatively,
you can drag and drop a file on top of a multi-file document.
Do the following steps to add a new file to a multi-file document:
1. Right-click the multi-file document of your choice.
2. Select Add File to show a list of file types.

3. Select a type for the new file.
The document is checked out to you and a new file representing the type of your choice is
added to the multi-file document.
4. Enter a suitable name for the newly added file.
A new file with the name and type of your choice is added to the multi-file document.
Creating Non-Document Objects
Besides documents, you can also create other objects like customers and projects. You can therefore use
M-Files to manage, for instance, your customer database by adding and editing customer objects in the
document vault. Similar to documents, objects such as customers and projects have a metadata card, but
they can exist without any files. They are also deleted and edited the same way as documents.
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When you start creating a new object, the first thing you will see is the metadata card.

Figure 7: The metadata card for a new customer.

After you have entered the values for the mandatory fields (marked with an asterisk), the object can be
saved by clicking Create. Clicking Cancel deletes the newly created object.
The Check in immediately option is selected by default to ensure that the new object is saved to the
repository immediately after clicking Create. You can leave the object checked out to you if you plan to add
additional metadata to it before saving the information to the vault.
Object types are defined using M-Files Admin. For more information, see Object Types.
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Example: Creating a New Customer
1. Click the Create button and then select Customer... from the context menu.
The New Customer dialog is opened.
2. In the Customer name field, enter the customer's name.
3. Optional: Enter other customer details in the available fields.
Click Add property to add additional customer properties.
4. Click Create once you are ready.
A new customer object is added to the vault.
Adding Content via Scanner
This section offers instructions on how to add new files to the vault – or to replace existing vault content –
by using a scanner.

In this chapter
•
•
•
•

Adding Documents from the Scanner
Adding Documents from the Scanner to a Multi-File Document
Replacing a Document with a Document from the Scanner
Scanning and Text Recognition (OCR)

Adding Documents from the Scanner
1. In M-Files, click the Create button and select Add Document from Scanner... from the context menu.
2. Optional: If the Select Source dialog appears, select your scanner from the list and click Select.
3. Scan your document using the scanner application.
When the scanning is complete, the Scanner Job dialog appears.
4. Select one of the following options:
Option:

Objective:

Scanning done

You do not want to scan additional documents.

Scan more pages to the current document

You want to scan another document and combine
it with the previously scanned document.

Scan another document

You want to scan another document and do not
want to combine it with the previously scanned
document.

5. Optional: If the Conversion to Searchable PDF dialog appears, select Convert if you want to convert
the scanned document into a searchable PDF. Otherwise, click Skip Conversion.
For more information on converting scanned documents to searchable PDFs, see Scanning and
Text Recognition (OCR).
6. When the New Document dialog appears, fill in the metadata and click Create once you are done.
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The scanned document or documents are added to M-Files.
Adding Documents from the Scanner to a Multi-File Document
Complete the following steps to add documents from a scanner to a multi-file document. For instructions on
converting single-file documents to multi-file documents, see Single-File and Multi-File Documents.
1. In M-Files, locate the multi-file document for which you want to add a file from the scanner.
2. Right-click the multi-file document and select Add File > Add File From Scanner... from the context
menu.
3. Optional: If the Select Source dialog appears, select your scanner from the list and click Select.
4. Scan your document using the scanner application.
When the scanning is complete, the Scanner Job dialog appears.
5. Select one of the following options:
Option:

Objective:

Scanning done

You do not want to scan additional documents.

Scan more pages to the current document

You want to scan another document and combine
it with the previously scanned document.

Scan another document

You want to scan another document and do not
want to combine it with the previously scanned
document.

6. Optional: If the Conversion to Searchable PDF dialog appears, select Convert if you want to convert
the scanned document into a searchable PDF. Otherwise, click Skip Conversion.
For more information on converting scanned documents to searchable PDFs, see Scanning and
Text Recognition (OCR).
The scanned document or documents are added to the multi-file document.
Note: The multi-file document only has one set of metadata and separate files belonging to the
multi-file do not have any separate metadata.
Replacing a Document with a Document from the Scanner
1. In M-Files, locate and select the document that you want to replace with a document from the scanner.
Single-file documents and documents in a multi-file document can be replaced with a document
from the scanner.
2. Press Alt to display the menu bar and select Operations > Scanning and Text Recognition (OCR) >
Replace with File from Scanner... from the menu bar.
Alternatively, you can right-click the document and select Scanning and Text Recognition
(OCR) > Replace with File from Scanner... from the context menu.
3. Optional: If the Select Source dialog appears, select your scanner from the list and click Select.
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4. Scan your document using the scanner application.
When the scanning is complete, the Scanner Job dialog appears.
5. Select one of the following options:
Option:

Objective:

Scanning done

You do not want to scan additional documents.

Scan more pages to the current document

You want to scan another document and combine
it with the previously scanned document.

Scan another document

You want to scan another document and do not
want to combine it with the previously scanned
document.

6. Optional: If the Conversion to Searchable PDF dialog appears, select Convert if you want to convert
the scanned document into a searchable PDF. Otherwise, click Skip Conversion.
For more information on converting scanned documents to searchable PDFs, see Scanning and
Text Recognition (OCR).
The existing document in M-Files is replaced with the document from the scanner.
Scanning and Text Recognition (OCR)
Paper documents can be added to M-Files by using a network scanner or a local scanner. For more
information on network scanning, refer to Scanner Sources. When using local scanning, the scanner
must be directly connected to the computer that is used to add the scanned file to M-Files. The scanning
functions can be accessed by pressing the Alt key and then opening the Operations menu.
Note: Scanner integration in M-Files Desktop uses the TWAIN and WIA technologies. Only
scanners that can be equipped with a TWAIN or WIA driver are supported.
If the M-Files OCR (optical character recognition) module is enabled, M-Files suggests that the scanned
file can be converted to a searchable PDF by character recognition once the scanning is completed. You
can activate the character recognition or ignore it. You can also define advanced settings for the character
recognition.
Note: The M-Files OCR module is an M-Files add-on product available for extra fee. It can be
activated with a license code. For more information, see Enabling the M-Files OCR Module and
Managing Server Licenses. M-Files uses an OCR engine offered by IRIS. For the M-Files OCR
module purchase inquiries, please contact our sales team at sales@m-files.com.
You can convert an image file to a searchable PDF as well. The optical character recognition is performed
on the image file to enable full-text searching across the file. After the conversion, you can find, for
example, a contract document converted from an image by performing a search using the names of the
contracting parties or any other text included in the original image file.
M-Files also automatically suggests the character recognition if you drag an image file to M-Files, provided
that you have the M-Files OCR module installed. M-Files does not suggest the character recognition for
PDF files, because performing the optical character recognition on an already searchable PDF reduces the
quality and increases the size of the PDF file. You must convert non-searchable PDF files into searchable
PDF files manually via the context menu of the PDF file.
Optical character recognition can be performed on the following file formats:
•

TIF
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•
•
•
•
•
•

TIFF
JPG
JPEG
BMP
PNG
PDF

TIFF files using an alpha channel or JPEG compression are not supported.
Note: If text recognition is performed on an image file which was not saved and returned to MFiles, the file will only be saved as a PDF. Otherwise, the original image file can be found in the
document version history.
Importing Image Files as Searchable PDFs
To import a picture file to the vault as a searchable PDF:
1. Drag and drop an image file to M-Files.
2. Optional: In the Conversion to Searchable PDF dialog, check the Use automatic language
detection checkbox to set M-Files to automatically detect the document language.
3. Optional: In the Conversion to Searchable PDF dialog, click Advanced to improve the quality of the
text recognition by selecting primary and secondary language options to match the language used in
the image.
Opening the advanced options disables the option to use automatic language detection.
4. Click Convert to start the conversion.
5. Once the conversion is complete, the New Document dialog appears. Finish importing the image by
filling in the metadata and clicking Create.
The image file is imported to to the vault as a searchable PDF, allowing you to locate it by using the MFiles search functions.
Converting an Image File Stored in M-Files to a Searchable PDF
1. In M-Files, locate the image file that you want to convert to a searchable PDF.
2. Right-click the file and select Scanning and Text Recognition (OCR) > Convert to Searchable PDF...
from the context menu.
3. Optional: In the Conversion to Searchable PDF dialog, check the Use automatic language
detection checkbox to set M-Files to automatically detect the document language.
4. Optional: In the Conversion to Searchable PDF dialog, click Advanced to improve the quality of the
text recognition by selecting primary and secondary language options to match the language used in
the image.
Opening the advanced options disables the option to use automatic language detection.
5. Click Convert to start the conversion.
The image file is converted into a searchable PDF and any textual content in the image can be found using
the search functions of M-Files.
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Replacing the Content of a Document File
You can use the Replace with File... command to select another document or file whose content (data in
the file) is to replace the content of the selected document.
The first version of the replaced document file will nevertheless be kept, as M-Files made a new version
of the document when it was checked out. The metadata remains unchanged, so the command affects
the contents of the file only. You can view the version history by opening the History dialog (see Version
History).
To replace the content of a document with that of another one:
1. Right-click the document file the content of which you want to replace.
2. Press the Alt key and select Operations > Replace with File... from the menu bar.
3. Locate and select the file that you want to use for replacing the original file content.
4. Click OK.
The content of the original file is replaced with the content of the file that you selected. Document metadata
is unaffected.
Object Permissions
To open the Permissions dialog of an M-Files object, click the permissions area at the bottom of the
metadata card.

You can quickly select the document permissions with named access control lists. An access control list
consists of various user groups or users and definitions of their permissions.
Editing object permissions
To edit the object permissions, click the Permissions area on the metadata card. The object has
automatic permissions if the Selected permission settings section of the Permissions dialog shows a
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list with columns Source, Description, and Active. To edit these permissions, see Permissions from many
sources.
If the object does not have automatic permissions, you can select Full control for all internal users, Only
for me, or the drop-down menu to use a named access control list.
To specify other permissions, click Edit. In the dialog that opens, unselect Use named access control
list. Click Add to show all users, user groups, and pseudo-users registered in M-Files, and edit the
permissions for them. Click Remove to remove users, user groups, and pseudo-users from the access
control list. To specify what the users can do with the object, see Allowing and denying permissions.
Permissions from many sources
If the effective permissions of the object come from many sources, meaning that – in addition to its own
permissions settings – its access rights are affected by automatic permissions, the Permissions dialog
displays the sources in the Selected permission settings section.
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Figure 8: Effective permissions from many sources.

In the Permissions dialog, you can select the final permissions of the object. In order for any specific
permission, such as read or edit access, to be granted for a specific user, all of the permissions in effect, at
all levels, must allow it simultaneously.
The Selected permission settings section contains the columns explained below.
Source
The Source column indicates the source from which the object has received a given permission. In the
example image further above, the object has automatic permissions granted via the project IT Training,
and the object's own permissions (This object). Both of them restrict the final permissions of the object.
Description
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The Description column provides descriptive text for the permission. If you have created an automatic
permission rule based on a value, a value list, or an object type and named it, the name is displayed in this
column.
Active
If you are allowed to bypass the automatic permissions when specifying automatic permissions for the
relevant value, value list, or object type, you can deactivate the automatic permissions granted via the
value by deselecting the permission in question. Then the permission setting is not active anymore and it
does not influence the final permissions of the object.
Allowing and denying permissions
To specify what the users are allowed to do with the object, go to the Permissions dialog and click Edit.
The available options are All, Change permissions, Remove, Edit, and Read. You can allow a permission
by selecting Allow and deny it by selecting Deny.
A user with Read permissions is allowed to open the files contained by the object, as well as to view its
properties. The user cannot check out the document, and is thus not able to make any changes to it. If the
user does not have Read permissions to the document, it will not be visible to the user in views or search
results.
Edit permissions enable users to freely edit the document. These permissions automatically include Read
permission and Edit permissions. Edit permissions do not encompass any deletion rights.
Remove permissions allow users to delete the document but not destroy it altogether. Deletion rights do
not encompass any other rights.
The right to Change permissions determines whether the user is allowed to change the permissions for
the document in question. These permissions do not include any other permissions, and they can be used
independently of the other permissions.
Note: Users with the right to Change permissions enable them to specify any other permission for
themselves.
Example
Denied permissions always take precedence over allowed permissions. This means, for instance, the
following: User A is a member of user group B. User group B has the Edit permission for document C.
User A, on the other hand, does not have Edit permissions for document C. Even though user A has Edit
permissions for document C by means of user group B, user A cannot modify the document, because it
has been separately denied from user A.

In this chapter
•
•

Effective Permissions
Pseudo-users

Effective Permissions
An object may have various permissions of its own, as well as automatic permissions. All these
permissions restrict the use of the object when the extended automatic permissions have been activated.
In order for specific access rights, such as read or edit permissions, to be granted to a certain user, all
settings must allow it simultaneously. That is, any given permission must be granted by all active settings
in order for it to be effective.
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Example:
Automatic permissions for objects via any project
The access that was specified for the object itself may cover full control of the document for all users while
the automatic permissions via a project may restrict the use of the document in such a way that full control
is granted to project managers only and all other users have read-only access.

Figure 9: Automatic permissions via a project may restrict the object's permissions.

Tip: You can quickly check the effective permissions by user and access right via the table shown
in the Permissions dialog.
Example:
Internal restrictions to permissions
•

The permission settings of the object allow full control for all users.
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•
•

Via its class, the object has been granted permissions that give full control to management and readonly access to all other users.
Via its safety class property, the object has been granted permissions that give full control to
management and edit rights to the HR department.

Since any given right must be allowed by all of these settings to be valid, the settings mentioned above
restrict each other in such a way that the following permissions are ultimately valid:
•
•
•

Full control for the management.
Read-only access to the HR department.
No rights at all for other users.

The final restrictions are always determined by the strictest settings. As explained further above, all
settings must allow the permissions simultaneously in order for them to be effective.
Changing the final permissions of the document or other object
Because all permissions restrict the use of the objects, changes to final access rights can be made in
different ways. In the client software, you can change access rights as follows:
You can change the object's own permissions from the Permissions dialog. If the object has permissions
granted via properties, the Details button is displayed on the Permissions tab. The button can be used to
change the object's own permissions (activate This object first).
If deactivation of the automatic permissions is allowed, you can deactivate the automatic permissions by
property.
You can change the object's properties via which automatic permissions were granted to the object (if
allowed).
If you cannot change the permissions or properties associated with the object itself and the automatic
permissions granted via them, you should contact the administrator for changes of access rights.
Pseudo-users
Instead of just adding users or user groups to the permissions of an object, you can also add so-called
pseudo-users, or users from metadata as well.
You can specify pseudo-users directly for the object and use these automatic pseudo-users for automatic
permissions and named access control lists. Pseudo-users that are specified via properties can also
be used in workflows when you want to specify people for tasks, send a notification to users, or define
permissions for different states.
You can specify pseudo-users via only those properties that are based on a Users or User groups value
list.
For information on how this feature is supported in different M-Files clients, refer to M-Files Feature
Comparison.
Example:
You can specify that the project manager for a certain project always has access to an object if this project
is indicated in the object's metadata. Then the project manager information is automatically delivered to
the object with the project and, on the basis of automatic permissions, the user is granted project manager
access rights to the object. If the project manager is changed, the project manager information can
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easily be changed for the project. This information is transferred to the documents or other objects as a
background task (see this note), so updating their project manager information separately is not necessary.
You can also perform multilevel user definitions via properties. For example, you can define the project
manager via the related project property (see the image below). This way, the project manager information
is kept up to date constantly, as it is associated with the project instead of each separate document. You
can specify access for these pseudo-users by object or utilize them when defining automatic permissions.

Figure 10: Select "User from metadata" when you want to specify pseudo-users.

You can specify automatic permissions and utilize the pseudo-user definitions in, for example, the "contract
of employment" class, which grants specific rights automatically to, for instance, an employee's supervisor.
In this case, the supervisor is automatically found with the employee information and the supervisor
is granted the appropriate rights. If the employee's supervisor changes, these rights are automatically
granted to the new supervisor.
Note: Object permissions are updated as an asynchronous background task. Object permissions
may be updated when, for example, a named access control list, a user, a user group, or the value
of a pseudo-user (such as a project manager) is modified. You may monitor the progress of the
task in M-Files Admin in the Background Tasks section. For more information, see Monitoring
Background Tasks.
For more information on automatic permissions, see Automatic Permissions for Value List Items.
Creating and Completing Assignments
Assignments transfer information and responsibility for task execution to the correct person. Assignments
can be used, for instance, to request a colleague to look over a proposal before it is sent to the customer.
Assignments can be included in a workflow, or they can be independent. For more information on
automatic assignments included in workflows, refer to Assign to user.
To submit a new assignment, create a new Assignment object. Because assignments are objects, you
can define the same assignment for several objects. Or, inversely, add several different objects to the
same assignment. For example, you can assign several drafts to a colleague for inspection with a single
assignment.

M-Files | 2. Daily Use | 70
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
Because the assignments are separate objects, they have their own version history and permissions. For
this reason, the document and assignment included in it can have separate permissions, and therefore
only a user who has reading rights to the document can mark the assignment completed. The user does
not need to have rights to edit the document, meaning that users with a read-only license to M-Files can
also mark the assignment completed.
You have three ways to create an assignment:
•
•
•

Create an assignment and add objects to it either by dragging and dropping or by using the Add File
function from the context menu.
Select one or more documents and select Assignment from the Create menu.
Create an assignment without adding an object to it and define the entire task in the description field of
the assignment.
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Figure 11: The metadata card for a new assignment.

Assignment description
Add a free-form description of the task. The assignment notice by email displays the description to the
person to whom the task was assigned.
Assigned to
Select the persons you wish to assign the task to. You can add more users by clicking the plus button (+)
on the toolbar. Whenever an assignment is a separate object, all persons to whom the task was assigned
must mark the assignment as complete before it is switched to the "complete" state.
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Deadline
If desired, you can select a deadline for the assignment. The user gets an automatic reminder if he has not
marked the assignment as completed when the deadline is approaching. The reminder will be sent using a
common notification rule which can be deleted by the administrator.
The deadline can also be useful for creating views. The administrator or user can create a view to display
objects whose deadline is approaching. For more information about views, refer to Creating a View.
Monitored by
You can use the Monitored by field to define the users you wish to notify every time a task is marked as
complete. The person submitting the assignment is automatically defined as a task monitor as soon as
the object is saved for the first time. Once the property has been automatically or manually added to the
metadata card, you can change or add more monitors by clicking the plus button (+) on the toolbar.
Mark as complete icon
You can mark the assignment complete by clicking the icon next to the Assigned to field.
Note: If a user creates the assignment, only this user and users with full control of the vault can
edit the Assigned to property value. However, if the assignment is created via a workflow, only
users with full control of the vault can edit the property value.
Creating a New Assignment for an Existing Document
1. In M-Files, locate the document for which you want to create a new assignment.
2. Right-click the document and select Create > Assignment... from the context menu.
3. In the Name or title field, enter a descriptive title for the assignment.
4. In the Assignment description field, enter a detailed description of the assignment to ensure that the
assignee is properly informed about the details of the assignment.
5. From the Assigned to drop-down menu, select the person to whom this assignment is assigned to.
6. Optional: In the Deadline field, select a deadline date by which the assignment must be completed.
7. Optional: Via the workflow controls at the bottom of the New Assignment dialog, select a workflow for
the assignment.
8. Click Create to create the assignment.
The new assignment appears in the Assigned to Me view of the assignee and they are informed by e-mail
about the new assignment.
Creating a New Assignment for a New Document
1. In M-Files Desktop, click the Create button and select Assignment... from the context menu.
2. In the Name or title field, enter a descriptive title for the assignment.
3. In the Assignment description field, enter a detailed description of the assignment to ensure that the
assignee is properly informed about the details of the assignment.
4. From the Assigned to drop-down menu, select the person to whom this assignment is assigned to.
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5. Optional: In the Deadline field, select a deadline date by which the assignment must be completed.
6. Optional: Via the workflow controls at the bottom of the New Assignment dialog, select a workflow for
the assignment.
7. Click Create to create the assignment.
8. Once the new assignment has been created, right-click the assignment in the listing area and select
Add File and choose a suitable file format for the new file.
9. Rename the new file accordingly.
10.Optional: Double-click the newly added file to edit it.
The new assignment appears in the Assigned to Me view of the assignee and they are informed by e-mail
about the new assignment.
Completing an Assignment
Once you have been given an assignment, you have to complete the tasks associated with the assignment
and mark the assignment complete to indicate that you, the task assignee, have completed the assignment
given to you.
1. In M-Files, locate and select the assignment that has been assigned to you.
You can find all the assignments assigned to you in the Assigned to Me view.
2. Complete all the tasks required in the assignment.
3. Mark the assignment complete by doing one of the following:
a. On the metadata card, click the ✓ (Mark complete) icon next to your name in the Assigned to field.
or
b. In the task area, select View and Modify > Mark Complete.
or
c. Right-click the assignment and select Workflow > Mark Complete.
The Mark Complete dialog is opened.
4. Optional: Write a comment to the Comment field.
5. Click OK to close the Mark Complete dialog.
6. Optional: Depending on the workflow settings of the assignment, you may still need to add an electronic
signature to authorize the assignment completion.
The assignment is completed and it is removed from the Assigned to Me view.
Completing an Approval Assignment
Once you have been given an approval assignment, you have to complete the tasks associated with the
assignment and mark the assignment either approved or rejected to indicate that you, the task assignee,
either approve or reject the target of the assignment. You could mark an assignment rejected, for instance,
if you consider the target document to be unpublishable.
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1. In M-Files, locate and select the assignment that has been assigned to you.
You can find all the assignments assigned to you in the Assigned to Me view.
2. Complete all the tasks required in the assignment.
3. Mark the assignment either approved or rejected by doing one of the following:
a. On the metadata card, click either the ✓ or X icon next to your name in the Assigned to field.
or
b. In the task area, select View and Modify > Mark Approved/Rejected.
or
c. Right-click the assignment and select Workflow > Mark Approved/Rejected.
The Mark Complete dialog is opened.
4. Optional: Write a comment to the Comment field.
5. Click OK to close the Mark Complete dialog.
6. Optional: Depending on the workflow settings of the assignment, you may still need to add an electronic
signature to authorize the operation.
The assignment is completed and it is removed from the Assigned to Me view. The user defined in the
Monitored by property gets a notification e-mail of the approval or rejection.
Making a Copy of an Existing Object
To create a copy of an existing object in the vault, right-click the object of your choice and select Make
Copy from the context menu. This command creates an entirely new object using the metadata and
contents of the source object. The version history is not copied to the new object.
Functions in Microsoft Outlook
M-Files offers several features and diverse benefits for the daily handling of e-mail messages and for
their utilization in customer relationships. For example, you can automate storing messages in M-Files by
utilizing Microsoft Outlook rules and M-Files features. Extensive integration with Microsoft Outlook provides
you with, for example, the following features:
•
•
•
•
•
•
•
•

E-mail messages and attachments can be saved to M-Files in various file formats.
You can send an e-mail message and, at the same time, save it to an M-Files vault of your choice by
using the Send and Save to M-Files button in the M-Files tab for Microsoft Outlook.
E-mail messages can also be saved automatically with their metadata by means of Outlook rules and
M-Files features.
Contact persons and customers can be automatically associated with e-mail messages.
The M-Files flag indicates messages that have been saved to M-Files.
Messages related to a particular subject are interlinked in M-Files. Thanks to this, the entire message
thread is easily accessible and readable in M-Files.
The Show in M-Files function allows you to open a stored message in the M-Files user interface.
When an e-mail message is saved to M-Files in Microsoft Outlook, the document date will automatically
be the same as the e-mail date, no matter when the message is saved to M-Files.
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To disable the Send and Save to M-Files button in Microsoft Outlook, configure these registry setting on
the client computer:
Key

HKEY_CURRENT_USER\SOFTWARE\Motive\M-Files\<version>\Client\Common
\<vault name>\MSOutlookRibbon

Value name

ShowSendAndSaveInMFilesTab

Value type

REG_DWORD

Description

When enabled, the Send and Save to M-Files button is visible in the M-Files ribbon.

Default
value

1

Enabled

Value

0

Disabled

1

Enabled

To add the Send and Save to M-Files button to the default composer window in Microsoft Outlook,
configure this registry setting on the client computer:
Key

HKEY_CURRENT_USER\SOFTWARE\Motive\M-Files\<version>\Client\Common
\<vault name>\MSOutlookRibbon

Value name

ShowSendAndSaveInBuiltInTab

Value type

REG_DWORD

Description

When enabled, the Send and Save to M-Files button is visible in the default composer
window of Microsoft Outlook.

Default
value

0

Disabled

Value

0

Disabled

1

Enabled

The M-Files system administrator can also apply these settings to multiple client computers. For more
information, see Configuration Options for the "Send and Save to M-Files" Button.

In this chapter
•
•
•
•
•
•

Saving An E-Mail Message in Microsoft Outlook to M-Files
Storage Formats
Creating a Microsoft Outlook Rule for M-Files
Saving messages in M-Files Folders
Associating Messages with Contacts
The M-Files Flag

Saving An E-Mail Message in Microsoft Outlook to M-Files
1. In Microsoft Outlook, do one of the following operations:
a. Locate the e-mail message that you want to save to M-Files, right-click the message and select
Save to M-Files, and then select the vault where you want to save the selected e-mail message.
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or
b. Locate the e-mail message that you want to save to M-Files, and then drag and drop the message to
the preferred M-Files folder located in the Microsoft Outlook navigation pane.
or
c. First compose a new e-mail message, then, in the Message window, open the M-Files tab and click
Send and Save to M-Files, and finally select the appropriate vault from the drop-down menu.
The New Document dialog is opened.
2. From the Save as type drop-down menu, select the format in which the e-mail message is saved.
For more information about e-mail message storage formats, see Storage Formats.
3. Fill in the metadata for the e-mail message and click Create once you are done.
Note that some properties may be automatically populated. For more information, see
Automatically Populated Metadata.
The selected e-mail message is added to the selected vault in M-Files. An M-Files flag is also added to the
message in Microsoft Outlook as an indication that the message has been saved to M-Files.
Storage Formats
E-mail messages and attachments can easily be saved from Microsoft Outlook directly to M-Files. The MFiles capabilities described in this section are available in Microsoft Outlook versions 2013, 2016, and
2019, and in versions of Microsoft 365 Apps for enterprise that Microsoft supports.
Microsoft Outlook offers the following options for the Save to M-Files feature:
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Figure 12: E-mail messages can be saved to M-Files in many formats.

Microsoft Outlook message (*.msg)
The e-mail message and any attachments are stored in M-Files in MSG format. The stored file and its
attachments open as a message in Microsoft Outlook.
Microsoft Outlook message; separate attachments (*.msg; *.*)
The e-mail message is stored as a multi-file document: message text is stored in MSG format and the
attachments in their native file formats. The stored MSG file opens as a message in Microsoft Outlook. The
attachments open in the applications associated with the file format.
Text only; no attachments (*.txt)
The e-mail message is stored as a text file. The stored file opens in, for example, Notepad. Attachments
are not saved.
Text only; separate attachments (*.txt; *.*)
The e-mail message is stored as a multi-file document: message text is stored as plain text and the
attachments in their native file formats. The attachments open in the applications associated with the file
format.
MHTML document; no attachments (*.mht)
The e-mail message is stored in M-Files in MHT format. The stored file is opened in a program that
supports reading of MHT files such as Internet Explorer.
MHTML document; separate attachments (*.mht; *.*)
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The e-mail message is stored as a multi-file document: the content of the message is stored in MHT format
and the attachments in their native file formats. The attachments open in the applications associated with
the file format.
Save Attachments to M-Files
The Save Attachments to M-Files function stores only e-mail attachments. The attachments are stored
in their native file formats. If an e-mail message contains several files as attachments, these files are
saved as a multi-file document. If the message contains one attachment, the file is saved as a single-file
document. The attachments open in the applications associated with the file format.
Note: If you would prefer to store multiple attachments as separate documents rather than as a
single multi-file document, please contact your M-Files consultant for additional information.
Creating a Microsoft Outlook Rule for M-Files
By utilizing Microsoft Outlook rules, you can easily automate saving specific kinds of email messages to
M-Files on the basis of, for example, the sender, subject, or recipient of a message. For instance, you can
specify that all proposal messages that you send are to be saved to M-Files on the basis that the subject
field contains the word proposal.
Note: These instructions are for Microsoft Outlook 2013. If you are using a different version of
Microsoft Outlook, there may be minor differences in how rules are created.
Complete the following steps to create a Microsoft Outlook rule for M-Files:
1. Open Microsoft Outlook and select an email message that represents the type of message for which
you want to create a rule.
You can select the message and create the rule on the basis of, for example, the sender of the
message, text in the subject field, or the recipient of the message.
2. On the Home tab, in the Move section, click Rules and the select Create Rule... from the menu.
The Create Rule dialog is opened.
3. Click the Advanced Options... button.
The Rules Wizard dialog is opened.
4. Check the condition or conditions that an email message must meet for this rule to be applied.
If you want to create a rule that applies to messages that are sent by the selected sender, check
the from <sender> check box.
5. Optional: If necessary, click an underlined value in the rule description field to edit the rule condition.
6. Click Next.
7. Check the move a copy to the specified folder check box.
You can also move the messages themselves directly to M-Files so that they are deleted from
Microsoft Outlook once they are moved, but the best practice normally is to move a copy of the
message to M-Files, in which case the actual message remains in the original folder, such as the
Inbox or Outbox folder.
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8. Click specified in the rule description field.
The Rules and Alerts dialog is opened.
9. Expand the M-Files node and then select the vault to which you want to move copies of messages that
match this rule.
10.Click OK to close the Rules and Alerts dialog and then click Next.
11.Optional: If you need to make exceptions to this rule, check any exception check box that you want to
be applied and edit the exception in the rule description field, if necessary.
12.Click Next.
13.In the text field, enter a descriptive name for the rule.
14.Check the Run this rule now on messages already in... and Turn on this rule check boxes and click
Finish to finish creating the rule.
The email messages in Microsoft Outlook that match the rule that you have just specified are moved
automatically to the selected vault in M-Files.
Note: If Microsoft Outlook is not open when you receive a message that matches this rule and
would therefore be automatically saved to M-Files, M-Files will suggest that you Save pending
messages now when Microsoft Outlook is opened the next time.
Saving messages in M-Files Folders
In addition to using the Save to M-Files function, you can save messages to M-Files by using M-Files
folders. This offers several additional features for saving messages:
•
•

•
•

You can save messages quickly and easily by dragging them to M-Files folders in Microsoft Outlook.
M-Files folders are automatically available to you in Microsoft Outlook if M-Files has been installed on
your computer. Automatically used M-Files folders correspond to the M-Files vaults to which you have
added a document vault connection.
The messages are always copied from their original folder in Microsoft Outlook: messages are not
removed from their original Microsoft Outlook folder when you move them to the M-Files folder.
You can specify automatically populated metadata for each M-Files folder.

The functions described in this section are available in Microsoft Outlook versions 2013, 2016, and 2019,
and in versions of Microsoft 365 Apps for enterprise that Microsoft supports.

In this chapter
•

Automatically Populated Metadata

Automatically Populated Metadata
You can specify automatically populated properties to be added to e-mail messages when you save
them to M-Files by dragging them to M-Files folders in Microsoft Outlook. These settings are folderspecific, allowing you to utilize multiple subfolders for a variety of use cases. The function is available in
Microsoft Outlook versions 2013, 2016, and 2019, and in versions of Microsoft 365 Apps for enterprise
that Microsoft supports.
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Note: These folders need to be added as subfolders under the automatically created M-Files
folders (representing your M-Files vault connections). If you create a folder directly on the main
level, you create a normal Microsoft Outlook folder, for which you cannot specify M-Files properties.
You can find the Specify M-Files Properties function in Microsoft Outlook by right-clicking an M-Files
folder.

Figure 13: Properties dialog for setting up automatically populated, folder-specific metadata.

Click the Add... button to define a new property.
You can, for instance, use the property Project and set it to have the fixed value Hospital Expansion
(Miami, FL). This way, the messages dragged into that folder are automatically associated with the
Hospital Expansion (Miami, FL). Alternatively, if you wish to save all job applications in the Job application
class, select the folder property Class and set its value to Job application.

M-Files | 2. Daily Use | 81
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
You may also specify M-Files folder properties to be read from the e-mail message itself. In this case,
select Add..., then the Read from the e-mail message option and choose a suitable field from the dropdown menu.
Allow users to retain the property value for this folder
This setting (visible only to users with at least the right to manage common views) adds a Retain column
to the folder properties dialog. The Retain option is available for all users, and also controlled by each
individual user. Activating the Retain option for a property tells M-Files to remember the latest value
provided by the user, ignoring the original fixed value set by the administrator.
Let's say the organization is connected to two projects with the same customer, and the default project
has been set to Alpha. The project manager for project Beta would probably want to enable the Retain
option, because this way the property needs to be changed only once. After this, M-Files remembers that
the project manager wants to associate his e-mails with project Beta, not Alpha, even though the default
project was set to Alpha.
Permissions
The Permissions option enables you to define user permissions for the messages that are saved in this
M-Files folder. This should not be confused with the view permissions for common folders (see below).
Prompt for metadata
You can specify whether the metadata card is to be displayed when messages are dragged into the MFiles folder. The metadata card should be displayed if you wish to check or modify automatically populated
metadata during saving, or if you have not defined any folder-specific properties.
Specifying common M-Files folders
You can also specify that the M-Files subfolder you created is common to all users, in which case the
folder will be displayed in Microsoft Outlook to all users. A common M-Files subfolder can be created and
specified by a user with at least the right to manage common views. When the user drags a message to a
common folder, the message automatically receives the metadata (properties) that have been specified for
the common folder.
The common folder settings are applied once the user starts Microsoft Outlook while being logged into the
vault.
Common folder view permissions
As soon as the Common to all users option has been enabled, the Permissions tab appears next to
the Metadata tab. This allows you to select view permissions for the common folder. This should not be
confused with the Permissions option on the Metadata tab (see above).
Defining Automatically Populated Metadata
1. In Microsoft Outlook, select an existing M-Files folder or create a new M-Files folder:
If you want to...

Do the following...

Define automatically populated metadata for
an existing M-Files folder

Right-click an existing M-Files folder in the
navigation pane and select Specify M-Files
Properties from the context menu.
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If you want to...

Do the following...

Define automatically populated metadata for a
new M-Files folder

Right-click a vault in the navigation pane, select
New Folder... from the context menu, name the
folder and press the Enter key.

The Properties dialog is opened.
2. Click Add... to define a new property.
The Define Property dialog is opened.
3. From the Property drop-down menu, select an M-Files property that you want to automatically
populate, and then select either:
a. Use a fixed value and enter or select a value in the field below if you want to populate the property
value with a fixed value.
or
b. Read from the e-mail message and select an e-mail header field to read information from by using
the Field drop-down menu if you want to populate the property value with information read from the
imported e-mail message.
4. Click OK to close the Define Property dialog.
The automatically populated property is added to the Properties list in the Properties dialog.
5. Optional: On the Properties list in the Properties dialog, check the Retain check box of an
automatically populated property if you wish M-Files to always remember the most recent value set by
any user for this property, ignoring the original value set in this dialog.
6. Using the Permissions drop-down menu, define the permissions for documents created via this folder.
7. Optional: Check the Prompt for metadata check box if you wish to display the metadata card and
prompt for additional metadata whenever an e-mail message is dragged and dropped to this folder.
8. Using the Save as type drop-down menu, select the e-mail message format for the messages saved to
this folder.
9. Optional: Check the Common to all users check box if you wish to display this folder to all vault users
in Microsoft Outlook.
If the Common to all users option is enabled, you can specify the users who may see this
folder on the Permissions tab.
When an e-mail message is dragged and dropped to the Microsoft Outlook folder for which you have
just set automatically populated metadata definitions, the message is saved to M-Files with automatically
populated metadata.
Associating Messages with Contacts
You can use M-Files Admin for specifying messages to be automatically associated with contact persons
and customers saved in M-Files on the basis of the sender and recipient information. A message from, for
example, matt.bay@estt.com can be automatically associated with the contact person Matt Bay and the
customer ESTT.
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Note: This feature is available in Microsoft Outlook versions 2013, 2016, and 2019, and in
versions of Microsoft 365 Apps for enterprise that Microsoft supports.
When the user is saving an e-mail message to M-Files in Microsoft Outlook, M-Files looks for similarity
between the e-mail addresses in the message and the properties that have been specified in M-Files
Admin. On the basis of similarity and the properties specified by the administrator, M-Files automatically
associates the message with customers or contact persons when the message is saved in the M-Files
folder in Microsoft Outlook. For more information on how to specify the properties in M-Files Admin, see
Email Client Integration Settings.
This automation takes place on a vault-specific basis (with a vault-specific M-Files folder in Microsoft
Outlook), also applying to all subfolders of the M-Files folder in question.
The M-Files Flag
The M-Files flag, shown in the Microsoft Outlook message listing, indicates that you have already saved
the message to M-Files.
If some other user (for instance another recipient) has saved the same message to M-Files, M-Files
prompts you to confirm whether you wish to save that message again. Even if you do not save the
message again, the M-Files flag will now be displayed in Microsoft Outlook for that message.
With the Update M-Files Status function in the context menu of the message, you can easily display all
M-Files flags. Also messages saved in M-Files by other users will then have an M-Files flag in Microsoft
Outlook.

2.3.2. Removing and Archiving Content
This section deals with ways you can remove objects from your vault, as well as with archiving vault
content.

In this chapter
•
•

Deleting, Undeleting, and Destroying Objects
Archiving

Deleting, Undeleting, and Destroying Objects
Deleting objects
To delete an object, right-click it and select Delete. The object is not destroyed permanently, but it will
become deleted.
Note: You can see the deleted objects in M-Files Desktop only if you have at least one of these
permissions:
•
•
•

System administrator permissions
Vault administrator permissions
The permission See and read all vault content (including deleted objects)

To show deleted objects, you can create a view for them or use a filtered search.
Undeleting objects
To restore a deleted object, right-click it and select Undelete. To find deleted objects, see Deleting objects.
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Destroying objects
To permanently remove an object, right-click a deleted object and select Destroy. You can also select
Destroy permanently in the confirmation dialog when you delete an object. To find the deleted objects,
see Deleting objects.
Archiving
When documents are no longer actively needed in the document vault, they can be archived. For example,
the system administrator can store all documents marked for archiving by users in a separate archive file,
from which they can also be restored to active use.
Mark for archiving
You can specify objects to be archived by selecting them in the listing area, right-clicking one of them,
and then selecting Archiving > Mark for Archiving from the context menu. The archiving operation
performed via M-Files Admin moves the marked objects from the vault to a separate archive file. For more
information, see Archiving Old Versions.
Clear Archiving Marker
You can remove the archiving marker of the selected object by right-clicking it and selecting Archiving >
Clear Archiving Marker from the context menu.

2.3.3. Editing Content
This section explains how documents are edited in M-Files via first checking them out for editing or coauthoring and then, when you are done with your changes, checking them back in to the vault. The section
also describes how to enable and use the Annotations and Redlining feature, how to use object comments,
workflows, and version history, and how to compare document content.

In this chapter
•
•
•
•
•
•
•
•
•
•
•
•

Checking Out a Document
Checking Out a Document for Co-Authoring
Checking Out a Document for Co-Authoring via Microsoft SharePoint
Checking In a Document
Annotations and Redlining
Object Comments
Workflows
Version History
Conflict History
Comparing Documents
Functions in Microsoft Word, Microsoft Excel and Microsoft PowerPoint
Functions in AutoCAD

Checking Out a Document
Checking out a document is an M-Files function that prevents concurrent editing. A checked out document
can still be viewed and opened in read-only mode by other users.
When you are opening a document that has not yet been checked out, the following message is displayed:

M-Files | 2. Daily Use | 85
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

Figure 14: The checkout message.

When you check out a document, a small check mark appears on the document icon to indicate that it has
been checked out to you. A red sign indicates that the document has been checked out to someone else,
in which case you are only able to open it in read-only mode.

Figure 15: An object checked out to someone else and an object checked out to you.

Note: When you check out a document in M-Files Desktop, the M-Files Web user interface
indicates that the same document is checked out to someone else even when you are using exactly
the same user account in both clients. The same applies the other way around, meaning that
when you check out a document in M-Files Web and view it in M-Files Desktop, it will appear to be
checked out to somebody else. This happens because the two clients use a different client cache.
You can, however, use the Undo Checkout command.
Functions without checkout
You can add files to and remove files from a multi-file document without checking it out for editing. You can
also rename and replace files without checking them out.
Sending a check-in request
If you need to edit a document that is currently checked out to some other user, you can send the user a
check-in request by right-clicking the document and selecting Send Check-in Request from the context
menu. The user then receives an e-mail message informing them that you are requesting the document to
be checked in. The message also contains a link to the document in question. The check-in request is sent
to the e-mail address associated with the user's login account.
Undoing Document Checkout
With the Undo Checkout function, you can undo checking out a document without saving the changes on
the server. In this case, you lose all changes you made to the document during the checkout. This function
is useful when you have checked a document out, made changes and saved the document, but do not
want the changes to take effect. In other words, you want to restore the document to how it was before you
checked it out.
If the document has never been checked in, it is deleted when the Undo Checkout function is used.
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Checking Out a Document for Co-Authoring
With M-Files, several users can edit a document at the same time. You can check out a document for coauthoring with Microsoft Office for the web when the Microsoft Office for the web tools and co-authoring
have been enabled for your vault or vaults.
Note: Office for the web has limits for the maximum size of the files. For more information, refer to
Microsoft documentation.
Editing an Office Document in the Co-Authoring Mode
You need to have an Office 365 account and editing permissions to the document you want to edit via coauthoring.
To check out a document for co-authoring:
1. Locate the object you want to make available for co-authoring in M-Files Desktop or in the classic MFiles Web.
2. Right-click the document and select Check Out for Co-authoring in the context menu.
Note: Co-authoring is only available for single-file DOCX, XLSX, XLSM, and PPTX
documents.
In M-Files Desktop, a security warning is opened about who can view and modify the file during
co-authoring. If you use the classic M-Files Web, skip to step 4.
3. In the Security Warning dialog in M-Files Desktop, click Begin Co-authoring.
The document is opened in Microsoft Office for the web.

Tip: If you are using Google Chrome and the browser cannot complete loading the
editor, check whether the address bar contains an icon informing the user about a
blocked redirection. If it does, go ahead and click it, and allow the redirection to be
carried out. Finally, close the browser window or tab and double-click the document in MFiles to reopen the editor.
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4. Edit the document in the browser.
Microsoft Office automatically saves your document when you make changes to it.
5. Once you are done, click End Co-authoring to close the editor.
In M-Files Web, this command is called Save and return to M-Files.
6. To end co-authoring, right-click the object in M-Files Desktop or the classic M-Files Web and select
Check In in the context menu.
The user who checks out the document for co-authoring must be the one who also checks
it in. The changes made during co-authoring are attributed to the user who checked out the
document for co-authoring and checked in the new version.
You can reject the changes made in co-authoring by right-clicking the object and selecting Undo
Checkout from the context menu.
The changes made by you and anyone else during co-authoring are saved to M-Files, unless you selected
Undo Checkout instead of checking in the document.
Participating in Co-Authoring
When a document has been checked for co-authoring, you can take part in the authoring process by doing
the following steps:
1. Locate the co-authored document in M-Files Desktop or the classic M-Files Web and double-click it to
open it in the co-authoring mode.
A co-authored document is marked with a yellow icon containing a white checkmark.
A dialog about editing the document in the co-authoring or opening it in read-only mode is
opened.
2. Select Edit (Co-authoring).
The document is opened in Microsoft Office for the web.
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Tip: If you are using Google Chrome and the browser cannot complete loading the
editor, check whether the address bar contains an icon informing the user about a
blocked redirection. If it does, go ahead and click it, and allow the redirection to be
carried out. Finally, close the browser window or tab and double-click the document in MFiles to reopen the editor.
3. Edit the document in the browser.
Microsoft Office automatically saves your document when you make changes to it.
4. Once you are done, click End Co-authoring to close the editor.
In M-Files Web, this command is called Save and return to M-Files.
The changes you made to the document are saved to M-Files once the user who started the co-authoring
has ended the co-authoring and checked in the document.
Checking Out a Document for Co-Authoring via Microsoft SharePoint
If you are not using Microsoft Office for the web, you can use the co-authoring functionality via Microsoft
SharePoint. In co-authoring via Microsoft SharePoint, also a person without an M-Files account can
participate in the co-authoring process. For instructions on how to set the co-authoring features to be used
via Microsoft SharePoint, see the knowledge base article Customizing Co-Authoring and Sharing Features.
Editing an Office Document in the Co-Authoring Mode via Microsoft SharePoint
You need to have a Microsoft account for co-authoring Office documents. If you do not have one, you can
create the account the first time you check out an object for co-authoring.
1. Locate the object you want to make available for co-authoring in M-Files.
2. Either:
a. Right-click the object and select Check Out for Co-authoring from the context menu.
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or
b. Right-click the object and select Begin Co-authoring from the context menu if the file is part of a
multi-file document or if it is already checked out to you.
Note: By default, co-authoring is available for DOCX, XLSX, and PPTX files only.
A security warning is opened about who can view and modify the file during co-authoring.
3. Click Begin Co-authoring in the Security Warning dialog.
4. In the Co-authoring dialog, click Send Link to send the shared object link to co-authoring participants
via your mail client.
You can also right-click the object you have checked out for co-authoring and select Send Coauthoring Link... whenever you want to share the co-authoring link to someone.
Please note that anyone with the link can view and modify the file.
5. Double-click the object in the listing area to begin co-authoring.
The document is opened in Microsoft Office for the web.
6. Click Edit in Browser in the upper right corner to begin editing in the co-authoring mode.
M-Files functions (such as adding metadata to the content) are not available during coauthoring.
7. Optional: Click Open in Word (or Open in Excel or Open in PowerPoint) above the Office ribbon to
begin co-authoring in the desktop application.
8. Save your changes if you are using the desktop application.
Microsoft Office automatically saves your document when you make changes to it.
9. Close the document.
10.Right-click the object in M-Files, and select End Co-authoring from the context menu.
11.Finally, right-click the object again and select Check In to check in the changes.
The user who checks out the document for co-authoring must be the one who also checks it
in. This M-Files user is responsible for the changes made in the document. The changes made
during co-authoring are attributed to the user who checked out the document for co-authoring
and checked in the new version.
You can reject the changes made in co-authoring by right-clicking the object and selecting Undo
Checkout from the context menu.
The changes made by you and anyone else during co-authoring are saved to M-Files. If you want to share
the document for co-authoring again, check out the file for co-authoring and send a new link to the file.
Participating in Co-Authoring via Microsoft SharePoint
When a document has been checked for co-authoring, there are two ways you can take part in coauthoring the document.
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1. Either:
a. If you receive a link to a co-authored document, click the link to open the document in the coauthoring mode.
or
b. Locate the co-authored document in M-Files and double-click it to open it in the co-authoring mode
(a co-authored document is marked with a red cloud on top of its icon) and click Edit (Co-authoring)
in the Co-authoring dialog.
2. Click Edit in Browser in the upper right corner to begin editing in the co-authoring mode.
3. Optional: Click Open in Word (or Open in Excel or Open in PowerPoint) above the Office ribbon to
begin co-authoring in the desktop application.
4. Save your changes if you are using the desktop application.
Microsoft Office automatically saves your document when you make changes to it.
5. Close the document.
The changes you made to the document are saved to M-Files once the user who started the co-authoring
has ended the co-authoring and checked in the document.
Checking In a Document
When you have edited and saved a document and are no longer using it, you should save the changes on
the server by right-clicking the object and selecting Check In from the context menu. Alternatively, you can
select the object and press the Alt key, and then select Operations > Check In from the menu bar. After
this, other users will be able to check out the document and edit it.
Tip: You can simultaneously check in all documents that you have checked out in the Checked
Out to Me view. The shortcut for checking in a document is Ctrl + I.
Checking in with comments
You can comment on changes you made when you check in a document. Right-click the object and
select Check In with Comments. Alternatively, select the object and press the Alt key, and then select
Operations > Check In with Comments. In the Check In dialog, you can enter description of the changes
you made. The comments are displayed in the Comments view of the object.
Note: Comments keep their permission settings. Only users defined in the permission settings,
when the comment was added, can see these comments.
Annotations and Redlining
You can add comments and stamps, as well as draw arrows, boxes and other shapes to your documents.
The feature supports most common file types, including Microsoft Word, Microsoft Excel, Microsoft
PowerPoint and Visio documents, email files, RTF files, HTML and web archive files as well as
OpenDocument files and PDF documents. When you select an annotated document, the task area shows
the options to show or hide the annotations.
Note: The annotations are not added to the documents themselves, but rather as detachable
layers that can also be hidden if need be.
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Note: The M-Files system administrator must first enable the annotations and redlining feature
before documents can be annotated. For more information, see Annotations and redlining.
Enabling annotations in the user interface
To make sure that annotations are enabled in your user interface:
1.
2.
3.
4.

Open M-Files Desktop and access your vault.
Press the Alt key on your keyboard.
Open the View menu.
Enable the Show Annotations option.

Annotation objects
Your annotations are saved as separate Annotation objects under the main document. M-Files
automatically creates these objects every time you start creating new annotations. Annotation objects
contain an XFDF file (XML Forms Data Format) that basically tells M-Files the type, form, and location of
your annotations.
Supported file formats
This feature supports the following file formats:
•
•
•
•
•
•
•
•
•
•
•

Email files (eml, emlx, msg)
HTML and web archive files (htm, html, mht, mhtml)
Image files (tif, tiff, jpg, jpeg, bmp, gif, png)
Microsoft Excel files (xlsx, xlsm, xltx, xltm, xlsb, xls, xlt)
Microsoft PowerPoint files (pptx, pptm, ppsx, ppsm, potx, potm, ppt, pps, pot)
Microsoft Word files (docx, docm, dotx, dotm, doc, dot)
OpenDocument files (odt, ott, ods, odp)
PDF files
RTF files
Text files (txt)
Visio drawings (vsd, vdx, vss, vsx, vst, vtx, vdw)

Troubleshooting
If you are running into issues with annotations or are unable to use them, see Why can't I convert a
document to PDF format or annotate a document? for assistance.

In this chapter
•
•

Adding Annotations to Documents
Editing Annotations

Adding Annotations to Documents
To create an annotation object and add annotations to a document:
1. Select a document in the listing area.
2. Make sure that the Preview tab is selected in the right pane.
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3. Select one of these options:
a. Right-click the document and select Create > Annotation.
or
b. Click New Annotations in the task area under the Annotations section.
Note: This option is only available for documents that do not have annotations.
An annotation object is added to the document's related objects in the listing area.
4. Use the annotation controls at the top of the preview to add annotations.
The annotation controls include different ways for you to highlight parts of the document and
icons for saving and printing the annotated document.
5. In the task area, click Save Annotations.
The annotation object is checked in.
Editing Annotations
To edit an annotation object:
1. Select an annotated document or an annotation object in the listing area.
2. Make sure that the Preview tab is selected in the right pane.
3. Click Edit Annotations in the task area under the Annotations section.
4. Use the annotation controls at the top of the preview to add annotations.
The annotation controls include different ways for you to highlight parts of the document and
icons for saving and printing the annotated document.
5. In the task area, click Save Annotations.
The annotation object is checked in.
Object Comments
You can add comments to objects in the vault with the Comments function. Click the comments icon
(
) on the metadata card to see the comments of an object. You can only add comments for
objects for which you have edit permissions, and only when you are not using a read-only license. As an
exception, you can add a comment for an object when you change its workflow state.
Note: Comments keep their permission settings. Only users defined in the permission settings,
when the comment was added, can see these comments.
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Workflows
During the lifecycle of a document, different contributors can change, edit, and make different decisions on
the document. It is important that each person that participates in the process knows their responsibilities
and the working stages.
The M-Files workflows let you model document lifecycles to real world processes. The workflows are
divided into states that represent the working stages of the document or other object.

Figure 16: Workflows make routine tasks of the organization easier. For example, processing purchase invoices.

Workflows are created and changed in M-Files Admin by M-Files system administrators. To create and edit
workflows, see Configuring Workflows.
To select a workflow and a workflow state for an object, use the workflow controls at the bottom of the
metadata card.

Changing the Workflow State on the Metadata Card
1. Select an object in the listing area.
2. Click the workflow state field at the bottom of the metadata card.
3. Select the workflow state.
The Change State dialog is opened.
4. Optional: In Comment, add comments about the state transition to the object.
5. Select one of these options:
Option

Description

OK

The state transition is made and the possible
comment is added.

Cancel

The state transition is made but no comment is
added.

The Change State dialog is closed.
6. Click Save.
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7. Optional: If the Electronic Signature dialog is opened, complete one of these steps:
a. If the Username and Password fields are shown, enter your user credentials and click Sign.
or
b. If the Username and Password fields are not shown, click Sign to enter your user credentials.
Changing the Workflow State with the Context Menu
1. In the listing area, right-click an object and click Workflow > Change State.
The Change State dialog is opened.
2. In State Transition, select the workflow state.
3. Optional: In Comment, add comments about the state transition to the object.
4. Click OK.
The Change State is closed and the state transition is made.
5. Optional: If the Electronic Signature dialog is opened, complete one of these steps:
a. If the Username and Password fields are shown, enter your user credentials and click Sign.
or
b. If the Username and Password fields are not shown, click Sign to enter your user credentials.
Changing the Workflow State in the Task Area
1. In the listing area, select an object that has a workflow.
2. In the task area, click the new state in the State transition section.
The Change State dialog is opened.
3. Optional: In Comment, add comments about the state transition to the object.
4. Click OK.
The Change State is closed and the state transition is made.
5. Optional: If the Electronic Signature dialog is opened, complete one of these steps:
a. If the Username and Password fields are shown, enter your user credentials and click Sign.
or
b. If the Username and Password fields are not shown, click Sign to enter your user credentials.
Version History
M-Files keeps previous versions of objects. You can return to a previous version from the object history.
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When you create a document and check it in, the first version of the document is saved on the server.
When you check out the document, make changes, and check it back in, the second version of the
document is saved on the server. You can roll back to one of these document versions.
In the History dialog, the
icon identifies a previous version of the object. In this example, a Microsoft
Word document is shown. You cannot change the content or metadata of previous versions.

Add label to this version
You can add a label to an object version. The label is shown in the Version label column in the History
dialog.
To add a label to the selected object version:
1. Click Add Label to This Version.
2. Select a label from the drop-down menu.
To create a version label:
1. Click Add Label to This Version.
2. Click the arrowhead next to the drop-down menu.
3. Click New Value (Version label).
Clear this label from the other versions of the object
Only system administrators and users with the Full control of vault administrative permissions can use
this option.
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To remove the selected label from other object versions, enable Clear this version label from the other
versions of the object. For example, you can make sure that only one version of a contract has the label
"Approved".
Roll back
In the History dialog, object versions are recorded from oldest to newest. You can restore old versions
with the Roll Back option.
When you do a rollback, M-Files uses the contents and metadata of the selected version to create a new
version of the object. Rollback does not have an effect on the versions in between. You can use the Roll
Back option only when the object is not checked out. Be careful when you roll back to an object version
that has a workflow state, because the workflow state can cause unwanted actions.
Note: You must have the correct permissions for the object to restore a previous version of it.
If you roll back to a version where the permission settings and the metadata of the object are
changed, you must have change permissions and edit rights to the object. If only the metadata or
the contents of the object are changed, you must have edit rights to the object.
Version history and permissions
To see a previous version of an object, you must have have access rights to that version and to the latest
checked-in version.
Conflict History
When automatic conflict resolution is enabled, M-Files automatically resolves conflicts that occur during
data synchronization between vaults. Vault users can then use the Conflict History dialog to see and
restore discarded object versions. For instructions on how to configure automatic conflict resolution, refer
to Configuring Automatic Resolution of Replication Conflicts.
The configuration specifies if you are told when changes you made to an object are discarded in conflict
resolution. The options are:
•
•
•

You get a notification.
A task is assigned to you.
There is no indication of discarded changes.

Showing and Restoring Discarded Object Versions
To show the discarded object versions:
1. In M-Files Desktop, right-click an object and select Conflict History.
The Conflict History dialog is opened.
Note: If there are many discarded object versions, it is possible that the oldest ones are
not shown.
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To compare document versions:
2. Press and hold the Ctrl key, and select two document versions.
3. Right-click a selected version and select Compare Selected Documents.
To restore a discarded object version:
4. Select a discarded object version.
5. Click Restore Object Version.
6. In the confirmation dialog that is opened, click Yes.
M-Files uses the contents of the object version to create a new version of the object.
Comparing Documents
You can use the Microsoft Word ribbon to compare two document versions. For more information, see
Compare.
Functions in Microsoft Word, Microsoft Excel and Microsoft PowerPoint
The M-Files functions in Microsoft Word, Microsoft Excel and Microsoft PowerPoint for Microsoft Windows
make it easy to manage documents. You can access the functions from the File menu, Office menu, or MFiles menu.
The M-Files functions in this section are available in Microsoft Word, Microsoft Excel, and Microsoft
PowerPoint 2013, 2016, and 2019, and in versions of Microsoft 365 Apps for enterprise that Microsoft
supports.
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Open From M-Files

Save to M-Files

Explore M-Files

Check Out

You can open a document from the vault to read or edit it. If you have many
vaults, use the Open from M-Files function to select the correct one. This
function is also available in the File and Office menus.

Save is the easiest way to save a document to M-Files. When you save to MFiles directly, the metadata card opens for editing. For more information, see
Creating a Document. If you use many vaults, select the correct vault in the
Save submenu. This function is also available in the File and Office menus.

If the opened file is in M-Files, the Explore M-Files function shows it in MFiles. This makes it is easier to use other M-Files functions on the file.

The Check Out function converts a previously read-only document into an
editable document.
Note: If the document is edited in read-only mode, all changes are
lost when you Check Out the document.

Check In

Check In Changes

Undo Checkout

The Check In function saves the edited document to the vault and closes it in
Microsoft Word.

The Check In Changes function checks in your changes and immediately
checks out the document to you. This lets other vault users see your changes
but lets you continue to edit the document.

The Undo Checkout function closes the current document and cancels the
checkout. If the Undo Checkout function is done on an edited document, all
changes made after the document was checked out are lost.
Note: It is not possible to use Undo Checkout on a single file of a
multi-file document. The function is also not available in the M-Files
menu.

Compare

With the standard Compare function, you can compare the content of the
current document to a previous version of the same document. The Compare
function opens the document version history where you can select a previous
version with which to compare the current one.
Note: Compare is available in Microsoft Word only.

Insert Property

Properties

See Add M-Files Property.

The Properties function opens the document's metadata card. See also
Object Metadata.
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In this chapter
•

Add M-Files Property

Add M-Files Property
To add object metadata to the content of a Microsoft Word, Microsoft Excel, or Microsoft PowerPoint
document, click Insert Property in the M-Files tab. It is also possible to add an electronic signature
to a Microsoft Word document with the Insert property function. For more information, see Electronic
Signatures.
Note: For Microsoft PowerPoint, the Insert Property function is available in versions 2013, 2016,
and 2019, and in versions of Microsoft 365 Apps for enterprise that Microsoft supports.
By default, the metadata fields in a Microsoft Word, Microsoft Excel, or Microsoft PowerPoint document
are updated when someone checks out the document in M-Files. As an alternative, it is possible to enable
automatic updates for metadata fields. When this setting is enabled, the metadata fields are updated
when metadata is changed in M-Files Desktop, the classic M-Files Web, or M-Files Mobile. To enable this
feature, tell your M-Files system administrator to enable automatic updates for metadata fields.
Using Insert Property with document templates
The Insert Property function can be very helpful when you create document templates. Text fields or cells
in the template are automatically filled with the selected properties when a user creates a new document. If
a property does not have a value, the text fields or cells in the document templates stay empty.
To define an existing document as a document template in M-Files, use the Is template property. To
control which users can set documents as templates, see Property Definition Permissions. It is, however,
not necessary to set a document to be a template to add metadata to the document.
An M-Files property added into a Microsoft Word document shows as a text field, that turns gray when
clicked. In Microsoft Excel documents, M-Files properties show as cell formulas. Microsoft PowerPoint
documents show the properties as text areas.
Example: Inserting M-Files Properties in Microsoft Word
1. Find a Microsoft Word document in M-Files.
2. Double-click the document and click Check Out.
The selected document is opened in Microsoft Word.
3. In Microsoft Word, place the cursor where you want the M-Files property to be added.
4. Open the M-Files ribbon and click Insert Property.
The Insert M-Files Property dialog is opened.
5. Click the name of a property.
6. Click OK to close the Insert M-Files Property dialog.
The value of the selected property is added to the selected location of the document.
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Functions in AutoCAD
To make work with CAD drawings easy, users get access to the M-Files functions directly in Autodesk
AutoCAD. You can access the functions from the File menu or the M-Files menu.
M-Files functions in AutoCAD:
•
•
•
•
•

Open from M-Files
Save to M-Files
Check Out
Check In
Undo Checkout

These functions are not supported in AutoCAD LT. The supported AutoCAD versions are specified in the
M-Files Lifecycle Policy.
For more information about these functions, see Functions in Microsoft Word, Microsoft Excel and
Microsoft PowerPoint .
Properties
See Properties.
Insert Field
With the Insert Field option, you can add M-Files metadata to drawings and AutoCAD fields. In AutoCAD,
you can find the M-Files metadata fields in the M-Files field category in the Field selection dialog. For
more information, see Add M-Files Property.

2.3.4. Object Relationships
You can create relationships between objects to link related documents. For example, an offer can contain
an offer document, a related price list, and a company brochure. Each object has a separate version
history and you can update them separately. Relationships do not create copies of linked objects but
establish references between them.
With relationships, you can specify metadata connections between objects the same way you do with
the metadata card. For example, you can link a customer with a document, which will then show in the
metadata of the object. Relationships added with the metadata card are also shown in the Relationships
dialog.
Tip: You can use the properties of a related object to create indirect views and searches or to
specify filter settings. For more information, see Indirect searches.

In this chapter
•
•
•

Relationship Operations
Relationships Between Objects in Separate Vaults
Subobjects

Relationship Operations
In M-Files Desktop, right-click an object in the listing area and select Relationships to manage the
relationships of an object.

M-Files | 2. Daily Use | 101
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
Adding Object Relationships
To add a relationship to the selected object:
1. On the Relationships From This Object or All Relationships tab, click Add Relationship.
2. In the Select Target Object dialog, select the target object.
For a specific version, right-click an object and click History.
Tip: You can also drag and drop objects from other windows to the Relationships
dialog to create many relationships at once.
3. Click Open.
4. In the Define Relationship dialog, select one of these options:
Option

Description

Latest version

The relationship always points to the latest version of the target object.

Specific version

The relationship points to the selected version of the target object. The
relationship does not show updates to the object.

5. Click OK.
6. In the Relationships dialog, click Close.
Editing Object Relationships
To edit a relationship of the selected object:
1. In the Relationships dialog, click Check Out.
2. On the Relationships From This Object or All Relationships tab, select the relationship.
3. Click Edit Relationship.
4. In the Relationship Properties dialog, select one of these options:
Option

Description

Latest version

The relationship always points to the latest version of the target object.

Specific version

The relationship points to the selected version of the target object. The
relationship does not show updates to the object.

5. Click OK.
6. In the Relationships dialog, click Check In.
7. Click Close.
Removing Object Relationships
To remove a relationship of the selected object:
1. In the Relationships dialog, click Check Out.
2. On the Relationships From This Object or All Relationships tab, select the relationship.

M-Files | 2. Daily Use | 102
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
3. Click Remove Relationship.
4. In the confirmation dialog that is opened, click Yes.
5. In the Relationships dialog, click Check In.
6. Click Close.
Relationships Between Objects in Separate Vaults
You can also create a relationship between objects that are saved to two different vaults. The objects are
not exported from one vault to the other but a link is created between them. To create the relationship, drag
an object from one vault to the other or use the Relationships function.
The relationship between the two objects is shown as a shortcut. When you double-click the shortcut, MFiles shows the actual object in a new window. When you select the shortcut, you can see some of the
related object's metadata and a link to the object in the target vault. You can also rename the shortcut. This
does not change the name of the original object or cause any conflicts between the vaults.
Note: If you have problems with the creation of relationships between vaults, contact your system
admin to make sure that the metadata definitions of the object types are matched between vaults.
Shortcut permissions
The shortcuts have their own permissions. By default, M-Files uses permissions for a new object in the
vault that you are currently logged in.
Shortcuts created with synchronization
When data is synchronized between vaults, sometimes the metadata of the imported objects creates
shortcuts. For example, if a document related to a project is imported without the project, M-Files creates a
shortcut for the project in the target vault. This shortcut is now a link to the object in the source vault.
Subobjects
In addition to relationships, objects can also have subobjects. For example, a customer object can have
a contact person as a subobject. Object types and the relationships between them are specified by the
system administrator in M-Files Admin. The Ctrl + J shortcut shows the object's subobjects and lets you
edit and remove them. You can add a new contact person directly from the vault with the Subobjects
option.

2.3.5. Document Collections
A document collection is a set of related documents. Unlike a multi-file document, each member of a
document collection is independent and has its own metadata. Also the document collection has its own
metadata. In a multi-file document, all files share the same metadata.

In this chapter
•
•

Creating Document Collections
Managing Document Collections

Creating Document Collections
To create a document collection:
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1. In M-Files, click the Create button.
2. Select Document collection.
If this object type is not shown in the context menu, click an empty area in the listing area and
select Create > Document collection.
The New - Document Collection dialog is opened.
3. Select a class and click Next.
4. Optional: Select a template.
5. Fill in the necessary metadata.
6. Click Create.
The document collection is created. Next, you can add document collection members.
Managing Document Collections
Right-click a document collection in the listing area and select Collection Members to open the document
collection and manage its content.
Adding Document Collection Members
To add a document collection member:
1. In the Collection Members dialog, click Add.
Tip: You can also drag and drop objects from other windows to the Collection
Members dialog to add many document collection members at once.
The Select Member Object dialog is opened.
2. Find and select the object that you want to add to the document collection.
3. Click Open.
4. In the Define Membership dialog, select one of these options:
Option

Description

Latest version

The relationship always points to the latest version of the target object.

Specific version

The relationship points to the selected version of the target object. The
relationship does not show updates to the object.

5. Click OK.
6. In the Collection Members dialog, click Close.
Editing Document Collection Members
To edit the membership of a document collection member:
1. In the Collection Members dialog, click Check Out.
2. Click Edit.
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3. In the Define Membership dialog, select one of these options:
Option

Description

Latest version

The relationship always points to the latest version of the target object.

Specific version

The relationship points to the selected version of the target object. The
relationship does not show updates to the object.

4. Click OK.
5. In the Collection Members dialog, click Check In.
6. Click Close.
Removing Document Collection Members
To remove a document collection member:
1. In the Collection Members dialog, click Check Out.
2. Click Remove.
3. In the confirmation dialog that is opened, click Yes.
4. In the Collection Members dialog, click Check In.
5. Click Close.

2.3.6. Using M-Files Desktop Offline
This section tells you how to make content available offline, how to edit documents in the offline mode, and
what happens when you are back online.

In this chapter
•
•
•

Offline Availability
Going Offline
Going Online

Offline Availability
You can make objects available in the offline mode with the Mark for Offline Availability function or with
Offline filters. For information on how to go offline and online, see Going Offline and Going Online.
Marking for Offline Availability
You can make individual objects, a group of objects, views, or virtual folders available offline. If you make
a view or virtual folder available offline, M-Files creates a new offline filter for it. This way, all new objects
that meet the filter conditions are automatically updated to the offline view. For information on how to edit
the offline filter that you created, see Offline filters.
To mark objects, views, or virtual folders for offline availability:
1. Select the objects, views, or virtual folders that you want to make available offline.
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2. Press Alt and select Operations > Offline Availability > Mark for Offline Availability from the menu
bar.
The selected documents are shown in the Offline view.
Removing Offline Availability
To remove the offline availability:
1. Select the objects, views, or virtual folders that you want to remove from the Offline view.
2. Press the Alt key and select Operations > Offline Availability > Remove Offline Availability from the
menu bar.
The selected documents are removed from the Offline view.
Offline filters
You can define filters to make sure you have access to important objects without a network connection
from Other Views > Offline.
To remove the offline filter, select Delete from the filter context menu. This only removes the offline filter,
not the view.
Example: Creating an Offline Filter for a Project
1. On the M-Files home screen, go to Other Views > Offline.
2. Press Alt to open the menu bar.
3. Select Create > Offline Filter.
The Offline Filter Properties dialog is opened.
4. In the Name field, enter a name for your offline filter.
The name is shown in the Offline listing area.
5. Click Define Filter to specify the conditions that objects must meet to be shown in this view.
The Define Filter dialog is opened.
6. On the Properties tab, click Add Condition and add these conditions:
a) From the Property drop-down menu, select Project.
b) From the Operator drop-down menu, select =.
c) From the Value drop-down menu, select a project.
7. Click OK to close the Define Filter dialog.
8. Select Show documents and other objects.
9. Click OK.
The offline filter is shown in Other Views > Offline. This lets you access all the documents and objects in
this view when the connection to M-Files Server is not available.
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Going Offline
You can use M-Files without a network connection.
To use M-Files without a network connection, click your username in the top-right corner of the user
interface and select Go Offline. You will then have access to the Offline view, which shows all the objects
that are available offline.
You can make objects available offline with the Mark for Offline Availability command. For more
information, see Offline Availability . Collection members, relationship objects, and subobjects are also
available offline if they are related to objects that are available offline.
In offline mode, you can create new objects and edit objects available offline.
Going Online
To go online from the offline mode, click your username in the top-right corner of the user interface and
select Go Online. When you are online, M-Files restores all other views and you can continue to browse
the document vault as usual. You can also check in documents shown in the Offline view and save the
changes on the server.
Because users can edit a document on the server while you edit it offline, M-Files makes sure you can
check in your changes when you go online. If other users did not edit the document, you can save the
offline version as the new version. But, if new versions were saved on the server when you were offline, MFiles lets you know. You can then select how to continue:
•
•
•

Save the version edited offline as a new document. The document on the server stays the same.
Reject the changes made offline, and accept the new version on the server.
Cancel Go Online.
Tip: If you check out the document before you go offline, other users can see that you checked out
the document. When you edit the document, other users cannot make changes to it.

2.4. Sharing Content
This section tells you how to share vault content to people with access to the same vault as you, and to
people outside your organization.

M-Files | 2. Daily Use | 107
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

Figure 17: You can share vault content in many ways to users with vault access and to people that do not use M-Files.

In this chapter
•
•
•

Sharing Links and Shortcuts
Sharing Public Links
Options for Email and PDF Sharing

2.4.1. Sharing Links and Shortcuts
M-Files users can have vault connections with different names, and each user can have customized views.
With M-Files, you can create shortcuts that the user customizations have no effect on.
Using the Get Hyperlink Dialog
Use the Get Hyperlink context menu item to create links or shortcuts to documents.
For instructions on how to create links to objects, files, and views in M-Files Web, refer to Creating M-Files
Web URLs.
To create a link or shortcut:
1. In M-Files, right-click an object in the listing area and select Get Hyperlink.
2. Select one of these options:
Select...

To...

Create Windows shortcut (.lnk)

Create a shortcut that opens the selected object
in the default application for the file format.

Create M-Files shortcut (.mflink)

Create a shortcut that opens the selected object
in M-Files Desktop.

Send M-Files shortcut (.mflink) by e-mail

Open a new email message with the M-Files
shortcut as an attachment.

Copy hyperlink to clipboard

Copy the object hyperlink to your clipboard in the
HTML format. You can paste the link for example
to an email message. You can also enter the path
to Windows File Explorer to open the object in MFiles.
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Select...

To...
To copy the link in the plain text format, select and
copy the text from the text field and click Cancel.

3. Optional: Click Advanced to specify the target version.
4. Optional: In Target version, select one of these options:
Option

Description

Latest version

The relationship always points to the latest version of the target object.

Specific version

The relationship points to the selected version of the target object. The
relationship does not show updates to the object.

5. Click OK.
Tip:
You can change the plain text URL command for the link to do something different than to open the
object.
Command

Action

show

Opens the object in M-Files Desktop.

showmetadata Shows the metadata card for the object.
open

Shows the check-out dialog and opens the document in the default application.

view

Opens the document in the default application in the read-only mode.

edit

Checks out the object and opens it for editing in the default application.

For example, the command m-files://edit/<vault GUID>/<object type ID>-<object
ID>?object=<object GUID> checks out the document and opens it for editing in the default
application.
For more information about M-Files URL properties, refer to this knowledge base article.
The Appearance of Hyperlinks
You can ask your administrator to change how the hyperlinks are shown. For more information, see
Changing the Appearance of Hyperlinks.

2.4.2. Sharing Public Links
You can share M-Files documents with temporary public links. This way, the documents are available to
anyone who receives the link.
Ask your system administrator to enable or disable the Share Public Link feature and specific sharing
options where necessary. For more information, see Configuration Options for Public Links .
Before you start, make sure that your M-Files system administrator has done these operations:
•

M-Files Web has been set up.
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•

The M-Files Web home page has been specified in the Document Vault Properties dialog.

To create a public link:
1. In M-Files, find the object that you want to share.
2. Optional: Right-click the object and select History to share a previous version of the object.
3. Right-click the object or the object version and select Share Public Link.
The Share Public Link dialog is opened.
4. Select the target version.
5. Use Expiration date (local time) to select the date and time after which the public link will not be
active.
6. Optional: In Description, enter a description.
The description is shown in the Shared by Me dialog.
7. Click Create Public Link.
The public link is added to the Public link field.
8. Click Copy to copy the public link to the clipboard.
9. Click Close.
You can now share the public link.
Managing and Removing Shared Public Links
In the Shared by Me dialog, you can manage and remove public links that you have shared. Users with
the administrative rights Full control of vault or See and read all vault content can see and manage the
public links shared by all vault users.
To manage and remove shared public links:
1. In M-Files Desktop, click your username in the top-right corner and select Shared by Me.
If you have the Full control of vault or See and read all vault content rights, you can also
select Shared Files (All Users).
The Shared by Me dialog is opened and all the public links shared by you are shown.
2. Do one or both of these operations:
Click...

To...

Copy Link

Copy a shared public link to the clipboard.

Stop Sharing

Remove a shared public link. In the confirmation
dialog that is opened, click Yes.

3. Click Close.
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2.4.3. Options for Email and PDF Sharing
Right-click a file in the listing area and select Sharing, E-mail and PDF to use one of these sharing
options:
•
•
•
•
•

Send Link by E-mail
Send Copy by E-mail
Send as PDF by E-mail
Save as PDF
Convert to PDF

Send Link by E-mail
With this option, M-Files creates an email message with a link to the selected file. The recipient must have
access to the vault and the file.
Send Copy by E-mail
With this option, M-Files creates an email message with a copy of the selected file attached.
Send as PDF by E-mail
With this option, M-Files converts the selected file to the PDF format and creates an email message with
the PDF file attached. The file in M-Files stays in its original format.
Save as PDF
This option lets you save the selected file as a PDF file without opening the file. After the PDF file is ready,
the Save As dialog is opened. Select the location where you want to save the PDF file.
If you save a single-file document, the Save As dialog shows the vault as the default save location. Click
Save to create a new document to the vault. Fill in the necessary metadata and then click Create. If you
save a file in a multi-file document, the Save As dialog shows the multi-file document as the default save
location. Click Save to save the PDF file to the same multi-file document.
Convert to PDF
With the Convert to PDF (replaces original file) option, M-Files converts the selected file to the PDF
format and replaces the original file (for example, a Word file) with the PDF file.
With theConvert to PDF (adds separate file) option, M-Files converts the selected file to the PDF format
and keeps the original version of it. If you convert a single-file document, M-Files converts it to a multi-file
document and adds the PDF file to it.
Troubleshooting
If you cannot convert documents to the PDF format, see Why can't I convert a document to PDF format or
annotate a document?
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2.5. Finding Content
This section describes how you can locate the content you are looking for by using the M-Files search
functions and views.

Figure 18: When you search for, say, job applications, M-Files looks for your search term in the titles, metadata, and contents of
documents and other objects in the vault. The search is also capable of searching for inflected forms of your search term.

In this chapter
•
•

Searching
Using Views

2.5.1. Searching
The most efficient way of finding your documents and other objects is to use the M-Files search functions.
This is especially useful when you remember only a single detail about the document or object, such as the
creation date or the user who created the document.
Quick search
With quick searches, you can search for words associated with the object.
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Search options and filters
The search options and filters allow you to define more search criteria related to the properties and location
of the objects that you are searching for. You can expand the search options for quick search by clicking
the search options button (
) to the right of the quick search field. The search filters can be opened by
clicking the Filters tab in the right pane.
For example, if you want to view the documents that a certain user has checked out during last month, this
is easier to do by defining search criteria in the search options than by creating a new view.
Search result sorting
The order in which the search results are listed is based mainly on frequency or recency of use. The
main idea is to emphasize things that are relevant for the user. The following information is of primary
importance for providing search results:
•
•
•

When was this document or other object created?
When and how many times was the document or other object edited?
When and how many times was it processed?

By using this information, you will find relevant data on the newest and most commonly used objects in
the organization. If several years have passed since the creation of the document and the document has
not been updated for a long time, the document is perhaps not considered very relevant for the user and is
therefore not included among the first search results.
In addition to the information related to object handling mentioned above, the occurrence of the search
string in metadata or file contents influences the order of the search results. The ranking of an item among
the search results is influenced by the search string appearing in the following places:
1. The name or title of the document or other object
2. Other metadata than the name or title of the document or other object
3. File contents
The name is of special importance because the document or object name often contains essential
information about the content. Additionally, M-Files ignores certain metadata that tend to decrease the
relevance of the search results. Full-text search in files is influenced by, for example, the length of the file
in such a way that the shorter document is given more importance than the long one when the two have
the same number of matches for the search string. In any case, the order of the search results is always
more dependent on metadata than file content.
Tip: If your M-Files system administrator has enabled translated object titles, you can use the
translated object titles in searches. The translated object titles are also shown in the title area of the
metadata card, in the listing area, in notifications, and in value lists.
Disabling relevance sorting
The M-Files system administrator can set the results to be sorted according to the user's preference
instead of the default relevance settings. For more information, see Disabling the Sorting of Search Results
by Their Relevance.
Search result grouping
M-Files automatically groups search results by object type. This helps you find the correct information.
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If there is a large number of search results under a grouping, M-Files shows only a part of the search
results. Click Show more results to see more search results. Use the options Next and Previous to show
the next or previous page. To change the number of results shown per page, right-click an empty space in
the listing area and select Display Mode > Objects per Group.
Search word emphasis in the results
When you make a search, your search terms are marked in yellow on the listing area as well as on the
metadata card and file content (preview). When preview is in use, search terms are highlighted in yellow in
the file contents for common file formats (Word, Excel, PowerPoint, Outlook, and so on).
Contents of the following types of files can be highlighted in the Preview tab:
•
•
•
•
•
•
•
•
•

Email files (eml, emlx, msg)
HTML and web archive files (htm, html, mht, mhtml)
Microsoft Excel files (xlsx, xlsm, xltx, xltm, xlsb, xls, xlt)
Microsoft PowerPoint files (pptx, pptm, ppsx, ppsm, potx, potm, ppt, pps, pot)
Microsoft Word files (docx, docm, dotx, dotm, doc, dot)
OpenDocument files (odt, ott, ods, odp)
PDF files
RTF files
Text files (txt)
Note: If you search for an exact match using quotation marks in your search query, such as "dat
sports", any partial matches, such as sports, are highlighted in addition to exact matches in
document contents and metadata.

Exporting search results
Before you export search results, make sure that all the necessary search results are shown. M-Files
exports only those search results. Use the options Show more results, Next, and Previous where
necessary.
To export search results, press the Alt key and select File > Export from the menu, or right-click an empty
area in the listing area and select Export from the context menu. Then, select the information that you
want to export.
•
•

To export a list of the search results as a CSV file, unselect the Export files check box. Click OK,
select the file location, and enter the file name to start the export.
To export a list of the search results as a CSV file and the object files, select the Export files check
box. Click OK to select the file location and to enter the file name. M-Files exports the object files to a
folder in that location. The folder name is <file name> (Files). To start the export, click Yes in the
confirmation dialog that is opened.

You can use for example Microsoft Excel or Apache OpenOffice Calc to open CSV files.
The number of exported results can be changed with a registry setting. Ask your system administrator for
necessary changes.
Search results in other vaults
When you perform a search in M-Files, the Search Results in Other Vaults pane at the bottom of the
search results listing shows you the number of results in any other vaults you are connected to. If the vault
icon next to the vault name is blue, it means that there are matches to your query in the vault. If, on the
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other hand, the vault icon is gray, it means that the search results are not yet available or there are no
matches to your query in the vault.
Note that the search results in other vaults are not updated if your search is filtered by additional conditions
or search refinements.
Tip:
The search results are retrieved only from the vaults that you are currently logged in to. You can
click Show all to view also the vaults you are currently not logged in to.
You can set your login account to be automatically logged in to a vault when Windows is started.
For instructions, see Log in automatically when Windows is started.

When you click any of the vaults in this pane, you are taken to the vault in question and the search results
for your query are displayed.
The Search Results in Other Vaults pane can be hidden or displayed by right-clicking on an empty space
in the listing area and selecting Display Mode > Show Search Results in Other Vaults from the context
menu.
You can also show the Search Results in Other Vaults pane minimized by default, so that only the
heading of the pane is displayed until you expand the pane. To display the pane minimized by default,
right-click on an empty space in the listing area and select Display Mode > Bottom Pane > Minimized
from the context menu. Note that this setting affects all the panes that are displayed at the bottom of the
listing area.
Note:
If you want the Search Results in Other Vaults pane to be disabled by default, you may adjust the
following registry setting on the client computer:
Key
Value name

MultiVaultSearchEnabled

Value type

REG_DWORD

Description

Enables or disables the Search Results in Other Vaults pane.

Default value

1

The Search Results in Other Vaults pane is enabled.

Valid values

0

The Search Results in Other Vaults pane is disabled.

1

The Search Results in Other Vaults pane is enabled.

In this chapter
•
•
•

HKEY_CURRENT_USER\SOFTWARE\Motive\M-Files\<version>\Client
\MFShell\<vault>

Quick Search
Filters Tab
Additional Conditions
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Quick Search
The M-Files Desktop quick search looks for objects that contain the search word in the metadata or file
contents. Normally, M-Files searches for matches in both, but you can change the setting on the Filters
tab. M-Files remembers your selection until you close the window or log out. See Filters Tab for more ways
to refine your search.
In the search field, enter a search string that has to do with the object, such as the title, the login account
of a person who has edited it, or a customer related to it, and click the search button. The search string
does not need to be a whole word — you can truncate the word by using an asterisk. For example, when
you search for data in the Demo Vault with the search string specific*, you will find a document named
Technical Specifications, because the name contains the string searched for. For a comprehensive list of
different operators and special characters you can use in your search query, see Operators and Special
Characters.
If you cannot find what you are searching for, there are plenty of ways with which you can narrow your
search and get more focused search results, such as:
•
•
•
•

using quotation marks or other operators and special characters, such as AND
using search options for quick search
using a more accurate search term by adding keywords or using more focused keywords
refining your search using the advanced search features on the Filters tab

To search for a particular word form, disable the Look for different inflected forms of the words in Quick
Search option in the Additional Conditions dialog. This option is enabled by default. When you do this to
search for, say, the word "corporation", the search results include only those objects that match this exact
word, not corporate, incorporated, and so on.
Words and phrases searched for are stored in the search drop-down menu, making it easy to repeat recent
searches.

Figure 19: In the quick search, you only need to enter the search word.

Search options for Quick Search
) to the right of the Quick Search field to expand the search options.
Click the search options button (
When the button is clicked, these options are shown:
•
•
•

Search type
Property conditions
Additional conditions

Some search conditions operate differently with different search engines. Refer to dtSearch, Micro Focus
IDOL, and M-Files Smart Search - Differences in M-Files Search.
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Search type
Select one of these options to specify the way your search queries are matched:

All words

Matched objects contain all the specified search words.

Any word

The search will return all objects that contain at least one of the specified search words.

Boolean

The search lets you use more specific search phrases and different operators, for
example AND or NOT. For the list of operators, see Boolean operators.
Note: Boolean search is available in vaults that use dtSearch or Micro Focus
IDOL as the search engine.

Property condition
Each object has property values that can be used as search criteria. The value of the property Project can
be for instance Hospital Expansion (Florida). If you perform a search with these values, the search returns
all the documents in which the Project property contains the value Hospital Expansion (Florida).
You can define a property condition by selecting a property, a condition, and a property value using the
drop-down menus in the search options section. You may define additional property conditions by clicking
the plus icon (

).

Subordination of search criteria
You can easily specify search criteria by utilizing their subordination, so the options shown in the lists
are filtered on the basis of other list choices. For example, if you have selected a certain workflow as the
search criterion, the state options are filtered in such a way that only the states related to your selected
workflow are visible and selectable. Corresponding filtering will be performed automatically for other
interdependent value lists as well. For example, contact persons are filtered by customer if these value lists
have a hierarchical relationship.
Subordinate search criteria can be used with the "is" operator. In the Additional Conditions dialog, the
operator "one of" can also be used.
Indirect searches
You can specify search criteria also by means of property relationships, which means that the object itself
need not have the property in question. Instead, the property selected as the search criterion is in this case
the property of a related object.
By using indirect search, you can, for example, find agreements related to a specific country; even
if the Country property has not been defined for the actual agreement, it is enough if it can be found
via a customer associated with the agreement. In this case, the search criterion is specified as
Customer.Country.
You can specify these indirect search properties by clicking the plus-sign button in the list and then
selecting the property of a related object to be used as the search criterion. In the example below,
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Customer was selected from the list first, and then the customer's Country property, which resulted in the
search criterion with a period, "Customer.Country", being displayed in the search field.
By using additional conditions, you can create three-level indirect search criteria.

Tip: You can specify indirect views in the same manner, by using the properties of related objects.
You can utilize indirectness in specification of filter settings as well. For more information on
creating views, see Creating a View.

In this chapter
•

Operators and Special Characters
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Operators and Special Characters
You can also use different operators and special characters in your search query to find documents and
objects that strictly meet your search criteria. The table below lists the operators and special characters
that can be used to broaden or narrow a search.
Search type

Operator or
special character

Description

Exact match

Quotation marks:
"phrase"

Enclose the search words in quotation marks to find objects
that contain all of the search terms in the given order.
Example search: "functional specification"

Any single
character

Question mark:
appl?

The ? character matches any single character except a
whitespace or underscore character (_) in its position.
Example search: appl? matches both "apply" and "apple".
Note: This character cannot be used as the first
character in a search term.

Any single digit

Hash: 201#

The # character matches any single digit in its position.
Example search: 201# matches, for example, "2017" and
"2018".
Note: This character cannot be used as the first
character in a search term.

Any number of
characters

Asterisk: market*

The * character matches any number of characters in its
position.
Example search: market* matches "markets", "marketing",
and so on.
Note: This character cannot be used as the first
character in a search term.
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Search type

Operator or
special character

Description

Fuzzy search

Vertical bar: que|
ry

Vertical bars can be used for searching for spelling variations
of the search term. The number of | characters used indicates
how many characters in the search term will be ignored.
Characters to the left of the first vertical bar must have an
exact match in the search results.
Example search: release s||chedule
Note: Fuzzy search is disabled by default and must
be enabled by the M-Files system administrator.
See Enabling Phonic and Fuzzy Searches for more
information.

Phonic search

The grave accent
mark ( ` ): `query

You can use the grave accent mark ( ` ) for searching for
words that sound like the word in your search query and
begins with the same letter. Add the ` character in front of the
search word to search for its phonic matches.
Example search: `John Doe
Note: To use this feature, your search engine must
be dtSearch.
Note: Phonic search is disabled by default and must
be enabled by the M-Files system administrator. For
more information, see Enabling Phonic and Fuzzy
Searches.
Note: Phonic searches are inclusive by nature, and
therefore they may occasionally produce too many
search results or their search precision may be low.

Synonym search

Documents containing synonyms of a word included in your
search query may also be listed in the search results.
For example, if you search for announcement, the search
results may also list documents containing words such as
notice, bulletin, publication, or statement, in
addition to the word announcement.
Note: Synonym search is disabled by default and
must be enabled by the M-Files system administrator.
See Setting Up Synonym Search for more information.
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Search type

Operator or
special character

Description

Underscore:
2018_01

The _ character matches a whitespace. Consequently, the
next character starts a search term and cannot be a wildcard
character ?, #, or *.
Example search: 2018_01 matches both "2018_01" and
"2018 01".

Boolean operators
Click the search options icon (

) and select Boolean to use the Boolean operators in your search.

Note: Boolean search is available in vaults that use dtSearch or Micro Focus IDOL as the search
engine.
Search type

Operator

Description

All of the search
terms must be
found

AND

The AND operator combines two search terms. Documents
found contain both terms.

One of the search
terms must be
found

OR

Exclude a search
term

NOT

Example search: functional AND specification
The OR operator retrieves all documents which contain at least
one of the terms entered.
Example search: agenda OR minutes
The NOT operator excludes a search term from the search
results. It can be used in conjunction with AND, OR or W/N.
Example search: agenda AND NOT minutes

Required search
term and an
optional search
term

AndAny

The AndAny operator combines required search terms with
optional ones. Search terms before the AndAny operator are
required and terms appearing after the operator are optional.
In other words, search terms after the AndAny operator are
considered as matches only if the search terms before the
operator are also found in the document.
Example search: agenda AndAny minutes
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Search type

Operator

Description

Faceted query

()

Brackets are used to group search terms together.
Example search: (agenda OR minutes) AND market*
This search returns all objects which contain the word
"agenda" or "minutes" and which also contain a word or words
beginning with "market".

Proximity search

W/N

The W/N operator retrieves objects that contain two words or
phrases within a certain distance of one another. The N value
indicates the number of intervening words between the search
words or phrases.
Example search: agenda W/4 2015

Filters Tab
With the advanced search features on the Filters tab, you can define more specific search criteria for the
document or object you are looking for. The more search criteria you use in the advanced search, the more
likely you are to find the exact object you want. This way, you can prevent the search from returning too
many results.
Advanced search features can be opened by clicking the Filters tab in the right pane. The Filters tab is
also opened whenever you activate the quick search field.
Your search results are updated in real time according to the selected search filters.
The Filters tab contains the following search options:
•
•
•
•
•

Scope
View
Repository
Object type
Search refinements

Scope
You can choose whether to search metadata, file contents, or both. By default, both metadata and file
contents are searched.
View
When you have a specific view open, you can choose to search only within the view that you are currently
in. Note that the View option is shown only if you currently have a view open on the listing area. The
View option is shown also for external views. However, the View option does not work if your system
administrator has not rebuilt the search index of the external repository.
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Repository
You may broaden or narrow down your search by selecting the repositories that you want to include in your
search. To do so, check the repositories that you want to include in your search.
Object type
You can also narrow down your search by selecting one or more of the object types in the list.
Search refinements
Note: This functionality is available only if your document vault uses the Smart Search or Micro
Focus IDOL search engine.
You can refine your search results by selecting one or more of the available criteria in this section. For
more information, see Search Refinements.
Default search filters
You can set frequently used search options to be remembered by M-Files so that you do not need to
reselect them in the future. For more information, see Default Search Filters.

In this chapter
•
•

Search Refinements
Default Search Filters

Search Refinements
Note: This functionality is available only if your document vault uses the Smart Search or Micro
Focus IDOL search engine. For further information, contact sales@m-files.com.
You can refine your search results on the Filters tab by selecting one or more of the available criteria in
the section below the Scope, Object type, and Repository options. You can, for instance, choose to only
search for objects that were created in 2017, modified within the last week, and that refer to a certain vault
user.
To view more criteria in a specific category, click the Show more option.
Note: Search refinements only apply to objects with M-Files metadata. Any objects that do not
have metadata (for example, unmanaged objects) are hidden in the search results if search
refinements are selected.
Once your search results have been refined to match your search query as well as the criterion or criteria
you have selected, you can refine your search even more by selecting additional criteria. Note that after
you have refined your search, the criteria for which there are no longer matches are now grayed out.
Default Search Filters
You can set default search filters that will be remembered by M-Files always when you log in to the vault
using M-Files Desktop. This is useful, if you often select the same search options on the Filters tab when
searching for documents or objects.
Do the following steps to set default search filters:
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1. In M-Files Desktop, perform a search.
The Filters tab is opened in the right pane.
2. On the Filters tab, hover over the the search criterion you want to select as your default search filter.
Note: If your vault uses the Micro Focus IDOL search engine, you can set any search
filter as default. If dtSearch is used instead, you can select filters from the Scope, Object
Type, and Repository search options as default.
The open lock icon (
3.

Click the open lock icon (

) appears in front of the check box.
).

The search criterion is shown in bold and it appears with closed lock icon (
default filters at the top of the Filters tab.

) under Your

4. Set as many filters as desired by repeating the steps 2 and 3.
5. Optional: To unselect a default search filter, click it under Your default filters.
The search filter is removed from the list.
When searching for documents and objects in M-Files Desktop, the set default filters are automatically
used as search criteria.
You can view your current default search filters and refine them on the Filters tab. The default search
filters are shown in bold and they are listed under Your default filters.
To remove all default filters, click the

icon.

Additional Conditions
) and then Additional
To open the Additional Conditions dialog, click the search options button (
Conditions. After you have applied additional conditions and close the dialog, the number of active
conditions is shown in parentheses in the Additional Conditions button.
Note: Some search conditions operate differently with different search engines. Refer to dtSearch,
Micro Focus IDOL, and M-Files Smart Search - Differences in M-Files Search.
Look for different inflected forms of the words in Quick Search
To search for a particular word form, disable the option Look for different inflected forms of the words
in Quick Search in the Additional Conditions dialog. When you do this to search for, say, the word
corporation, the search results include only those objects that match this exact word, not corporate,
incorporated, and so on.
Note: The search for inflected forms is enabled by default. If needed, the M-Files system
administrator can disable this option for all vault users. For more information, see Disabling the
Search for Inflected Forms.
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Look in the metadata of all versions
When you select the Look in the metadata of all versions option, the search operation looks for results in
the metadata of all object versions instead of only the latest ones.
Two limitations apply to this option:
•
•

The option is not used in quick searches.
The property definition setting Do not search for old object versions can have an effect on the
results.

Show latest version
When you select Look in the metadata of all versions, the search will be performed on all versions of
each object. If the option Show latest version is on as well, M-Files shows the newest version of each
returned object instead of showing the old version that actually matched the search conditions.
Exporting search conditions
You can use the Export Conditions function to save the search criteria. To access this search-related
function, press the Alt key on your keyboard and select File > Export Conditions....
The generated text file contains the search criteria as a string that can be used with the M-Files API
method SearchForObjectsByExportedSearchConditions. For more information on the method, see the MFiles API documentation.

In this chapter
•
•
•
•

Status-Based Conditions
Property-Based Conditions
File Information Based Conditions
Permissions-Based Conditions

Status-Based Conditions
The search criteria related to the object status are specified on the Status tab.
Object type
Define the object type of the objects being searched for. If the object type is not specified, the search will
be performed on all objects.
Object ID
Each object has an individual ID that M-Files Server automatically creates for each new object using
consecutive numbers. With the ID search criterion, you can find the objects efficiently according to their
ID numbers. You can make the ID search more specific by using operators. For more information, refer to
Property-Based Conditions.
Checked out
If you specify as a search criterion that the document has been checked out and select Yes from the dropdown menu, the search returns all documents that have been checked out for editing. This search criterion
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is useful, for example, when you want to see all documents in the vault that have been checked out to any
user.
Checked out to
You can also search for documents that have been checked out to specific users of the document vault.
For example, if you want to find all the documents in the Demo Vault that have been checked out to the
user AndyN, choose = as the operator and select AndyN from the user list. You can also select !=,in which
case you will see all the documents that have been checked out by users other than AndyN. Checked Out
to Me shows all the documents that have been checked out to the user logged in to the document vault.
Checked out between
When you check out a document, it remains checked out until you check it in. Thus you can also search
for documents that have been checked out earlier but have not been checked back in. For example, if you
want to find all documents that were checked out between February 16 and 17, 2013, select 2/16/2013 as
the start date and 2/17/2013 as the end date.
Object flags
Interaction between vaults has imported special objects to M-Files which are used to process data between
vaults. These are described as conflicts and shortcuts. Conflicts are created when the versions in separate
vaults differ. Shortcuts refer to objects that are located in different vaults.
When a filter is used, these special objects can be included in the search or omitted from it.
Deleted
If you specify as a search criterion that the document has been deleted, you will see all deleted documents.
M-Files preserves all deleted documents. In order to perform this search, you need permissions for viewing
deleted documents.
Example: Searching Only for Deleted Projects
You need to have permissions to see deleted objects.
1.

Click the advanced search options button (

) to the right of the Quick Search field.

2. Click the Additional Conditions button.
The Additional Conditions dialog is opened.
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3. Check the Object type check box, select = from the first drop-down menu, and finally select Projects
from the rightmost drop-down menu.
4. Check the Deleted check box and select Yes from the drop-down menu.
5. Click OK to close the Additional Conditions dialog.
6. Enter a search term in the Quick Search field or leave it empty if you do not want to filter your search
any further.
7. Press Enter or click the arrow button next the Quick Search field to start your search.
The search results show the deleted projects for your search term or all the deleted projects if you omitted
the search term.
Property-Based Conditions
Each object has property values that are assigned to it in the metadata card. These property values
can be used to search for documents in a precise manner. A document property can be for example
Project, and the value of this project can be Hospital Expansion (Florida). If you perform an
advanced search with these values, the search returns all documents for which Hospital Expansion
(Florida) has been defined as the value of the Project property.
To get started, click Add Condition and define the values of the condition according to the instructions in
this section. To remove the selected property condition, click Remove Condition. Note that the checkbox
next to the property name does not indicate selection for this purpose, but instead specifies whether or not
the condition is in use.
Note: Any disabled conditions are automatically removed when the properties dialog is closed.
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Properties
The criterion defined in the Property column can either refer to the value of 1) a certain, single property
or 2) that of all properties that have been defined to show values from a certan value list (see below for an
example).
What does any property in the property name mean?
Many of the properties are accompanied by the expression any property. If you use this type of property
as a search criterion, it means that the search results will include all objects where the property value
matches your search term no matter what the name of the property is as long as it has been defined to
show values from the specified list. This is perhaps best explained with an example:
Example: If you have installed M-Files for evaluation, the properties Supervisor and Project manager in
the sample vault both show values from the list Employees. If you now select Employee (any property) as
a search criterion, the search returns all objects where the Supervisor or Project manager property has the
value that you searched for. If, on the other hand, you use the Supervisor property as your search criterion,
the search only returns objects that contain the Supervisor property with the specified value.

Figure 20: The properties tab of the additional search conditions dialog.

Operators
In the Operator field, you can also determine other criteria than equal to. See the table below for the list of
available operators.
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Operator
=

!=

>

Description
Equal to

Unequal to

Greater than
This operator is useful when the value to be selected contains numbers. You
can easily find all values that are greater than the value you have specified. For
example, if your document vault contains the data type of the Department property
as numbers, the search criterion > 10 returns the documents whose Department
value is greater than 10.

>=

<

<=

One of

Not one of

Contains

Does not contain

Starts with

Does not start with

Greater than or equal to

Less than

Less than or equal to

You can select some property values for the search, for instance certain projects
but not all of them. In this case, the search results are just the documents whose
Project property has one of the values you selected with the One of operator. For
example, the Project property of the document Window Chart E12.dwg is "Hospital
Expansion (Florida)".

This search option is the opposite of the previous one.

When you want to search for documents by letter combination, for instance a word,
you can use the Contains operator. For example, if you want to find all documents
in the Demo Vault whose Project property value contains the letters pan, the search
results include the document Window Chart E12.dwg, whose Project property is
"Hospital Expansion (Florida)". The word Expansion contains the letters pan that
were determined as the search criterion. If you want to include wildcards in your
search criterion, use the Matches wildcard pattern option.

This search option is the opposite of the previous one.

The Starts with option works in almost the same way as the Contains option. Here,
the word must start with the value specified.

This search option is the opposite of the previous one.
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Operator
Matches wildcard
pattern

Does not match
wildcard pattern
Is empty

Is not empty

Description
The matches wildcard pattern option can be used with the wildcards ? and *. The
? character replaces any single character, and the * character replaces any number
of characters. See further below for an example.

This search option is the opposite of the previous one.

In some cases, the properties of a document have no value. This happens when
no value is specified for the property at the stage of filling in the metadata card
– e.g., when no value has been specified for the Project property. The Is empty
operator utilizes the missing value in the search. For example, you can easily find
all documents whose Project property has no value.

This search option is the opposite of the previous one.

Values
From the Value column, you select the value for the selected property that is used as the search criterion.
You can filter the list of available values by right-clicking Filter: * and selecting Set Filter from the context
menu. Enter a suitable filter word in the Set Filter to List dialog. Note that you can enter only one filter
value in the text field. If you need to select multiple values from the Value column, you can try extending
your filter by using wildcards. If not applicable, you must select the values without a filter.
Note: You can select multiple values by holding down the Ctrl key while clicking values.
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Figure 21: Selecting properties for the search filter.

For instance, when you search for projects with the Matches wildcard pattern operator and the search
term ????house*, the results include all the objects whose Project property value begins with any fourcharacter string, followed by the word house, and then a string with any number of any characters. If the
vault has a document with a Project property Warehouse Management System Development, it is
shown in the search results.
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Figure 22: Utilizing the "matches wildcard pattern" operator.

If a property definition based on a hierarchical value list is selected as the search criterion, you can also
select whether to include the values higher and lower in the hierarchy in the search.
Options
If your search criteria includes a property containing a timestamp, you can make the search more specific
by selecting an option from the Options column, selecting an operator, and entering a suitable value in
the Value field. For example, you can find all recently created documents. Give "Created < 7" as your
search criterion, and select the option DaysFrom(). The search will return all documents created over
the last seven days. See the table below for the list of available options for timestamp properties and their
descriptions.
Option

Example

Description

Date()

Created = 18.12.2015

Returns objects that have a given
timestamp property containing a
given date.

DaysFrom()

Created < 7

Returns objects with a given
timestamp property containing
a date within a given number of
days preceding the current date.

DaysTo()

Effective through < 10

Returns objects with a given
timestamp property containing
a date within a given number of
days following the current date.
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Option

Example

Description

Month()

Created = 05

Returns objects that have a given
timestamp property containing a
date with a given month. Use the
format MM.

Year()

Document date = 2015

Returns objects that have a given
timestamp property containing a
date with a given year. Use the
format YYYY.

YearAndMonth()

Created = 2015-12

Returns objects that have a given
timestamp property containing a
date with a given year and month.
Use the format YYYY-MM.

Figure 23: Utilizing options for properties of the timestamp data type.

Also refer to Subordination of search criteria and Indirect searches under Filters Tab. You can always
utilize indirectness for specifying the properties in filter settings.
Example: Searching for Ongoing Projects for American Customers
1.

Click the advanced search options button (

) to the right of the Quick Search field.

2. Click the Additional Conditions button.
The Additional Conditions dialog is opened.
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3. Go to the Properties tab and click Add Condition to add a property condition.
4. From the topmost Property drop-down menu, select In progress.
5. From the topmost Operator drop-down menu, select =.
6. From the topmost Value drop-down menu, select Yes.
7. Click Add Condition again to add another property condition.
8. Locate Customer in the next Property drop-down menu and click the plus sign next to Customer to
expand its properties and select the Country customer property.
This creates an indirect property association that uses the Country property of the customer
object to define a country for the project. As the project object does not include country data in
this case, the customer object can be used indirectly to provide it.
9. From the Operator drop-down menu, select =.
10.From the Value drop-down menu, select USA.
The Additional Conditions dialog should now look like this:
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11.Click OK to close the Additional Conditions dialog.
12.Enter a search term in the Quick Search field or leave it empty if you do not want to filter your search
any further.
13.Press Enter or click the arrow button next the Quick Search field to start your search.
The search results show the projects (for the search term or all the projects if no search term was given)
that are in progress for customers from the United States.
File Information Based Conditions
An M-Files document contains metadata and zero or more files. You can use the Files tab to specify
search criteria related to files.
File name
If you can remember the file name or parts of it, File name is an efficient search criterion. If you remember
the exact name, select the equals sign and enter the name of the file in the next field. For more information
on the available operators, see Property-Based Conditions.
File size (KB)
If you want to search files of a specific size, enter the minimum and maximum file size here.
File created, File changed
You can also make searches according to the creation and modification time of the files. For more
information, see Status-Based Conditions.
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Linked to external location
You can make a search on files that are linked to an external location. You can choose to search within
files that are all linked to one and the same external location, or within all linked files that are external to MFiles. For more information about linking files, see External File Sources.
Show duplicates only
Use the Show duplicates only option to create a view that contains only duplicate content. This is useful,
for example, when you want to remove duplicate files from the vault.
Note: This option is only available when you define a filter for a view.
Example: Searching for PNG Images
1.

Click the advanced search options button (

) to the right of the Quick Search field.

2. Click the Additional Conditions button.
The Additional Conditions dialog is opened.

3. Go to the Files tab, check the Contains files check box, and select Yes from the adjacent drop-down
menu.
4. Check the File name check box and select matches wildcard pattern from the adjacent drop-down
menu.
5. Enter *.png in the text field next to the drop-down menu.
6. Click OK to close the Additional Conditions dialog.
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7. Enter a search term in the Quick Search field or leave it empty if you do not want to filter your search
any further.
8. Press Enter or click the arrow button next the Quick Search field to start your search.
The search results show the PNG images found for your search term or all the PNG images in the vault if
you omitted the search term.
Permissions-Based Conditions
Each object has permission settings that are assigned to it on the Permissions tab of the metadata card.
Objects can also be searched according to their permission settings. You can, for example, create a
search listing all objects that are visible to the company management only. This way, you can also change
the permissions of specific objects.

Figure 24: You can also search objects by specific permissions.

Note: When applying the condition Access control list and selecting a named access control
list that uses pseudo-users via metadata properties, the search results may not be accurate or you
might get no results. For more information, refer to Pseudo-users and Named Access Control Lists.
Example: Searching for Objects That Are Visible to the HR Department
Your vault needs to have the HR Department user group and you need to be a member of that group.
1.

Click the advanced search options button (

) to the right of the Quick Search field.

2. Click the Additional Conditions button.
The Additional Conditions dialog is opened.
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3. Go to the Permissions tab and check the Visible to user/group check box.
4. From the Operator drop-down menu, select includes.
5. From the Value drop-down menu, select HR Department.
6. Click OK to close the Additional Conditions dialog.
7. Enter a search term in the Quick Search field or leave it empty if you do not want to filter your search
any further.
8. Press Enter or click the arrow button next the Quick Search field to start your search.
The search results show the objects that match your search term and are visible only to the HR
department.

2.5.2. Using Views
Your day-to-day use of M-Files mainly involves browsing views in which documents and other objects have
been grouped according to object metadata, such as project or customer information.
For example, all objects for which the Project metadata has been specified can be grouped by project. For
more information on configuring views and grouping levels, see Creating a View.
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Figure 25: Views organize objects in the vault by the metadata properties of objects. Views can be based on, for example, object
types, such as Customer or Project, and they can be further subdivided by the properties of the listed objects, such as Country or
Customer.

In this chapter
•
•
•

Creating a View
Traditional Folders
View-Specific Operations

Creating a View
In M-Files, documents and other objects can be categorized into different views according to their
metadata. Creating views is largely based on specifying the metadata used for searching and categorizing
documents.
Views allow you to save frequently used searches and define grouping levels. For information about
searching for documents, refer to Searching.
To create a view:
1. In M-Files, open the document vault to which you want to create the view.
2. Click the Create button and select View... from the context menu.
The Define View dialog is opened.
There are two phases in determining a view:
1. Specify a filter to ensure that the view only displays objects you want to see. Specifying filters is similar
to defining search criteria.
2. Determine the folder structure of the objects. This is useful when you have a large number of objects
and you want to group them into different levels according to specific properties.
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Figure 26: The Define View window.

In the example shown above, the documents must be checked out to the user Andy Nash, they must not
have been deleted, and they must be of the type Drawing. No properties have been added to the display
hierarchy in this window, so all documents that meet the criteria are displayed in a single list.
Name
Start by assigning a name to the view. The name should be as descriptive of the contents of the view as
possible, so that users can deduce from the name of the view what kind of objects it contains.
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Common to all users
Normally, views are created for personal use only. If you wish, you can define the view to be a common
view visible to a desired user group. To define a common view, you need the document vault permission
for managing the common document vault's common views.
You should carefully consider which views are needed by all M-Files users. For instance, the Documents
by Projects view is often necessary. The users of the client software can hide unnecessary views from
their own computers, and the administrator can restrict the visibility of the views by setting appropriate
permissions. The views also can be assembled in groups (view bundles) from which, for example, the
views used by the sales department are easy to find.
Defining the filter
See Defining a Filter for a View.
Show documents and other objects
By default, the view shows documents and objects according to the filter settings and folder structure.
This option can be deselected if, for instance, new views are created under the current view. Note: When
creating a new view inside the current view, the conditions of the upper view remain simultaneously valid.
In other words, the sub-view results only include objects that also meet the conditions of the upper view.
Look in all versions
If you leave the Look in all versions box unchecked, the view will only list those objects whose latest
version meets the specified criteria.
If you check the box, the filtered search will be performed on all versions of each document. Only the
newest version meeting the criteria will be displayed. For example, if TinaS has modified versions 1 and
2 of a document, and AndyN has updated the document to version 3, search criterion Last Modified By =
TinaS will return version 2 of the document.
Show latest version
If the option Show latest version is on, M-Files will show the newest version of each returned object instead
of showing the old version that actually matched the search conditions.
Folder structure
See Grouping Levels.

In this chapter
•
•
•
•
•
•
•

Defining a Filter for a View
Grouping Levels
View Advanced Settings and Permissions
Creating a View in a Virtual Folder
Converting a Virtual Folder into a View
Example: Creating a New View for French Customers
Example: Creating a Common View Containing All the Documents Created by the Current User
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Defining a Filter for a View
When defining a filter for the view, you specify the conditions according to which the objects are to be listed
in the view. You can define criteria for the view on the Status, Properties, Files and Permissions tabs.

Figure 27: The Define Filter dialog.

For more information about the available filters, see Status-Based Conditions, Property-Based Conditions,
File Information Based Conditions, and Permissions-Based Conditions.
Grouping Levels
When you create a view that contains documents or other objects, you can use properties to further group
objects in the view. For example, you can create a view that shows documents grouped in folders by
customers.
To define a grouping level for a view:
1. In M-Files Desktop, complete one of these steps:
a. Navigate to a view for which you want to define a grouping level, right-click an empty area in the
listing area, and then select Properties.
or
b. If you want to define a new view, navigate to the location in which you want to create a new view,
right-click an empty area in the listing area, and then select New View. For instructions on defining a
new view, see Creating a View.
2. In the Properties dialog of the view, in the Folder structure section, complete one of these steps:
a. Select a grouping level in the Grouping levels list and click Add to create a new grouping level.
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or
b. Select an existing grouping level and click Edit to edit the selected grouping level.
The Define Grouping Level dialog is opened.
3. Use the Group by drop-down menu to select the object type, value list, or function by which you want
to group objects on the selected level.
4. Optional: If you selected an object type for grouping the selected level, you can click Define Filter
to specify the conditions for including folders in the grouping level. For more information on defining
the conditions, see Status-Based Conditions, Property-Based Conditions, File Information Based
Conditions, and Permissions-Based Conditions.
5. If you selected an object type for grouping the selected level, use the Reference direction option to
select the metadata reference direction between the object type of the grouping level and the objects in
the view:
a. To <selected object type>: The objects in this view have metadata that refer to the object type
used as the grouping level. In other words, the reference direction is from the objects in the view to
the object type used as the grouping level (see the example further below).
or
b. From <selected object type>: The object type used as the grouping level has metadata that refers
to the objects in this view. In other words, the reference direction is to the objects in this view from
the object type used as the grouping level. This option is used when the objects in the view do not
have metadata references to the object type used for grouping the view (see the example further
below).
Note: Views and virtual folders that use property references of the From <selected
object type> type cannot be marked for offline availability.
The Reference direction selection is dependent on the metadata structure of the vault. As an
example, take a look at this graphical representation of a simple vault metadata structure:
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Say that you want to have a view that contains projects grouped by customers. You would
then filter the view by the Project object type and add the Customer object type as a grouping
level with To Customer as the reference direction because the Project objects in the view refer
to the object type used for grouping the view (Customer).
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On the other hand, say that you want to have a view that contains customers grouped by
projects. The first thing to note here is that the Customer object type does not have any
metadata information about projects (as seen in the metadata structure image further above).
This means that the reference direction needs to be from the grouping object type, Project, to
the Customer objects. So, in this scenario, you would add the Project object type as a grouping
level with From Project as the reference direction, and select Customer as the property used
by the grouping level object type. Filtering the view separately in this instance is not necessary
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because the Customer property selected for the grouping level filters the view to contain only
customers.

Note: If you would like to disable the Reference direction setting in the vault, see
Disabling the Reference Direction Setting for Grouping Levels.
6. Use the Property drop-down menu to select the property that is utilized by the item selected in the
Group by drop-down menu. This selection defines the property that you want to group by on this
grouping level.
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7. Optional: If you selected IntegerSegment() in the Group by drop-down menu and a property of the
Number (integer) or Number (real) data type in the Property drop-down menu, in the Segment size
field, define a segment size that you want to group objects by on the selected grouping level.
If you set, say, 10 as the segment size, objects are grouped into virtual folders by segments 0-9,
10-19, 20-29, and so on. If you set 100 as the segment size, objects are grouped by segments
0-99, 100-199, 200-299, and so on.
8. Optional: Check the Show empty folders check box if you want to include empty virtual folders on this
grouping level, that is, virtual folders that do not contain any objects because the object on which the
virtual folder is based is not referenced by any other object or it does not refer to any other object in the
view.
9. Optional: Check the Show objects that have an empty value for this property check box if you
want to include on this grouping level objects that do not have a value for the property selected in the
Property drop-down menu as the grouping property, and then select either:
a. Show objects on this level: Select this option if you want to list within the grouping level the
individual objects that do not have a value for the selected grouping property.
or
b. Show objects in a separate folder: Select this option if you want to list objects that do not have
a value for the selected grouping property in a separate folder in the grouping level. In the Folder
name field, enter the name of the folder under which such objects are listed.
10.Optional: Open the Advanced tab to modify the performance options for viewing and accessing the
virtual folders in this grouping level. Modifying these settings may be beneficial for views or virtual
folders that contain a large number of folders. For more information, see Grouping Level Advanced
Options.
11.Click OK to finish creating the grouping level.
The objects in the selected view are now grouped by the grouping level that you have just defined.

In this chapter
•
•

Grouping Level Advanced Options
Grouping Options in the M-Files Desktop User Interface

Grouping Level Advanced Options
The Advanced tab of the grouping level settings contains performance options for viewing and accessing
virtual folders. Modifying these settings may be beneficial for views or virtual folders that contain a large
number of folders.
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Figure 28: The advanced options for a grouping level.

Show only subfolders that were recently selected by the user
In the advanced settings for the view grouping level, you can specify whether the user is to be shown all
virtual folders belonging to the level or whether the user may select the folders to be used. Folder selection
is useful when the view or virtual folder includes a large number of subfolders (more than 500). By means
of folder selection, the user can easily select the folders to be modified. The use of folder selection is
significantly quicker than, for example, grouping by first letter when the number of objects is large (more
than 10,000).
For instance, if the view has been defined By Customer or By Project and the company has thousands of
customers or projects, user-specific folder selection makes it easier for users to perform their daily tasks in
the required customer or project folders. In this case, the user employs the Select Folder function to select
only the folders that should be used.
Important remarks
•
•
•
•

The set of folders selected for each grouping level is cleared when the user session ends. In other
words, the folders need to be reselected, for instance, after the user logs out from the vault.
The setting is specific to each grouping level.
Folder limitation can be used if the grouping level is specified on the basis of a property that utilizes a
value list.
For common views, folder limitation can be specified by a user with at least the right to manage
common views.
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Other performance options
If the retrieval of the subfolder listing is slow, you can try each algorithm in order to determine which is
fastest for this type of view.
Activate the Do not check object permissions for hiding subfolders option to improve browsing
performance. This may, however, cause empty folders to be displayed in the listing.
Grouping Options in the M-Files Desktop User Interface
You can add, change or remove grouping levels directly in the M-Files Desktop user interface by doing the
following:
1. Open M-Files Desktop and any vault connection.
2. Open a view of your choice.
3. Right-click an empty space in the listing area.
4. Perform one of the following operations:
If you want to...
Add a grouping level to a view that does not
yet have any grouping defined

Add an additional grouping level to a view

Change the current grouping level

Remove the current grouping level

Do the following steps:
a. Open the Group By menu.
b. Select the grouping level from the list of
choices or select Define... to define your own.

a. Open the Add Grouping Level menu.
b. Select the grouping level from the list of
choices or select Define... to define your own.

a. Open the Current Grouping Level menu.
b. Select a new grouping level to replace the
current one or select Define... to create a new
grouping level.

a. Select Remove Current Grouping Level.

5. Optional: If you want to categorize the objects or virtual folders alphabetically, right-click an empty
space in the listing area and select Group by First Letter(s) or Group Folders by First Letter(s).
For the Group by First Letter(s) command to work, the Allow this property to be used as a
grouping level in views option of the Name or title property has to be enabled.
View Advanced Settings and Permissions
In the Advanced tab of the Define View dialog, you can specify these settings:
•
•
•

Set whether a subview of a virtual folder is shown in other virtual folders of the same level.
Set M-Files to index the view to make it faster to use.
Set searches in the view to be done for the content of the view only.
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Visibility setting of subviews in virtual folders
You can set a view created in a virtual folder to be shown in that virtual folder only or in all virtual folders
of the same level. See Creating a View in a Virtual Folder for instructions on how to create views in virtual
folders. This setting is shown only for views in virtual folders.
Note: If the same level contains views and virtual folders, views created in the virtual folders are
not shown in the views of the same level.
To display your view in all the other folders of the same level, select the In all folders of this level option.
In the above example, the newly created view would be visible in all the virtual folders under the view By
Customer and Class.
Indexing the view
Indexing of the view can be used to speed up the use of certain important views in a large document vault,
if the filter criteria for the view sufficiently filter the group of objects. Indexing of the view is recommended
only if the view does not include many objects (for instance, 10,000 objects in a vault with a total of
1,000,000 objects) and if the view is used daily and is working slowly.
Indexing views should be used sparingly and only for views that benefit significantly from it, since each
indexed view in the vault slightly slows down the creation and editing of documents and other objects.
View-specific indexing can be activated by a user with at least the right to manage common views.
Setting searches to be done within the view
With the Search within this view by default, you can specify that searches done in this view are normally
done for the content of the view only. Users can still use the View setting on the Filters tab to change the
searches to be done in the entire vault instead.
Permissions tab
In the Permissions tab of the Define View dialog, you can specify the users who can see the view. The
tab is shown for common views.
Creating a View in a Virtual Folder
New views can also be created in virtual folders. Open the virtual folder where you want to create a new
view. Select Create > View and define its settings as instructed in Creating a View. For example, you can
create a "Proposals that expire this week view" in the Proposals folder.
Note: When you create a new view in a folder, the parent view and folder conditions are valid at
the same time. This means that the new view only accepts objects that also meet the conditions of
the parent view and folder.
Converting a Virtual Folder into a View
Virtual folders can also be converted into views via the Customize tab of the virtual folder Properties
dialog, or by right-clicking a virtual folder and selecting Customize Folder.
After the customization, you can modify the display settings of the new view and create grouping levels in
the same way as for other views. Then, for example, in the Memo view, created on the basis of the Memo
virtual folder, you can group documents according to meeting types.
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Note: Because views can be created in folders, and folders can be converted to views, views and
virtual folders may be available parallel in the listing area. Views can therefore contain folders as
well as views, and folders can contain views as well as folders.
A folder that has been converted into a view can be restored as a folder by right-clicking it and selecting
Remove Folder Customization from the context menu.
Example: Creating a New View for French Customers
1. In M-Files, open the document vault to which you want to create the view.
2. Click the Create button and select View... from the context menu.
The Define View dialog is opened.
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3. In the Name field, enter the name French customers.
The name will appear in the listing area under My Views.
4. Optional: Check the Common to all users check box if you want to define this view as a common view.
5. Click Define Filter to specify the conditions that objects must meet to be shown in this view.
The Define Filter dialog is opened.
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6. On the Status tab, check the Object type check box, select the equal (=) operator from the adjacent
drop-down menu, and select the Customer from the rightmost drop-down menu.
7. Go to the Properties tab.
The Properties tab is opened.

8. Click Add Condition and add the following condition:
a) Use the Property drop-down menu to select the Country property.
b) Use the Operator drop-down menu to select the equal (=) operator.
c) Use the Value drop-down menu to select France as the country.
9. Click OK to close the Define Filter dialog and to return to the Define View dialog.
10.Check the Show documents and other objects option check box.
11.Click OK to finish creating the view.
The view you have just defined appears in the listing area under My Views and it contains all the objects
and documents that meet the conditions that you have specified in the filter settings of your view.
Example: Creating a Common View Containing All the Documents Created by the Current User
You must be either a vault administrator or a system administrator to be able to define a common view.
1. In M-Files, open the document vault to which you want to create the view.
2. Press Alt to open the menu bar.
3. Select Create > View...
The Define View dialog is opened.

M-Files | 2. Daily Use | 153
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

4. In the Name field, enter a descriptive name for the view.
The name of the view can be, for example, Documents Created by Me.
5. Check the Common to all users check box.
6. Click the Define Filter... button.
The Define Filter dialog is opened.
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7. Go to the Properties tab.
The Properties tab is opened.

8. Click Add Condition and add the following condition:
a) Use the Property drop-down menu to select the Created by property.
b) Use the Operator drop-down menu to select the equal (=) operator.
c) Use the Value drop-down menu to select the (current user) option.
9. Click OK to close the Define Filter dialog.
10.Click OK to close the Define View dialog and to finish creating the view.
All users of the vault should now have a new view under Common Views. They can use the view to list all
the documents that they have created in the vault.
Traditional Folders
You can create traditional folders in M-Files. These folders do not have the additional properties provided
by views. Traditional folders are comparable to, for example, folders on your C: drive and can be used for
importing files to M-Files. Traditional folders allow you to retain the original folder structure of the imported
files. See also Saving Folders to M-Files.
Creating a New Traditional Folder
1. In M-Files Desktop, press Alt to display the menu bar and select Create > Traditional Folder from the
menu.
2. Optional: Right-click the traditional folder that you have just created and select Rename to rename the
folder.
A new traditional folder is created and added in the Traditional Folders view. You can use the folder for
importing files and folders to M-Files.
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View-Specific Operations
This topic compiles a list of various, view-specific commands and features.
Using the Clean View, Hide View, and Unhide Views commands
Clean View... is a command that a user logged in to the document vault can perform for any view. It is
used for removing temporary local files and all empty folders automatically. To do this, press the Alt key
and select View > Clean View... from the menu.
Some views of the M-Files sample vault cannot be removed, but they can be hidden. A regular user cannot
remove views that have been created in M-Files Admin. In such cases, you can right-click the view on the
listing area and Hide View from the context menu.
To unhide views, press the Alt key and select View > Unhide Views... from the menu.
Tip: You can create a view showing all the deleted objects if you have any of the following
permissions: full control of vault, permission to see all objects, or permission to see deleted objects.
Just create a view with the filter Deleted = Yes (see Status-Based Conditions).
Saving the display settings of a view as common display settings
M-Files allows you to save the display settings of a view as common display settings. To use this function,
you need administrative rights to the relevant vault. The function saves the display settings common to
users view-specifically. You can choose whether the function is to be applied for all users or only those
users who have not yet modified their own display settings. With the function, you can, for example, define
specific columns to be displayed for all users.
To do this, press the Alt key and select View > Save As Common Display Settings... from the menu.
Resetting the display settings to their defaults
By using this function, you can reset modified display setting values to the defaults set by the system
administrator. Alternatively, you can reset the display settings to the M-Files software defaults.
To do this, press the Alt key and select View > Reset Display Settings to Defaults... from the menu.
Binding a report to a view
You can bind a report for example to the view Sales by customer or Proposals by salesperson. With the
options under View > Reports in the menu bar, you can bind a report to a view and specify its location. If
you want this setting to apply for all users, enable the option Common to all users in the view settings. To
define a common view, however, you need the permissions for managing the vault's common views.
For more information on reports, see Reporting and Data Export.
Exporting a view
You can export the contents of a view in the same way that you export search results. For instructions, see
Exporting search results.
Sharing views
You can share your views with other users in the same vault. You cannot share common views. If you
share a subview of a view, the filters of the view will not affect the shared subview.
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To share a view, right-click a view and select Share View by Email. To share many views, hold down the
Ctrl key and click the views that you want to share. Then right-click a selected view and select Share View
by Email.
In both cases, a new email message is opened in your email client.
Note: The email message contains an M-Files shortcut to the view as an attachment. By default,
the shortcut expires in 14 days. To change the default expiration time, contact your M-Files
administrator.

2.6. User Settings
This section details various settings and user operations available in M-Files Desktop.

In this chapter
•
•
•
•
•
•
•
•
•
•

M-Files Desktop Settings
Setting Default Tab for Object
Editing Notification Settings in M-Files Desktop
Managing Vault Applications in M-Files Desktop
Substitute Users
Changing the Software and Vault Language
Changing the M-Files Password
Clearing the Local Cache of the Vault
Show Status
Refreshing External Objects

2.6.1. M-Files Desktop Settings
M-Files Desktop Settings allow you to add, edit, remove, and test vault connections. Additionally, on the
Settings tab, you can modify various options related to the user- and computer-specific behavior of the
client software, such as disabling the automatic check-in prompt or changing the M-Files drive letter.
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Figure 29: The M-Files Desktop Settings main window.

When you open M-Files Desktop Settings, you will first see the Document Vault Connections tab. If you
want to add a new vault connection, click the Add... button and follow the instructions in Adding a Vault
Connection.
Note: Before you start setting up your document vault connection, consult your M-Files system
administrator to ensure that M-Files Server and the document vault have been installed.

In this chapter
•
•
•
•
•

Adding a Vault Connection
User-specific Settings
Computer-Specific Drive and Cache Settings
Other Computer-Specific Settings
Exporting Vault Connections and Settings

Adding a Vault Connection
You can start adding a new vault connection by clicking Add... in the M-Files Desktop Settings main
window.
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Note: If the connecting computer is using Windows Server 2012 and the server computer has been
set to only accept Transport Layer Security (TLS) 1.2 connections, TLS 1.2 must be enabled on
the client computers by following the instructions in Enabling TLS 1.2 on Windows Server 2012
Computers.

Figure 30: The Add Document Vault Connection dialog.

To establish the connection, you first need to specify a few properties.
Name
Begin by assigning a name to the document vault connection. The name can be anything, but it is a good
idea to make it descriptive. The name will be displayed on the M:\ drive as a directory containing the
contents of the document vault.
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Server/Name
Enter the network name or IP address of the server on which M-Files Server has been installed and that
contains the document vault.
Server / Port number
Specify the port to connect to on the server. The default TCP/IP port for M-Files is 2266.
Server/Protocol
Define the protocol to be used for the network connection. The following protocols are available:
•
•
•
•
•
•

gRPC
Local gRPC
TCP/IP
SPX
Local Procedure Call (LPC)
HTTPS
Note: When you use the gRPC protocol for connections between the M-Files server and M-Files
clients, a valid TLS certificate must be in use on the server for connection security and encryption.
For instructions, see Managing Server Certificates.

Encrypted connection
Enable this option to secure the communication between M-Files Desktop and M-Files Server. RPC
encryption does not require Internet Information Services or any other additional components and is often
the simplest way to achieve encryption of network communication between M-Files Desktop and M-Files
Server in the organization's internal network.
The option is available for the TCP/IP protocol only. If the protocol is HTTPS, the connection is always
encrypted at the HTTPS protocol level. For connections from outside the organization's internal network,
HTTPS or VPN should still be used, as RPC communication to the default TCP port, 2266, is often blocked
by firewalls.
Note: For RPC encryption to work, the user as well as the computer must be able to authenticate
to the server computer. In practice, this requires that the client computer belongs to the Windows
domain and that the user is a domain user.
For more information on encrypted connections and for instructions on how to configure the server to
require encrypted connections, refer to Protecting Data in Transit with Encryption in M-Files.
It is also possible to use pre-shared keys in combination with HTTPS for securing a VPN-less access from
outside the organization's private network.
HTTP proxy settings
You may specify an explicit HTTP proxy server for document vault connections that use the HTTPS
protocol. This option may be needed if your organization wants to route all traffic through an HTTP proxy
server. To use an HTTP proxy server for a document vault connection, enable the option Specify HTTP
proxy settings and in the HTTP proxy server field, type in the address of the proxy server and optionally
the port number in the format <server address>:<port number>.
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Server / Test Connection
You can use this button to check that the connection works correctly.
Authentication
Specify the method the document vault is to use for authenticating the user. The authentication options are
Current Windows user, Specific Windows user, and M-Files user.
The user is always authenticated on M-Files Server when logging in to the document vault, for example.
M-Files Server is capable of checking the login accounts and passwords of all M-Files users. This is the
M-Files authentication method. When Windows authentication is used, M-Files Server has the passwords
checked by the domain server.
With Windows authentication, users log in to the database with same information that they use to log in to
the local computer or the organization domain. If the organization uses a domain, using the domain logins
and passwords is the quickest and easiest authentication method. This means that new passwords and
logins are not needed, which makes this a rather user-friendly method.
Differences between the various authentication methods

Current Windows You can use the Current Windows user method to log in with your current Windows
user
credentials.

Specific Windows Selecting Specific Windows user means that you need to enter your Windows
user
username, password, and domain information when you log in. This option allows you
to log in with a different account than the one you used for accessing Windows.

M-Files user

The M-Files authentication method allows you to log in to M-Files only. If your
organization does not have a Windows domain or you do not have access to it, you
should select M-Files authentication for logging in.

Vault on server
When there are several document vaults on the server, you can use this field to specify the document vault
to connect to.
Log in automatically when Windows is started
You can choose to establish the connection to the document vault whenever Windows is started. This
is a useful option if you are going to use the document vault daily. For more information, refer to Login
Accounts.
Visible to all users on this computer
In Windows, there can be several users who each have their own user-specific settings. It is possible to
provide user-specific access to M-Files document vaults. If you want the document vault to be visible to all
users on this computer that have been defined in the operating system, check this box.
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Test Connection to Document Vault
After specifying the contents of the above fields, you can check whether you can successfully connect to
the document vault. If the connection works, the server has responded to the connection test.
Analyze connection
When you have created the vault connection and open the Document Vault Connection Properties
dialog by double-clicking the vault connection in the M-Files Desktop Settings dialog, you can use the
Analyze Connection button to display further details about the connection. The analysis measures the
round-trip time between the client and the server, as well as the download and upload speeds.
User-specific Settings
These settings allow you to modify certain aspects of the M-Files Desktop behavior specific to your
Windows user account. To open the User-specific Settings dialog:
1. Open M-Files Desktop Settings.
2. Open the Settings tab.
3. Click User-specific Settings.
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Figure 31: The user-specific settings are specific to Windows users per workstation.

Dialog boxes and prompts
You can define comments to be asked of the user upon each check-in. If the Check in immediately option
has been selected for file closure, comments are not requested.
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By default, a warning is always displayed when the user logs out if the user has objects checked out.
Dialog boxes are also closed after a default timeout.
Behavior at file open
You can define for each file extension type whether the specific file format is always opened in Check Out
or Open as read-only state. You can also specify for each extension type that, upon opening each file, the
software asks the state in which the file is to be opened.
Behavior at file close
You can define which actions are performed on the file upon closing it. The definition applies to all file
formats. By default, the user will be asked what they wish to do to the file upon closing it. If the user does
not change the default procedure (Do not check in), the dialog will be automatically closed after a chosen
time and the document will remain checked out.
Computer-Specific Drive and Cache Settings
These workstation-specific settings allow you to change the M-Files drive letter and to control options
related to the local data cache. To open these settings:
1. Open M-Files Desktop Settings.
2. Open the Settings tab.
3. Click Computer-specific Settings.
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Figure 32: Drive and Cache options of M-Files Desktop.

Drive
Select the drive letter for the M-Files drive. The default drive is M:\.
Local cache
When using M-Files, the documents are retrieved from the server to your local hard drive. The local cache
makes M-Files significantly faster to use over slow connections.
Maximum in-memory cache size per vault
Here you can specify the amount of the computer's main memory that the document cache is allowed to
take up.
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Maximum on-disk cache size per vault
Here you can specify the amount of the computer's disk space that the document cache is allowed to take
up.
Destroy local data
M-Files saves information about vault contents locally in the computer cache. The data remains on the
server, but the cache makes M-Files faster to use. Local files take up space on the computer's hard drive
and for this reason, it may sometimes be necessary to destroy local data. This function can be used to
destroy locally cached data by user and by document vault.
Note that the Destroy Local Data function may delete data that cannot be restored from the M-Files server
such as currently checked-out files on your computer, offline content, and temporary local files. Therefore
it is important to ensure that you have saved and checked in all the documents that you need before
destroying local data.

Figure 33: The local vault and user combinations are listed in the Destroy Local Data dialog.

Note:
If you only want to delete temporary local files and empty the metadata cache, see Clearing the
Local Cache of the Vault.
The table below compares the locally cached elements that are either deleted or preserved when
Clear Local Cache or Destroy Local Data is run.
Cached content

Clear Local Cache

Destroy Local Data

Temporary local files

Optional

Delete

Metadata

Delete

Delete

Checked-out documents

Keep

Delete

Document preview data

Keep

Delete
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Cached content

Clear Local Cache

Destroy Local Data

Offline content

Keep

Delete

Other Computer-Specific Settings
These workstation-specific settings allow you to change M-Files Desktop behavior related to dialog boxes
and prompts, vault security, file saving, and offline mode. To open these settings:
1.
2.
3.
4.

Open M-Files Desktop Settings.
Open the Settings tab.
Click Computer-specific Settings.
Open the Miscellaneous tab.

Figure 34: The Miscellaneous tab contains different computer-specific settings.
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Dialog boxes, prompts, and security
By default, these settings are enabled:
•
•

Display a warning if M-Files Desktop is connected to an older M-Files Server
Allow this M-Files client to use applications that are installed in the document vault

Saving to M-Files
In this section, you can customize application-specific rules for saving files to M-Files. Application-specific
rules can be used to, for example, exclude temporary files and other unwanted files from being saved to
the vault. Rules can also be used to allow operation with applications that use special file saving methods.
The rules make sure that, for example, a metadata card of new files is displayed if automatic identification
does not function.
Process-specific Save Behavior
Click first Customize and then Add to add a new rule. The Process-specific Save Behavior dialog is
opened.
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Figure 35: General process-specific settings.

On the General tab, you can enable or disable the setting Detect file save operations from standard file
dialog boxes. By default, the setting is enabled.
You can also define process-specific file formats that are always or never accepted for saving in M-Files.
Use of an asterisk (*) defines that the process-specific setting is valid for all file formats.
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Figure 36: Advanced process-specific settings.

On the Advanced tab, you can enable or disable the setting Detect file closing and apply user-specific
check-in behavior. By default, the setting is enabled.
You can also define process-specific file formats that will be immediately checked in when the new file with
the extension in question has been saved and the metadata card has been completed.
Offline mode
By default, the documents are kept ready for the offline state for a quick transition to the offline mode.
When the computer-specific setting Keep documents prepared for offline mode is enabled, M-Files
downloads the necessary objects at specified intervals. Disable the setting if you do not use the offline
mode or the feature causes additional load for the machine.
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Exporting Vault Connections and Settings
Document vault connections and settings can be exported to a Windows registry file. By running the
exported registry file on other computers, you can use the same M-Files configuration data on several
computers.
To export vault connections and settings:
1. Open M-Files Desktop Settings.
2. Open the Settings tab,
3. In the Export section, select the components that you want to export by checking the appropriate check
boxes.
4. Click the Export... button.
The Save As dialog is opened.
5. Specify the target location and file name for the REG file.
6. Click Save.
The settings for the components of your choice are saved to a REG file and stored to the location that you
defined in the Save As dialog.

2.6.2. Setting Default Tab for Object
In the right pane, the Metadata tab or the Preview Tab tab is shown when you click an object. You can set
one of these as a default in M-Files Desktop.
To open the Default Tab for Object setting:
1. In M-Files Desktop, click your username in the upper right corner.
2. Click User Settings > Default Tab for Object.
3. Select one of these options:
Select the option...

If you want to...

Metadata

See the metadata card of the object when you
click an object.

Preview

See a preview of the object when you click an
object. If there is no preview available for the
object, the metadata card is shown.

Automatic Selection

See the same tab that you viewed the previous
object with. If there is no preview available for the
object, the metadata card is shown.

2.6.3. Editing Notification Settings in M-Files Desktop
You can set M-Files to inform you by email about some events, for example changes made to objects. This
can be useful when you want to keep track of modifications made to a specific document.Note that you
must have read permissions to a document to get notifications related to it.
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Note: To use this feature, event logging and notifications must be enabled on the M-Files server.
For more information about server settings, see Editing Notification Settings in M-Files Admin.
To open the Notification Settings dialog in M-Files Desktop, click your username in the upper right corner
and select User Settings > Notification Settings.
Unselect Enable notification messages to disable your notification rules.
Note: Your M-Files system administrator can set specified notification messages to be sent to all
users. This means that you can get some notifications, for example, for assignments even if you
have disabled notification messages.

Figure 37: You can set M-Files to inform you by email of modifications made to objects.

Creating a new notification rule
Click Add in the Notification Settings dialog to open the New Notification Rule dialog.
Give the rule a name. Under Notification sent, select When a selected event occurs or When object
matches the conditions of the filter. The content of the dialog changes based on your selection.
Message delivery
Select one of the message delivery options explained in the table below.

M-Files | 2. Daily Use | 172
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
Option

Description

Notification messages disabled

Select this option to disable notification messages.

A separate notification message
for each event

Select this option if you wish to receive a separate message for
every event that meets the rule. The message is sent immediately
whenever the notification rule is met.
Note: This option is not available if you selected When
object matches the conditions of the filter under
Notification sent.

A digest message once a day

Select this option if you wish to be informed of events via a digest
message once a day.
If you selected When object matches the conditions of the filter
under Notification sent, select the days on which you wish to
receive the digest message.
The time when the message is sent is set by the system administrator
in M-Files Admin. For more information, see Editing Notification
Settings in M-Files Admin.

Notification recurrence
Select whether you want to get a notification for an object only once or on each day that you selected in
Message delivery. The selection is available only if you selected When object matches the conditions
of the filter under Notification sent.
Filter
Define a filter. The filter determines the group of objects to which the notification rule applies. For more
information about filters, see Defining a Filter for a View.
Event subscriptions
If you selected When a selected event occurs, select the check box for all the events for which you want
a notification message.
Exclude notifications of events caused by the current user
Select this option if you do not want to be informed of events caused by yourself, such as modifications
that you have made to an object. This option is available only if you selected When a selected event
occurs under Notification sent.
Private and common rules
If you want a notification message to be sent only to you, select Private rule. If you want a notification
message to be sent to several selected recipients, select Common rule. M-Files Admin is used for
specifying the permissions for creating a common rule. For more information, see Manage common views
and notification rules in this table.
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Recipients
Specify the users or user groups who will receive notifications on the basis of this rule.
Enabling push notifications for the M-Files mobile apps
You can enable push notifications for M-Files Mobile by following the instructions in Setting Up Push
Notifications for the M-Files Mobile Apps.

In this chapter
•
•

Example: Daily Notifications for New Orders
Example: Reminder Messages for Contracts

Example: Daily Notifications for New Orders
This example shows how you can create a private notification rule for sending you a daily digest message
of all the new order objects in the vault.
Note: To use this feature, event logging and notifications must be enabled on the M-Files server.
For more information about server settings, see Editing Notification Settings in M-Files Admin.
1. Open M-Files Desktop.
2. Click your username in the upper right corner.
3. Click User Settings > Notification Settings.
The Notification Settings dialog is opened.

4. Click the Add button.
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5. In the Name field, give your rule a name, such as New orders.
6. In Notification sent, select When a selected event occurs.
7. In Message delivery, select A digest message once a day.
8. Click the Define Filter button.
9. Open the Properties tab.
10.Click Add Condition.
11.For the newly added property condition, select Class as the property, = as the operator, and Order as
the value.
12.Click OK.
The property condition 'Class' = 'Order' is now shown in the Filter field of the Notification Rule
Properties dialog.
13.Enable notifications for the event New document or other object.
14.Optional: If you do not want to receive notifications for order objects created by yourself, enable the
option Exclude notifications of events caused by the current user.
15.When you are done, click OK.
The new notification rule is added to the list in the Notification Settings dialog.
Example: Reminder Messages for Contracts
This example shows how you can create a common notification rule for contracts that have their deadline
in 30 days. You will be notified every day starting 30 days before the deadline until the deadline is met.
Note: To use this feature, event logging and notifications must be enabled on the M-Files server.
For more information about server settings, see Editing Notification Settings in M-Files Admin.
1. Open M-Files Desktop.
2. Click your username in the upper right corner.
3. Click User Settings > Notification Settings.
The Notification Settings dialog is opened.
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4. Click the Add button.
5. In the Name field, give your rule a name, such as Contract reminder.
6. In Notification sent, select When object matches the conditions of the filter.
7. In Message delivery, select A digest message once a day.
All days of the week are selected by default.
8. In Notification recurrence, select Notify of each matching object repeatedly.
9. Click the Define Filter button.
10.Open the Properties tab.
11.Click the Add Condition button three times.
12.For the first condition, select Assignees as the property, = as the operator, and (current user and users
for whom the current user is a substitute) as the value.
13.For the second condition, select Deadline as the property, <= as the operator, DaysTo() as the option,
and 30 as the value.
14.For the third condition, select Deadline as the property, > as the operator, DaysTo() as the option, and 0
as the value.
If you do not set this condition, you will get notifications also after the deadline.
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15.Click OK.
The property condition 'Assignees' = '(current user and users for whom the current user is a
substitute)' AND DaysTo( 'Deadline' ) <= 30 AND DaysTo( 'Deadline' ) > 0 is now shown in the
Filter field of the Notification Rule Properties dialog.
16.When you are done, click OK.
The new notification rule is added to the list in the Notification Settings dialog.

2.6.4. Managing Vault Applications in M-Files Desktop
Various third-party applications can be used for modifying and extending M-Files Desktop and M-Files
Server behavior. For information on managing and installing the applications, see Installing and Managing
Vault Applications.
Managing the vault applications
After a vault-specific client application has been installed via M-Files Admin, it is available for M-Files
Desktop users. Upon logging in to the vault, M-Files prompts you to enable the new application. If the
administrator requires the application to be enabled, you cannot log in and use the vault until you have
approved the use of the application.
You can manage computer-specific client applications by pressing the Alt key and selecting Settings >
Applications from the menu bar.
Computer-specific settings
Note that the computer-specific settings influence the use of the applications as well. By default, the user
computer-specifically allows M-Files to use applications that are installed in the document vault. If this
setting is disabled, neither the optional nor compulsory vault-specific applications are available.
To enable or disable this setting:
1.
2.
3.
4.
5.

Open M-Files Desktop Settings.
Select the Settings tab.
Click Computer-specific Settings.
Select the Miscellaneous tab.
Enable or disable the application setting under the Security heading.

2.6.5. Substitute Users
You can define substitute users for periods of absence. The substitute users you specify have the rights
to carry out assignments given to you during this period. For step-by-step instructions on how to assign
yourself a substitute user, see Appointing a Substitute User.
Assignments and user permissions
Assignment and document permissions may differ. If the assignment requires the assignee to edit a
document, the substitute user of the assignee must have:
•
•

edit rights to the document
either a named user license or a concurrent user license (see License type)

For more information about assignments, see Creating and Completing Assignments.
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Assignment notifications
If the assignment is created after the substitute user has been specified, the substitute user will also
receive notification of the assignment. If the substitute user is specified after creating the assignment, the
substitute user will not receive any separate notification of the assignment.
Viewing assignments
You can see all the tasks assigned to you in the Assigned to Me view that you can access by opening the
Assigned tab in M-Files Desktop.

In this chapter
•

Appointing a Substitute User

Appointing a Substitute User
1. Click your username in the upper right corner.
2. Click User Settings > Substitute Users.
The Substitute Users dialog is opened.

3. Click Add... to select the substitute user or users.
The Select Users dialog is opened.
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4. Select the preferred user or users and click Add.
You can select more than one item at once. Hold down the Ctrl key to select multiple individual
items or hold down the ⇧ Shift key to select adjacent items on the list.

The Select Users dialog is closed and the selected user or users are added to the Substitute
users list.
5. Click OK to close the Substitute Users dialog.

The users who you have just appointed as your substitute users will now be able to complete assignments
assigned to you and will receive notifications about such assignments.

2.6.6. Changing the Software and Vault Language
You can change both the M-Files software and the vault language via M-Files Desktop. For a list of the
supported user interface languages, see Language Versions of the M-Files Software. For information about
creating new vault localizations, see Translating the Metadata Structure.
Do the following steps to change the software and the vault language:
1. Click your username in the upper right corner.
2. Click User Settings > Change Language.
The Change Language dialog is opened.
3. Use the Software language drop-down menu to change the language of the M-Files user interface.
4. Use the Vault language drop-down menu to change the language of the current vault.
The vault language selection contains all languages that the document vault has been translated
into.
5. Click OK to change the languages and to close the Change Language dialog.

2.6.7. Changing the M-Files Password
If you are using M-Files authentication, you can change your password by completing the steps provided
below.
Note: If you cannot see this option, it means that your login account is not using M-Files
authentication, and thus you have no separate M-Files password for the selected vault.
To change your M-Files password:
1. Enter a vault via M-Files Desktop.
2. Either:
a. Click your username in the top-right corner of the user interface to open the user menu and select
Change Password... from the context menu.
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or
b. Press the Alt key and select Settings > Change Password... from the menu bar.
The Change M-Files Password dialog is opened.
3. Enter your current password in the Old password field.
4. Enter a new password in the New password field.
5. Confirm your new password by retyping it in the Confirm new password field.
6. Click OK to save your changes.
Your M-Files password should now be changed to the one you specified in the New password field.

2.6.8. Clearing the Local Cache of the Vault
You can remove temporary local files from a document vault by pressing the Alt key in the M-Files Desktop
user interface and then selecting Settings > Clear Local Cache... from the menu bar.

Select the temporary local files that you want to delete and click Delete, or click Delete All to delete all
temporary local files in the vault. When you click Finish, the metadata cache in the vault is cleared. The
cache is used to store data such as property values and object references.
For instructions on converting temporary local files into documents, see Converting a temporary local file to
a document.
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Note:
If you want to delete all locally cached data in a vault, see Destroy local data. Note that the Destroy
Local Data function may delete data that cannot be restored from the M-Files server such as
currently checked-out files on your computer, offline content, and temporary local files.
The table below compares the locally cached elements that are either deleted or preserved when
Clear Local Cache or Destroy Local Data is run.
Cached content

Clear Local Cache

Destroy Local Data

Temporary local files

Optional

Delete

Metadata

Delete

Delete

Checked-out documents

Keep

Delete

Document preview data

Keep

Delete

Offline content

Keep

Delete

2.6.9. Show Status
In M-Files, objects are kept on the M-Files server and transferred to the caches of M-Files users'
computers to make sure using M-Files Desktop is as fast as possible.
With the Show Status component, you can monitor the file transfers from the server to your computer and
find out how long it will take to download a document. This tool is particularly useful if you are using M-Files
over a slow connection. In regular local area network use, documents are usually transferred so quickly
that there is no time or any reason to even check the status information.
You can open the Show Status dialog either via the Windows start menu shortcut or by right-clicking the
M-Files icon in the Windows notification area and the selecting Show Status.
The File Transfer tab
The Status column in the File Transfer tab indicates whether the file has been transferred or is being
transferred. The status is indicated as a percentage. You can stop the transfer by selecting the document
and clicking Stop.
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Figure 38: The File Transfer tab of the Show Status component.

The Configure... button opens M-Files Desktop Settings. For more information, refer to M-Files Desktop
Settings.
Document vault connections
On the Document Vault Connections tab, you can see which document vault connections are available and
whether the vault is online.
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Figure 39: The "Document Vault Connections" tab of the "Show Status" component.

Go Online, Go Offline
These functions allow you to switch between the Offline and Online modes. The function of the button
changes according to the current status. See also Going Offline and Going Online.
Log Out, Log In
If you are logged in to a document vault, you can use the Log Out button to log out and quit M-Files
Desktop. The function of the button changes according to your current status.

2.6.10. Refreshing External Objects
M-Files can also be connected to external databases. This way, a two-way connection can be set up
between M-Files and, for example, a customer database. Customer data can be accessed through M-Files
as well as through the user interface of the external database. You can refresh data automatically in both
directions.
By pressing the Alt key in the M-Files Desktop interface and then selecting Settings > Refresh External
Objects from the menu bar, you can make sure that M-Files contains up-to-date external object
information.
For more information on external objects, see Connections to External Databases for Object Types.
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3. System Administration
This section, intended mainly for M-Files system administrators, explains how to manage, maintain, and
configure the M-Files system.
This section, intended mainly to M-Files system administrators, explains how to manage, maintain, and
configure the M-Files system.

Figure 40: M-Files clients (on the left) are used for accessing M-Files Server (in the center), which manages the document vaults (on
the right).

The first subsection, Setting Up and Maintaining M-Files, introduces the M-Files system, provides
instructions for installing and upgrading the system, and explains how server connections and vaults are
managed.
The second subsection, Configuring M-Files, discusses the various ways you can configure and
personalize your system to match your specific requirements and processes. It includes themes such as
modifying the metadata structure of the vault, configuring workflows, using vault applications, making use
of event handlers and scripts, and so forth.

In this chapter
•
•

Setting Up and Maintaining M-Files
Configuring M-Files

3.1. Setting Up and Maintaining M-Files
This section describes what the M-Files system consists of, how you can set it up, and how to make sure
everything is running as intended. For instructions on how to, for instance, modify the vault metadata
structure, object workflows, or the metadata card behavior, or on how to install and use vault applications,
see Configuring M-Files.
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In this chapter
•
•
•
•
•

System Overview
Installing and Upgrading M-Files
M-Files Admin
Connections to M-Files Server
Managing Document Vaults

3.1.1. System Overview
An M-Files system consists of the following components:
1. a server computer (or multiple servers) running the M-Files Server component and containing the
document vault or vaults
2. M-Files clients used for displaying and editing the vault-stored information via the end-users' computers
or mobile devices
You can access document vaults in the following ways:
•
•
•

by installing M-Files Desktop on your desktop or laptop
by accessing M-Files Web via any web browser
with the M-Files mobile apps for iOS and Android devices

Figure 41: M-Files clients (on the left) are used for accessing M-Files Server (in the center), which manages the document vaults (on
the right).

The image above offers a high-level description of the M-Files system: the clients (M-Files Desktop,
M-Files Web, or any of the M-Files mobile applications) on the left are used for accessing the server
computer (center of the image), which in turn manages one or more document vaults (on the right).
Alternatively, M-Files Server and the document vaults may be located on a cloud-based server (see
Deployment Options for M-Files Server).
You can edit server settings and the document vault structure with M-Files Admin. With M-Files Desktop
Settings, you can add, remove and edit vault connections. For more information about using M-Files Web
and the mobile applications, see the topics Accessing M-Files Web and Accessing M-Files Mobile.

M-Files | 3. System Administration | 185
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

In this chapter
•
•
•
•
•

System Components
Deployment Options for M-Files Server
Language Versions of the M-Files Software
Security and Authentication
Electronic Signing and Compliance

System Components
Your M-Files software includes the following components:
•
•
•
•
•
•
•
•
•

M-Files Setup: Use this to install M-Files.
M-Files Desktop: The most commonly used component that displays content in various views and is
tightly integrated into Windows.
M-Files Desktop Settings: Use this component to connect your client computer to document vaults on
M-Files Server, and to edit other local settings.
M-Files Server: This component manages the centralized saving and sharing of content.
M-Files Admin: A tool used by your company's information systems administrator for adjusting M-Files
Server settings, managing the document vault, and modifying the vault structure.
Show Status: With this component, you can monitor file transfer status. This is useful if you are using
M-Files over a slow connection and need to view the transfer progress.
M-Files Web: In addition to using the M-Files Desktop, you can access M-Files by using a web browser.
M-Files Mobile: To access M-Files with your mobile device, you can use the M-Files mobile apps for
iOS and Android.
Automatic Updates: Automatically keep your M-Files software up to date.

M-Files also includes an ActiveX/COM API as well as the M-Files Web Service API that allows
programmatic access to M-Files through a REST-like interface (refer to M-Files Web Service). The M-Files
API and its documentation are included within the installation of the M-Files software.
Deployment Options for M-Files Server
M-Files offers several server deployment options, giving you the flexibility to leverage M-Files based on the
model that best suits your organization's business needs and budget. Below is a short description of each
server deployment option. Contact M-Files sales at sales@m-files.com if you need more information and
advice on finding the best solution for your organization.
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Figure 42: You can access your vaults with M-Files Desktop, M-Files Web, and M-Files Mobile regardless of the server deployment
solution that you decide is best suited for your organization.

On-premises server
An on-premises server deployment is best suited for organizations that have already invested in existing
servers and systems, or are required to use an on-premises solution deployed behind the organization's
own firewall for regulatory reasons.
Using on-premises servers for M-Files vaults does not, however, mean that they could not be securely
accessed from outside (or inside) the company network. The vaults in the organization's private network
can be accessed via M-Files Web, M-Files mobile applications, or M-Files Desktop (via a VPN connection
or by using a pre-shared key) regardless of your location.
Cloud server
Document and intelligent information management via a cloud-based server deployment provides software
as service (SaaS) flexibility associated with licensing and scalability (such as the ability to easily expand
storage, or to modify the number of user licenses as necessary) without significant capital investment
and incremental resources to support it. In addition, cloud-based solutions offer inherent remote access
to company documents, and flexible monthly billing. Powered by the Microsoft Azure cloud platform, MFiles Cloud delivers additional redundancy and automated third-party backup that offers greater protection
against data loss or theft.
Please note that using a cloud-based deployment also enables you to use all the client options for
connecting to your vaults.
M-Files Cloud Subscription Management Portal
M-Files Cloud Subscription Management Portal allows end user administrators to manage their
subscriptions online.
The portal enables the following functions:
•
•

Adding new licenses and removing existing licenses.
Adding new user accounts and removing existing ones.
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•
•

Changing user details and license types.
Downloading M-Files installers.

Self-hosted cloud server
The managed instance deployment option of the Microsoft Azure SQL Database allows to host your
database engine by your organization. A managed instance of the Microsoft Azure SQL Database is a fully
managed SQL Server Database Engine instance hosted in Azure cloud.
Hybrid server
With an M-Files hybrid deployment, organizations can both leverage their existing on-premises technology
investments and take advantage of an award-winning document and intelligent information management
solution running in the public cloud or a private cloud, as needed.
Furthermore, M-Files Cloud can be seamlessly integrated with existing on-premises systems like an ERP
or CRM, such as SAP or Microsoft Dynamics GP and AX. Conversely, an on-premises deployment of
M-Files can be easily integrated into existing cloud-based business applications, such as Salesforce,
Microsoft Dynamics Online, or NetSuite.
The same client options (M-Files Desktop, M-Files Web, or any of the M-Files mobile applications) are
equally available for organizations using a hybrid server deployment.
Language Versions of the M-Files Software
The M-Files software is currently available in the following languages:

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Albanian
Arabic
Bulgarian
Chinese (Simplified/PRC)
Chinese (Traditional/Taiwan)
Croatian
Czech
Danish
Dutch
English
Estonian
Finnish
French
German
Greek
Hebrew
Hungarian
Italian
Japanese

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Korean
Macedonian
Mongolian
Norwegian
Polish
Portuguese (Brazil)
Romanian
Russian
Serbian (Cyrillic)
Serbian (Latin)
Slovak
Slovenian
Spanish
Swedish
Thai
Turkish
Ukrainian
Vietnamese

You may change the language of the software and the document vault (metadata structure) while the
software is running. Even if, for example, a Finnish version of M-Files has been installed on the computer,
you can easily switch to the English version without reinstalling the software. This is a significant benefit
when shared computers are used.
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Note: Only when 1) the software installation language, 2) the vault language, and 3) the Windows
display language are the same, all the M-Files functions and the metadata structure of the
document vault are displayed in the language in question. For more information, see Languages
and Translations.
Security and Authentication
This section discusses various topics regarding system security as well as connections to M-Files Server
and the M-Files vaults.

In this chapter
•
•
•
•

M-Files and Virus Scanning
Accessing M-Files Vaults without VPN
HTTPS Connections to M-Files Server
M-Files and Federated Authentication

M-Files and Virus Scanning
M-Files is compatible with all commonly used virus scanning products.
It is important to make sure that the virus scanners on the end users' computers do not do scheduled
scanning for the virtual M-Files drive (the M: drive by default). A scheduled scan for the M-Files drive
loads all the content from the M-Files server to the user's client and unnecessarily puts strain on both the
network and the server.
Additionally, for best performance, you can disable any real-time scanning for the virtual M-Files drive
(the M: drive by default) and the M-Files installation folder (C:\Program Files\M-Files\ by default).
The exclusion of these locations from real-time scans can prevent unnecessary system load and possible
conflicts between M-Files and the anti-virus software.
Note: If you use McAfee security products, also refer to this article.

Excluding the M-Files drive and installation folder from virus scanning
To exclude the M-Files drive and the installation folder from virus scanning, add their paths to the
appropriate exclusion lists or exception lists in the anti-virus software. For example with Symantec
Endpoint Protection Manager (SEPM), this is done with an exceptions policy. Other commonly used antivirus software products can use terminology such as "excluded items list", "exclude objects", or "exclude
from scanning".
There are typically separate exclusion lists for scheduled scanning and real-time scanning.
Excluding the M-Files Client process from virus scanning
If your anti-virus software supports excluding processes by name, it is usually a good idea to exclude
the MFClient.exe process from any real-time scanning on the client computers. By default, the path
to MFClient.exe is C:\Program Files\M-Files\<version>\Bin\x64\MFClient.exe. With
SEPM, for instance, this can be done with the instructions in the Symantec knowledge base article How to
create an application exception in the Symantec Endpoint Protection Manager.
The exclusion of the MFClient.exe process from real-time scanning can improve performance. This is
because it prevents the virus scanner to scan the same files twice: once when the application opens the
file and another time when MFClient.exe does an internal open operation on the same file.
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Excluding M-Files server processes and vault data from virus scanning
On the M-Files server machine, make sure that these processes are excluded from real-time virus
scanning:
Process name

Default location

MFServer.exe

C:\Program Files\M-Files\<version>\Bin\x64\

MFServerAux.exe

C:\Program Files\M-Files\<version>\Bin\x86\

MFIndexer.exe

C:\Program Files\M-Files\<version>\Bin\x64\

MFIndexingManager.exe
C:\Program Files\M-Files\<version>\Bin\x64\
MFDataExport.exe

C:\Program Files\M-Files\<version>\Bin\x64\

mf-grpc-webserver.exe

C:\Program Files\M-Files\<version>\Server\Web\GRPC\

In addition, make sure that these folders are excluded from virus scanning:
•
•

The M-Files installation folder, which is located in C:\Program Files\M-Files\ by default
The vault data folder, which is located in C:\Program Files\M-Files\Server Vaults\ by
default

If these processes and folders are not excluded from virus scanning on the M-Files server machine, users
can experience poor vault performance or it can cause faulty backups of the vault data.
Excluding Microsoft Windows processes
Make sure that the pdfSaver.exe process is excluded from real-time virus scanning. The default location
of the process is C:\Program Files\Tracker Software\PDF-XChange Standard. The exclusion
of the pdfSaver.exe process from real-time scanning improves the performance when the user converts
documents to PDF.
Antimalware Support
M-Files Server supports antimalware checks on Windows Server 2016 and newer. Files uploaded to the MFiles server can be scanned for viruses and malware before they are saved in the repository. This requires
an anti-virus software compatible with Windows Antimalware Scan Interface (AMSI), such as Windows
Defender, and that real-time scanning is enabled.
To take the antimalware checks into use, add these values to the Windows registry of the M-Files Server
computer:
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server
\MFServer

Value name

EnableAntimalwareScanner

Value type

REG_DWORD

Value

1

Description

Enables antimalware scanning on Windows 10, Windows Server 2016, and newer.
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HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server
\MFServer

Key
Value name

TreatAntimalwareScannerErrorsAsTransferBlockingErrors

Value type

REG_DWORD

Description

Specifies whether file transfers to M-Files Server are blocked if the antimalware software
is not available or has not been properly configured. The default value is 0.

Value

0

Do not block file transfers if antimalware software is not available or is
misconfigured.

1

Block file transfers if antimalware software is not available or is misconfigured.

For the changes to take effect, you must restart the M-Files Server service.
Accessing M-Files Vaults without VPN
Organizations have traditionally relied on Virtual Private Network (VPN) technology to secure access to
corporate resources (such as M-Files vaults) from outside the private network of the organization. M-Files
versions 10.2 and later enable you to provide secure access to the M-Files system without the downsides
of the traditional VPN-based approach.
The security of this approach is based on encrypting all network traffic between client devices and
the server with HTTPS (SSL/TLS) and on using a pre-shared key as an additional "shared secret" in
authentication to ensure that only authorized devices can attempt to connect to the system.
Note: Cloud-based servers, M-Files Web, and the mobile applications use the HTTPS protocol by
default, but for pre-shared keys to work on desktop clients connecting to an on-premises server,
"RPC over HTTP with SSL" communication between the server and the desktop clients needs to be
enabled. For more information, refer to the document Enabling RPC over HTTPS connections to MFiles Server.
Together, the HTTPS encryption and the use of a pre-shared key as a second factor in authentication
provide similar security as VPN but without the complexity and compatibility challenges of VPN. However,
it needs to be noted that the approach is not identical to VPN from the security point of view, and that
each organization needs to determine if granting access to M-Files vaults without VPN is appropriate
considering the organization's business needs and security requirements.
For more information about using pre-shared keys for secure M-Files access, please refer to Securing
Access to M-Files Vaults with a Pre-Shared Key.
Note: M-Files Cloud environments do not support pre-shared key authentication. You can use
in M-Files Cloud environments other strong authentication mechanisms by compatible identity
providers, such as Azure Active Directory and Okta.
HTTPS Connections to M-Files Server
The communication between M-Files Server and the M-Files clients can be accomplished by using
various connection protocols. Cloud-based servers (as well as the M-Files Web client and the M-Files
mobile applications) only accept communication via the HTTPS protocol, whereas the default way for MFiles Desktop to communicate with an on-premises M-Files server is to use the Remote Procedure Call
(RPC) protocol (TCP/IP, port 2266). Since this mode of communication does not require any additional
configuration steps, it is usually the preferred way of communicating inside the organization's internal
network.
In some situations, however, it is preferable to enable M-Files Desktop to communicate with M-Files Server
via the HTTPS protocol instead of RPC. This is especially useful if clients are connecting from outside the
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company's internal network. HTTPS connections are always encrypted and are typically not blocked in
hotel networks or other public networks.
For instructions on how to enable "RPC over HTTP with SSL" communication between M-Files Desktop
and M-Files Server, refer to the document Enabling RPC over HTTPS connections to M-Files Server. With
the configuration described in the document, all traffic from M-Files Desktop is encrypted and tunneled
through TCP port 443.
Once the "RPC over HTTP with SSL" connections have been enabled on the server, end users will be
able to use the HTTPS protocol while adding or editing a document vault connection in M-Files Desktop
Settings.
M-Files and Federated Authentication
Traditionally, the need to verify user identity has been met by using software-specific credentials or
Windows credentials. Federated authentication offers organizations the possibility to use an authentication
system that is completely external to M-Files. Federated authentication allows M-Files users to be
authenticated using third-party services called identity providers, such as Google or Azure AD. In many
cases, having a centralized repository for all the M-Files user credentials completely outside the M-Files
system can be very useful. Federated identity management also enables single sign-on, and provides the
opportunity for the users to utilize their existing credentials.

Figure 43: Authentication flow in a federated authentication system.

The figure gives an overview of the federated authentication process:
1. An M-Files user attempts to log in to a vault, and the client, be it M-Files Desktop or any other M-Files
client, sends an authentication request to M-Files Server.
2. M-Files Server creates an authorization request, which it sends to the identity provider.
3. The user is then redirected to the identity provider's login page where the user provides her credentials.
4. After the identity provider has validated the credentials, it returns a response to M-Files Server in the
form of an identity token, which contains an assertion affirming that the user has been authenticated.
5. M-Files Server verifies the identity token and grants the user access to the vault.
You may use the configurations editor in M-Files Admin to enable federated authentication in your vault.
For more information, see Using the Configurations Editor.
For more information about using federated authentication with M-Files, see the article Using Federated
Authentication with M-Files.
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Electronic Signing and Compliance
Companies using M-Files can manage their documents and processes efficiently and with quality. M-Files
can be used for compliance with various specifications, good manufacturing practices, general procedures,
and documentation according to standards. Moreover, M-Files provides functions to manage and monitor
general documents associated with daily business.
M-Files also meets the special requirements related to records and following various specifications and
standards. For example, M-Files complies with the following standards and guidelines:
•
•
•
•
•

ISO 9001 series
FDA 21 CFR Part 11
EU GMP Annex 11
HIPAA
Sarbanes-Oxley

M-Files can also be used to implement TLL-4-compliant data systems (TLL-4 is a data security
classification used in public administration and defense forces).
M-Files supports the administration of electronic records and signatures in compliance with FDA 21 CFR
Part 11. This involves maintenance of the detailed audit trail of actions performed on the documents,
secure monitoring of individual actions, and certification of electronic signatures with usernames.
Activation
The Electronic Signatures and Advanced Logging module includes the event logging extensions mentioned
above and the electronic signature functionality. The module is available for a separate fee.
For you to activate the module, an appropriate license code must be activated on your system. The
license is provided on a subscription basis. Activate or update the license code in M-Files Admin (for more
information, see Managing Server Licenses). In addition to this, the audit trail features of the vault must be
activated (see Document Vault Advanced Properties). If you do not have M-Files Compliance Kit installed,
you also need to add the electronic signature metadata structure to your vault manually (for instructions,
see Metadata Definitions for an Electronic Signature Object).
More information
For more information on the Electronic Signatures and Advanced Logging module related extensions for
event logging and electronic signatures, refer to Vault Event Log and Electronic Signatures.
M-Files can also be used to address other standards, quality management systems, compliance
requirements, guidelines, and procedures and processes in different fields. Log entries, audit trails, version
history, and electronic signatures form one set of functions that M-Files can offer. To find out how M-Files
can support your business by complying with applicable standards and specifications, please contact us at
sales@m-files.com.

3.1.2. Installing and Upgrading M-Files
This section guides you through the steps and requirements for an M-Files installation or upgrade, along
with describing how to set up a vault, add users to it, and establish a vault connection.

In this chapter
•
•

System Requirements and Technical Details
Installing the Software
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•

Installing M-Files Upgrades

System Requirements and Technical Details
This section contains hardware and software requirements and guidelines for the M-Files implementation.
The Technical Details page includes information about special environments, file data encryption, and
third-party applications.

In this chapter
•
•
•
•
•

Operating System Requirements
Server Hardware Guidelines
Requirements for M-Files Mobile and M-Files Web
Microsoft SQL Server Requirements
Technical Details

Operating System Requirements
Supported operating systems for M-Files Desktop
•
•
•
•
•

Microsoft Windows 10
Microsoft Windows 8.1
Microsoft Windows Server 2019
Microsoft Windows Server 2016
Microsoft Windows Server 2012 R2
Note: If the server only accepts TLS 1.2 connections and the client computer uses Microsoft
Windows Server 2012, refer to Enabling TLS 1.2 on Windows Server 2012 Computers.

Supported operating systems for M-Files Server
•
•
•
•
•
•
•

Microsoft Windows Server 2022
Microsoft Windows Server 2019 (recommended)
Microsoft Windows Server 2016 (recommended)
Microsoft Windows Server 2012 R2
Microsoft Windows Server 2012
Microsoft Windows 10
Microsoft Windows 8.1

The version of the operating system can be Workstation or Server. You can install M-Files Server
on a physical or a virtualized server. For example, you can use Hyper-V or VMWare ESXi for server
virtualization. However, you cannot use M-Files in a Windows Container or in an Nano Server environment.
For data security reasons, do not install M-Files Server on a computer that is also used as a Microsoft
domain controller.
Using Linux and macOS
Linux and macOS users can get access to M-Files with M-Files Web. The recommended browser is
Google Chrome. macOS users can install the M-Files for Chrome extension for the classic M-Files Web.
For instructions, refer to Installing and Enabling the M-Files for Chrome Extension.
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Support for 64-bit operating systems
M-Files is compatible with 64-bit Microsoft Windows operating systems.
.NET Framework requirements
The server and client computers must have Microsoft .NET Framework 4.7.2 or later installed for all MFiles functions to work correctly.
Server Hardware Guidelines
The M-Files system can be set up on a single server or on dedicated database, application, and search
servers. If you use M-Files Ground Link, see the hardware setup guidelines for the Ground Link proxy
server.
Plan the server architecture and especially the memory capacity and the CPU of the server so that it is
easy to upgrade the server machine later.
M-Files Desktop, M-Files Admin, and M-Files Server cannot be used on computers with an ARM
processor. End users that use this type of computer can access vaults with M-Files Web.

!

Important: The configurations that this section gives are examples only. There are many things
that have an effect on the system performance. For example, the degree of concurrent activity and
the type of operations that users do in the vault.
The disk space requirements for the metadata database are dependent on the complexity of the
metadata structure and the number of object versions in the database. You can use the estimates
of this section in typical document management use cases.
In large M-Files implementations, contact M-Files to help you with the implementation plan.

In this chapter
•
•
•

Hardware Guidelines for Single-Server Environments
Hardware Guidelines for Environments with Multiple Servers
Hardware Guidelines for Ground Link Proxy Servers

Hardware Guidelines for Single-Server Environments
This section lists the minimum hardware requirements and hardware guidelines for environments where
the M-Files server machine runs the M-Files Server application and the database server (Firebird or
Microsoft SQL Server).

!

Important: The configurations that this section gives are examples only. There are many things
that have an effect on the system performance. For example, the degree of concurrent activity and
the type of operations that users do in the vault.
The disk space requirements for the metadata database are dependent on the complexity of the
metadata structure and the number of object versions in the database. You can use the estimates
of this section in typical document management use cases.
In large M-Files implementations, contact M-Files to help you with the implementation plan.
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Minimum requirements
CPU

2 cores

Memory

1 GB

Storage

300 MB disk space for M-Files Server

Environments with up to 50,000 objects
CPU

4 cores

Memory

4 GB

Storage

RAID 1 or RAID 5 disks and enough disk space for files, database, and
backups

Environments with up to one million objects
CPU

8 cores

Memory

16 GB

Storage

RAID 1 or RAID 5 disks and enough disk space for files, database files,
and backups. Database files, Microsoft SQL Server transaction logs,
and search index files must be stored on solid state drives (SSD) for
optimal performance.

Operating system

64-bit operating system

Database management
system

Microsoft SQL Server 2019 or later, Standard or Enterprise Edition

Hardware Guidelines for Environments with Multiple Servers
For environments with a large number of objects and users, we recommend to have separate dedicated
server machines for the M-Files Server application, the vault database, and full-text search indexing. For
better scalability and availability, it is also possible to have multiple application, vault database, and full-text
search indexing servers.
In Multi-Server Mode environments, each application server must have hardware that meet the server
requirements.

!

Important: The configurations that this section gives are examples only. There are many things
that have an effect on the system performance. For example, the degree of concurrent activity and
the type of operations that users do in the vault.
The disk space requirements for the metadata database are dependent on the complexity of the
metadata structure and the number of object versions in the database. You can use the estimates
of this section in typical document management use cases.
In large M-Files implementations, contact M-Files to help you with the implementation plan.

Environments with up to one million objects when Microsoft SQL Server is on a separate server
We recommend to have a separate SSD drive for indexing on the M-Files Server. In this example, file data
is stored on the application server.
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System component

Database server

Application server

CPU

8 cores

8 cores

Memory

32 GB

16 GB

Storage

2 TB SSD drive

10 TB in total (4 TB for files +
4 TB for indexing + 20% as a
buffer)

Database management system

Microsoft SQL Server 2019 or
later, Standard or Enterprise
Edition

Environments with up to five million objects and five terabytes of files
Note: In these types of environments, configurations without a separate full-text search indexing
server can be sufficient.
System component

Database server

Application server

Full-text search
indexing (distributed
IDOL installation on 1
server)

CPU

16 cores

8 cores

8 cores

Memory

32 GB

16 to 32 GB

16 to 32 GB

Storage

256 GB SSD drive for
operating system

256 GB SSD drive for
operating system

256 GB SSD disk for
operating system

SSD disks for database
data and database
transaction log

15 TB HDD for file
data. The file storage
can be attached to the
application server or the
application server can
connect to a separate
file server.

256 GB HDD/SSD disks
for IDOL installations:

Use RAID 1 or similar

Use RAID 1 or similar

•
•
•

1 disk for DIH/DAH
engine
1 disk for daily index
content engine
5 disks for main index
content engines

Use RAID 1 or similar

Operating system

Microsoft Windows
Server 2019

Microsoft Windows
Server 2019

Microsoft Windows
Server 2019
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System component

Database server

Application server

Full-text search
indexing (distributed
IDOL installation on 1
server)

Database management Microsoft SQL Server
system
2019 or later, Standard
or Enterprise Edition

Environments with up to 15 million objects and 8 terabytes of files
The full-text search indexing
(distributed IDOL installation on 3
servers)
System
component

Database server

Application server

CPU

32 cores

Memory

Storage

Frontend server

2 backend servers

16 cores

8 cores

16 cores per server

128 GB

32 GB

128 GB

128 GB per server

256 GB SSD
disk for operating
system

256 GB SSD
disk for operating
system

256 GB SSD
disk for operating
system

256 GB SSD
disk for operating
system

Two 512 GB SSD
disks for database
data

25 TB HDD for
file data. The file
storage can be
attached to the
application server
or the application
server can connect
to a separate file
server.

256 GB HDD/SSD
disks for IDOL
installations:

256 GB HDD/SSD
disks for IDOL
installations:

•

•

Use RAID 1 or
similar

Use RAID 1 or
similar

Microsoft Windows
Server 2019

Microsoft Windows
Server 2019

Two 128 GB SSD
disks for database
transaction log
Use RAID 1 or
similar

Operating system

Microsoft Windows
Server 2019

Database
management
system

Microsoft SQL
Server 2019 or
later, Standard or
Enterprise Edition

•

1 disk for DIH/
DAH engine
1 disk for daily
index content
engine

10 disks for
main index
content engines

Use RAID 1 or
similar

Microsoft Windows
Server 2019
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Environments with up to 50 million objects and 10 terabytes of files
The full-text search indexing
(distributed IDOL installation on 6
servers)
System
component

Database server

Application server

CPU

32 cores

Memory

Storage

Frontend server

5 backend servers

16 cores

8 cores

16 cores per server

512 GB

64 GB

128 GB

128 GB per server

256 GB SSD
disk for operating
system

256 GB SSD
disk for operating
system

256 GB SSD
disk for operating
system

256 GB SSD
disk for operating
system

Two 1 TB SSD
disks for database
data

30 TB HDD for
file data. The file
storage can be
attached to the
application server
or the application
server can connect
to a separate file
server.

256 GB HDD/SSD
disks for IDOL
installations:

256 GB HDD/SSD
disks for IDOL
installations:

•

•

Use RAID 1 or
similar

Use RAID 1 or
similar

Microsoft Windows
Server 2019

Microsoft Windows
Server 2019

Two 256 GB SSD
disks for database
transaction logs
Use RAID 1 or
similar

Operating system

Microsoft Windows
Server 2019

Database
management
system

Microsoft SQL
Server 2019 or
later, Standard or
Enterprise Edition

•

1 disk for DIH/
DAH engine
1 disk for daily
index content
engine

10 disks for
main index
content engines

Use RAID 1 or
similar

Microsoft Windows
Server 2019

Hardware Guidelines for Ground Link Proxy Servers
In environments for Ground Link proxy services, we recommend this setup.
Environments with one Ground Link proxy
CPU

4 cores

Memory

8 GB

Storage

10 GB disk space for M-Files Server and temporary files
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If the same server machine is used for multiple Ground Link proxies, multiply the hardware resources by
two.
Requirements for M-Files Mobile and M-Files Web
Supported operating systems for the M-Files Mobile apps
App name

Required OS version

M-Files Mobile for iOS

iOS 11 or later

M-Files Mobile for Android

Android 5 or later

M-Files for MobileIron

iOS 11 or later, Android 5 or later

M-Files for BlackBerry

iOS 13 or later, Android 8 or later

M-Files for Intune

iOS 13 or later, Android 5 or later

Supported browsers for M-Files Web
Always use the latest available version of the browser.
Web browser

Operating system

Google Chrome

Microsoft Windows, macOS

Mozilla Firefox

Microsoft Windows

Safari

macOS

Microsoft Edge

Microsoft Windows

Supported browsers for the classic M-Files Web
For optimal user experience with the classic M-Files Web, use the M-Files for Chrome extension. The
extension is available in the Chrome Web Store for Chromium-based browsers. These include Google
Chrome and Microsoft Edge. As an alternative to the extension, your M-Files admin can set up Microsoft
Office for the web.
Always use the latest available version of the browser.
Web browser

Operating system

Google Chrome (recommended)

Microsoft Windows, macOS

Microsoft Edge (recommended)

Microsoft Windows

Mozilla Firefox

Microsoft Windows

Safari

macOS

Microsoft SQL Server Requirements
You can use Microsoft SQL Server 2012, 2014, 2016, 2017, 2019, or later with its latest service pack as
the vault database engine. All the Microsoft SQL Server editions are supported. These include Microsoft
SQL Server Express, Standard, and Enterprise.
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M-Files supports the use of Microsoft SQL Server on Microsoft Windows. With a self-hosted cloud-based
SQL database, you can also use Microsoft Azure SQL Database Managed Instance as the vault database
engine.
Loading the Microsoft SQL Server assembly
M-Files uses an SQL server assembly that must be used in the SQL server instance for M-Files to
operate. Usually, M-Files loads this assembly to the SQL server instance automatically. However, it can
be necessary to manually allow the use of the assembly, if, for example, M-Files does not have sufficient
permissions in the SQL server instance. For instructions, refer to the support article M-Files and SQL
Server 2017 compatibility). If the SQL server assembly is updated, you must repeat the process.
Enabling Microsoft SQL Server features
Enable the features given here to use Microsoft SQL Server as the M-Files database engine.
Instance features:
•
•

Database Engine Services
Reporting Services, Native Mode (if reporting is used)

Shared features:
•
•

Management Tools, Basic
Management Tools, Complete (if reporting is used)

Technical Details
Database engine and data storage
M-Files Server includes Firebird Embedded, a powerful SQL database engine. Firebird is the default
database engine of M-Files. Purchasing additional database software is thus not required. When using
Firebird as the database engine of M-Files, the metadata of documents and other objects will be stored in a
SQL database. The data files of objects are stored in the file system.
Optionally, Microsoft SQL Server 2012, 2014, 2016, 2017, 2019, or later with its latest service pack can be
used as the database engine of M-Files for better performance and support for larger repositories. All the
Microsoft SQL Server editions are supported. These include Microsoft SQL Server Express, Standard, and
Enterprise.
Tip: For the best performance, we recommend using Microsoft SQL Server 2016 Service Pack 1 or
later as they support updateable columnstore indices, enabling better performance when opening
sub-levels of views (such as Documents by project).
When using Microsoft SQL Server as the database engine of M-Files, the metadata of documents and
other objects will be stored in a SQL database. The data files of objects can be stored either in the MS
SQL database or in the file system. Microsoft SQL Server can be installed on the M-Files Server computer,
or alternatively, the M-Files Server computer can connect to an existing SQL Server farm. In the latter
case, the processor and RAM requirements of the M-Files Server may be smaller than indicated above.
If your organization wants to use a self-hosted cloud-based SQL database, you can use the managed
instance deployment option of the Microsoft Azure SQL Database. A managed instance of the Microsoft
Azure SQL Database is a fully managed SQL Server Database Engine instance hosted in Azure cloud.
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M-Files uses Unicode and thus supports storing and finding data in East Asian languages as well. The
data saved in the file system can be encrypted with the AES-256 algorithm. For more information, refer to
Protecting File Data at Rest with Encryption in M-Files.
Network communication
M-Files Desktop uses the TCP/IP, HTTPS, or gRPC protocol to communicate with M-Files Server. The
classic M-Files Web uses HTTP or HTTPS, the new M-Files Web uses gRPC, and M-Files Mobile uses
HTTP, HTTPS, or gRPC for server communication.
It is recommended to use encrypted connections in all client-to-server communication. For more
information, see Protecting Data in Transit with Encryption in M-Files.
Special environments
M-Files is compatible with the following special environments:
•
•

Remote Desktop Services (Terminal Services)
Citrix XenApp

•
•

M-Files is Citrix Ready for Citrix XenApp 7.6. See M-Files and Citrix XenApp for the configuration
details.
Linux file servers
Novell networks

User authentication
M-Files supports multiple authentication methods (can be mixed):
Windows authentication

Users are authenticated using their Windows account names and
passwords. Login accounts can be imported from Active Directory
(LDAP).

Federated authentication

Users are authenticated against an external Identity Provider (IdP),
such as Azure Active Directory. See Using Federated Authentication
with M-Files for more information.

M-Files authentication

Users are authenticated with usernames and passwords specified
within M-Files.

M-Files supports using pre-shared keys for an additional level of security. For more information, see
Accessing M-Files Vaults without VPN.
Database connections
M-Files Server can be integrated with existing databases, such as CRM and ERP databases. All
databases with an OLE DB or ODBC driver are supported (includes SQL Server, Access, Oracle, and
MySQL).
Integrations with third-party applications
Numerous third-party applications can be integrated to M-Files. See www.m-files.com/integrations and
https://catalog.m-files.com for examples.
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Application programming interface (API)
M-Files includes an ActiveX/COM API. Supported languages include VB.NET, C#, Visual Basic, VBScript,
and C++. Additionally, M-Files includes the M-Files Web Service API that allows programmatic access to
M-Files through a REST-like interface (refer to M-Files Web Service).
M-Files API is included within the installation of the M-Files software. The API documentation is available
as an online version ( M-Files API) and as a Microsoft HTML Help file, which you can download at https://
www.m-files.com/api.
M-Files UI Extensibility Framework allows external add-ins (M-Files Applications) to be used for
personalizing the behavior of M-Files Desktop. With these applications, the M-Files experience can be
modified to better match specific business areas and needs. For more information, refer to the M-Files UI
Extensibility Framework documentation.
Installing the Software
M-Files can be installed as a single installation or distributed and installed on several computers at once.
These instructions are for executing a single M-Files installation. For advanced installation options, such
as customizing the installation package to automatically configure client or server connections, disabling
automatic checking for software updates or using Active Directory group policies in distributing M-Files,
refer to the document M-Files Setup: Advanced User's Guide.
Tip: While the M-Files installation is in progress, you may want to see information about M-Files
and Virus Scanning.
•
•

The server and client computers must have Microsoft .NET Framework 4.7.2 or later installed for all MFiles functions to work correctly.
You have received the M-Files setup file from your system administrator, or you have downloaded it via
the M-Files download page.

For a single M-Files installation, follow these steps:
1. Quit all other applications running on your computer and double-click the M-Files setup file.
The welcome screen of the installation wizard appears.
2. Click Next.
3. Read and accept the end-user license agreement to be able to continue.
4. Click Next.
5. Select the software components to be installed.
You can install M-Files for evaluation or perform a normal installation.
If you are not an M-Files system administrator in your organization, you only need to install MFiles Desktop. In this case, M-Files Server has been installed on your organization's local area
network, and your M-Files system administrator has the M-Files Server Tools (M-Files Admin)
installed. After the normal installation, you can connect to the document vault(s) on your M-Files
server via M-Files Desktop Settings.
The evaluation installation includes all the software components as well as a sample vault, which
you can start exploring immediately after installation.
6. Continue the installation by clicking Next.
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7. Specify the installation location and click Next.
8. If you do not want to change anything, click Next to start the installation.
9. Select whether or not you would like to see the Guided Tour and click Finish to complete the
installation process.
The M-Files software has now been installed on your computer. If you have performed an evaluation
installation, you can continue familiarizing yourself with the software by opening the Guided Tour via the
Windows Programs menu.

In this chapter
•

Example: Single-Instance Installation of M-Files

Example: Single-Instance Installation of M-Files
This is a short description of a basic M-Files installation to a single computer that, in this case, serves as
both the server machine and the client. The purpose of this example is to provide the main steps of setting
up the elementary components of an M-Files system.
Complete the following steps:
1. Install the M-Files software as instructed in Installing the Software.
2. Create a document vault as instructed in Creating a New Document Vault.
Note, however, that with the evaluation installation option, two vaults are automatically deployed.
Sample Vault contains a reference metadata structure and views for some common information
management processes as well as sample files to help you to easily evaluate the search. My
Vault contains the same metadata structure and views as Sample Vault but does not contain
the sample content. You can use the structure of My Vault as a foundation for your purposes
instead of creating a new vault from scratch. You can also restore the sample structure from
the M-Files Server installation folder (C:\Program Files\M-Files\<version>\Server
\sample\My Vault.mfb by default).
3. Create a new login account to the server as instructed in Creating a Login Account.
4. Create a new user (or multiple users) to your vault as instructed in Creating a User.
At this point, the following tasks should be completed:
•
•
•
•

M-Files Server, M-Files Admin, and M-Files Desktop have been installed.
There is a document vault on the server – either one of the vaults that come with the
evaluation installation or one that you have created from scratch.
There is at least one login account on the server.
There is at least one user in your vault.

5. Open M-Files Desktop Settings and create a connection to the vault as instructed in Adding a Vault
Connection.
You should now have a vault on the M-Files server with a user whose credentials you can use to log in to
the vault and start browsing the content with M-Files Desktop.
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Installing M-Files Upgrades
The M-Files installer automatically detects the previous versions of the software and can migrate the
settings from the old to the new version. Hence, do not uninstall any previous versions of M-Files before
upgrading.
Note: If M-Files is not deployed with Windows Group Policy, you must have local administrator
permissions on your computer to install a new M-Files version.
Perform the following tasks to upgrade M-Files to a newer version:
1. Execute the M-Files installer for the new version.
2. Select the Simple upgrade option.
With the Simple upgrade option selected, the setup automatically installs the same components that were
installed in the earlier M-Files version. The setup installs the new version and transfers the M-Files settings
along with all local data from the earlier version to the new version. Finally, the setup uninstalls the earlier
version.
Important remarks
•

•

•

•

Speed and performance improvements in M-Files 2015.2 and newer can cause some empty virtual
folders to appear in views in which empty folders are set to be hidden. Because of this, we recommend
reading the document Security Aspects to Consider When Upgrading to M-Files 2015.2 before
upgrading your system.
If you are upgrading from a version that is older than M-Files 2015, note that the new installation
includes significant improvements to the vault database structure. This means that – especially
with large document vaults – the upgrade process might take substantially longer than usual. It is
also recommended to ensure that the server computer has at least twice the amount of free space
required by the metadata database file (the FDB file for Firebird and MDF file for Microsoft SQL Server
databases). The database structure is upgraded automatically by the M-Files installer.
Property group and dynamic property configuration for M-Files 10.2 and M-Files 2015 has been
replaced with more versatile configuration options in M-Files 2015.1 and later. See the document
Configuring the Metadata Card (M-Files 2018) for more details.
If you are upgrading M-Files Server from M-Files 2015.2 or earlier to M-Files 2015.3 or later and both of
the following are true:
•
•

You have a document vault that contains documents either in the Chinese, Japanese, or Korean
language.
The selected primary or secondary language for the full-text search features of the vault is some
other than Chinese, Japanese, or Korean. For more information, see Creating a New Document
Vault.

In such a case, you should rebuild the full-text search index of the vault after the upgrade is complete
so that the documents in the aforementioned languages are still retrievable by searching their contents.
For instructions, see Vault Maintenance.
Installation preconditions
All M-Files Server instances in a replication setup must have the same four-digit build number (for instance
4320 in 11.2.4320.32 and 11.2.4320.33).
You can use the following table to verify the compatibility between M-Files Server and M-Files Desktop:
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M-Files Desktop (M-Files M-Files Desktop (M-Files M-Files Desktop (M-Files
2015 and 2015.x)
2018)
Online)
M-Files Server (M-Files
2015 and 2015.x)

Compatible

Compatible

Not compatible

M-Files Server (M-Files
2018)

Compatible

Compatible

Compatible

M-Files Server (M-Files
Online)

Not compatible

Compatible

Compatible

To verify compatibility with M-Files API and replication, see M-Files version compatibility regarding API and
Replication.
Note: In some cases, you must disable your antivirus software for the duration of the upgrade
process.
Installation order
You can choose to either first upgrade the client computers and then the server computer, or first the
server computer and then the client computers. If you do not upgrade to the immediately subsequent MFiles version, make sure that the new version is compatible with the old version to avoid unnecessary
interruptions (see the compatibility chart above). In such a case it is also recommended that you first
upgrade the server and then the client computers.
Note: Some of the new properties of the higher M-Files version may not be available until both MFiles Desktop and M-Files Server have been upgraded to the new version.
Upgrading offline vaults
As the internal database structure of the document vault changes during a software upgrade, the document
vaults must be upgraded as well. All the vault in the online state are upgraded automatically during a
software upgrade, but if any of the vaults are in the offline state, they need to be updgraded manually. To
do this, open the vault context menu in M-Files Admin and select Upgrade.
Preparing for the server upgrade
Before installing the upgrade on M-Files Server, ensure that the following conditions are met:
•
•

•
•

Make sure that your server fulfills the hardware and software requirements of the new version (see
System Requirements and Technical Details).
The administrator should also ensure that recent backups of the document vaults are available and
usable. The backups may be useful should an unexpected fault situation occur during the server
upgrade.
The administrator should also take backups of the master database.
The backups should preferably be stored on a separate disk drive.

In the event of a fault situation, write to our customer support at support@m-files.com immediately. Do
not attempt to rectify the fault yourself, as solving the fault situation is usually much easier if no additional
actions have been performed.
Service releases
Service releases are smaller M-Files software upgrades that share the same main version number (for
example "11.0" for M-Files 2015), followed by the four-digit version ID for the service release. For instance,
versions 11.0.4300.47 and 11.0.4300.58 are service releases for M-Files 2015 (11.0.4300.27). Usually,
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the service releases do not contain any new properties, but rather are released if faults requiring repair are
detected in the software, or if compatibility with higher versions of other software requires changes to MFiles.
Service release versions are fully compatible between each other and can be installed in whichever order.
In other words, whether the service release is installed first on the workstations and then on the server, or
vice versa, makes no difference.
Automatic updates
Automatic updates keep your M-Files software up to date. If a newer version of M-Files covered by your MFiles subscription becomes available, it is downloaded to your computer and you are notified about it. New
M-Files versions normally become available as automatic updates about a month after a new version has
been officially released.
To ensure version compatibility, see Installation preconditions.
Disabling the updates
You can open the automatic updates control panel via your Windows start menu or by right-clicking the
M-Files icon in your Windows notification area and selecting Settings > Automatic Updates from the
context menu. If you wish to disable automatic updates, you can do so by opening the Settings tab and
unchecking the Check for updates automatically check box. Administrators can disable automatic
updating altogether by using a modified installation package. For more information, see M-Files Setup:
Advanced User's Guide.
You can check for updates manually by opening the Installation tab and clicking the Check Now button.
Upgrading the M-Files OCR module for versions M-Files 2015 and later
M-Files Server versions for M-Files 2015 and later do not support the OCR module of the M-Files versions
prior to M-Files 2015, so you might need to upgrade this module after upgrading the server software. See
Instructions for enabling the M-Files OCR Module for detailed instructions.
Centralized deployment via Windows Group Policy
You can use the Windows Group Policy feature to automatically distribute M-Files to client computers.
Alternatively, you may use any other centralized deployment mechanism that you are familiar with. You
can also customize the behavior of the M-Files setup program. For more information on these options,
refer to M-Files Setup: Advanced User's Guide.

3.1.3. M-Files Admin
M-Files Admin is a tool that is used for administrating and maintaining M-Files document vaults and MFiles Server connections.
M-Files Server is the backbone of the M-Files system. It saves all objects (such as documents, employees
and customers), controls access rights, registers object modifications (version history), and allows the
system administrator to configure connections also to other systems (such as a customer registry).
Basically, M-Files Server saves and controls all information related to the M-Files system.
Technically, M-Files Server, like M-Files Desktop, is a service. This means that M-Files Server starts
automatically when the server computer starts. The M-Files Server software is run even if there are no
users logged in on the computer running the M-Files Server software.
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Figure 44: The M-Files Admin main window displaying the different levels inside a document vault.

M-Files Admin Terminology

Login account

The M-Files Server login account that is used to log in to M-Files
Server and on the basis of which a new user can be added to the
document vault.

Metadata

In M-Files Admin, you can change the structures of metadata (for
example, value lists, property definitions, document classes, and
document class groups) and create new metadata, whereas you just
specify values for these metadata items in the day-to-day use of MFiles. Compare with M-Files Terminology.

Object type

Besides documents, you can also manage other objects, such as
customers and projects. These data set definitions are called object
types. Document is one object type.

Property Definition

Property definitions are used to determine properties associated with
document classes. A property definition is used to define the property
name (which should be descriptive) and data type, which determines
the type of the data entered (in relation to the property).
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Role

Roles can be used to provide users with permissions that mainly
affect M-Files Server Administration. The permissions gained through
roles always take precedence over document and object permissions.
User who has all permissions to a document vault can access any
object, even if the access of a particular user to a document has been
denied by means of object-specific permissions.

System administrator

A system administrator is a user who has been assigned the role
of system administrator. This means that the user's login account
has the server role System administrator. With this role, the user
gets all the permissions to each vault on the server and the user has
server-level access to do all possible functions in M-Files. A system
administrator can add the role of system administrator to other login
accounts. For a system administrator to log in to a vault on the server,
a user account in that vault is not necessary.

User

The M-Files user, who, at the server level, can be either a regular
user or a system administrator. Users can be added to the desired
document vaults, and a user's document vault administration
permissions depend on the document-vault-level roles assigned to
the user. On the document vault level, roles mainly determine the
user's permissions to document vault administration. A regular user's
basic permissions are also assigned by means of roles.
Users can be grouped into external and internal users. For example,
you can define your customers as external users. External users
can only see and access documents and objects specifically marked
for them. By default, they do not have permissions to view any
documents.

User group

You can create user groups on the M-Files server to which individual
users can be added. Each user automatically belongs to the user
group All internal and external users. In addition, each internal user
automatically belongs to user group All internal users. User groups
are specified on the document vault level. User groups can be used to
define the permissions to an object, that is, to specify the users who
may access it.

Value List

A value list is a list that contains various values, such as the names of
all customers. The same value list can be utilized in several different
properties.

Vault

The document vault is managed with M-Files Admin. This is where
you can add users to the document vault, change the metadata
structures of objects, and edit views visible to all users. See also MFiles Terminology.
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Workflow

Workflows define how the organization manages a process. An
example of a workflow is invoice circulation. The workflow has related
states and definitions regarding the task performer, permissions, and
state transitions.

3.1.4. Connections to M-Files Server
This section offers an information about various operations and settings related to connections to M-Files
server.
Note: It is recommended to use Universal Naming Convention (UNC) paths (such as \
\ServerName\) when you are defining a connection to a network drive, as the letter assigned to
the drive may not be visible to the M-Files server. In addition, Windows drive letter assignments are
frequently user-specific. A network drive may, for example, contain an external database for a value
list.

In this chapter
•
•
•
•
•
•
•

Adding a New Connection to M-Files Server
Managing Server Licenses
Login Accounts
Scheduled Jobs
Server Activity Monitor
Backing Up the Master Database
Managing Server Certificates

Adding a New Connection to M-Files Server
To set up a new connection to M-Files server in M-Files Admin, select Connections to M-Files Servers in
the left-side tree view. In the task area, click New Connection to M-Files Server.
Note: If the connecting computer is using Windows Server 2012 and the server computer has been
set to only accept Transport Layer Security (TLS) 1.2 connections, TLS 1.2 must be enabled on
the client computers by following the instructions in Enabling TLS 1.2 on Windows Server 2012
Computers.
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Name
First assign a name to the connection.
Connection / Server Name
Enter the network name or IP address of the server on which M-Files Server has been installed and that
contains the document vault.
Connection / Port Number
The server was specified in the previous field, and in this field you specify the port to connect to on the
server. Enter the server port number to connect to. M-Files uses port 2266 by default.
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Connection/Protocol
Specify the protocol to be used for the network connection. The following protocols are available:
•
•
•
•
•
•

gRPC
Local gRPC
TCP/IP
SPX
Local Procedure Call (LPC)
HTTPS
Note: When you use the gRPC protocol for connections between the M-Files server and M-Files
clients, a valid TLS certificate must be in use on the server for connection security and encryption.
For instructions, see Managing Server Certificates.

Encrypted connection
Activate this option to enable RPC encryption between M-Files Admin and M-Files Server.
The option is available for the TCP/IP protocol only. If the protocol is HTTPS, the connection is always
encrypted at the HTTPS protocol level. For connections from outside the organization's internal network,
HTTPS or VPN should still be used, as RPC communication to the default TCP port, 2266, is often blocked
by firewalls.
Note: For RPC encryption to work, the user as well as the computer must be able to authenticate
to the server computer. In practice, this requires that the client computer belongs to the Windows
domain and that the user is a domain user.
For more information on encrypted connections and for instructions on how to configure the server to
require encrypted connections, refer to Protecting Data in Transit with Encryption in M-Files.
Connection / Test Connection
You can test the operation of the connection to M-Files server with the Test Connection button.
Authentication
Specify the method M-Files Server is to use for authenticating the user. The authentication options are
Current Windows user, Specific Windows user and M-Files user.

In this chapter
•

Connecting to and Disconnecting from the Server

Connecting to and Disconnecting from the Server
You can use the Disconnect function to disconnect the network connection to the server. You can
reconnect the connection later without having to specify the server registration properties again.
To disconnect:
1. Open M-Files Admin.
2. Select a connection to M-Files server.
3. Open the Action menu.
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4. Select Disconnect.
To reconnect:
1.
2.
3.
4.

Open M-Files Admin.
Select a connection to M-Files server.
Open the Action menu.
Select Connect.

Managing Server Licenses
To open license management settings in M-Files Admin, right-click your M-Files server in the left-side tree
view and click License Management.
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Figure 45: M-Files license management window.

License status
The status of the license is shown here. Users receive a notification before the license expires.
Serial number
This is your M-Files serial number.
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Licensed to
The license holder is displayed here. This confirms that your organization is the registered user of the
software.
Subscription expires
Subscription expiry date. During the subscription period, you are entitled to all M-Files version updates
free of charge. You also need to have an active M-Files subscription for receiving customer support free of
charge.
Number of named user licenses / In use
The number of licenses installed is displayed for each license type separately. Below that, you can see
the number of licenses in use. Named user licenses are assigned to individual login accounts. For more
information about license types, refer to License type.
Number of concurrent user licenses / In use
The number of concurrent user licenses in use is determined by the number of currently logged in users
using this license type. A license is reserved when a user using this license type logs in to M-Files. When
the user logs out of M-Files, the license becomes available. For more information about license types, refer
to License type.
Number of read-only licenses / In use
A read-only license allows the user only to read content. It does not allow the user to create or modify
documents in the document vault. For more information about license types, refer to License type.
Additional modules
Here you can see the additional modules to which you have access, such as the OCR module.
Refresh
The Refresh button brings the "in use" license data up to date.
Install License
When the evaluation period expires, you need a license to be able to use M-Files. Install your license by
clicking the Install License... button. Enter the serial number and license code you have obtained, and
then click OK.
Login Accounts
The vault has users who must first authenticate themselves to M-Files Server. Before creating the users,
you must create login accounts on M-Files Server. These login accounts are added to vaults as users. The
same server login can be added to several vaults.
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Figure 46: Login accounts are used for authenticating M-Files users to M-Files Server. They can be imported from a domain to MFiles Server. Login accounts are associated with vault-specific users.

In this chapter
•
•
•
•
•
•

Login Account Properties
Creating a Login Account
Importing Login Accounts
Changing the Login Account of a User
Performing Actions on Multiple Login Accounts
Viewing Logged-In Users

Login Account Properties
You can create a login account in M-Files Admin when you right-click Login Accounts in the left-side tree
view and select New Login Account. For a step-by-step guide, see Creating a Login Account.
Tip: You can also import Windows login accounts to M-Files. For more information, see Importing
Login Accounts.
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Figure 47: The new login account creation dialog.

Windows authentication
Windows authentication can be used for authentication on M-Files Server. In this case, the user logs in to
the vault with the same login information used to log in to Windows or the domain of the organization.
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Domain login is the quickest and easiest authentication method. This means that new passwords and
logins are not necessary, which makes this a user-friendly method. For more information, see Differences
between the various user authentication methods.
Note: If your organization uses federated identity management, refer to Using Federated
Authentication with M-Files.
M-Files authentication
With the M-Files authentication method, the user can log in to M-Files only. If the organization does
not have a Windows domain or the user must not have access to it, it is a good idea to use M-Files
authentication for the vault.
Personal information
Enter an email address and a full name for the login account. This information is used for sending
notifications. For more information about notifications, see Editing Notification Settings in M-Files Admin. If
the authentication method used is Windows authentication, you can retrieve the personal information from
the domain when you click Update Information from Domain.
License type
Select a license type for the login account.
Named user license
Named user licenses are assigned to individual login accounts. This license allows the login account to use
M-Files any time, independent of other users.
Concurrent user license
When a login account entitled to a concurrent user license logs in, one license of this type is taken up.
When the login account logs out, the license becomes available for use by other login accounts that use
this same license type.
Read-only license
Read-only licenses are assigned to individual login accounts. This license allows the login account to
use M-Files at any time, independent of other users. With the license the user is only able to read the
documents, not create or modify them.
External Connector license
External Connector licenses enable third-party systems to anonymously read M-Files database. The
license type is necessary for example when M-Files data is published programmatically in an intranet or
extranet environment to an unrestricted number of users.
Account is disabled
This function provides an easy way to specify whether the user can log in to the server or not. This function
is useful if you do not want to remove the login account altogether, but to disable it for the time being.
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Server roles: System administrator
With this role, the user can make any changes on the server level. The user can change the server logins
and create and delete vaults. In other words, a system administrator can do any operation on a vault.
For a system administrator to log in to a vault on the server, a user account in that vault is not necessary.
However, you can set the system administrator to not have access to vaults and rights to create users
in vaults where they do not have a user account. To do this, a specific license is necessary. For more
information, contact licensing@m-files.com.
See the table for a comparison between the permissions of a system administrator and a user with the Full
control of vault administrative rights. For a description of the administrator permissions in the Advanced
Vault Settings section of the M-Files Admin configurations editor, see Configuring Advanced Vault
Settings.
Operation

System administrator

Vault administrator

Create a vault

Allowed

Not allowed

Attach a vault

Allowed

Not allowed

Restore a vault

Allowed

Not allowed

Detach a vault

Allowed

Not allowed

Back up a vault

Allowed

Not allowed

Copy a vault

Allowed

Not allowed

Destroy a vault

Allowed

Not allowed

Optimize the database

Allowed

Not allowed

Back up the master database

Allowed

Not allowed

Restore the master database

Allowed

Not allowed

Take a vault offline

Allowed

Not allowed

Rebuild the full-text search index

Allowed

Allowed

Reset thumbnail images in a vault

Allowed

Allowed

Verify and repair a vault

Allowed

Not allowed

Migrate to Microsoft SQL Server

Allowed

Not allowed

Manage content replication and archiving
settings

Allowed

Allowed to manage cloud
storage based replication
jobs

Create or import a login account

Allowed

Not allowed

Create a scheduled job

Allowed

Not allowed

Change M-Files Server notification settings

Allowed

Not allowed

Manage M-Files licenses

Allowed

Not allowed

Configure web and mobile access

Allowed

Not allowed

Shut down M-Files Server

Allowed

Not allowed

Log in to any vault

Allowed

Not allowed
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Operation

System administrator

Vault administrator

Create and import users

Allowed

Not allowed

Import user groups

Allowed

Not allowed

Create user groups

Allowed

Allowed

See and read all vault content (including deleted
objects)

Allowed

Allowed

See and undelete deleted objects

Allowed

Allowed

Destroy objects

Allowed

Allowed

Force undo checkout

Allowed

Allowed

Change permissions for all objects

Allowed

Allowed

Change metadata structure

Allowed

Allowed

Manage workflows

Allowed

Allowed

Manage login accounts

Allowed

Allowed

Manage common views and notification rules

Allowed

Allowed

Manage vault applications

Allowed

Not allowed

Edit scripts (for example related to event
handlers, workflow states, and automatic
property values)

Allowed

Not allowed

Manage connections to external sources

Allowed

Not allowed

Disable or enable vault event logging

Allowed

Not allowed

See and manage scheduled jobs

Allowed

Not allowed

Restart vault

Allowed

Allowed

Creating a Login Account
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Login Accounts.
4. In the task area, click New Login Account.
The New Login Account dialog is opened.
5. In Username, enter a username.
6. Select an authentication method and enter authentication details in the fields below the selected
authentication method.
7. Enter an email address and a full name in the personal information fields.
If you use Windows authentication, you can click Update Information from Domain to retrieve
personal information from the domain's directory service.
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8. In License type, select a license.
For information about the license types, see License type.
9. Optional: Check the Login account is disabled check box if you want to disable the login account for
the time being.
10.Optional: Check the System administrator check box if you want to assign a system administrator
role for the login account. This role entitles the user to make any changes on the server level, including
changing the server logins and creating and deleting document vaults.
11.Click OK.
You should now have a new login account and it should appear in the Login Accounts list when you
highlight Login Accounts in the left-side tree view in M-Files Admin.
Importing Login Accounts
Do the following steps to import login accounts to M-Files Server:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Login Accounts.
4. In the task area, click Import Login Accounts.
The Import Login Accounts dialog is opened.
5. Select either:
a. Choose from list to select the user group using drop-down menus. In Domain, select the desired
domain. In Organizational unit, select the desired organizational unit within that domain. Finally, in
User group, select the user group that you want to import.
or
b. Enter Name. This option is especially useful if you have so many user groups that searching the
correct one from list is hard. Enter the name of the user group in the format <domain>\<user group>
and click Show.
The list area in the dialog is populated with the members of the selected user group.
6. Optional: Check the Include users from nested groups check box to be able to import login accounts
from nested groups within the selected user group.
The list area in the dialog is populated with the members of the selected user group and the
members of any user group nested within the selected user group.
7. Select the login account or login accounts by clicking a login account on the list.
You can select more than one item at once. Hold down the Ctrl key to select multiple individual
items or hold down the ⇧ Shift key to select adjacent items on the list.
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8. Using the License type for new login accounts drop-down menu, select the license type for the login
accounts to be imported.
For more information about license types, see License type.
9. Click OK to import the selected login accounts.
The selected login accounts are imported to M-Files Server and should now appear in the Login
Accounts list when you click Login Accounts in the left-side tree view in M-Files Admin.
Changing the Login Account of a User
Sometimes it may be necessary to change the login account for a user. The user's login account may have
to be changed when, for example, the user needs a new login account due to his or her last name being
changed or when login accounts are moved from one domain to another.
When a user login account must be changed, it is important to preserve the vault user associated with
the original login account and to associate the same user with the new login account to preserve the user
history and the user's personal settings in the vault.
Note: It is important to distinguish between login accounts and users:
•

•

Login accounts are server-level (or in some cases vault-level) accounts that are used for
authenticating users to M-Files Server. A login account can be associated with multiple users,
but only one user per vault.
Users are vault-level objects that store user-specific settings and user history and that have
permissions to perform specific operations in a vault. A user is linked to one and only one login
account.

Do the following steps to correctly change a login account for a user after new login accounts have been
created in M-Files:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Users.
The Users list is opened in the right-side pane.
6. Right-click the user whose login account you need to change and select Properties from the context
menu.
If new login accounts are synchronized from an Active Directory source, M-Files automatically
creates new users for the new login accounts. To associate the new login account with the
correct existing user, you must first delete the new, automatically created user.
The User Properties dialog is opened.
7. Use the Login account drop-down menu to select a new login account for the user.
8. Click OK to close the User Properties dialog and to save your changes.
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The new login account is now correctly associated with the existing user. Now when the user logs in using
the new credentials, their previous user history and personal settings in the vault are available.
Performing Actions on Multiple Login Accounts
You can perform certain actions on many login accounts at the same time. This is useful if you have a lot of
login accounts in M-Files and you need to, for example, change the license type of multiple login accounts.
When you have selected multiple login accounts, the actions available are Enable, Disable, Delete, and
Change License Type.
Do the following steps to perform actions on many login accounts at the same time:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Login Accounts.
4. Select one of these options:
a. If you want to select a range of login accounts, click the first login account, hold down the ⇧ Shift key
and select the last login account in the range.
or
b. If you want to select multiple individual login accounts, hold down the Ctrl key and select the desired
login accounts.
5. In the task area, click the desired option.
Viewing Logged-In Users
You can server-specifically view the currently logged-in users and their license types.
Do the following steps to view the users who are currently logged in to the server:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Login Accounts.
4. In the task area, click Show Logged-in Users.
The Logged-in Users dialog is opened, showing the users who are currently logged in. You can click
Refresh to update the view.
If necessary, you can also force certain users to log out by selecting the user and clicking Force Logout.
This might be very useful, for instance, when concurrent licenses are used: The operation enables you
to force the logout of idle users to release the license to be used by someone who actually needs it at
the moment. Forcing active users to log out, however, normally does not affect them at all. Active users
immediately get a license if available licenses exist.
Note: Displaying the logged-in users and forcing their logout requires you to have administrator
rights.
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Scheduled Jobs
Backups can be automated with Scheduled Jobs, which you can find at the bottom of the left-side tree
structure in M-Files Admin. Backups can be restored later on, if need be (see Restoring a Document Vault
for instructions). In addition to backups, scheduled jobs can be used for other tasks, such as optimization
of the vault database.

In this chapter
•
•

Creating a New Scheduled Job
Scheduled Backup Jobs

Creating a New Scheduled Job
Note: If you are looking for information on scheduled export and import jobs, see Scheduled Export
and Import.
Complete the following steps to define a new scheduled backup job:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Scheduled Jobs.
4. In the task area, click New Scheduled Backup Job.
The Scheduled Job Properties dialog is opened.

M-Files | 3. System Administration | 224
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

5. In the Description field, enter a description for the new scheduled job.
6. To define a schedule for this task:
a) Click the Schedule... button.
The Define Schedule dialog is opened.
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b) Define the appropriate schedule using the available options.
The schedule option When idle is not supported in M-Files.
c) Click OK to close the Define Schedule dialog.
7. Click Backup to open the Backup tab.
The Backup tab is opened.
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8. Select either:
a. Master database: Select this option if you want to schedule a backup job for the master database.
or
b. Vault: Select this option if you want to schedule a backup job for a document vault. Use the Vault
drop-down menu to select the vault that you want to back up and the Backup type drop-down menu
to select either the Full backup or Differential backup backup type.
Note: A full backup is the most complete copy that can be produced with M-Files. It
contains, for example, the history information of all documents. You cannot make a
differential backup if you have not made a full backup first. A differential backup contains all
data that has been changed after the last full backup.
9. Click the ... button to select the destination of the M-Files backup file (MFB).
10.Optional: Click Set Account... to run the task with another account than the Local System account. If
the file location is on a network drive that the Local System account cannot get access to, you must set
another account. On the Set Account dialog:
a) Select This account.
b) In This account, enter the name of the user account.
c) In Password and Confirm password, enter the password of the user account.
d) Click OK to close the Set Account dialog.
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11.Optional: If you want to divide the vault backup into multiple files, check the Divide to multiple files
check box and set the file size limit.
The names of the backup files should not be modified as they might no longer be recognized
during a backup operation later on.
12.Optional: Check the Overwrite existing files check box if you want your new backup files to replace
any existing files with the same file name.
13.Click OK to finish creating the scheduled backup job.
The scheduled backup job you have defined is added to the Scheduled Jobs list and it is run according to
the specified schedule.
Scheduled Backup Jobs
The Backup tab of the Scheduled Job Properties dialog enables you to define what needs to be backed
up and to which location. You can also specify whether to divide the backup into multiple files and whether
to overwrite existing backup files.
For step-by-step instructions on how to create a vault backup, see Backing Up a Document Vault.

M-Files | 3. System Administration | 228
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

Figure 48: The Backup tab of the Scheduled Job Properties dialog.

Backup types
Two kinds of backups can be made of document vaults: full backups and differential backups. Only full
backups can be made of the master database.
A full backup is the most complete copy that can be produced with M-Files. It contains, for example, the
history information of all documents. You cannot make a differential backup if you have not made a full
backup first.
To save disk space, full backups should be scheduled to occur less frequently, for instance once a week,
and differential backups for example once a day. Be sure to specify backups separately for both the
document vault and the master database.
The differential backup contains all data that has been changed after the last full backup. When restoring a
differential backup, you will need the full backup and the files from the last differential backup.
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Server Activity Monitor
M-Files Admin includes a tool called Server Activity Monitor for observing events, processes, and tasks
executed by vault users or M-Files Server. The tool enables you to easily identify possible issues related to
operations taking place on the server.
Note: The activity monitor records a limited number of events. This means that once the record is
full, every time a new event is recorded, the oldest event is removed from the list.
This topic describes the various views included in the monitoring tool, but let's first see how to access
Server Activity Monitor in M-Files Admin.
To open the server monitoring tool:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Server Activity Monitor.
As a result, you should see the activity monitor on the right side window of M-Files Admin.
Note: The views are not updated in real time. You can use the Refresh and Reset commands on
the task pane to update and clear the views. The activity monitor is always on, so you do not need
to separately activate it.

Figure 49: Server Activity Monitor in M-Files Admin.

Tip: You can sort the information by any numerical column in any of the views by clicking the
column heading of you choice.
Tip: You can easily copy any of the server activity listings shown by selecting and copying a listing
and pasting the selection into, say, Microsoft Excel or Microsoft Word. If you paste the selection
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into a Microsoft Excel worksheet, the copied listing is separated into multiple cells, preserving the
original row and column format.
Task pane commands
The commands on the task pane allow you to perform various operations in Server Activity Monitor:
•
•
•
•
•

Refresh updates the server activity data with up-to-date information.
Reset removes all the existing server activity data and restarts the monitoring.
Show System Sessions / Hide System Sessions shows or hides active system sessions and
operations. If system sessions are hidden, only user activity is shown.
Export Server Activity... allows you to export the current server activity data to a JSON file.
Import Server Activity... allows you to import and view server activity data previously exported to a
JSON file.

Active sessions on server
This view lists all the active user and system sessions by vault connection. If the connection is listed as
(server), the connection is not to any of the vaults, but to the server itself.
Most active sessions
This view lists the total number (Count) and duration of operations (Total duration) by user, the
description of the operation (Operation), the average duration per operation (Average), and the vault
connection (Vault).
The Total row shows the total duration and number of operations for the entire period server activity has
been monitored, and the number of operation calls made per second during the monitoring period.
Note: This view lists only thirty operations at a time, whereas the Total row displays the total
number and duration of operations for the entire period of time server activity has been monitored.
Therefore the calculated total number and duration of the operations visible in the view may not be
equal to the figures shown in the Total row.
Objects modified
This view displays the number of object modifications by user and vault.
The types of modification listed in this view are:
•
•
•

object creation
object modification
object deletion

The Total row shows the total number of object modifications for the monitoring period and the average
number of object modifications made per second.
Note: This view lists only thirty operations at a time, whereas the Total row displays the total
number of operations for the entire period of time server activity has been monitored. Therefore the
calculated total number of the operations visible in the view may not be equal to the figures shown
in the Total row.
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Views and searches
This section lists the views accessed and searches initiated by the user. It displays the total duration, the
number of uses, and the average duration per use of a single view (such as Recently Accessed by Me) or
a search. Each row displays the user who accessed the view or performed the search, as well as the vault
in which the operation was performed.
The Total row shows the total duration it has taken to open views and perform searches during the
monitoring period. It also displays the total number of searches performed and views opened, and the
average number of such operations made per second.
Note: This view lists only thirty operations at a time, whereas the Total row displays the total
number and duration of operations for the entire period of time server activity has been monitored.
Therefore the calculated total number and duration of the operations visible in the view may not be
equal to the figures shown in the Total row.
Background processes
The Background processes view lists activities automatically executed by M-Files Server, such as
scheduled maintenance tasks and processing of automatic state transitions. In addition to the name of the
process, the view displays the affected vault, as well as the duration, the last start time, and – for periodic
events – the next start time of the process.
Backing Up the Master Database
The M-Files master database contains the server login accounts and scheduled backup jobs. For
example in case of a hardware failure, the master database can be restored from the backup so that login
information and server-specific settings like scheduled backup jobs are not lost.
Complete the following steps to back up the master database:
1. Open M-Files Admin.
2. Right-click a connection to M-Files server.
3. Click Back Up Master Database.
The Back Up Master Database dialog is opened.
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4. In the Destination section, click ... to browse for the location where you would like to have the backup
file placed.
5. Optional: Click Set Account... to run the task with another account than the Local System account. If
the file location is on a network drive that the Local System account cannot get access to, you must set
another account. On the Set Account dialog:
a) Select This account.
b) In This account, enter the name of the user account.
c) In Password and Confirm password, enter the password of the user account.
d) Click OK to close the Set Account dialog.
6. Optional: Check the Divide to multiple files check box if you want to divide the backup into multiple
files of given size.
Use the File size limit spinner to specify the size of the split backup files.
7. Optional: Check the Overwrite existing files check box if you want to overwrite any existing backup
files in the location you have selected.
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8. Optional: In the Scheduling section, select the Add to scheduled jobs option if you want to specify a
recurring schedule for backing up the master database.
a) Click the ... button.
The Define Schedule dialog is opened.

b) Define the appropriate schedule using the available options.
The schedule option When idle is not supported in M-Files.
c) Click OK to close the Define Schedule dialog.
9. Click OK to back up the master database.
The master database backup is stored in the location you have selected.
Restoring the Master Database
Complete the following steps to restore the master database:
1. Open M-Files Admin.
2. In the left-side tree view, right-click a connection to M-Files server.
3. Click Restore Master Database.
The Restore Master Database dialog is opened.
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4. Click ... to browse for the location of the master database backup file.
5. Optional: Click Set Account... to run the task with another account than the Local System account. If
the file location is on a network drive that the Local System account cannot get access to, you must set
another account. On the Set Account dialog:
a) Select This account.
b) In This account, enter the name of the user account.
c) In Password and Confirm password, enter the password of the user account.
d) Click OK to close the Set Account dialog.
6. Click OK to restore the master database.
A confirmation message is displayed after the master database has been restored.
Managing Server Certificates
When you use the gRPC protocol for connections between the M-Files server and M-Files clients, a valid
TLS certificate must be in use on the server for connection security and encryption. If the certificate cannot
be found, it is outdated, or it will become outdated in a week or less, a warning icon (
Files Admin user interface.

) is shown in the M-

Before you start, make sure that you have a TLS certificate and a private key for the certificate. For
information about digital certificates, refer to information given by certificate authorities. For example,
Verisign, IdenTrust, or DigiCert. You can also create your own certificate, for example, with OpenSSL.
The best practice is to use certificates by well-known public authorities, such as certificates that are
commonly used in public web servers. Otherwise, when you use self-signed certificates, you must add
the corresponding public keys to the Trusted Root Certification Authorities certificate store of the client
computers. This way the signatures can be properly verified on systems that access the M-Files server
with gRPC. Make sure that you add the signing certificate under the Local Computer and Current User
certificate stores. The client computer must be able to verify the entire certificate chain. If any of the
signatures cannot be verified, the connection cannot be opened.
To set up a server certificate:
1. Open M-Files Admin.
2. Right-click a connection to M-Files server.
3. Click Manage Server Certificate
The Server Certificate Management dialog is opened.
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4. Enable the option Use a TLS certificate.
5. Under the Private Key section, click Change.
An Open dialog for selecting the private key is opened.
6. Locate and double-click a valid private key (a KEY file) to put it to use.
The key must be in the format specified by either the PKCS8 or the PKCS1 standard.
7. Under the Certificate section, click Change.
An Open dialog for selecting the certificate file is opened.
8. Locate and double-click a valid TLS certificate (a CRT file) to put it to use.
The certificate must be in PEM (Privacy-Enhanced Mail) format.
9. Make sure the certificate details are as expected and click OK.
The certificate is now in use for connections between the M-Files server and M-Files clients.

3.1.5. Managing Document Vaults
This section describes how you can create, operate and maintain document vaults, and deals with various
other aspects closely related to document vaults, such as content replication, vault languages, and
connections to external databases.

In this chapter
•
•
•
•
•
•
•
•
•
•
•

Vault Operations
Vault Maintenance
Languages and Translations
Connections to External Sources
Email Client Integration Settings
Content Replication and Archiving
Vault Event Log
Monitoring Background Tasks
Monitoring Vault Indexing
Measuring Vault Performance
Interaction Among Several Vaults

Vault Operations
This section provides instructions for various administrative document vault operations, such as creating,
copying, backing up, or restoring a document vault, or restarting a vault, which is an operation that must be
occasionally carried out to make vault configuration changes effective.

In this chapter
•
•
•

Creating a New Document Vault
Copying a Vault
Attaching a Document Vault
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•
•
•
•
•
•
•
•
•
•
•

Detaching a Document Vault
Backing Up a Document Vault
Restoring a Document Vault
Creating a Search Index
Backing Up and Restoring the Vault Search Index
Destroying a Document Vault
Upgrading a Document Vault
Migrating the Vault Database to Microsoft SQL Server
Restarting a Vault
Taking a Vault Offline and Bringing a Vault Online
Logging in to and out of a Vault in M-Files Admin

Creating a New Document Vault
If you want to create a new vault in a language other than the currently selected software language, you
must first change the software language and restart the M-Files Server service via Windows Task Manager
before creating the vault. For instructions on changing the software language, see Selecting the Software
and Vault Language.
To create a document vault:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Document Vaults.
The Document Vaults list is opened in the right-side pane.
4. In the task area, click New Document Vault .
The Document Vault Properties dialog for a new vault is opened.
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5. In the Name field, enter a name for the new document vault.
6. Use the Primary language and Secondary language drop-down menus to select the primary and
secondary languages for full-text search features.
These selections affect, for example, the way inflected or irregular forms of words or compounds
are dealt with in searches. If the document vault is to contain material in several languages, it
is recommended to select the language that is used most as the primary language and a less
commonly used language as the secondary language.
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Selecting a language or languages improves the probability of finding the right search results.
Even if a certain language was not selected as the primary or secondary language, the full-text
search will nevertheless return results if words in this language were used in the search.
7. Optional: Click Import... to change the vault icon to facilitate finding the right vault if you are using
multiple vaults.
a) In the Change Icon dialog, select an item from the list or click Browse... to search for a different
icon.
b) Click OK once you have selected the new icon.
You can revert back to the default icon by clicking Use Default.
8. Optional: Change the advanced settings on the Advanced tab.
9. Click OK once you are done.
You should now have created the document vault and it should appear on the left-side tree view of M-Files
Admin under Document Vaults.
Note: When you create a document vault, M-Files automatically creates an ID for it. The ID can
be changed later in the Document Vault Properties dialog of the vault by clicking the Change
Unique ID button.
After you have created the vault, the users of the vault must add a connection to it via M-Files Desktop
settings. For instructions, see Adding a Vault Connection.

In this chapter
•
•

Document Vault Advanced Properties
Document Vault Authentication

Document Vault Advanced Properties
On the Advanced tab of the Document Vault Properties dialog, you can define whether you want to use
Firebird or Microsoft SQL Server for saving document vault information.
Firebird is a SQL database engine integrated in M-Files. As part of the M-Files Server service, it requires
no separate installation and is therefore very easy to use. Choose Firebird as the database engine, unless
you have a particular reason to choose Microsoft SQL Server. Switching from Firebird to Microsoft SQL
Server can be easily done later on if necessary. Changing from Microsoft SQL Server to Firebird is not,
however, possible.
Microsoft SQL Server is a SQL database engine that requires purchasing and separate installation. It
is recommended to use Microsoft SQL Server with large document vaults, but it also requires that the
administrator is already familiar with the Microsoft SQL Server management.
Note: Never modify the content structure of the document vault database directly using, for
instance, database system management tools. The database contents may be modified with the
M-Files Server service only. Other modifications endanger the logical integrity of the database,
which may cause faulty operation of the software and loss of data. The structure and contents of
the document vault may only be modified via M-Files Desktop, M-Files Admin, and M-Files API.
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Use Firebird
See Using Firebird as the Database Engine.
Use Microsoft SQL Server
See Using Microsoft SQL Server as the Database Engine.
Audit trail features
M-Files supports the administration of electronic records and signatures in compliance with FDA 21 CFR
Part 11. Electronic signing requires the Electronic Signatures and Advanced Logging module, which
is available for a separate fee. The module includes event logging extensions and electronic signature
functionality. The module is activated with an appropriate license code.
In addition to this, vault-specific properties of the audit trail must be activated. Open the Properties dialog
of the vault for which you want to activate these features and, on the Advanced tab, enable Advanced
Event Log features under Audit trail features. Electronic signatures are automatically enabled as soon
as the license code is activated. For more information, see Electronic Signing and Compliance.
For a list of the event types recorded to the event log, see section Number of events, and event types.
Tip: If you want to give system administrators more visibility into actions that vault users perform in
a vault, see User Action Log.
Security features
Extended metadata-driven permissions
For vaults created with version 8.0 (or later), the extended metadata-driven permissions are active by
default. Otherwise they need to be manually activated. Please bear in mind that you cannot undo the
operation.
Note: If you have assigned automatic permissions to values in earlier versions of M-Files, it is
strongly recommended to check that the permissions are still working as desired.
For more information on automatic permissions, refer to Automatic Permissions for Value List Items. You
can activate the automatic permissions by value, value list, object type, or class. For you to be able to use
the automatic permissions via a specific property, you should also allow this in the property definition's
properties. For more information, see New Property Definition.
Enable file data encryption at rest
This option allows you to use the AES-256 algorithm for encryption of the vault file data at rest. The
encryption is compliant with the Federal Information Processing Standard (FIPS) publication 140-2.
This option only encrypts file data that is stored to the vault after the feature has been turned on. If you
want to encrypt existing data:
1. Select the vault in the left-side tree view of M-Files Admin.
2. Select Action > Maintenance > Update encryption status of existing files.
From the perspective of the end-user, file data encryption is not visible in any way.
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Note: Especially when encryption is enabled, it is crucial for the administrator to have thorough and
frequent back-up processes in place. The combination of encrypted file data, hard drive failure and
inadequate backup system could eventually lead to the loss of all data.
Annotations and redlining
The Annotation and redlining feature enables you to add annotations to documents in the document vault.
You can enable the annotations and redlining feature by checking the Annotations and redlining check
box in the Document Vault Properties dialog. For more information about annotations in M-Files, see
Annotations and Redlining.
M-Files Web
Enter the URL to your M-Files Web home page. M-Files requires this to include M-Files Web URLs in
hyperlinks and M-Files Web links in notification messages.
Make sure that the URL starts either with http:// or https://. For example: https://
myserver.mydomain.com.
Classic M-Files Web
Enter the URL to your classic M-Files Web home page. M-Files requires this to include classic M-Files
Web URLs in hyperlinks and classic M-Files Web links in notification messages.
Make sure that the URL starts either with http:// or https://. For example: https://
myserver.mydomain.com.

In this chapter
•
•

Using Firebird as the Database Engine
Using Microsoft SQL Server as the Database Engine

Using Firebird as the Database Engine
Firebird is an SQL database engine integrated in M-Files.
M-Files uses Firebird as the default vault database engine. If a vault contains several tens of thousands of
objects, we recommend using Microsoft SQL Server. If a vault has originally been set up to use Firebird but
the number of objects in the vault and the size of the metadata file has since then significantly increased,
we recommend migrating the vault database to Microsoft SQL Server.
We recommend that you start to plan migration to Microsoft SQL Server when the size of the metadata file
for a vault is close to 1 GB. For instructions on checking the metadata file size, see Checking the Size of a
Firebird Metadata File.
You can apply a registry setting to extend Firebird usability to 2 GB per vault. You can use Firebird also
after this limit has been exceeded, but, for performance reasons, Microsoft SQL Server is in this case the
recommended database engine.
To open the vault settings for the Firebird engine:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
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3. Expand Document Vaults.
4. Right-click a vault.
5. Click Properties.
The Document Vault Properties dialog is opened.

6. Open the Advanced tab.
7. Click Define... under the Use Firebird option to open the settings for the Firebird engine.
The Firebird settings dialog is opened.
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On the Firebird settings dialog, you can do these operations:
•
•

Changing the Location of the Vault Data
Defining A Separate Location for Vault File Data

Changing the Location of the Vault Data
If necessary, you may change the default location of the vault data, that is, the file data and the metadata
of the vault. Note that the vault metadata must be stored on the local drive of the M-Files Server computer.
If you wish to store the file data of the vault in a separate location (which can be, for example, a network
drive), see Defining A Separate Location for Vault File Data.
Before you begin, take the vault offline for the duration of the operation. For instructions, see Taking a
Vault Offline.
To change the location of vault data, complete the following steps:
1. Open the vault database engine settings.
The current location of the vault data is shown in the vault database engine settings dialog.
2. Using File Explorer or any other file manager, copy the FileData and the MetaData folders from their
current location to the new location.
3. Click the ... button to browse for the new file data location.
The Browse For Folder dialog is opened.
4. Select the new location for vault data, and then click OK to close the Browse For Folder dialog.
Note that the selected location should be on the local drive of the M-Files Server computer and it
should contain the FileData and MetaData folders.
5. Click OK to close the vault database engine dialog, and finally click OK to close the Document Vault
Properties dialog.
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After the operation is complete, bring the vault back online. For instructions, see Bringing a Vault Online.
Defining A Separate Location for Vault File Data
By default, vault file data is stored in the same folder as vault metadata. If necessary, you can define a
separate location for the file data of the vault. This enables you to locate your file data on a large network
drive or file server. It is, however, recommended to store the metadata and files in the same location.
Before you begin, take the vault offline for the duration of the operation. For instructions, see Taking a
Vault Offline.
To define a separate location for file data, complete the following steps:
1. Open the vault database engine settings.
The current location of the vault file data is shown in the vault database engine settings dialog.
2. Using File Explorer or any other file manager, copy the folder FileData from its current location to the
new location.
3. Click the Advanced... button.
The Advanced dialog is opened.

4. Enable the Separate location for file data option.
5. Click the ... button to browse for the new file data location.
The Browse For Folder dialog is opened.
6. Select the new location for vault file data, and then click OK to close the Browse For Folder dialog.
Note that the selected location should contain the FileData folder. The location can also be a
UNC path to a network drive.
7. Optional: Click Set Account for File Data... to select the account that M-Files Server uses for
accessing the vault file data. This may be necessary if the local system account does not have
permission to access the selected location.
a) Select the This account option.
b) In the This account field, specify the account that M-Files Server should use for accessing vault file
data in the selected location.
c) In the Password and Confirm password fields, enter the password of the account.
d) Click OK to close the Set Account dialog.
8. Click OK to close the Advanced dialog.
9. Click OK to close the vault database engine dialog, and finally click OK to close the Document Vault
Properties dialog.
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After the operation is complete, bring the vault back online. For instructions, see Bringing a Vault Online.
Using Microsoft SQL Server as the Database Engine
Instead of Firebird, you can use Microsoft SQL Server 2012, 2014, 2016, 2017, 2019, or later with its latest
service pack as the database engine. M-Files supports all the SQL Server editions (Express, Standard,
Enterprise, etc.). For the best performance, we recommend using SQL Server 2016 Service Pack 1 or
later. M-Files supports the use of Microsoft SQL Server on Microsoft Windows.
Note: In new installations, we recommend using Microsoft SQL Server Enterprise Edition 2017
Service Pack 1 or later. If you are already using Microsoft SQL Server as the database engine for
one or more vaults, and are interested in upgrading to a newer version for performance reasons, we
recommend consulting our customer support at support@m-files.com before upgrading.
The Microsoft SQL Server Enterprise Edition versions 2008–2017 provide the possibility for
compressing table data and indexes. This reduces the input/output activity of the disk, but also
increases the CPU load by about 10 percent. Typically this means reduced database sizes.
Microsoft SQL Server 2016 Service Pack 1 and above support updateable columnstore indexes
(in earlier versions, columnstore indexes are only available in Enterprise Edition), enabling better
performance when opening sub-levels of views (such as Documents by project). This is especially
beneficial when empty virtual folders are set to be hidden.
Using SQL Server means that the database server memory can be more efficiently used and the backup
storage of large data vaults is improved. In the event of problems, errors etc., you can switch to the
mirrored database server without delay.
We recommend using Microsoft SQL Server with large document vaults that contain several hundreds
of thousands or more documents or other objects. With large document vaults, Microsoft SQL Server
provides better overall efficiency than Firebird. However, use of the Microsoft SQL Server database engine
requires that the administrator is already familiar with the Microsoft SQL Server management.
Note: Microsoft SQL Server licenses are not included in M-Files licenses and must be purchased
separately.
Microsoft SQL Server may be located on the same machine as the M-Files Server, or it can be installed
on another server. If SQL Server is installed on another server, M-Files Server and SQL Server must be
linked with a fast network connection. Instructions for ensuring the efficient operation of SQL Server can
be found in the Microsoft SQL Server documentation. Firstly, it is recommended to ensure that the SQL
Server machine has a sufficient amount of memory. The number and speed of processors and hard drives
also have a significant impact on the efficiency.
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Figure 50: The Microsoft SQL Server properties dialog.

Note: If your SQL Server does not use the default port (1433), the server name must be given as
<server name>,<port>.
When Microsoft SQL Server is used as the document vault database engine, M-Files Server stores data in
the document vault in the associated database. Certain secondary data that do not require a backup, such
as search indexes, are left outside the database.
File Data Location
File data can be saved in the Microsoft SQL Server database or other location, such as a network drive.
You can choose to:
•

Store file data in the vault database
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•

Store file data in a file-system folder: With this option, you can freely specify the location for saving
the files to a network drive or to another location. You can keep the file data secure by designating a
specific account for processing the file data.
Note: If you want to use a network drive for storing file data, you must use the format
//<server>/<path> for specifying the file data location.
Note:
In M-Files builds older than 12.0.6661.0, the vault is offline for the entire duration of changing
the file data location. Note that if your vault contains large amounts of file data (for instance over
one terabyte of data), changing the location may take several days, or even over a week, to
complete.
With the build 12.0.6661.0 and later, the vault remains online and fully operational for the
majority of the duration of changing the file data location. Only when the new file data location
is taken into use, is the vault offline for the duration of taking the new location into use. If you
cancel the operation of changing the file data location, you can always resume it by selecting the
same location as you previously selected for file data.

For further instructions, see Changing the Location of the Vault File Data.
Backing Up
The administrator is responsible for making backup copies and timing the backup copies of the document
vault database. Backup copying is performed using SQL Server's own management tools and backup
copying solutions offered by third parties. When restoring a backup copy, the administrator first returns the
document vault database to the SQL Server using the desired method, and then reattaches the document
vault to M-Files using the Attach Document Vault function.
If you are using Microsoft SQL Server as the database engine and your file data is stored on the file
system separately from the database, administrators must back up both the Microsoft SQL database and
the files on the file system separately.

!

Important: Always back up the SQL database first and then the file system data to avoid
references to non-existing object files.

The steps to be followed in this case are:
1. Back up the Microsoft SQL database first (metadata).
2. Do not run M-Files Server optimization at this point, as this would remove files that might have been
marked for destruction after step 1 was performed.
3. Back up file system data (object files).
For more comprehensive backup instructions, see the M-Files knowledge base article M-Files Backup
Policy.
Migrating to Microsoft SQL Server
The document vault database engine can also be changed from Firebird to Microsoft SQL. For more
information, see Migrating the Vault Database to Microsoft SQL Server.

In this chapter
•

Changing the Location of the Vault File Data
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Changing the Location of the Vault File Data
If you use Microsoft SQL Server and your file data of the vault is stored either in the vault database or the
file system, you may change the location of the vault file data.
To change the location of the vault file data, complete the following steps:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Right-click a vault.
5. Click Properties.
The Document Vault Properties dialog is opened.

6. Open the Advanced tab.
7. Under the Use Microsoft SQL Server option, click the Define... button.
The Document Vault - Microsoft SQL Server dialog is opened.
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8. Click the File Data Location... button.
The File Data Location dialog is opened.
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9. Either:
a. If you want to change the location of the vault file data from the vault database to the file system, or
from one folder in the file system to another, select the option Store file data in a file-system folder
and then click the Define... button.
or
b. If you want to change the location of the vault file data from the file system to the vault database,
select the option Store file data in the vault database and then click OK.
10.If you selected the option Store file data in a file-system folder, complete the following steps:
a) Optional: If you are changing the vault file data location from one folder in the file system to another,
using File Explorer or any other file manager, copy the FileData folder from its current location to
the new location.
b) In the File-System Folder dialog, click the ... button to browse for the new file data location, or type
in the location in the text field.
The location can also be a UNC path to a network drive.

c) Optional: Click Set Account for File Data... to use an account other than the Local System account
for accessing file data.
Setting the account may be necessary especially if the file data is located on a network drive
that the Local System account cannot access.
d) Click OK to close the File-System Folder dialog.
11.Click OK to close the File Data Location dialog and the vault database engine dialog, and finally click
OK to close the Document Vault Properties dialog.
12.If you are changing the vault file data location from the vault database to the file system, or from the
file system to the vault database, you are prompted to confirm that you want to change the file data
location. Click Yes.
The file data of the vault is then copied to the new location.
Note:
In M-Files builds older than 12.0.6661.0, the vault is offline for the entire duration of
changing the file data location. Note that if your vault contains large amounts of file data
(for instance over one terabyte of data), changing the location may take several days, or
even over a week, to complete.
With the build 12.0.6661.0 and later, the vault remains online and fully operational for the
majority of the duration of changing the file data location. Only when the new file data
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location is taken into use, is the vault offline for the duration of taking the new location
into use. If you cancel the operation of changing the file data location, you can always
resume it by selecting the same location as you previously selected for file data.
Your vault now uses the specified location for storing and accessing the file data of the vault.
Document Vault Authentication
The Authentication tab of the Document Vault Properties dialog contains settings related to vault user
synchronization and authentication. The tab is available in the Document Vault Properties dialog of
existing vaults. When you create a vault, you cannot see this tab.
User synchronization
There are two methods to set up user synchronization with Azure AD. With the SCIM method (the first one
in the list), user group management is done in Azure AD and Azure AD pushes the users to M-Files. With
the plugin method (the second one in the list), user group management is done in M-Files Admin and MFiles pulls the users from Azure AD.
•

Synchronizing Users from Azure Active Directory to M-Files
•
•

•

To use this method, you must have an Azure AD Premium license.
To use this method in an on-premises environment, you must also enable vault-specific login
accounts. With vault-specific login accounts, you manage all login accounts in each vault separately.
For instructions, write to our customer support at support@m-files.com.
Configuring Azure Active Directory Synchronization Plugin

User authentication
•

Use these instructions to set up Azure AD authentication in one of these environments:
•
•

•

A cloud environment.
An on-premises environment where you only use M-Files Desktop with one or a small number of
vaults.
If you use some other environment, refer to Configuring OpenID Connect and OAuth 2.0 for M-Files
Authentication.

Anonymous Authentication
Enable this feature to set M-Files Web and M-Files Mobile users to have read-only access to this vault
without username and password. You must have External Connector license to use this feature. M-Files
Desktop and the classic M-Files Web do not use this setting. To set up the classic M-Files Web to use
anonymous authentication, see Publication Settings for Classic M-Files Web.
When the feature is enabled, M-Files adds an anonymous user to the vault. The user has no login account
on the server, but you can use it to set permissions, and add it to user groups. The anonymous user is
created as an external user but you can change it to be an internal user. The anonymous user does not
decrease the number of your read-only license.

In this chapter
•

Enabling Azure AD authentication

Enabling Azure AD authentication
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•
•

To set M-Files Web and M-Files Mobile to use Azure AD authentication in an on-premises environment,
refer to Configuring OpenID Connect and OAuth 2.0 for M-Files Authentication instead.
Before you set up this feature, log out of all Azure AD accounts that are not used for logging in to MFiles.

To enable Azure AD authentication:
1. Open M-Files Admin and go to a vault.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
2. Right-click the vault and select Properties.
3. Open the Authentication tab.
4. Enable Use Azure AD for authentication.
5. Select one of these options:
Option

Description

Prompt each user for consent upon first vault
access

Select this option to let vault users decide whether
they want to give the applications access to their
user credentials in Azure AD. With this option,
Azure AD shows a prompt when the user logs in
to the vault for the first time. In the prompt, the
user can give the permissions to the applications.

Give consent on behalf of all users in the
directory (requires Azure AD administrator
rights)

Select this option to give the applications access
to user credentials in Azure AD on behalf
of all vault users. Only an Azure AD global
administrator can give consent on behalf of other
users.
When you click OK or Apply, M-Files displays a
login prompt. Write the credentials for the Azure
AD account that is used for logging in to M-Files.

The user credentials must have access to the Azure AD domain that you want to use for the
user synchronization.
6. Optional: In an on-premises environment, complete the configuration with the instructions in Configuring
Mappings Between Incoming Connections and Vaults.
7. Configure the user synchronization in Azure AD.
Refer to Synchronizing Users from Azure Active Directory to M-Files.
Copying a Vault
You can use the Copy Document Vault operation to create a copy of a vault. You can copy the vault fully
or select the data components that are copied.
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Note: The Copy Document Vault operation copies the vault first fully and then deletes the data
components that have not been selected. For large vaults, the operation time can be long.
It is possible to copy the structure of a vault without the actual content to a new vault. You can use
for example the sample vault, that is included in the M-Files installation, in this operation. To copy the
structure of a large vault, we recommend exporting the structure. For more information, see Exporting
Content.
To copy a vault:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Right-click a vault.
4. Click Operations > Copy Document Vault.
The Copy Document Vault dialog is opened.
5. In the Name field, enter a name for the copy of the vault.
6. Click Define to define the vault data location on the server to which the copy is saved.
The Document Vault dialog is opened.
7. Click the ... button to browse for the vault data location.
8. Optional: To define a separate location for file data:
a) Click Advanced.
The Advanced dialog is opened.
b)
c)
d)
e)

Select the Separate location for file data check box.
Click the ... button to browse for the file data location.
To define a separate account for copying file data, click Set Account for File Data.
Click OK to close the Advanced dialog.

9. Click OK to close the Document Vault dialog.
10.In the Data to copy section, select the vault data components that you want to copy.
Click All to select all components or Structure Only to select only the structure components of
the vault.
If the Documents and other objects check box is selected, you can exclude file data from the
vault copy for troubleshooting purposes. Click Advanced and select the Exclude file data from
the vault copy check box.
11.Click OK to copy the vault.
Attaching a Document Vault
A document vault may be detached from M-Files Server (see Detaching a Document Vault), in which case
all data in the document vault is kept in a file folder on a hard drive but the document vault is not registered
on the server. If you know the name of the document vault and want to start using it again, you can do so
by attaching the vault back to M-Files Server using M-Files Admin.
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Figure 51: When the vault is detached from the server, it is not displayed in the list of available document vaults in M-Files Admin
and users cannot access it, but all the data stored in the vault stays intact. You can, for instance, move a detached vault to a another
server machine and take it back into use by attaching it to the new server.

If, for example, lack of space makes it necessary to move a document vault from one server to another,
this can be done with the Detach and Attach functions: simply detach the vault on server A, copy the vault
data to server B, and attach the vault on server B.
Do the following steps to attach a document vault:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Select Document Vaults.
4. In the task area, click Attach Document Vault.
The Attach Document Vault dialog is opened.
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5. In the Name field, enter the name of the detached document vault.
You may look for the name of the detached vault on the server computer in the folder C:\<MFiles installation directory>\Server Vaults.
6. Select either:
a. Attach using original identity: Select this option if you want to use the existing ID of the vault.
or
b. Attach as a different vault (new identity): Select this option if you want to create a new unique ID
for the vault.
The vault identity is used in establishing document vault connections to the server.
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7. Optional: On the Advanced tab, you may select and configure the database engine for storing
document vault data.
See Using Firebird as the Database Engine and Using Microsoft SQL Server as the Database
Engine for more information.
8. Click OK.
The Attach Vault Options dialog is opened.
9. Select the features to be disabled in the attached vault:
•
•
•
•
•
•
•
•

External object types and value lists: Connections to external databases for object types and
value lists
Connections to external sources
Reporting and metadata export data sets
Scheduled export and import jobs
Active Directory user group synchronization
Event handlers
Vault applications
Remote full-text search indexes: Search indexes that are not used by dtSearch

If you do not know which features to disable, do not make any changes in this dialog.
10.Click Disable selected.
A dialog is displayed listing the features that will be in use in the attached vault.
11.In the Attach Vault dialog, click Attach.
The selected document vault is attached to M-Files Server and can be accessed again.
The users of the document vault must add a connection to it via M-Files Desktop settings. For instructions,
see Adding a Vault Connection.
Detaching a Document Vault
You can detach a vault from a connection to M-Files server, in which case the vault data is not destroyed
but kept on the hard drive of the server computer. You can later restore the server connection with the
Attach Document Vault operation.
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Figure 52: When the vault is detached from the server, it is not displayed in the list of available document vaults in M-Files Admin and
users cannot access it, but all the data stored in the vault stays intact. You can, for instance, move a detached vault to another server
machine and take it back into use by attaching it to the new server.

Do the following steps to detach a document vault:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Document Vaults.
4. Select a document vault that you want to detach and click Detach on the task area.
5. Click Yes at the prompt to confirm your action.
The selected document vault is detached from M-Files Server.
Backing Up a Document Vault
The vault backup function can be used for backing up the document vault or for scheduling a recurring
vault backup job. For more information about scheduled backups, refer to Scheduled Backup Jobs.
Note: You can restore the backup only on a server whose M-Files Server version is the same as or
later than the version on the server that is used to create the backup. If you restore the backup on a
server that has a later version, see Upgrading a Document Vault.
Note: If you are using Microsoft SQL Server as the database engine of your vault, see Backing Up
for instructions on backing up and restoring your vault data.
It also is important to note that M-Files stores on the hard drive of the server machine a vault-specific set
of secondary data that is not included in a vault backup, but instead re-recreated after the vault backup
has been restored. This data includes PDF renditions for hit-highlighting and preview, thumbnails, and
most importantly, the search index of the vault. As rebuilding the search index for a large vault can take a

M-Files | 3. System Administration | 257
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
significant amount of time, you should always consider backing up and restoring the search index as well.
For instructions, see Backing Up and Restoring the Vault Search Index.
To back up a document vault, do the following steps:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Right-click a vault
4. Click Operations > Back Up.
The Back Up Document Vault dialog is opened.
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5. Using the Backup type drop-down menu, select either Full backup or Differential backup.
A full backup is the most complete copy that can be produced with M-Files. It contains, for
example, the history information of all documents. You cannot make a differential backup if you
have not made a full backup first. A differential backup contains all data that has been changed
after the last full backup.
6. Click the ... button to select the destination of the M-Files backup file (MFB).
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7. Optional: Click Set Account... to run the task with another account than the Local System account. If
the file location is on a network drive that the Local System account cannot get access to, you must set
another account. On the Set Account dialog:
a) Select This account.
b) In This account, enter the name of the user account.
c) In Password and Confirm password, enter the password of the user account.
d) Click OK to close the Set Account dialog.
8. Optional: If you want to divide the vault backup into multiple files, check the Divide to multiple files
check box and set the file size limit.
The names of the backup files should not be modified as they might no longer be recognized
during a backup operation later on.
9. Optional: Check the Overwrite existing files check box if you want your new backup files to replace
any existing files with the same file name.
10.Select either:
a. Run immediately to start the backup job right away.
or
b. Add to scheduled jobs and click the ... button to schedule the backup job as a recurring task.
Note: For more information about scheduled jobs, see Scheduled Jobs.
11.Click OK to either start the backup process or to add the scheduled task to the list of scheduled jobs.
The vault backup should now be run or added to the list of scheduled jobs, depending on your choice
under the Scheduling header of the dialog.
Restoring a Document Vault
Even if a document vault is destroyed or the data is somehow corrupted, you can always restore the
healthy vault from a backup. For more information about creating backups, see Backing Up a Document
Vault and Scheduled Backup Jobs.
Note: You can restore the backup only on a server whose M-Files Server version is the same as or
later than the version on the server that is used to create the backup. If you restore the backup on a
server that has a later version, see Upgrading a Document Vault.
Note: If you are using Microsoft SQL Server as the database engine of your vault, see Backing Up
for instructions on backing up and restoring your vault data.

M-Files | 3. System Administration | 260
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

Figure 53: You can restore a backup of a document vault using M-Files Admin.

Do the following steps to restore a document vault from a backup file:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Document Vaults.
4. In the task area, click Restore Document Vault.
The Restore Document Vault dialog is opened.
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5. In the Full backup field, specify the location of the backup file on the server from which the full backup
is to be restored.
6. Optional: In the Differential backup (optional) field, specify the location of the differential backup file to
restore a differential backup on top of the full backup.
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7. Select either:
a. Restore using original identity: Select this option to use the existing ID of the document vault.
or
b. Restore as a different vault (new identity): Select this option to generate a new unique ID and to
specify a new name for the vault to be restored.
The identity is used in establishing document vault connections to the server. The name of the
vault can be changed on the server, and the document vault connection can have any name in
the client software of the end user.
8. In the Location for vault data on server field, specify the location where the data of the document
vault is saved.
9. Optional: Click Advanced... if you want to define a separate location for file data.
10.Optional: Select the Overwrite existing files check box if you want to overwrite existing files in the
selected metadata and file data locations.
11.Click OK.
The Attach Vault Options dialog is opened.
12.Select the features to be disabled in the attached vault:
•
•
•
•
•
•
•
•

External object types and value lists: Connections to external databases for object types and
value lists
Connections to external sources
Reporting and metadata export data sets
Scheduled export and import jobs
Active Directory user group synchronization
Event handlers
Vault applications
Remote full-text search indexes: Search indexes that are not used by dtSearch

If you do not know which features to disable, do not make any changes in this dialog.
13.In the Attach Vault dialog, click Attach.
A document vault is restored from the selected backup file.
The users of the document vault must add a connection to it via M-Files Desktop settings. For instructions,
see Adding a Vault Connection.
Creating a Search Index
You must create a new search index for a vault for example when you take a new search engine in use.
This page tells you how to create a search index in an on-premises installation when your search engine
is Smart Search or Micro Focus IDOL. If you use M-Files Cloud, write to M-Files Customer Support at
support@m-files.com.
Only a system administrator can create a search index.
For instructions on how to create a search index when your search engine is dtSearch, refer to Rebuilding
the dtSearch Full-Text Search Index in M-Files knowledge base.
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Note: Version 1.2 of the TLS protocol is mandatory for Smart Search.
To create a search index when your search engine is Smart Search or Micro Focus IDOL:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand Search > Indexes.
3. Click Add Index.
4. Expand the created index.
5. Give the index a unique name.
6. Change the remaining settings where necessary.
a. If you use the default service type, Smart Search, fill in Application ID and API Key under Smart
Search Options.
To get the application ID and API key, write to licensing@m-files.com and include the vault GUID in
the request. Tell also the search index location that you will use, for example the United States or
European Union. If your data must be in a specified country, make sure that the location is available
from support@m-files.com.
or
b. Define the Micro Focus IDOL settings with the instructions in Installing Micro Focus IDOL 12 for MFiles.
7. To use the search index as the active index, write the name of the newly created search index in the
Search > Active Combined Index field.
8. In the new search index, set Enabled to Yes.
9. Click Save.
10.Restart the vault.
11.Make sure that the indexing is done with a few full-text searches in M-Files Desktop.
12.Optional: Disable the previously used index when you are sure that the new index works correctly.
a) In Advanced Vault Settings, go to Configuration > Search > Indexes > <index name>.
b) Set Enabled to No.
With the new search index, you can take search facets in use. For more information, see Configuring
Search Facets.
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Backing Up and Restoring the Vault Search Index
As the search index of the vault is not included in a vault backup, and since re-creating the index for a
large vault can take a large amount of time, you should always consider backing up the search index
together with a vault backup. This section provides instructions for backing up and restoring the search
index of your vault.
Backing up and restoring the vault search index (dtSearch)
Do the following steps to back up the vault search index when you are using dtSearch as your search
engine:
1. Copy the Indexes folder from the location of the vault data on the server (for example C:\Program
Files\M-Files\Server Vaults\<vault name>\Indexes).
2. Store the copied folder in a safe place.
The index itself stores its state, and your backup of the index does not need to be as new as the
vault backup.
Once you have a backup of your search index, do the following steps to restore the backed up search
index:
3. Take the vault offline.
For instructions, see Taking a Vault Offline.
4. Delete the Indexes folder and replace the folder with the backup.
5. Bring the vault online.
For instructions, see Bringing a Vault Online.
The indexing begins to catch up until the search index is completely up-to-date.
Backing up and restoring the vault search index (IDOL)
Do the following steps to back up the vault search index when you are using Micro Focus IDOL version 12
as your search engine:
1. Use Windows Task Manager to stop the MFIndexingManager service.
When the indexing service is stopped, no new material is added to the index.
Note: In M-Files May '20 Update or later, M-Files Server migrates the index log files
to IDOL and deletes the index log files from M-Files Server. If you use M-Files May '20
Update or later, you do not need to do the following step.
2. Copy the existing index log files IndexFLog.log and IndexMLog.log or IndexCLog.log (in case
of an external repository) and store the copied files in a safe place.
The usual location of the log files is in the FileData and MetaData folders in C:\Program
Files\M-Files\Server Vaults\<vault name>\Indexes\Combined\M-Files.
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3. Wait until all IDOL indexing queues in each content engine are empty.
The queues are empty when the folders in the IDOL indexing queue are empty. The location of
the IDOL indexing queue is for example E:\IDOL12\data\PROD1-content-12000\index
\status.
4. On the IDOL frontend server, open a browser.
Note: If you have existing backup files created by the DREEXPORT command and you
have not deleted them, you have to give new names to the backup files because the
process does not overwrite.
Note: You need to perform the following step on each backend engine and the daily
index content engine.
5. On the address bar of the browser, give the command http://<content engine
IP address>:<content engine indexing port number>/DREEXPORTIDX?
FileName=<optional path and backup file name>.
Example: http://192.168.75.130:10001/DREEXPORTIDX?FileName=BU
The command generates a file called <file name>-0.idx.gz into the folder of the content
engine, for example in E:\IDOL12\data\PROD1-content-12000\index. The file includes
all index data to the point of last full indexing batch.
6. Start the MFIndexingManager service.
7. Copy the backup files of the content engines from <IDOL installation directory or
drive>\<content engine>\bin\single<content engine port range>\content into a
safe place.
Once you have the backup of your search index in place, you can start the restore process. By default,
the restore process uses the same folders as the backup. Do the following steps to restore the backed up
search index:
8. Use Windows Task Manager to stop the MFIndexingManager service.
When the indexing service is stopped, no new material is added to the index.
9. Wait until all IDOL indexing queues in each content engine are empty.
The queues are empty when the folders in the IDOL indexing queue are empty. The location of
the IDOL indexing queue is for example E:\IDOL12\data\PROD1-content-12000\index
\status.
10.On the IDOL frontend server, open a browser.
Note: You need to perform the following step on each backend engine and the daily
index content engine.
11.To clear the whole index, give the command http://<content engine IP address>:<DIH/DAH
indexing port>/DREINITIAL? on the address bar of the browser.
Note: You need to perform the following step on each backend engine and the daily
index content engine.
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12.Add the index from the corresponding backup by giving the command http://<content engine
IP address>:<content engine indexing port>/DREADD?<optional backup file path
and file name>-0.idx.gz.
Example: http://192.168.75.120:10001/DREADD?BU-0.idx.gz
13.Check the number of documents with MFAutonomyConsole using the getstatus action against the
DIH and DAH engines.
Note: If the backup has been taken before the M-Files May '20 Update, you have the
index log files in addition to the IDOL index. In this case, perform the following step. If the
backup has been taken after the M-Files May '20 Update, you do not need to perform the
following step.
14.Overwrite the index log files IndexFLog.log and IndexMLog.log or IndexCLog.log (in case of an
external repository) with the backup files.
The usual location of the log files is in the FileData and MetaData folders in C:\Program
Files\M-Files\Server Vaults\<vault name>\Indexes\Combined\M-Files.
15.Start the MFIndexingManager service.
You can run multiple backups or restores simultaneously with a PowerShell script in the backend engines
and the daily index content engine.
Example of a backup script:
$navOpenInBackgroundTab = 0x1000;
$ie = new-object -com InternetExplorer.Application
$ie.Navigate2("http://192.168.75.128:9001/DREEXPORTIDX?FileName=BU");
# backup from Daily
$ie.Navigate2("http://192.168.75.130:10001/DREEXPORTIDX?FileName=BU",
$navOpenInBackgroundTab);
# backup from backend server 1, engine 10001
$ie.Navigate2("http://192.168.75.131:20001/DREEXPORTIDX?FileName=BU",
$navOpenInBackgroundTab);
# backup from backend server 2, engine 20001
$ie.Visible = $true;
Example of a restore script:
$navOpenInBackgroundTab = 0x1000;
$ie = new-object -com InternetExplorer.Application
#$ie.Navigate2("http://192.168.75.128:9001/DREADD? BU-0.idx.gz ");
# restore Daily
$ie.Navigate2("http://192.168.75.130:10001/DREADD?BU-0.idx.gz",
$navOpenInBackgroundTab);
#restore backend server 1, engine 10001
$ie.Navigate2("http://192.168.75.131:20001/DREADD?BU-0.idx.gz",
$navOpenInBackgroundTab);
# restore backend server 2, engine 20001
$ie.Visible = $true;
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Destroying a Document Vault
The Destroy function can be used to permanently destroy all data from a document vault.

!

Warning: When you destroy a vault, the following operations are carried out:
•
•

All the vault file data on the M-Files server is permanently deleted.
The vault database is permanently deleted.

Complete the following steps if you wish to destroy a vault:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Document Vaults.
4. Right-click the document vault that you want to destroy, and then select Operations > Destroy from the
context menu.
You are prompted to make sure that you want to destroy the selected vault.
5. Click Yes at the prompt.
The selected document vault, including its file data and its database, are permanently deleted and the vault
can no longer be accessed by users.
Note: The Destroy function naturally does not affect backups located on the hard drive. The
document vault can thus be restored if backups have been made.
Upgrading a Document Vault
If the internal database structure of the document vault changes, which usually happens during a software
upgrade, the document vault must be upgraded. During a software upgrade, this is done automatically
for all the vaults that are in the online state. If the vault is offline during a software upgrade, it can only
be used after it has been manually upgraded. To do this, right-click a vault in M-Files Admin and select
Operations > Upgrade from the context menu.
Note: Upgrading a document vault makes it incompatible with older M-Files Server versions.
Migrating the Vault Database to Microsoft SQL Server
M-Files uses Firebird as the default vault database engine. For vaults that contain several hundreds of
thousands of objects, we recommend you to use Microsoft SQL Server. If a vault uses Firebird but the
number of objects in the vault greatly increases, it can be beneficial to have the vault use Microsoft SQL
Server as the database engine instead. You can migrate your vault database from Firebird to Microsoft
SQL Server in M-Files Admin.
Note: You can only migrate the document vault database engine from Firebird to Microsoft SQL
Server. Migrations from Microsoft SQL Server to Firebird are not supported.
•
•

Your vault must currently use Firebird as the database engine.
You must have a Microsoft SQL Server connection.
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After the migration, the file data location is the same as with Firebird. If you want to change the file data
location before or after the migration, do these steps:
1.
2.
3.
4.

Take the vault offline.
Move the file data to a different location.
Specify the location of the vault file data.
Bring the vault back online.

To migrate your vault database from Firebird to Microsoft SQL Server:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Right-click a vault.
4. Click Operations > Take Offline.
5. Click Yes to confirm that you want to take the document vault offline.
6. Optional: It is recommended that you back up the document vault at this point.
For instructions on backing up the document vault, see Backing Up a Document Vault.
7. In the left-side tree view, right-click the vault again and select Operations > Migrate to Microsoft SQL
Server from the context menu.
The Document Vault - Microsoft SQL Server dialog is opened.
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8. In Server name, enter the connection address to your Microsoft SQL Server, such as
mysqlserver.mydomain.local.
9. In Database name, enter the name of the database to be created for the vault.
It is recommended to use the same name as the vault has on M-Files Server.
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10.In the Administrator credentials and Basic user credentials sections, fill in the credentials in one of
the two following ways:
Option
Enter the credentials
for a login that has the
sysadmin server role
on your Microsoft SQL
Server, giving M-Files
Server the rights to make
the necessary migrationrelated operations.
Manually create the
Microsoft SQL Server
database and login
accounts (without the
sysadmin server role) and
use the non-sysadmin
credentials for M-Files
Server.

Steps
a. In the Administrator credentials section, enter the credentials for
a login that has the sysadmin server role on your Microsoft SQL
Server.
b. In the Basic user credentials section, select the Use an
automatically generated login option.

a. By using Microsoft SQL Server Management Studio, create an
empty database for the vault.
b. Still in Microsoft SQL Server Management Studio, create two login
accounts without the sysadmin server role, for example User A
and User B.
c. Back in M-Files Admin and the Document Vault - Microsoft SQL
Server dialog, in the Administrator credentials section, enter the
credentials for User A.
d. In the Basic user credentials section, first select the Use an
existing login option and then enter the credentials for User B.

The easiest way is to select the first option, and to let M-Files Server make all the necessary
changes on your Microsoft SQL Server. In some cases, however, system administrators may
need to withhold Microsoft SQL Server sysadmin credentials from M-Files Server. In these
cases, the vault database and the Microsoft SQL Server login accounts need to be created
manually (the second option). For detailed instructions, refer to the document How to Configure
M-Files to Operate Without Sysadmin Role in MS SQL Server.
M-Files Server uses the basic user credentials for almost all vault operations, and the
administrator credentials – in addition to creating the database and the login accounts – for
some of the maintenance operations.
11.Optional: Click Test Connection to test the connection to your Microsoft SQL Server.
12.Click OK.
A warning dialog is opened to tell you that the operation cannot be undone.
13.Click Yes to close the warning dialog and start the migration.
14.After the migration is complete, in the left-side tree view, right-click the vault.
15.Click Operations > Bring Online.
Once the migration process is complete, the database of your M-Files vault is located on the Microsoft SQL
Server that you specified.
After migrating the vault database to Microsoft SQL Server, you need to create a backup job for the
database in Microsoft SQL Server Management Studio. For more details and recommendations, see MFiles Backup Policy.
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In this chapter
•

Migrating the Vault Database from One Microsoft SQL Server to Another

Migrating the Vault Database from One Microsoft SQL Server to Another
When migrating from one Microsoft SQL Server to another, the new Microsoft SQL Server should be
running the same or newer version of Microsoft SQL Server, and the Microsoft SQL Server edition
(Enterprise or Standard) should also be the same or higher than that of the old Microsoft SQL Server.
In other words, do not migrate vault databases from Microsoft SQL Server to an older version or lower
edition of Microsoft SQL Server.
To migrate a vault database from one Microsoft SQL Server to another:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Right-click a vault.
4. Click Operations > Take Offline.
5. Open Microsoft SQL Server Management Studio and take a full backup of the vault database.
6. Restore the database to the new Microsoft SQL Server as a new database.
7. In M-Files Admin, right-click the document vault and select Properties from the context menu.
The Document Vault Properties dialog is opened.
8. Open the Advanced tab.
9. Under the Use Microsoft SQL Server option, click the Define... button.
The Document Vault - Microsoft SQL Server dialog is opened.
10.In the Server name field, specify the name of the new Microsoft SQL Server.
11.In the Database name field, specify the name of the new database.
12.In the Administrator credentials and Basic user credentials sections, specify the new authentication
settings.
13.Click OK to close the Document Vault - Microsoft SQL Server dialog and then click OK to close the
Document Vault Properties dialog.
14.In the left-side tree view, right-click the vault.
15.Click Operations > Bring Online.
From this point forward, the M-Files server will access the vault database from the new Microsoft SQL
Server.
After migrating the vault database to the new Microsoft SQL Server, you need to create a backup job for
the new database in Microsoft SQL Server Management Studio on the new Microsoft SQL Server. For
more details and recommendations, see M-Files Backup Policy.
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Restarting a Vault
The restart operation takes the vault offline and brings it back online in one go. With this operation, you
avoid the risk of leaving the vault accidentally offline. When a vault is offline, also any open sessions that
users may have are closed. Users cannot check in objects or log in to a vault until the vault is back online.
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Right-click a vault which is in the online state.
4. Select Operations > Restart.
5. Click Yes at the prompt.
Taking a Vault Offline and Bringing a Vault Online
When you take a document vault offline, M-Files closes the vault. This also closes any open sessions that
users may have. Users cannot log in to a document vault that has been taken offline until the vault has
been brought back online.

Figure 54: When a vault is taken offline, all vault users are disconnected. If a user checks out a document for editing and makes
modifications to the content, during which the vault administrator takes the vault offline, the user is unable to check in the document
until the vault is brought back online. It is therefore not recommended to carry out unscheduled operations that require the vault to be
taken offline.
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Taking a Vault Offline
To take a vault offline:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Right-click a vault which is in the online state.
4. Select Operations > Take Offline.
Bringing a Vault Online
To bring a vault online:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Right-click a vault which is in the offline state.
4. Click Operations > Bring Online.
Logging in to and out of a Vault in M-Files Admin
To log out of a vault on the server level, select the vault via the left-side tree view in M-Files Admin, and
then select Action > Log Out from the menu bar.
When you have logged out from the document vault, the name of this function changes to Log In, allowing
you to log back in.
Vault Maintenance
Maintenance recommendations
Summary of the recommended maintenance operations:
•
•
•
•
•
•

It is not necessary to use the Optimize Database operation regularly. M-Files does it automatically.
Use the Rebuild Full-text Search Index operation twice a year for large repositories (with hundreds of
thousands of objects and hundreds of gigabytes of data).
Use the Reset Thumbnail Images operation only if the thumbnail images do not work correctly.
Use the Verify and Repair (Quick) operation twice a year for all repositories.
Clean the vaults at least once a year.
Verify the integrity of your vault and master database backups at least two to four times a year.
If the embedded Firebird SQL database is used, see Backing Up a Document Vault, Restoring a
Document Vault, and Backing Up the Master Database. If Microsoft SQL Server is used, refer to the
documentation of the backup tools you use to create the backups. Also, see M-Files Backup Policy for
further guidelines and best practices related to backups.

Regular vault maintenance makes sure that there is high performance even for vaults with a large number
of objects. The Maintenance submenu for a vault in M-Files Admin contains functions to verify and
optimize the integrity of the internal database structure. It also contains functions to rebuild the full-text
search index and to reset thumbnail images in the vault. Also, it is important to regularly verify the integrity
of your vault and master database backups. See also Manual Optimization.
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Optimizing the database
The Optimize Database (Thorough) operation tries to make the performance of the vault database better.
The operation defragments indexes, updates database statistics, and compresses the full-text search
index.
M-Files automatically runs the Optimize Database (Thorough) operation once a week. Normally, it is
not necessary to do this yourself at all. However, if the vault responds more slowly than usual, it can be
necessary to run the operation. The vault can respond slowly after a large number of objects is imported to
the vault (for example if the number of objects in a vault that uses Firebird as the database engine quickly
increases from 0 to 10,000 objects).
You can run the operation in the quick mode first, but we recommend to use the thorough mode in most
cases.
These tasks are done when you run the Optimize Database (Thorough) operation:
1. Taking the vault offline (for vaults that use Firebird or Microsoft SQL Server as the database engine)
2. Rebuilding metadata indexes
3. Recalculating relevance scores for objects
4. Cleaning out unused access control lists
5. Clearing the change logs of object types
6. Upgrading the vault database to improve performance
7. Backing up metadata (only for vaults that use Firebird as the database engine)
8. Restoring metadata (only for vaults that use Firebird as the database engine)
9. Rebuilding database indexes
10.Updating the statistics for database objects
11.Compressing the full-text search index
12.Finalizing the operation
13.Bringing the vault online (only for vaults that use Firebird as the database engine)
These tasks are done when you run the Optimize Database (Quick) operation:
1.
2.
3.
4.

Rebuilding metadata indexes
Recalculating relevance scores for objects
Clearing the change logs of object types
Updating the statistics for database objects

Updating encryption status of existing files
The selection of the setting Enable encryption for file data at rest in the Document Vault Advanced
Properties has an effect on the functionality of the Update encryption status of existing files operation:
•
•

If the Enable encryption for file data at rest is selected, all the files in the vault previously not
encrypted are now encrypted as well.
If the Enable encryption for file data at rest is not selected, the encryption of all the encrypted files in
the vault is removed.

Rebuilding the full-text search index
This operation completely rebuilds the full-text search index and can require a large amount of time. For
example, in vaults with tens of gigabytes of data, the operation can continue several days.
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We recommend to do this operation if you think that the search index is corrupted or if the search
operations are slower than usual. In large repositories, especially if the objects are edited a lot, we
recommend that you do this operation twice every year.

!

Warning: Search operations in the vault are disabled immediately when the rebuild process starts.
For instructions on how to let vault users use the search operations during the process, refer to
Rebuilding the dtSearch Full-Text Search Index. See also Rebuilding Search Indexes.

Resetting thumbnail images
You can reset the thumbnail image cache for the vault if you use the thumbnail view in M-Files Desktop
and if the images are not working correctly. This can happen, for instance, after installing a software
capable of displaying thumbnails that could not previously be shown.
Using Verify and Repair
You can use this operation to verify that the database is intact and that all the data has been saved
correctly to M-Files.
If errors are found, M-Files repairs some of them automatically, but some errors need user actions. If you
have errors that cannot be fixed automatically or you cannot fix yourself, write to our customer support at
support@m-files.com.
These tasks are done when you run the Verify and Repair operation:
1. Verifying vault information
2. Verifying special records
3. Verifying data file records
4. Verifying physical data files
5. Verifying file records
6. Verifying file link records
7. Verifying object versions
8. Verifying object properties (general integrity checks)
9. Verifying object properties (detailed integrity checks)
10.Finalizing the operation
For large vaults, the operation time of Verify and Repair (Thorough) can be long. Thus, we recommend
that you use the operation in the quick mode twice per year.
The steps during the Verify and Repair (Quick) and Verify and Repair (Thorough) operations are the
same except for the verification of physical data files (step 4). In this step, the thorough mode checks
whether file checksums of the physical files in the vault file data location match those reported by the
metadata database.
Cleaning the vaults
When you clean the vaults, you release disk space for new objects.
To clean a vault:
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1. In M-Files Admin, export the content that you want to remove from the vault.
Example filter:
• Status tab: Deleted set to No
• Properties tab: Created property with the <= operator and the value set to a date
2. In M-Files Desktop, delete the objects that you have already exported and enable Destroy
permanently.
Note: When you search for objects to delete and destroy, use the same filters as in step 1. This
makes sure that you only destroy content that you have exported.
3. In M-Files Admin, manually optimize the database.
Enable Delete the files of destroyed objects.
Note: The scheduled automatic optimization does not remove the destroyed files.
Languages and Translations
The language of the M-Files user interface depends on three factors:
•
•
•

M-Files software language
Vault language
Windows display language

You can switch to using any of the software languages easily via the language setting as described further
below. For intructions on how to translate the vault metadata structure to the language of your choice, see
section Translating the metadata structure.
Changing the Windows display language depends on your Windows version. For instance in Windows 10,
you can change the display language via Control Panel > Language.
Note: The classic M-Files Web has different requirements for a fully localized user experience. See
this note for more information. The new M-Files Web uses your browser language setting to select
the language of the user interface.
Changing the software language
M-Files software can be used in several different languages. Changing the language is easy and the
change can also be done during use. You can open the Change Language dialog by clicking on the
M-Files icon on the Windows notification area and by selecting Settings > Change Language. M-Files
software offers these languages automatically.
If, for example, English is selected as the software language, the following options are displayed in English:
Check Out, Check In and Workflow. If Finnish were to be chosen, the same options would be shown in
Finnish: Varaa muokattavaksi, Palauta muokkauksesta and Työnkulku.
Additional language versions to those currently supported are available by separate agreement with MFiles.
Translating the metadata structure
The document vault metadata structure can be translated into different languages. The document vault
metadata structure refers to the vault's object types, classes, property definitions, value lists, workflows,
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and so on. The document class titles, such as Proposal, Order and Contract, can be translated into the
desired languages.
The company can translate the metadata structure independently or have it translated by a third party.
Managing the translation material is easy: the administrator can export the translation material in the XML
file format. The material can then either be translated in-house or by a professional translation agency. The
actual translation process is not dependent on M-Files Admin or its permissions.
Translating the metadata structure can be particularly beneficial for companies with operations in more
than one country, or companies with more than one in-house language. This enables users to add
documents and other objects using the metadata structure in their own language. The multilingual
metadata structure can also be useful if the company uses several languages for other than geographical
reasons.
See Multilingual Metadata Structures for further information on how to create a localized version of the
metadata structure of your vault.
Tip: If your M-Files system administrator has enabled translated object titles, you can use the
translated object titles in searches. The translated object titles are also shown in the title area of the
metadata card, in the listing area, in notifications, and in value lists.
Different language for software and metadata structure
Besides the M-Files functions, metadata specific to document vaults can be selected and edited in a userspecified language if the metadata structure has also been translated. If the metadata structure has not
been translated into the relevant language(s), for instance, from Finnish to English, it can be difficult for
the user to understand why some information is displayed in Finnish and some in English. Only users with
administrator rights can view and edit the actual content of the metadata structure.
For example, the class Proposal, object type Customer and property definition Document date belong
to the metadata structure. If the user has selected Finnish as the software language but the metadata
structure has not been translated into Finnish, the user will see these options in English only because they
have been added to the metadata structure and titled in English.
Thus, for instance, when creating a new document, some metadata card information will be displayed
in Finnish (Lisää ominaisuus, Avaa muokattavaksi and Luo) and some in English (Proposal, Customer
and Project). This is because some of the texts, such as Luo, are part of the M-Files software that has
been already translated into Finnish but the Proposal concept in the metadata structure has not yet been
translated.
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Figure 55: A metadata card containing Finnish and English.

In this chapter
•
•
•

Multilingual Metadata Structures
Selecting the Software and Vault Language
Enabling Translatable Object Titles

Multilingual Metadata Structures
The metadata structure is always specific to the document vault and the vault can have a multilingual
metadata structure. For example, the following elements of the metadata structure can be translated:
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•
•
•
•
•
•
•

names of classes and class groups
names of object types
names and values of value lists (for instance meeting types)
names of property definitions
names of user groups and named access control lists
names of workflows and their states
names of views

The default setting for value lists is that the contents of the value list are not translated. If you want to
translate the contents of the value list, meaning the actual values, complete the following steps:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and then select Value Lists.
The Value Lists list is opened in the right pane.
6. Double-click the value list that you want to edit.
The Value List Properties dialog is opened.
7. Open the Advanced tab.
8. Enable the option The contents of this value list can be translated.
9. Click OK to close the Value List Properties dialog.
The contents of the selected value list can now be translated.

In this chapter
•

Translating the Metadata Structure

Translating the Metadata Structure
Using the Languages and Translations dialog, you can export the translatable content of the metadata
structure and translate the exported structure in Excel, Word, or a professional translation program, such
as SDL Trados or SDL Passolo.
To translate the metadata structure of the vault, follow the steps provided below.
First, you need to open the Languages and Translations dialog.
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Select the desired vault.
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4. Open the Action menu and select Languages and Translations.
The Languages and Translations dialog for the selected vault is displayed.

Next, add your language to the list and export the list of terms to an XML or XLIFF file.
5. Click the Add... button.
The Language dialog is opened.
6. In the Name field, enter the language name.
7. Optional: In the Code field, enter a code of your choice for the language.
This can be, for instance, an ISO 639-1 code.
8. Click OK to close the Language dialog.
9. Select the newly added language from the list.
10.Click the Export... button.
The Export Strings dialog is opened.
11.Define the settings for your language export.
For more information, see Adding and Exporting Languages.

M-Files | 3. System Administration | 281
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
12.Define the location for your export file and click Save.
The export file is saved as an XML or XLIFF file to the location you specified.
Once the export has completed, you can start working on the actual translation.
13.Open the exported file in the software of your choice and add the translations.
For instructions on completing the process with Microsoft Excel, see Translating in Microsoft
Excel.
The final step is to import the completed translation back to M-Files.
14.Return to M-Files Admin and repeat the steps from 2 to 4 to open the Languages and Translations
dialog.
15.Click the Import... button.
16.Select the target language and click Open.
17.Select whether you want to import all strings or just the ones that have been marked as translated.
For more information, see Importing Translations.
18.Click OK.
19.Once the import is complete, click Close to close the Languages and Translations dialog.
Translations for the newly added language have been imported to M-Files and you can select the vault
language in M-Files Desktop.

In this chapter
•
•
•

Adding and Exporting Languages
Translating in Microsoft Excel
Importing Translations

Adding and Exporting Languages
The Export function of the Languages and Translations dialog can be used to specify the target language
of the translation and the format of the material to be translated:
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Figure 56: The "Export Strings" dialog.

Languages
Select the source and target languages. Note that you can translate the metadata structure only one
language at a time.
If you are working in Excel, both the source and target language need to be exported. The source
language character strings, that is, the words to translate, are in their specific column and the target
language translations are added to a column of their own.
You can also export the source language only. If you are using a translation agency or separate translation
software for translating, you should determine the required format for the translation material.
Strings
When commencing the translation process for the first time, select Export all strings. A string refers to one
concept or a specific attribute in the metadata structure, thus usually, a word or a phrase. Each language
has its own strings, that is, a specific vocabulary for the metadata structure.
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You can later use the Export only strings that have not been marked as translated option to export the new
or changed strings only.
File format
The available file formats are Simple XML and XLIFF.
Select Simple XML, if you want to translate the strings in Microsoft Word or Excel. Select XLIFF, if you
want to use a professional translation tool, such as SDL Trados or SDL Passolo.
Translating in Microsoft Excel
Translating the metadata structure into the target language in Excel is quite straightforward. Simply open
the XML file in Excel: choose the default settings As an XML table and Excel will create a schema based
on the XML source data.
Identifier is the identifier of the concept, meaning the word or phrase to be translated. For example, an
identifier starting with PropertyDef indicates that it is a property definition name. ObjectType is an object
type name and UserGroup is a user group name. M-Files creates these identifiers automatically. The
translator does not need to pay much attention to these identifiers as such, although they can be helpful
pointers when choosing a suitable translation. For a closer look at how the identifiers are named, see
Naming convention of the identifiers.
The Source column contains the concepts to be translated. The Target column is empty. The translator
enters the translations in this column.

Figure 57: The exported XML table opened in Excel for translation.
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In the above example, a translation from English to the target language has been started. The translation
for each source language string is to be placed in the target column. When the translation has been added,
the 0 in the translated column should be replaced with 1. This tells M-Files that the strings has been
translated.
Naming convention of the identifiers
The identifiers are formed as follows: TableID_ResourceID1_ResourceID2_StringID.
•

Table ID: Identifies the type of the metadata structure element in question.

•

• PropertyDef
• ObjectType
• Item (referring to any translatable value list item)
• NamedACL
• View
• Language
Record ID 1: The ID number of the metadata element in question. For instance, the Document object
type has the identifier ObjectType_0_0_Name, where ObjectType is the table ID and the first 0 is
the record ID 1. The record ID 2 is always 0 for elements other than Item.
Record ID 2: The ID number of the item in question. For example, the workflow Processing job
applications in the M-Files sample vault has the identifier Item_7_105_Name, where Item is the table
ID, 7 the record ID 1, and 105 the record ID 2 identifying the item on the Workflows value list.
String ID (Name or NamePlural): The part of the identifier that specifies whether the translation should
be in the singular or plural form.

•

•

Importing Translations
When translating in Microsoft Excel, the string can be marked as translated by changing the cell value of
the translated column from 0 to 1. However, if the Import all strings option is selected when re-importing
the translation back to M-Files, all strings are imported to M-Files regardless of whether the value of the
translated column.
Note: If the target column is left empty and the value of the translated column is set to 1, M-Files
uses the source language string as the translation.
If you only want to import the strings marked as translated, select the Import only strings that have been
marked as translated option. This way, only the strings with the value 1 in the translated column are
imported to M-Files. For example, if new additions are made to the source language at a later stage, this
selection can be used to import only the translations of the new additions to M-Files.
If changes are made in the source language, this version data can be found in the source-version column
of the exported XML file: when changes are made to the source language string, the value of this string
cell is always increased by one. The target language translation must then be checked and changed to
correspond to the change in the source language.
Also, if the values of the translated strings in the translated column have previously been changed to 1,
they will be reset to 0 if changes are made to the source language of these strings. For this reason, it is
recommended to instruct the translator to mark the translated and accepted translations as translated, after
which the value 1 indicates that the target language translations are up to date.
To import the translation back to M-Files from Microsoft Excel, save the translated XML file in Microsoft
Excel in XML Data format. You can then import the file to M-Files using the Import function of the
Languages and Translations dialog. It is alright for the file to have different name when importing and
exporting.
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Importing a translation to M-Files is quite straightforward. Just select the appropriate target language and
whether you want to import all the strings or just the ones marked as translated.
After importing, M-Files asks if you want to rebuild the full-text search index for the metadata. Edited
translations cannot be used in searches until the search index is rebuilt. This may take several minutes or
even hours depending on the number of objects in the document vault.
Selecting the Software and Vault Language
Users can change both the software language and vault language via M-Files Desktop. The software
language refers to the texts and labels that you see in the M-Files user interface, such as button texts,
dialog titles, warning messages, and so on. The vault language refers to the metadata structure language,
which is always specific to a given document vault.
Do the following steps to change the software and the vault language:
1. Click your username in the upper right corner.
2. Click User Settings > Change Language.
The Change Language dialog is opened.
3. Use the Software language drop-down menu to change the language of the M-Files user interface.
4. Use the Vault language drop-down menu to change the language of the current vault.
The vault language selection contains all languages that the document vault has been translated
into.
5. Click OK to change the languages and to close the Change Language dialog.
The M-Files user interface language and the current vault language are changed accordingly.
If 1) the software installation language, 2) the vault language, and 3) the Windows display language are
the same, all the M-Files functions and the metadata structure of the document vault are displayed in the
language in question.
Note: If you want to create a new vault in a language other than the currently selected software
language, you must first change the software language and restart the M-Files Server service via
Windows Task Manager before creating the vault.
Note: If the user adds a new value to the value list, the new value (concept) will be added to
the original metadata structure, that is, the source language contents, regardless of the user's
vault language. For example, a user with Finnish as the vault language, can add a new value
LVI-piirustus to the value list Drawing Types/Piirustustyypit. If the source language was English,
the new Finnish value "LVI-piirustus" is displayed among the English values: "Architectural, LVIpiirustus, Mechanical, Services", and so on. The name of this value can be changed in Value List
Properties to correspond the source language, after which it can be re-translated into Finnish.
Common views can be named in the same way according to the text added by the user, regardless
of the source language.
Note: If the metadata structure is translated into several languages, the software or the vault
language selected by the user does not affect the search results. For example, if the user has
selected Finnish as the language and added a document to class Hinnasto, the document in
question is included in the search results when using the search criterion Price List. However,
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then the concepts Price List and Hinnasto must be translations of each other, that is, different
translations of the same concept.
Changing the User-Specific Default Vault Language
Administrators can also change the default language of a vault for a specific user. The selected default
language can be any of the vault languages. If neither the user nor the administrator changes the vault
language, M-Files will use the vault source language as the default.
Do the following steps to change the default vault language for a specific user:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Users.
The Users list is opened in the right-side pane.
6. Right-click the user whose default vault language you want to change and select Properties from the
context menu.
The User Properties dialog is opened.
7. Use the Vault language drop-down menu to change the default vault language for the selected user.
8. Click OK to save your changes and to close the User Properties dialog.
The default language in the selected vault is changed for the selected user.
Enabling Translatable Object Titles
To use translatable object titles, you need to have the desired languages added as vault languages in the
Languages and Translations dialog. However, it is not required that the metadata structure is translated
into those languages.
Note: This feature is not supported in the M-Files add-ins such as M-Files Add-in for Teams and
SharePoint Online.
The translatable object title configuration allows you to give objects titles in different languages. When an
object has multilingual titles, the translated names can be used as search criteria. You can search for and
find documents and other objects in your own language regardless of the original object's language. The
language version that matches the Vault language in the Change Language dialog is used on the title
area of the metadata card, listing area as well as in notifications and value lists.
To enable translatable object titles, do the following steps:
1. Check that the desired languages with language codes are listed in the Languages and Translations
dialog.
If a language or a code is missing from the list, add it according to the instructions in Translating
the Metadata Structure. Note down of the language codes.
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2. Open M-Files Admin and go to a vault.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
3. Expand Metadata Structure (Flat View).
4. Click Property Definitions.
The Property Definitions dialog is opened.
5. In the task area, click New Property Definition to create property definitions for the desired object title
languages.
Note: The data type of the property definitions must be Text.
For instructions on creating property definitions, see Creating a New Property Definition.
If you want to allow adding a Finnish title for an object, you can create a property definition
called Title in Finnish.
6. Select Configurations and expand Advanced Vault Settings.
7. Expand the Configuration node and select Translatable Object Titles.
8. Specify the settings according to the information in the following table.
Setting name

Description

Example value

Object Types Using
Translated Titles

Specify the object types
that can use translated title
properties.

Document

Translated Title Properties

Specify the property
definitions that are used as
an alternative language title,
each with their corresponding
language code. Use the
language codes noted down
from the Languages and
Translations dialog.

Language Code: fi
Title Property: Title in
Finnish

9. Click Save.
Now you are ready to enter translated titles for objects of the specified object type. After you have added
the properties to the metadata of an object and entered the translated names, the title is shown according
to the selected vault language on the title area of the metadata card, listing area as well as in notifications
and value lists. Translated object titles do not affect pinned shortcuts or notifications sent to unknown or
multiple recipients.
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Figure 58: An example of a Finnish object name property on the metadata card and listing area.

Note: After you have saved the changes and M-Files Server has been restarted, end users must
log out from and log back in to the vault to be able to use translatable object titles. You can log out
all vault users by restarting the vault, but taking a vault offline should always be done in a controlled
manner and the vault users should be notified beforehand.
Tip: You can use metadata card configuration rules to show the translated object titles after the
actual Name or title property.
Connections to External Sources
M-Files offers flexible approaches for information presentation and transfer also from external sources.
Databases, for example, are required to support OLE DB or Open Database Connectivity (ODBC)
connections. The type of a database connection can be either read-only or two-way. With a read-only
connection, M-Files is reading from an external database, such as a customer database, but you are not
allowed to enter new data via M-Files. With a two-way connection, changes and additions made in M-Files
are saved in the external database.
A good example of an external database connection is a connection between M-Files and an external
customer database. Many organizations already have a vast database of customer information, consisting
of tables populated with customer information. When the user creates a new offer document in M-Files,
it makes sense to add the existing customer information to it. M-Files can be set to import customer
information from an external database. The information can then be accessed directly from, for example,
the metadata card when a new document is created.
You can also import and link existing files from external objects. This makes deploying M-Files easy and
quick, since all existing files can be accessed via M-Files without a separate transfer process. When you
access files via M-Files, it makes sense to enrich them with metadata at the same time. Furthermore,
among other things, version history is created in M-Files; concurrent editing is avoided; and, thanks to
M-Files scheduled jobs, backups are easy to manage. Adding metadata also enables you to better take
advantage of the search capabilities of M-Files.

M-Files | 3. System Administration | 289
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

In this chapter
•
•
•

External File Sources
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External File Sources
You can import or link files from external sources to M-Files. With a link between a folder on a network
drive and an M-Files vault, you can modify files both in M-Files and on the network drive. If you want to
make changes in M-Files only, you can import the files to the vault.
You can also use external repository connectors to import content to your vault. See Connectors. Make
sure that you do not use both features to import the same content.

In this chapter
•
•
•
•

Creating a New Connection to an External Source
Defining Metadata for an External File Source
Searchable PDF
Deleting a Connection to an External Source

Creating a New Connection to an External Source
Before you begin, see this note if you plan to use the Link files option and to preserve the original files in
the external location. You can also use external repository connectors to import content to your vault. See
Connectors. Make sure that you do not use both features to import the same content.
Follow these instructions to define a new connection to an external source.
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Connections to External Sources and then select File Sources.
6. In the task area, click New File Source to start creating a new connection to an external source.
The Connection Properties dialog is opened.
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7. In the Description field, provide a description for the new connection. You can, for example, describe
the external source for which this connection is used.
8. In the Path from the server field, enter the path to the external location that you wish to connect to MFiles. The location can be, for example, a network drive of a scanner.
The path must be specified from the point of view of the M-Files server.
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9. Optional: Check the Include subfolders check box if you wish to include in the connection the entire
folder structure of the specified path.
10.Click Set Account... to specify an account in M-Files to be used for processing files from the external
location.
By default, M-Files uses the server identity (Local System account) as the account.
11.Optional: Click Filters... to define the files to be processed.
a) In the Include files that match any of the following filters field, enter the filter or filters for the files
that are to be included via this connection.
b) In the Exclude files that match any of the following filters field, enter the filter or filter for the files
that are to be excluded from this connection.
By default, all files are included except for BAK and TMP files.
You may use wildcards to define a filter (for example, *.* or *.docx). Multiple filters are
separated with semicolons (;).
12.Select either:
a. Link files: Select this option if you wish to modify the files of the external source both in M-Files and
externally. Modifications made in M-Files are also visible to external users, and modifications made
outside M-Files are visible in M-Files.
Note: M-Files will store a version history of the linked documents, so that all versions
modified in M-Files, as well as every first preceding version modified outside M-Files before a
new version is created in M-Files, will be available for future use.

!

Important: If the M-Files user group All internal users or All internal and external users does
not have edit access to a linked document, the document is deleted from the external file
source when it is added to M-Files. If this happens, you can at any time copy the file back to
the external location simply by adding edit access to either the All internal users or All internal
and external users user group (see Object Permissions).
This behavior can be prevented with a registry setting. For instructions, see Preventing
Linked Documents from Being Removed.

or
b. Import files: Select this option if you want the files of the external source to be copied to M-Files.
Modifying imported documents in M-Files will not have an effect on the original files.
You may also check the Delete source file after importing check box if you want the source files to
be deleted after they have been imported to M-Files. This option may be useful, for example, when
importing scanned documents to M-Files.
13.Optional: Select the Preserve folder structure check box and in the Target folder field, enter a target
folder for the external files if you wish to preserve the original folder structure of the external source in
M-Files using traditional folders.
You may click the ► (right-pointing triangle) icon to refresh the list of traditional folders or to add
a new traditional folder to the vault.
14.Optional: Select the Check for new and deleted files periodically check box if you want M-Files to
automatically check the source folder at predefined intervals and update itself according to which files
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and folders are new and which have been deleted. Enabling this option makes any changes in the
source folder automatically visible in M-Files as well.
a) In the Delay between checks field, enter the interval in seconds between the automatic source
folder checks to define how frequently you want M-Files to check the changes made to the source
folder.
15.Optional: You may click Refresh Now to connect to the external source immediately.
Click Refreshing Status... to display additional information about the process of refreshing the
external source.
16.Optional: On the Metadata tab, define the metadata to be added for externally created objects.
For more information, see Defining Metadata for an External File Source.
17.Optional: On the Advanced tab, you can specify an alias for the new connection.
For more information, see Associating the Metadata Definitions.
When you have automatic aliases in use and you write a name on the General tab, the Aliases
field on the Advanced tab is automatically filled in. The alias has the format <predefined
prefix>.<name>. Define automatic aliases for your vault in the configurations editor.
18.Click OK.
The new connection to an external source is created and added to the File Sources list. Files are added
from the external source to M-Files on the basis of the settings you have defined for the connection.
Defining Metadata for an External File Source
To define automatic metadata for externally created documents:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Connections to External Sources and click File Sources.
6. On the File Sources list, double-click the file source that you want to edit.
The Connection Properties dialog is opened.
7. Click Metadata.
The Metadata tab is opened.
8. In Object type, select the object type that the external objects get when they are imported or linked to
M-Files.
The selected object type must have the Objects of this type can have files setting enabled.
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9. Click Add... to define a new property and value to be added automatically for objects created from
external files, or select one of the existing properties and click Edit... to edit it.
The Define Property dialog is opened.

10.Use the Property drop-down menu to select the property for which you want to define a value.
11.In the Define Property dialog, select one of the following options:
a. Use a fixed value: Use this option to specify a fixed property value.
or
b. Read from an XML file produced by HP DSS: Use this option if you want to obtain a property
value from user-provided metadata when a document is scanned and OCRed using HP DSS.
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or
c. Read from an XML file: Use this option to read a property value from an XML file using an XPath
expression. The name of the XML file must match the name of the file to be imported. For instance,
when the name of the file is filename.txt the XML file must be named filename.xml.
For example, say you have the following XML file:
<?xml version="1.0" encoding="UTF-8"?>
<document>
<name>The name of the document</name>
<keywords>Keywords in an XML file</keywords>
</document>
Now, to use the text inside the keywords element in the XML file as the value for the selected
property, you would enter document/keywords in the Read from an XML file field, and thus you
would get Keywords in an XML file as the property value. The string document/keywords is a
simple XPath expression that selects all keywords elements that are children of the document
element.
XPath is a W3C standard syntax for defining locations in an XML document. For detailed information
on XPath syntax, see the W3Schools XPath Tutorial.
Note: If the XML file uses namespaces, you need to take them into account in the XPath
expression. You can use the namespace prefixes in the expression. Note that the default
namespace, however, has no prefix. Selecting from the default namespace is possible, for
instance, by using the namespace-uri() or the local-name() XPath function, or both,
in the expression. Multiple namespaces with the same prefix are not supported.
For example:
mynamespace:document/keywords
or
//*[namespace-uri()='http://www.exampleuri.com' and localname()='document']/[namespace-uri()='http://www.exampleuri.com' and
local-name()='keywords']
or
d. Use an OCR value source: Click Define... to define a zone in a scanned document from which to
capture the property value. For detailed instructions, see Defining an OCR Value Source.
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or
e. Read from the properties of the imported file: Use this option to populate the property value
with a Microsoft Windows file property value. Use the File property drop-down menu to select the
appropriate file property. The accepted data types for the file properties are as follows:
•
•
•
•
•
•
•
•
•

Name: Text, Text (multi-line)
Directory: Text, Text (multi-line)
Extension: Text, Text (multi-line), Choose from list
Created at: Timestamp
Last modified: Timestamp
Last accessed: Timestamp
Read-only: Boolean (yes/no)
Hidden: Boolean (yes/no)
Archive: Boolean (yes/no)

12.If the selected property is of the Choose from list data type, and you chose Read from an XML file
produced by HP DSS, Read from an XML file or Use an OCR value source in the previous step, in
the Conversion to value list item section, select either:
a. Use the value read as the ID of the item: Select this option if you want to use the captured value
as an identifier of the value list item with a separately defined name.
or
b. Use the value read as the name of the item: Select this option if you want to use the captured
value as the name of the value list item. You can check the Add a new item to the list if a
matching item is not found check box if you want to add a new value list item whenever a new
value is captured.
13.Click OK to close the Define Property dialog.
14.Use the Permissions drop-down menu to set the permissions for new objects created via the external
source.
You can click the ... button to refine the permission settings.
15.Optional: Check the Read values from an XML file check box if you want property values to be read
from an XML file. Check also the Delete the XML file after use check box if you want the XML file to
be deleted after the metadata has been read.
The name of the XML file must match the name of the file to be imported. For instance, when the
name of the file is filename.txt the XML file must be named filename.xml. The supported
XML formats are:
•
•

Regular XML data
XML data output by HP Digital Sending Software (DSS)

16.Click OK to finish defining the metadata.
The metadata that you have just specified is assigned to any new object created via this external source.

In this chapter
•

Defining an OCR Value Source
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Defining an OCR Value Source
You can extract text or barcodes from a scanned document using optical character recognition (OCR)
and use them as automatic property values for files imported from an external source, a scanner in this
case. The OCR value source is a zone defined on a scanned page. For more information on defining
different properties for objects imported from external file sources, see Defining Metadata for an External
File Source.
Optical character recognition can be performed on the following file formats:
•
•
•
•
•
•
•

TIF
TIFF
JPG
JPEG
BMP
PNG
PDF

TIFF files using an alpha channel or JPEG compression are not supported.
The use of an OCR value source is only possible when using an external source. The OCR value source
cannot be defined in M-Files Desktop.
Note: The M-Files OCR module is an M-Files add-on product available for extra fee. It can be
activated with a license code. For more information, see Enabling the M-Files OCR Module and
Managing Server Licenses. M-Files uses an OCR engine offered by IRIS. For the M-Files OCR
module purchase inquiries, please contact our sales team at sales@m-files.com.
Note: You can use the OCR value source without enabling the Use OCR to enable full-text
search of scanned documents option in the Searchable PDF tab.
Do the following steps to define an OCR value source:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Connections to External Sources
6. Click File Sources.
7. On the File Sources list, double-click the file source that you want to edit.
The Connection Properties dialog is opened.
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8. Click the Metadata tab.
The Metadata tab is opened.
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9. Click Add... to define a new property and value to be added automatically for objects created from
external files, or select one of the existing properties and click Edit... to edit the existing property.
The Define Property dialog is opened.
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10.Select the option Use an OCR value source and click the Define... button.
The OCR Value Source Definition dialog is opened.
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11.In the Zone type section, select either:
a. Text: Select this option if the OCR zone contains text.
or
b. Barcode: Select this option if the OCR zone contains a barcode.
Note: For the supported barcode types, see Supported Barcode Types.
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12.In the Zone position section, define a zone from which to extract a value for the selected property. The
characters may include any letters, numbers or punctuation marks. For example, an invoice number
shown on a page can be added as the Invoice number property value for the scanned document.
An example of a zone definition:

If you are capturing a barcode and there is only one barcode to recognize on the page, you can
specify the whole page as the zone. If there are several barcodes, restrict the zone in a such a
way that it contains the desired barcode only. With QR codes, you should specify a zone larger
than the actual barcode. If the specified zone has several barcodes, all of them are considered
to be a property value.
a) In the Page field, enter the page number of the scanned document that you want to use as the OCR
value source.
b) Using the Unit options, select the appropriate unit for defining the zone position.
c) In the Left field, enter the left corner position of the OCR zone. The left corner of the scanned
document is considered "0".
d) In the Right field, enter the right corner position of the OCR zone.
e) In the Top field, enter the top corner position of the OCR zone. The top corner of the scanned
document is considered "0".
f) In the Bottom field, enter the bottom corner position of the OCR zone.
13.Using the Primary language and Secondary language drop-down menus, select the primary and
secondary language of the documents scanned via this external connection to improve the quality of
the recognition results. The list of secondary languages only contains languages that are allowed to be
used with the selected primary language.
Although the OCR automatically recognizes all Western languages and Cyrillic character sets,
specifying a language selection often improves the quality of the text recognition results. In
ambiguous cases, a problematic recognition result may be resolved by a language-specific
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factor, such as recognition of the letter 'Ä' in Finnish. The list of secondary languages only
includes languages that are allowed to be used together with the selected primary language.
14.Click OK to close the OCR Value Source Definition dialog.
15.Back in the Define Property dialog, select either:
a. Use the value read as the ID of the item: Select this option if you want to use the captured value
as an identifier of the value list item with a separately defined name.
or
b. Use the value read as the name of the item: Select this option if you want to use the captured
value as the name of the value list item. You can check the Add a new item to the list if a
matching item is not found check box if you want to add a new value list item whenever a new
value is captured.
16.Click OK to close the Define Property dialog.
The zone you have just defined is used to automatically extract a value for the selected property using
OCR whenever a new object is created via the selected external file source.
To ensure that the defined zone is correctly positioned, in most cases the document to be scanned should
be placed onto the scanner glass by hand rather than fed via an automatic sheet feeder.
In some cases, the OCR may give an incorrect recognition result of the text: for example, depending on
the font type or size, the number 1 may be interpreted as the letter I. To ensure that the characters are
added correctly to the document metadata, you can check the property values with event handlers and
VBScript. You can then use VBScript to check, for example, that all added characters are numbers. For
more information, see Event Handlers.
Supported Barcode Types
The M-Files OCR module supports the following barcode types:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

QR Code
EAN-13
EAN-8
EAN-5
EAN-2
MSI Plessley
MSI Pharma
UPC-A
UPC-E
Codabar
Interleaved 2 of 5
Discrete 2 of 5
Code 39
Code 39 Extended
Code 39 HIBC
Code 93
Code 128
PDF 417
Postnet
Postnet 32
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•
•
•
•
•
•
•
•
•
•
•

Postnet 52
Postnet 62
Patchcode
UCC-128
UPCE Extended
IATA 2 of 5
Datalogic 2 of 5
Reverse 2 of 5
Code 39 (out-of-spec)
Code 128 (out-of-spec)
Codabar (out-of-spec)

Searchable PDF
M-Files can convert images imported from external file sources into searchable PDFs using optical
character recognition (OCR). This makes full-text search of scanned documents possible. After conversion,
you can find the PDF document by searching the actual document content.
Optical character recognition can be performed on the following file formats:
•
•
•
•
•
•
•

TIF
TIFF
JPG
JPEG
BMP
PNG
PDF

TIFF files using an alpha channel or JPEG compression are not supported.
Note: Converting the file to a searchable PDF does not affect the outward appearance of the
document when viewing it. The users still see the original scanned image. M-Files stores the
automatic text recognition results in the PDF as invisible text, which is used when searching the file.
Possible text recognition inaccuracies will not affect the appearance of the scanned document in
any way when viewed on screen or printed.
Note: The M-Files OCR module is an M-Files add-on product available for extra fee. It can be
activated with a license code. For more information, see Enabling the M-Files OCR Module and
Managing Server Licenses. M-Files uses an OCR engine offered by IRIS. For the M-Files OCR
module purchase inquiries, please contact our sales team at sales@m-files.com.
Do the following steps to convert images from an external file source into searchable PDFs:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Connections to External Sources.
6. Click File Sources.
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7. On the File Sources list, double-click the file source that you want to edit.
The Connection Properties dialog is opened.

8. Click the Searchable PDF tab.
The Searchable PDF tab is opened.
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9. Check the Use OCR to enable full-text search of scanned documents check box.
10.Using the Primary language and Secondary language drop-down menus, select the primary and
secondary language of the documents scanned via this external connection to improve the quality of
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the recognition results. The list of secondary languages only contains languages that are allowed to be
used with the selected primary language.
Although the OCR automatically recognizes all Western languages and Cyrillic character sets,
specifying a language selection often improves the quality of the text recognition results. In
ambiguous cases, a problematic recognition result may be resolved by a language-specific
factor, such as recognition of the letter 'Ä' in Finnish. The list of secondary languages only
includes languages that are allowed to be used together with the selected primary language.
11.Optional: Check the Use hyper-compression to reduce PDF file size check box if you want to reduce
the file size of the searchable PDFs created via this connection.
12.Optional: Check the Convert to PDF/A-1b format check box if you want the converted PDF documents
to comply with the ISO standard 19005-1:2005 for long-term preservation of electronic documents.
PDF/A-1b is a more restricted format than the format of standard PDF files, so the file size of
documents converted to PDF/A is often larger than that of files converted to standard PDF. In
addition, by exporting to PDF/A, certain advanced appearance settings may be omitted. You
should use conversion to PDF/A form only if it is particularly necessary due to, for example, the
requirements for long-term preservation.
13.Click OK to close the Connection Properties dialog.
The documents scanned via this connection are converted into searchable PDFs provided that they are
in the applicable file format. After they have been imported or linked to M-Files, you can find them by
searching for their content.
Note: Text recognition can also be performed via M-Files Desktop. For more information, refer to
Scanning and Text Recognition (OCR). If you wish to use text recognition using external sources
through the M-Files Admin only, this limitation can be set by changing the registry settings. The
registry settings can be used to set other limitations as well. For more information on registry
settings, write to our customer support at support@m-files.com.
Deleting a Connection to an External Source
Complete the following steps to delete a connection to an external source:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Connections to External Sources and then select File Sources.
6. Right-click the connection that you want to delete and select Delete from the context menu.
7. Click Yes at the prompt to confirm the deletion.
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8. Optional: If the type of the connection you are about to delete is Link, you must choose between the
following options:

a. Import Linked Files: The documents obtained via the connection are imported to M-Files, but
the link between the documents in M-Files and the files on the file system will be disabled. When
you select this option, the connection imports the files from the file source and after the import is
complete, you may delete the connection. The files on the file system and the documents in M-Files
will continue to live their own lives independently of each other.
or
b. Destroy Documents: The documents obtained via the connection are destroyed in M-Files, but the
previously linked files remain on the file system. The external folder will no longer be linked to MFiles and the files previously obtained via this connection are available in the external location only.
or
c. Cancel: This option cancels the operation.
The selected connection is deleted and files are no longer imported or linked from the selected file system
location to M-Files.
Scanner Sources
Via the scanner connection, it is easy to save paper documents into the document vault. This way, the MFiles search capabilities can be applied also to scanned paper documents.
When using external sources, M-Files does not communicate directly with the scanners but uses an
external connection to read the file produced by the scanner from, for instance, the scanner's network
drive. The connection is configured in M-Files Admin under External File Sources.
These connections can be made, for example, with Hewlett-Packard MFP series devices by using HP
Digital Sending Software (DSS). In this case, the device is connected directly to the local area network and
the user scans the paper document with the device.
It is also possible to enter metadata via the device's touchscreen. The scanned file and the metadata are
sent to the DSS software performing optical character recognition (OCR) for the file. The scanned image
and recognized text are combined into a PDF file. The PDF file and an XML metadata file are saved in a
folder controlled by M-Files via external location configuration. On detecting new files, M-Files transfers the
files to the document vault as documents with metadata.
For instructions on how to use a scanner as an external source for M-Files, see Creating a New
Connection to an External Source.
Note: Text recognition can also be performed with the M-Files OCR module. For more information,
refer to this note. You can also scan using a local scanner that is directly connected to your
computer. For more information, refer to Scanning and Text Recognition (OCR).
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Mail Sources
You can use external mail sources to save, manage, and share important email, and to make sure that
important information does not get lost in email boxes. For example, you can set a designated archive
account to import all email to the vault and to then delete the messages from the mail server. In the vault,
you can manage the imported messages with the M-Files features. Example use cases include managing
orders or archiving sent offers. You can use the Cc and Bcc fields to save sent email to the vault as well,
for example proposals and order confirmations. To avoid junk mail, you can set the email account to accept
email only from users in your organization.

In this chapter
•
•

Connecting to a New Mail Source
Defining Automatic Metadata for a Mail Source

Connecting to a New Mail Source
To connect to a new mail source:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Connections to External Sources and select Mail Sources.
6. In the task area, click New Mail Source.
The Connection Properties dialog is opened.
7. In Description, enter a description for the new connection.
8. In Service type, select one of these options:
•
•
•
•

Generic POP3 service: Use the POP3 protocol to connect to a mail service that is not listed
here.
Generic IMAP4 service: Use the IMAP4 protocol to connect to a mail service that is not
listed here.
Microsoft Exhange Online: Connect to Microsoft Exchange Online.
Google Mail using IMAP4: Connect to Google Mail with the IMAP4 protocol.

9. In the Configuration section, enter the required information for your service type. See the information
in the table.
Service

Setting name

Description

Generic POP3
service

Mail server

The IP address or domain name of the mail
server.

Use encrypted
connection (SSL/TLS)

Specifies whether the connection to the server is
encrypted. In most cases, encrypted connection
is necessary.

Port number

The communication endpoint of the mail server.
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Service

Generic IMAP4
service

Microsoft
Exchange Online

Setting name

Description

Username

The username to access the mail server.

Password

The password for the user.

Mail server

The IP address or domain name of the mail
server.

Use encrypted
connection (SSL/TLS)

Specifies whether the connection to the server is
encrypted. In most cases, encrypted connection
is necessary.

Port number

The communication endpoint of the mail server.

Folder

The folder from which M-Files reads and imports
the mail to the vault.

Username

The username to access the mail server.

Password

The password for the user.

Tenant ID

The tenant ID (also called directory ID) of your
Azure Active Directory application.
For example: 00112233-4455-6677-8899aabbccddeeff

Client ID

The client ID (also called application ID) of your
Azure Active Directory application.
For example: 00112233-4455-6677-8899aabbccddeeff

Client secret

The client secret of your Azure Active Directory
application.
For example:
sXXtFz1UtYMRCVc.2.23TMC-94-T.yK-84

Folder

The email address and folder from which MFiles reads and imports the mail to the vault.
For example: mail@example.com/Inbox or
mail@example.com/Important/Sales.

HTTP proxy

This is an optional setting. For authentication
and email requests to use a proxy server, enter
the address and port of the server. For example:
192.168.1.1:8080. The proxy server must
support the SSL protocol.

Google Mail using Client ID
IMAP4

The client ID of your OAuth application.

For example:
833377787449-9k39jmvkpctlb5hr40554cgmfi3lesjp.app
Client secret

The client secret of your OAuth application.
For example: P_ifREDH1E8-MAIRHI1JYmkT
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Service

Setting name

Description

Folder

The folder from which M-Files reads and imports
the mail to the vault.

HTTP proxy

This is an optional setting. For authentication
and email requests to use a proxy server, enter
the address and port of the server. For example:
192.168.1.1:8080. The proxy server must
support the SSL protocol.

10.Optional: In the Action section, select the appropriate options:
Select the option...

If you want to...

Include attachments

Import attachments with email messages.

Import only messages
that have attachments

Import only the email messages that have attachments.

Delete messages from
server after importing

Remove the messages from the mail server automatically when they have
been imported to M-Files. Make sure that any information only supported
by the email server is not lost.

Remove attachments
from server after
importing

Remove the attachments from the mail server when the email messages
have been imported to M-Files. This option is available only if the selected
service type is not Generic POP3 service and the option Include
attachments is enabled.

Save in Outlook
Save the email messages to M-Files in the Outlook message format
message format (*.msg) (MSG). Attachments are stored in the MSG file and the messages
appear in M-Files as single-file documents (see Single-File and Multi-File
Documents).
Note: This functionality requires Microsoft Exchange Server or a
32-bit MAPI client to be installed on the M-Files server.
If you want to save the email messages as RFC 822 compliant EML files,
configure the registry setting that follows on the M-Files server computer.
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files
\<version>\Server\MFServer\Vaults\<vault
GUID>\ MailSources\<external mail source
name>

Value name

StoreEmailInRawEmlFormat

Value type

REG_DWORD

Description

When this is enabled, M-Files stores new email
messages as EML files.

Default value

0

Disabled

Valid values

1

Enabled

0

Disabled

This registry setting overrides the selected storage format option. For the
changes to take effect, you must restart the M-Files Server service.
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Select the option...

If you want to...

Separate attachments
from the message

Save attachments separately from the body of the message. This option
can be enabled only if the option Save in Outlook message format
(*.msg) is enabled. The message without its attachments is saved to an
MSG file, and any attachments are stored beside the MSG file in their
original file formats. If the message contains attachments, the message
and its attachments appear in M-Files as a multi-file document.

11.Optional: Select the Check for new and deleted files periodically check box to enable M-Files to
synchronize with the mail server at predefined intervals.
a) In Delay between checks, enter the time interval in seconds between synchronizations.
12.Optional: Click Refresh Now to synchronize the vault with the mail server right away.
Click Refreshing Status... to see the current status of the refreshing process.
13.Optional: On the Metadata tab, define properties for new objects created via this connection.
For more information, see Defining Automatic Metadata for a Mail Source.
14.Optional: On the Advanced tab, set an alias for this connection.
For more information, see Associating the Metadata Definitions.
When you have automatic aliases in use and you write a name on the General tab, the Aliases
field on the Advanced tab is automatically filled in. The alias has the format <predefined
prefix>.<name>. Define automatic aliases for your vault in the configurations editor.
15.Click OK.
This locks the Service type setting. Create a new connection to change the service type.
Email messages are imported to M-Files from the mail source with the specified settings. You can
optionally change advanced settings for a Microsoft Exchange Online or Google Mail mail source in the
Connections to External Sources > Mail Sources Common section of Advanced Vault Settings.
Defining Automatic Metadata for a Mail Source
You can define automatic metadata for new objects created from an external mail source. You can use
fixed property values or extract property values from the imported e-mail messages.
Do the following steps to define automatic metadata for objects created from an external mail source:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Connections to External Sources and then select Mail Sources.
6. On the Mail Sources list, double-click the source that you want to edit.
The Connection Properties dialog is opened.
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7. Click the Metadata tab.
The Metadata tab is opened.
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8. Use the Object type drop-down menu to select the object type for new objects created via this
connection.
9. Use the Permissions drop-down menu to select the permissions for new objects created via this
connection.
You can click the ... button to refine the permission settings.
10.In the Properties section, click Add... to add a new automatic property for objects created via this
connection or select one of the existing properties and click Edit... to edit it.
The Define Property dialog is opened.

11.Select either:
a. Use a fixed value: Use this option to add a fixed value for the selected property.
or
b. Read from the e-mail message: Use this option to extract a value from the e-mail message for the
selected property.
Note: If you select the Date field as the source of the property value, the data type of the
property must be Time. It is not recommended to select a property of the Timestamp data
type for the Date field because Timestamp values are adjusted by the time zone settings on
client computers.
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12.If the selected property is of the Choose from list data type, in the Conversion to value list item
section, select either:
a. Use the value read as the ID of the item: Select this option if you want to use the extracted value
as an identifier of the value list item with a separately defined name.
or
b. Use the value read as the name of the item: Select this option if you want to use the extracted
value as the name of the value list item. You can check the Add a new item to the list if a
matching item is not found check box if you want to add a new value list item whenever a new
value is extracted.
13.Click OK to close the Define Property dialog.
The email messages imported to M-Files via this connection are assigned automatic properties according
to the settings that you have defined.
Email Client Integration Settings
You can specify messages to be automatically associated with contact persons and customers in M-Files.
M-Files does this on the basis of the sender and recipient information when the messages are saved
to your vault in Microsoft Outlook. For an introduction to this feature, see Associating Messages with
Contacts.
For information on how this feature is supported in different M-Files clients, refer to M-Files Feature
Comparison.
To open the Email Client Integration Settings dialog:
1. Open M-Files Admin.
2. In the left-side tree view, select a vault.
3. Click Action > Email Client Integration Settings.
Contact persons
M-Files looks for a match with a contact person's email address. M-Files associates the message with the
contact person Matt Bay if the properties of the contact person object have the same email address as the
message (matt.bay@estt.com).
Customers
If you have specified customer information in the email integration settings:
1. M-Files looks for customer matches via the contact person (the Customer object type must be the
owner of the Contact person object type): M-Files associates the message with the customer ESTT
if Matt Bay is the contact person for ESTT.
2. M-Files looks for similarity between the domain name in the email address and the customer's
properties: M-Files associates the message with the customer ESTT on the basis of the email address
domain, matt.bay@estt.com or patsy.bay@estt.com, if the domain estt.com is found in the
customer's properties. The message is not associated with any contact person, unless a full match is
found with the contact person information.
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Advanced Settings
On the Advanced tab, you can further specify associations between email information and M-Files
metadata. M-Files automatically populates the metadata card according to the defined mappings.
Note: These settings are applicable when
•
•

you drag and drop the email from Microsoft Outlook to M-Files.
you select Save to M-Files from the Microsoft Outlook ribbon.

You can select a default class for all the email messages that are saved to M-Files via Microsoft Outlook.
With the other options, you can define an appropriate metadata property for the value of each email header
field.
For example, if you want M-Files to automatically insert the information from the From field to a certain
property on the metadata card of the email object, select the appropriate property from the drop-down
menu.
Accepted data types
There are limitations for the data types of the properties that are assigned to object metadata via these
settings. You can see the accepted data types in the table. You must also allow the properties to be used
with the Document object type (or with all object types).
Email header field
To

From

Cc

Subject

Received

Sent

Importance

Sensitivity

Accepted data types
•

Text (multi-line)

•
•

Text
Text (multi-line)

•

Text (multi-line)

•
•

Text
Text (multi-line)

•

Timestamp

•

Timestamp

•
•

Text
Text (multi-line)

•
•

Text
Text (multi-line)
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Content Replication and Archiving
Content replication and archiving enables synchronization of objects between vaults. This helps in ensuring
that data is up to date between various specified vaults. Replication and archiving can be carried out by
using the export and import operations available in M-Files Admin.

Figure 59: The replication features in M-Files Admin.

Note: Accessing these settings requires you to log in to the server with a login account that has
the System administrator server role. Vault users with the Full control of vault rights are allowed to
manage cloud storage based replication jobs.
Ways to utilize replication and archiving
With content replication and archiving, you can, for instance:
•
•
•
•
•
•
•

Archive data from an actively used vault to an archive vault.
Archive data for long-term preservation in XML or PDF/A form in compliance with standards.
Collect data from several M-Files vaults within a single, centralized vault.
Use specific vaults for each of the various operations of the company.
Publish certain documents for interest groups, such as partners, customers, or subcontractors.
Perform backups.
Restore the system after an error reliably (as in disaster recovery).

Figure 60: You can, for example, replicate documents from a production vault to a publication vault according to given property values
of documents. For instance, a document may be replicated to a publication vault when the property Published is set to Yes.

For a more extensive presentation on replication and archiving, see M-Files Replication and Archiving
User's Guide.
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Important remarks
•

•

•
•
•

•

•

For association and synchronization of objects and their metadata between separate vaults, the
metadata definitions must also be associable between vaults. For more information, see Associating the
Metadata Definitions.
It is advisable to check the permissions of confidential imported objects in the target vault after an
import operation is complete, especially if the source and the target vaults have differing users or user
groups.
If M-Files is installed on several servers, each server must have a unique server license installed.
All M-Files Server instances in a replication setup must have the same four-digit build number (for
instance 4320 in 11.2.4320.32 and 11.2.4320.33).
Two-directional replication of metadata structure is highly discouraged as the structure of the target
vault is always overwritten with the structure in the content package, even if the metadata structure
of the vault is more recent than the one in the content package. Thus, if two-directional replication of
metadata structure is enabled, it may overwrite changes made to the metadata structure of any vault in
the replication scheme.
An exception to the above recommendation are value list items, as they are provided with timestamp
information to indicate when they have been created or modified. Therefore replicating value list items
does not have the same shortcomings as replicating other metadata structure items, as value list
timestamps assure that the most recent value list items are always preserved during replication.
Replication from a vault to another vault is not supported if the vaults have the same GUID. Two vaults
must never share the same GUID. It is possible to generate such a situation, for example if a copy or a
backup of a vault is attached to another server using the original GUID.
It is highly discouraged to compress M-Files content packages using the ZIP archive format. ZIP
archives do not specify the character encoding that is used for the file names stored in the archive, and
therefore it may not be possible to import content packages that have been compressed using ZIP to
systems that use different system language and code page settings than the system from which the
content package was exported. If you wish to compress the content package, it is recommended to use
a format that retains the character encoding information of file names, such as 7Z.

In this chapter
•
•
•
•

Exporting Content
Importing Content
Scheduled Export and Import
Archiving Old Versions

Exporting Content
You can use content exporting for long-term archiving of content, synchronization of data among several
vaults, or freeing up disk space on the server.
Do the following steps to export content:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
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5. Select Content Replication and Archiving.
The content replication and archiving features are displayed in the right-side pane.
6. Click the One-time Export... button.
For information about creating a recurring export operation, see Defining a Scheduled Export.
The Export Content dialog is opened.
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7. On the Package Location tab, define the location for the content package.
a) Click the ... button to define a temporary local folder for the content package.
b) Optional: Click Set Account... to define the user account to be used for saving the content package
to the selected local folder.
You need to use a user account that has write permissions to the selected local folder.
8. Optional: Still on the Package Location tab, enable the Use replication via cloud storage option to
export to a cloud storage location.
a) In the Connection string field, enter the provided connection string for connecting to the cloud
storage.
If you do not yet have the connection string, click Get... to obtain one. This opens up a
preformatted e-mail message to be mailed to M-Files customer support.
b) In the User-specified folder name field, enter a folder location in the cloud storage that will be used
for exporting from one vault and importing to another.
c) In the User-specified password for encryption field, enter a password of your choice that will
be used for encrypting content packages. The same password must be used for exporting and
importing the same packages.
9. Optional: In the Configuration ID field, you can enter any string of characters for identifying this
replication job.
M-Files automatically creates a numeric ID for each scheduled replication job, but you can
optionally enter an additional ID for the job to the Configuration ID field. The ID can be any
string of characters. If a configuration ID cannot be found when the jobs are processed, M-Files
simply uses the numerical replication job ID.
10.Click the Objects and Files tab.
The Objects and Files tab is opened.
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11.Enable the Export objects and files option by checking the check box and select the Export existing
objects option.
For more information about the options on this tab, see Export Objects and Files.
Note:
If the Export only changes since latest run option is enabled, only the files and objects
that are new or have changed since the given date and time are exported. If you are
exporting metadata structure elements while this option is enabled, the elements are not
exported unless there have been changes made to files or objects.
Thus if you want to export metadata structure elements regardless of whether objects or
files have been changed, it is recommended to do either of the following operations:
•
•

Export the metadata structure separately.
Disable the Export only changes since latest run option if metadata structure
elements are to be exported alongside objects and files. Note that if you do not limit
the scope of the export in any way, it may take a considerable amount of time to
complete the export job.

12.Optional: To define the conditions that objects must meet to be exported, enable the Use a search
filter option by checking the check box and click the Define... button.
a) In the Define Filter dialog, define the conditions that objects must meet to be exported and click OK
once you have defined all the necessary conditions.
13.Click the Structure tab.
The Structure tab is opened.
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14.Enable the Export structure option and either:
a. Check the All Elements option to export all metadata structure elements.
or
b. Check individual metadata structure elements on the list to define individually the elements to be
exported.
For more information about the options on this tab, see Export Structure.
15.Click OK to close the Export Content dialog and to start the export.
Note: Make sure that the export operation is complete before you take any actions in the
vault.
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When the export operation is complete, you can use the export package to import the exported content to
another vault. See Importing Content.

In this chapter
•
•
•

Export Package Location
Export Objects and Files
Export Structure

Export Package Location
On the Package Location tab of the Export Content dialog, you can change the location of the content
package. M-Files names the files automatically according to the vault ID and timestamp, so that you can
find the content package easily at a later time.
You can also modify the user account to be used. The user needs to have the rights to the specified
saving location in order for the export to be successfully completed. The default selection is Local System
account.
M-Files automatically creates a numeric ID for each scheduled replication job, but you can optionally
enter an additional ID for the job to the Configuration ID field. The ID can be any string of characters.
If a configuration ID cannot be found when the jobs are processed, M-Files simply uses the numerical
replication job ID.
Use replication via cloud storage
You can also use replication via a cloud storage location. When exported, the replication packages are
locally encrypted with the AES-256 algorithm and then uploaded to the cloud storage location. When
imported, the replication packages are downloaded from the cloud storage location and then decrypted
locally. This functionality can be helpful when you are replicating data between different locations and want
to be completely certain that only the appropriate persons can access the data.
Connection string
Click Get to update the connection string for the cloud storage location. Use the same string for export and
import. If there is no Get button, click Request to send an email to our customer support, and wait for them
to send you the connection string.
User-specified folder name
The folder name is unique for one export-import pair. For instance, replication from the master vault to a
secondary vault could be named "MasterOut" and replication from the secondary vault to the master vault
"MasterIn".
User-specified password for encryption
The replication password is used for encrypting the replication packages. The password can be whatever
you decide. Just remember to use the same password for both export and import.
Export Objects and Files
The Objects and Files tab enables you to change settings for exporting object and file content.
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Figure 61: The "Objects and Files" tab of the "Export Content" dialog.
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Export existing objects
Use a search filter
By using a filter, you can specify which existing objects you want to export. For example, you can export
certain objects by object type or property. In particular, when publishing certain documents, such as
brochures or press releases, for interest groups only, you can use the search filter for the publication when,
for example, the requirement of a certain class or property is met.
If a previously exported object is no longer part of the export set, mark it to be destroyed in the
target vault
By enabling this setting, any of the objects that were included in an earlier export set but are not in the
current one will be deleted in the target vault upon import. If you wish to delete for example certain price
lists from a vault designed for partner use, you need to make sure that this setting has been enabled and
that the price lists do not fit the criteria of the export set.
Note: The setting is job-based and applies only for scheduled export and import jobs.
Note: The setting Do not import object destructions in the properties of the import job overrides
this setting.
Include latest versions only
You can choose to export only the latest versions of the selected objects for archiving. Older versions of
the selected objects will not be archived.
Save files also in PDF/A-1b format
You can indicate whether you also want to save the files in PDF/A-1b format when archiving them. PDF/
A-1b format complies with the standard ISO 19005-1:2005, on the long-term preservation of electronic
documents.
Saving in PDF/A-1b format is possible with Office files and standard PDF files. Files in PDF/A-1b format
are not imported during import. Saving in PDF/A-1b format slows down the export to some extent.
Clear Archiving Marker
If you have chosen to export objects with the Marked for archiving property defined, you can indicate that
the property should be cleared after the content export. With this setting is enabled, the exported objects
are no longer marked for archiving.
Destroy exported objects after exporting
You can specify whether you want to destroy the exported objects after the export. If you have selected to
export the latest versions only, you cannot choose this setting.
Export information on destroyed objects and object versions
Instead of the existing objects, you can choose to export data from the destroyed objects and object
versions only. This function is intended mainly for clearing the destroyed objects from the vault.
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Export only changes since latest run
You can choose to export only the changes made since the latest run. By default, M-Files offers the date
of the latest export (or of the last import of exported objects to the source vault with a timestamp older than
the previous export).
Note:
If the Export only changes since latest run option is enabled, only the files and objects that are
new or have changed since the given date and time are exported. If you are exporting metadata
structure elements while this option is enabled, the elements are not exported unless there have
been changes made to files or objects.
Thus if you want to export metadata structure elements regardless of whether objects or files have
been changed, it is recommended to do either of the following operations:
•
•

Export the metadata structure separately.
Disable the Export only changes since latest run option if metadata structure elements are to
be exported alongside objects and files. Note that if you do not limit the scope of the export in
any way, it may take a considerable amount of time to complete the export job.

Preview
Click the Preview button to see the number of objects to be affected by the export process.
Export Structure
The Structure tab enables you to select which parts of the metadata structure you want to export.
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Figure 62: The Structure tab of the Export Content dialog.

Export structure
You can choose the metadata structure elements of the selected vault to be exported or select all elements
by activating All Elements.
Note: Built-in elements are always created in M-Files by default and include, for example, the
property definitions Name or title, Created by, Last modified by, and Keywords. In addition to these,
administrators can create new, user-defined elements.
Note: It is recommended to use aliases or GUIDs in event handlers and metadata card
configurations because they are exported as-is and because the metada element IDs may differ
between the source and the target vaults.
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Note: For the imported metadata card configurations to be visible in the target vault, you need to
either restart M-Files Admin or to perform a forced refresh (Ctrl + F5) in the configurations editor.
Export contents of the selected value lists
By selecting the Export contents of the selected value lists checkbox you can choose to export all value list
content.
Note: All the removed values are replicated as well. This means that values in the target vault may
be deleted through a metadata structure import. The values are not deleted completely, however,
but instead only marked as deleted. This enables the ability to search and re-enable any deleted
values in the source or target vault via M-Files Admin.
Selecting OK creates an export package of the selected metadata to the location specified on the Package
Location tab.
Export users' custom display settings of the selected views
By enabling the Export users' custom display settings of the selected views checkbox you can choose
to include users' custom display settings to the export package.
Note: Exporting a view always includes the common display settings of the view.
Importing Content
After creating an export package, you can import its content to a vault. You can use the Import Content
function when you need to import data to another vault for example for replication, publication, archiving, or
backup purposes. The objects and their metadata are imported and synchronized with those in the target
vault. M-Files always imports versions that are new or changed compared to the current versions in the
target vault.
Complete the following steps to import a content package:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click Content Replication and Archiving.
The content replication and archiving features are displayed in the right-side pane.
6. Click the One-time Import... button.
For information about creating a recurring import operation, see Defining a Scheduled Import.
The Import Content dialog is opened.
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7. On the Package Location tab, define the location for the content package.
a) Optional: Enable the Import multiple content packages if you want to import multiple packages
from the selected location.
b) Click the ... button to define the location of the content packages to be imported.
c) Optional: Click Set Account... to define the user account to be used for retrieving the content
package from the selected folder.
You need to use a user account that has read permissions to the selected folder.
8. Optional: Still on the Package Location tab, enable the Use replication via cloud storage option to
import from a cloud storage location.
a) In the Connection string field, enter the provided connection string for connecting to the cloud
storage.
If you do not yet have the connection string, click Get... to obtain one. This opens up a
preformatted e-mail message to be mailed to M-Files customer support.
b) In the User-specified folder name field, enter a folder location in the cloud storage that will be used
for importing to one vault and exporting from another.
c) In the User-specified password for encryption field, enter a password of your choice that will
be used for encrypting content packages. The same password must be used for exporting and
importing the same packages.
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9. Check the Delete content package after importing check box if you want the content package to be
removed after the operation has been completed.
10.Optional: In the Configuration ID field, you can enter any string of characters for identifying this
replication job.
M-Files automatically creates a numeric ID for each scheduled replication job, but you can
optionally enter an additional ID for the job to the Configuration ID field. The ID can be any
string of characters. If a configuration ID cannot be found when the jobs are processed, M-Files
simply uses the numerical replication job ID.
11.On the Objects and Files tab, you can specify how objects and files are imported.
For more information, see Import Objects and Files.
12.On the Structure tab, you can specify how metadata structure is imported.
For more information, see Import Structure.
13.On the Permissions tab, you can specify the permission settings for the imported objects.
For more information, see Permissions (Importing Content).
14.Click OK to start the import operation.
A summary of the package content to be imported is opened.

!

Important: It is essential to take into consideration that exporting and importing objects
with relationships to other objects may, in some cases, produce a conflict. If the conflict
cannot be resolved automatically, some of the selected objects might not be replicated.
The import summary report should be reviewed carefully before proceeding with the
import operation.

In this chapter
•
•
•
•
•

Import Package Location
Import Objects and Files
Import Structure
Permissions (Importing Content)
Import Summary Report

Import Package Location
The Package Location tab displays options related to the package containing the objects, files, and
metadata structure to be imported. See the corresponding settings in Exporting Content when you are
importing the content package to the selected vault.
The location must be the same as that of the content package exported from the source vault. That is, MFiles must find the exported data to perform the import. The location may be different, but in that case a
separate data transfer between locations must be implemented.
Note: The exported package can contain different marker files. M-Files only imports content
packages that have the Ready marker file but not the Imported marker file for the target vault.

M-Files | 3. System Administration | 332
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

Figure 63: The Package Location tab of the Import Content dialog

You can also import several packages at a time by checking the Import multiple content packages check
box. This enables you to select a folder instead of a single file.
The content package will be automatically deleted after importing if the Delete content package after
importing option is enabled.
M-Files automatically creates a numeric ID for each scheduled replication job, but you can optionally
enter an additional ID for the job to the Configuration ID field. The ID can be any string of characters.
If a configuration ID cannot be found when the jobs are processed, M-Files simply uses the numerical
replication job ID.
Use replication via cloud storage
You can also use replication via a cloud storage location. When exported, the replication packages are
locally encrypted with the AES-256 algorithm and then uploaded to the cloud storage location. When
imported, the replication packages are downloaded from the cloud storage location and then decrypted
locally. This functionality can be helpful when you are replicating data between different locations and want
to be completely certain that only the appropriate persons can access the data.
Connection string
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The connection string contains the storage location information. Please make sure to use the same string
for both export and import (see Export Package Location).
Manage Replication
Click Manage Replication... to open a dialog listing the queued import packages. This allows you to easily
remove any erroneous packages that may be blocking the queue.
User-specified folder name
The folder name is unique for one export-import pair. For instance, replication from the master vault to a
secondary vault could be named MasterOut and replication from the secondary vault to the master vault
MasterIn.
User-specified password for encryption
The replication password is used for encrypting the replication packages. The password can be whatever
you decide. Just remember to use the same password for both export and import.
Import Objects and Files
The Objects and Files tab enables you to change settings related to importing object and file content.
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Figure 64: The Objects and Files tab of the Import Content dialog.
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Import checkout states of objects
If the objects are checked out in the vault from which you are exporting, you can import the check-out
states to the target vault as well. Then the object is also checked out in the target vault, which prevents
other users from editing it. This reduces the possibility of conflicts, which could be caused by simultaneous
editing in multiple vaults.
Use the name of an imported element as its alias if no other alias is available
Since only built-in, GUID and "ID+name" matching metadata definitions are automatically connected, other
metadata definitions must be associated by using aliases. However, the necessary alias definitions may
not have been made in the source vault. In the latter case, the data export can be facilitated by means of
this setting. When this option has been selected, the alias need only be defined in the target vault as long
as it is in line with the element's source vault name.
For example, you may want to import objects of the Project type but have not defined an alias for the
Project object type in the source vault. By selecting this option and adding, in the target vault, an alias
corresponding to the source vault's name for the project object type (in this case, the alias is "Project"), you
will get the necessary definitions for the import.
Note: You must use the default language names from the source vault as the aliases for the
metadata definitions in the target vault to be able to perform connection of the metadata definitions.
Note: This setting is valid only when the metadata definition in question (object type, property
definition, value list, or similar) has no alias defined in the source vault.
Do not import object destructions
Select this option if:
•
•

You do not want to destroy objects that you have destroyed in the source vault also in the target vault.
For example, if you use the target vault for archiving destroyed objects, select this setting.
You do not want to destroy objects that are no longer part of the export set. Please note that this setting
nullifies the export setting If a previously exported object is no longer part of the export set, mark it to be
destroyed in the target vault.

Import Structure
On the Structure tab, you can disable any external database connections to object types, value lists and to
user groups, as well as disable any active event handlers to be replicated.
Additionally, you may want to disable any custom code in property definitions and in workflows. To enable
custom code in the imported structure, you need to have the system administrator permissions.
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Figure 65: The Structure tab of the Import Content dialog.

Clicking OK generates a report that displays all modifications to the target vault structure.
Permissions (Importing Content)
The Permissions tab of the importing dialog allows you to change the permission settings of the content to
be imported.
Complete the following steps to modify the permissions:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
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4. Expand a vault.
5. Click Content Replication and Archiving.
The content replication and archiving features are displayed in the right-side pane.
6. Either:
a. Click One-time Import... if you want to modify the permissions of a single import package.
or
b. Click the task area item New Scheduled Import... if you want to modify the permissions of a
recurring import job.
Depending on your choice, either the Import Content or the Scheduled Job Properties dialog
is opened.
7. Select the Permissions tab.
The Permissions tab of either the Import Content or the Scheduled Job Properties dialog is
opened.
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8. In the Permissions of the imported objects section, select one of the following options:
Option

Description

Use the permissions from the content package Select this option if you want the imported objects
to have the same permissions as the objects in
the source vault.
Use the default permissions of the object
types

Select this option if you want the imported objects
to use the default permissions defined via the
properties dialog of each object type.

Specify permissions for imported versions

Select this option if you want to manually define
permission settings that are to be applied to all
the imported objects.

9. Optional: Check or uncheck the Activate new or changed definitions of automatic permissions
option checkbox.
If the content package contains any new or changed definitions of automatic permissions,
importing the content package with this option enabled activates all the automatic permissions
triggered by the imported definitions in the target vault. Importing the content package with this
option unchecked still imports the automatic permission definitions to the target vault, but does
not cause any new automatic permissions to be activated.
10.Optional: Check or uncheck the Ignore the definitions of automatic permissions of the imported
objects option checkbox.
When selected, this option makes the importing process bypass the definitions of automatic
permissions of all the imported objects in the content package. This way you can choose to
preserve the automatic permissions of all the objects in the target vault by leaving out any
potential changes to the definitions of automatic permissions from the objects in the imported
content package.
11.Click OK to close the dialog.
Import Summary Report
Before accepting any changes to the target vault, M-Files presents a detailed summary of the content
package to be imported. It is highly recommended to carefully review the summary report explaining the
results of the content import.
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Figure 66: The summary report for the content to be imported.

It is very important to make sure that no unintended duplicate structure elements will be generated, and
that all changes to the target vault's metadata structure will be as expected. In the event there are incorrect
mappings, the process should be canceled and the names or aliases of the elements in the source and/or
target vault modified accordingly.
Scheduled Export and Import
For keeping vaults up to date between each other and in interaction, scheduled export and import must
be defined for the vaults. With scheduled export and import, you can synchronize the objects and their
metadata between vaults.
Note: The schedule option When idle is not supported in M-Files.
Note: It is recommended that you study the section Interaction Among Several Vaults before
defining any export or import jobs.
Scheduled export
Define the scheduled export in the source vault where you can save the content to be exported on a
scheduled basis. The same settings are available as when defining an individual export. For further
information, refer to Export Content. Exported data can be imported to another vault for publication,
replication, archiving or backup.
Scheduled import
When you want to import the content to another vault for synchronization or other use, you should define
the scheduled import to the target vault. The same settings are available as when defining an individual
import. For further information, refer to Import Content.
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Scheduling an export or an import job works the same way as scheduling tasks in the Windows Control
Panel.
Note: In addition to the content export and import, you should be able to associate the metadata
definitions for the interaction between separate vaults, so that synchronization is possible through
archiving. For further information, refer to Interaction Among Several Vaults.

In this chapter
•
•

Defining a Scheduled Export
Defining a Scheduled Import

Defining a Scheduled Export
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Content Replication and Archiving.
The content replication and archiving features are displayed in the right-side pane.
6. In the task area, click New Scheduled Export.
The Scheduled Job Properties dialog is opened.
7. In the Description field, type in a name for the scheduled export job.
8. To define a schedule for this task:
a) Click the Schedule... button.
The Define Schedule dialog is opened.
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b) Define the appropriate schedule using the available options.
The schedule option When idle is not supported in M-Files.
c) Click OK to close the Define Schedule dialog.
9. On the Package Location tab, define the location for the content package.
a) Click the ... button to define a temporary local folder for the content package.
b) Optional: Click Set Account... to define the user account to be used for saving the content package
to the selected local folder.
You need to use a user account that has write permissions to the selected local folder.
10.Optional: Still on the Package Location tab, enable the Use replication via cloud storage option to
export to a cloud storage location.
a) In the Connection string field, enter the provided connection string for connecting to the cloud
storage.
If you do not yet have the connection string, click Get... to obtain one. This opens up a
preformatted e-mail message to be mailed to M-Files customer support.
b) In the User-specified folder name field, enter a folder location in the cloud storage that will be used
for exporting from one vault and importing to another.
c) In the User-specified password for encryption field, enter a password of your choice that will
be used for encrypting content packages. The same password must be used for exporting and
importing the same packages.

M-Files | 3. System Administration | 343
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
11.Optional: In the Configuration ID field, you can enter any string of characters for identifying this
replication job.
M-Files automatically creates a numeric ID for each scheduled replication job, but you can
optionally enter an additional ID for the job to the Configuration ID field. The ID can be any
string of characters. If a configuration ID cannot be found when the jobs are processed, M-Files
simply uses the numerical replication job ID.
12.On the Objects and Files tab, enable the Export objects and files option by checking the check box
and select the Export existing objects option.
For more information about the options on this tab, see Export Objects and Files.
Note:
If the Export only changes since latest run option is enabled, only the files and objects
that are new or have changed since the given date and time are exported. If you are
exporting metadata structure elements while this option is enabled, the elements are not
exported unless there have been changes made to files or objects.
Thus if you want to export metadata structure elements regardless of whether objects or
files have been changed, it is recommended to do either of the following operations:
•
•

Export the metadata structure separately.
Disable the Export only changes since latest run option if metadata structure
elements are to be exported alongside objects and files. Note that if you do not limit
the scope of the export in any way, it may take a considerable amount of time to
complete the export job.

13.Optional: To define the conditions that objects must meet to be exported, enable the Use a search
filter option by checking the check box and click the Define... button.
a) In the Define Filter dialog, define the conditions that objects must meet to be exported and click OK
once you have defined all the necessary conditions.
14.On the Structure tab, enable the Export structure option and either:
a. Check the All Elements option to export all metadata structure elements.
or
b. Check individual metadata structure elements on the list to define individually the elements to be
exported.
15.Click OK to save the scheduled export job and close the Scheduled Job Properties dialog.
The scheduled export job that you have just defined is added to the Scheduled Export and Import list
and will be run according to the defined schedule.
Defining a Scheduled Import
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
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5. Click Content Replication and Archiving.
The content replication and archiving features are displayed in the right-side pane.
6. In the task area, click New Scheduled Import.
The Scheduled Job Properties dialog is opened.
7. In the Description field, type in a name for the scheduled import job.
8. To define a schedule for this task:
a) Click the Schedule... button.
The Define Schedule dialog is opened.

b) Define the appropriate schedule using the available options.
The schedule option When idle is not supported in M-Files.
c) Click OK to close the Define Schedule dialog.
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9. On the Package Location tab, define the location for the content package.
a) Optional: Enable the Import multiple content packages if you want to import multiple packages
from the selected location.
b) Click the ... button to define the location of the content packages to be imported.
c) Optional: Click Set Account... to define the user account to be used for retrieving the content
package from the selected folder.
You need to use a user account that has read permissions to the selected folder.
10.Optional: Still on the Package Location tab, enable the Use replication via cloud storage option to
import from a cloud storage location.
a) In the Connection string field, enter the provided connection string for connecting to the cloud
storage.
If you do not yet have the connection string, click Get... to obtain one. This opens up a
preformatted e-mail message to be mailed to M-Files customer support.
b) In the User-specified folder name field, enter a folder location in the cloud storage that will be used
for importing to one vault and exporting from another.
c) In the User-specified password for encryption field, enter a password of your choice that will
be used for encrypting content packages. The same password must be used for exporting and
importing the same packages.
11.Optional: Check the Delete content package after importing check box if you want the content
package to be removed after the operation has been completed.
12.Optional: In the Configuration ID field, you can enter any string of characters for identifying this
replication job.
M-Files automatically creates a numeric ID for each scheduled replication job, but you can
optionally enter an additional ID for the job to the Configuration ID field. The ID can be any
string of characters. If a configuration ID cannot be found when the jobs are processed, M-Files
simply uses the numerical replication job ID.
13.On the Objects and Files tab, you can specify how objects and files are imported.
For more information, see Import Objects and Files.
14.On the Structure tab, you can specify how metadata structure is imported.
For more information, see Import Structure.
15.On the Permissions tab, you can specify the permission settings for the imported objects.
For more information, see Permissions (Importing Content).
16.Click OK to save the scheduled import job and close the Scheduled Job Properties dialog.
The scheduled import job that you have just defined is added to the Scheduled Export and Import list
and will be run according to the defined schedule.
Archiving Old Versions
You can archive old versions of documents that you no longer need. When you archive old versions of
documents, the selected document versions are transferred from the document vault to the archive file.
Do the following steps to archive old versions of documents:
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1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click Content Replication and Archiving.
6. In the menu bar, click Action > Archive Old Versions.
You can also right-click an empty area in the Scheduled Export and Import list and select
Archive Old Versions.
The Archive Old Versions dialog is opened.
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7. Select either:
a. All documents: Select this option if you want to archive old versions of all documents.
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or
b. Documents marked for archiving: Select this option if you want to archive old versions of the
documents that you have marked for archiving.
Note: You can mark a document for archiving in M-Files Desktop by right-clicking a
document and selecting Archiving > Mark for Archiving from the context menu. For more
information, see Archiving.
8. Select the conditions (you can select all that apply) for limiting the number of old versions to be
archived:
You can click Preview to view the number of old versions to be archived with the selected
settings.
Option

Description

Checked in before

Select this option to archive old versions that have
been checked in before the given date.

At least <number> versions older than the
current version

Select this option to archive old versions that are
a given number of versions older than the current
version.

At least <number> days older than the current
version

Select this option to archive versions that are
a given number of days older than the current
version.

No version tag

Select this option to exclude versions that have a
version label from the archive.

9. In the Content package location section, click the ... button to select the location to save the archive.
10.Optional: Click Set Account... to run the task with another account than the Local System account. If
the file location is on a network drive that the Local System account cannot get access to, you must set
another account. On the Set Account dialog:
a) Select This account.
b) In This account, enter the name of the user account.
c) In Password and Confirm password, enter the password of the user account.
d) Click OK to close the Set Account dialog.
11.Click OK to save your changes and to close the Archive Old Versions dialog.
The selected old versions of documents are archived to the location you have defined.
The archived documents can later be restored to the document vault via Content Replication and
Archiving.
Note: If you have archived documents in earlier versions of M-Files than 9.0, please note that you
cannot restore archive files in the .MFA file format to a vault using version 9.0 or later. If you want
to restore an archive file in the .MFA file format, you must use a vault that has version 8.0 or older
installed. After this, you can upgrade the vault and perform archiving that is compatible with version
9.0 and newer.
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Vault Event Log
The vault event log records document vault events, such as new object creations and user logins. Events
can be viewed and organized in any desired order, filtered and exported. You can add new types of events
to be recorded by purchasing the Electronic Signatures and Advanced Logging module.
Tip: If the list contains a large number of items, you might want to filter it. To filter the view, open
the View menu and click Filter. Enter a desired text to filter the column contents.
Note: Event logging must be enabled to send notifications. For more information about
notifications, refer to Editing Notification Settings in M-Files Admin.
To enable the vault event log, in M-Files Admin, select the document vault of your choice, then select
Event Log, and finally click Enable via the task area.
Showing events X–XXXX
You can browse the events page by page by using the arrow icons. A single page can display 10,000
events at maximum.
Results per page
You can select how many events are shown per page.
Define Filter
You can specify the events to be displayed in the list by either object type or object ID.
Export
You can export and archive all or selected events in XML file format.
Delete events X–XXXX
In addition to being able to delete all events, you can select events for listing on the page and delete them
(this does not apply to filtered lists).
Detailed information on an individual event
The Event Details dialog provides detailed information on the saved changes.
Note: To view more detailed information on an individual event, you must have the Electronic
Signatures and Advanced Logging module activated.
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Figure 67: The "Event Details" window.

Number of events, and event types
If the Electronic Signatures and Advanced Logging module is in use and the Advanced Event Log features
have been enabled, the event log records all events without any restrictions. Otherwise, M-Files Server
removes the oldest events when the total number of events exceeds the maximum number of events.
By default, the maximum number of events is 10,000. To change it, specify the following value in the
Advanced Vault Settings section: Event Log > Maximum Number of Events.
While M-Files offers a versatile event log, several additional event types that can be covered by logging are
enabled with the Electronic Signatures and Advanced Logging module.
Tip: If you want to give system administrators more visibility into actions that vault users perform in
a vault, see User Action Log.
The following event types are recorded in the M-Files Admin event log:
Assign request

Event log cleared

Public link accessed

User group created

Backup completed

Event log exported

Public link created

User group deleted
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Backup started

Event logging disabled

Public link deleted

User group modified

Check-in

Event logging enabled

Restoration from backup User group member
completed
added

Check-in request

File downloaded

Rollback

Checkout

File downloaded via
public link

Signature settings added Custom event

Undo checkout

Free-form request

Signature settings
deleted

Vault settings modified

Document or other object Login
changed

Signature settings
modified

Vault variable modified

Document or other object Logout
deleted

The state of a document
or other object changed

Document or other object New document or other
destroyed
object

User created

Document vault created

Object undeleted

User deleted

Document vault created
as a copy of another
vault

One version of a
User modified
document or other object
destroyed

User group member
removed

The Electronic Signatures and Advanced Logging module adds the following event types to the M-Files
Admin event log:
Metadata structure
changes:
Class changed

Named ACL deleted

State created

Value list item changed

Class created

Object type changed

State deleted

Value list item created

Class deleted

Object type created

State transition changed

Value list item deleted

Common view changed

Object type deleted

State transition created

Value list item undeleted

Common view created

Property definition
changed

State transition deleted

Workflow changed

Common view deleted

Property definition
created

Value list changed

Workflow created

Named ACL changed

Property definition
deleted

Value list created

Workflow deleted

Named ACL created

State changed

Value list deleted

Vault property changes:
Event handler changed
Event handler created
Event handler deleted
Event handler index changed
Other:
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Application enabled
Application disabled
Application installed
Application uninstalled
Application license changed
Content package exported
Content package import started
Content package import completed
Electronic Signatures and Advanced Logging module
The Electronic Signatures and Advanced Logging module enables you to use electronic signatures and to
record additional event types in the vault event log. The module is available for a separate fee.
For you to activate the Electronic Signatures and Advanced Logging module, the license code must be
activated on your system. The license is provided on a subscription basis. Activate or update the license
code in M-Files Admin (for more information, refer to Managing Server Licenses). In addition to this,
properties of the audit trail must be activated vault-specifically. For more information, see Document Vault
Advanced Properties.
For more information on User Action Log, that also comes with the module, see User Action Log.

In this chapter
•

User Action Log

User Action Log
You can enable the User Action Log feature to have more visibility into the actions performed by individual
M-Files Desktop users in a given vault. The feature allows the additional events described in the table
below to be included in the vault event log. To enable the feature, see Enabling User Action Log.
Important remarks
Please take the following information into consideration when using the feature:
•
•
•

Actions performed via M-Files Web, M-Files Mobile or any M-Files API based custom clients are not
logged.
Actions performed in offline mode are not logged.
Using this feature considerably increases the size of the vault log.

Logged events
When the feature is in use, the following additional events are recorded to the vault event log:
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Event

Description

Collection Members dialog
opened

An event of this type is recorded when the Collection Members dialog
is opened in M-Files Desktop.
The entry contains the following details:
•
•
•

Column inserted

The user who opened the dialog
The timestamp of the event
The name and ID of the object

An event of this type is recorded when a column is added to a listing in
M-Files Desktop.
The entry contains the following details:
•
•
•

Column removed

The user who performed the modification
The timestamp of the event
The column that was added

An event of this type is recorded when a column is removed from a
listing in M-Files Desktop.
The entry contains the following details:
•
•
•

Column settings modified

The user who performed the modification
The timestamp of the event
The column that was removed

An event of this type is recorded when columns are added or removed
via the Choose Columns dialog in the M-Files Desktop.
The entry contains the following details:
•
•
•

Data exported

The user who performed the modification
The timestamp of the event
The columns that are visible to the user after the modification

An event of this type is recorded when data is exported from the vault.
The entry contains the following details:
•
•
•
•

The user who did the export operation
The timestamp of the event
The export settings and the number of exported objects
The name and ID of the exported objects
•

This behavior must be enabled in Advanced Vault Settings.
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Event

Description

File opened

An event of this type is recorded when a file is opened via M-Files
Desktop.
The entry contains the following details:
•
•
•

File opened for document
comparison

The user who opened the file
The timestamp of the event
The name and ID of the object

An event of this type is recorded when a user compares document
content in M-Files Desktop.
The entry contains the following details:
•
•
•

Metadata card opened

The user who compared document content
The timestamp of the event
The name and ID of the compared document

An event of this type is recorded when the metadata card is displayed in
the right pane, bottom pane, or popped out for any object.
The entry contains the following details:
•
•
•

The user who opened the metadata card
The timestamp of the event
The property IDs, name, and ID of the object

The property IDs are shown only if you have enabled this behavior via
settings of the feature.
Object copied to clipboard

An event of this type is recorded when an object is copied to the
Windows clipboard in M-Files Desktop.
The entry contains the following details:
•
•
•

The user who copied the object
The timestamp of the event
The name and ID of the object

If multiple objects are copied, all items are separately logged.
Object dragged from M-Files

An event of this type is recorded when an object is dragged and dropped
from M-Files Desktop.
The entry contains the following details:
•
•
•

The user who exported the object
The timestamp of the event
The name and ID of the object

If multiple objects are exported, all items are logged.
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Event

Description

Object history opened

An event of this type is recorded when the History dialog is opened via
M-Files Desktop.
The entry contains the following details:
•
•
•

Object listing invoked

The user who opened the dialog
The timestamp of the event
The name and ID of the object

An event of this type is recorded when a search is performed in M-Files
Desktop.
The entry contains the following details:
•
•
•

Object listing requested from
server

The user who invoked the listing
The timestamp of the event
The search terms and search criteria

An event of this type is recorded when a search is performed in M-Files
Desktop.
The entry contains the following details:
•
•
•

The user who requested the listing
The timestamp of the event
The search terms and search criteria

For M-Files to start recording events of this type, you must restart the
vault after enabling the feature.
Object relationships opened

An event of this type is recorded when the relationships of an object are
browsed in the M-Files Desktop listing area.
The entry contains the following details:
•
•
•

The user who browsed the relationships
The timestamp of the event
The name and ID of the object

Object or objects marked to be An event of this type is recorded when M-Files Desktop is used to mark
available offline
an object to be available in the offline mode.
The entry contains the following details:
•
•
•

The user who marked the object to be available offline
The timestamp of the event
The name and ID of the object
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Event

Description

Preview tab opened

An event of this type is recorded when the preview tab is displayed for a
document or a non-document object containing one or more files.
The entry contains the following details:
•
•
•

Relationships dialog opened

The user who opened the preview pane
The timestamp of the event
The name and ID of the document (or, alternatively, the name of the
file and the name and ID of the object containing the file)

An event of this type is recorded when the Relationship dialog is
opened in M-Files Desktop.
The entry contains the following details:
•
•
•

Search initiated

The user who opened the dialog
The timestamp of the event
The name and ID of the object

An event of this type is recorded when a search is performed in M-Files
Desktop.
The entry contains the following details:
•
•
•
•

View or folder marked to be
available offline

The user who performed the search
The search terms
The timestamp of the event
The columns shown in the listing area

An event of this type is recorded when M-Files Desktop is used to mark
a view or folder to be available in the offline mode.
The entry contains the following details:
•
•
•

View or folder opened

The user who marked the view or grouping level to be available
offline
The timestamp of the event
The name and ID of the object

An event of this type is recorded when a view or grouping level is
opened in M-Files Desktop.
The entry contains the following details:
•
•
•
•

The user who opened the view or grouping level
The timestamp of the event
The name and ID of the object
The columns shown in the listing area
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In this chapter
•

Enabling User Action Log

Enabling User Action Log
To use the feature, your server license must contain the Electronic Signatures and Advanced Logging
module.
To enable the User Action Log feature for a single vault:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand Event Log.
3. Select User Action Log.
4. Change the value of the Enabled setting to Yes.
5. Optional: Change the settings as required under the Event Settings node.
See the descriptions of the settings by clicking the information icon next to each individual
setting.
6. Click Save to save your changes.
Note: M-Files starts recording the events for all vault users that have logged out and
logged back in after the settings were applied in M-Files Admin. You can log out all
vault users by restarting the vault, but taking a vault offline should always be done in a
controlled manner and the vault users should be notified beforehand.
The feature is now in use in the vault. Repeat the steps for any additional vaults that you want to be using
this feature.
Monitoring Background Tasks
M-Files Server performs various tasks for your document vault in the background. You may monitor the
progress of these operations in M-Files Admin.
Background tasks are complex and time-consuming processes that are processed in the background so
that they can be executed in parallel with other M-Files Server tasks without interfering or stalling other
ongoing processes.
Complete the following steps to monitor background tasks in your document vault:
1. Open M-Files Admin.
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2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Background Tasks.
The Background Tasks view is opened.
You can browse the background tasks page by page by using the arrow icons.
If the list contains a large number of items, you might want to filter it. To filter the view, open the View
menu and click Filter. Enter a desired text to filter the column contents.
The background tasks that are currently in progress are listed in the Background Tasks view. You can
click Refresh in the task area to refresh the view.
Monitoring Vault Indexing
You can use M-Files Admin to see the indexing status of a vault. This can be helpful, for example, when
you want to do one of these:
•
•
•

Make sure that indexing for the vault has completed.
See when the last object of the indexing round was processed.
Monitor the status of an index rebuild.

To see information about the indexing status:
1. Open M-Files Admin and go to a vault.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
2. Click Indexing Status.
3. In the task area, click the name of the index.
4. On the Status tab, expand an indexing scenario.
For example, Normal or Rebuild (Normal).
The indexing status information is shown.

For a description of a piece of information, click the information icon (

).

Measuring Vault Performance
You can use M-Files Admin to measure the performance of a specific vault to detect problems or
bottlenecks in the performance of the vault. The performance tests measure the network round-trip time to
the database server of the vault as well as the time it takes to insert 100,000 rows into the vault database.
Do the following steps to measure vault performance:
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1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click Performance.
The Performance view is opened in the right-side pane.

6. In the task area, click Begin Testing.
You can stop the test at any time by clicking Stop Testing in the task area.
The network round-trip time to the database server as well as the database insert speed are
measured.
The results of the tests are displayed in the Duration column. If there are no remarks displayed in the
Remarks column, your vault should be performing optimally.
If one or more of the tests took longer than their expected duration, a remark is displayed in the Remarks
column. If the network round-trip time to the database server took longer than expected, it may be
indicative of a slow network connection or heavy traffic on the network. If the database insert speed test
took longer than expected, your server hardware may be insufficient or there may be heavy load on the
server.
Note: The vault performance tests have predefined threshold times. The default threshold time
for the network round-trip test is 1,500 microseconds, and for the database insert speed test, it is
6,000 milliseconds. For instructions on modifying the default threshold values, see Settings for Vault
Performance Measurement.
Interaction Among Several Vaults
M-Files enables a multi-level interaction between several document vaults. The interaction enables you, for
instance, to:
•

Archive data from an actively used vault to an archive vault.
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•
•
•

•
•

Back up data from the vault on your server to the vault in the cloud service so that the users can
immediately connect to the cloud service if they face problems with the vault installed on your server.
Centralize data from several M-Files vaults to a single vault.
Use several vaults, separating the various functions of the company so that content, metadata
structures, and the permissions for the vaults can be customized to match the needs of various
operations and business units.
Publish certain documents via a separate vault for interest groups.
Create relationships between objects in different vaults so that objects in other vaults can be found as
the company's operations require.

With interaction, you can share documents and other objects efficiently between separate vaults. You
can, for example, specify certain documents for sharing from the company's vault with a publishing vault.
This enables you to easily provide your customers and other cooperation partners with up-to-date price
lists, product descriptions, brochures, and other material from this publishing vault at all times without any
manual copying or outdated information.
Note: If M-Files is installed on several servers, each server must have a unique server license
installed. For example, if you want to replicate information between vaults on separate servers,
unique server licenses must be installed for all the servers.
Settings required for the interaction
Associations for the metadata definitions
In order for you to associate and synchronize metadata between vaults, the metadata definitions must also
be associatable between vaults. For more information, refer to Associating the Metadata Definitions.
Synchronization of objects and values between vaults
In addition to associations for the metadata, the objects and values need to be updated or synchronized
regularly so that the data content is up to date across vaults. Synchronization of data between vaults is
performed with replication of contents, with data then exported from the source vault and imported to
another vault.
The synchronization of this content can be performed with scheduled export and import operations. The
content can be synchronized, for example, every 15 minutes. With this approach, the data in the target
vault will always be up to date. For more information, refer to Content Replication and Archiving.
Two-way synchronization is possible between vaults, but synchronization can also be performed among
many individual vaults. When defining the export, you can use a filter if you want to export and publish only
certain documents or another objects for the target vault.

In this chapter
•
•

Associating the Metadata Definitions
Synchronization of Objects and Their Values Between Vaults

Associating the Metadata Definitions
To associate and synchronize objects and their metadata between different vaults, the metadata definitions
must also be associatable between different vaults.
Associations between metadata definitions can be made in several ways depending on how the vaults
are used. Certain metadata definitions are always associated automatically. Some of them are associated
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automatically according to the vault structure, but for some of them, it must be done manually using
aliases.
Purpose of the Vault vs. Metadata Associations
Associations between metadata can be created in several ways, depending on the purpose of use of the
vaults. The target vault can be used in archiving, replication, backups, and publication. For this reason, you
should consider – before creating a vault that might be used as a target vault – which implementation is the
easiest and best for creation of the desired vault.
If the association and synchronization is performed between two or more existing vaults, check the
association of the metadata definitions and define the scheduled export and import between vaults.
Perfect copy (for example replication, archiving, and backup)
If you want the vaults to be perfect – full and complete – copies of each other in terms of both metadata
and contents, you should first create a target vault through backup or copy of the relevant vault and then
define the export and import. This way, especially the metadata definitions are automatically matched with
the names and IDs and any separate definition of aliases need not be performed one metadata definition at
a time.
Note: Metadata definitions created after creation of the vault must be manually associated
between vaults by using aliases.
Partially the same metadata structure and partially the same contents (for example vaults intended
for different purposes in the company)
If you want the metadata largely matching each other between vaults, you should consider first creating the
metadata structure of the target vault through metadata structure export (see Export Structure) and then
define the export and import. After this, you should verify in the target vault that the metadata structure
corresponds to the use of the target vault.
Note: Metadata created after creation of the vault must be manually associated between vaults by
using aliases.
Different metadata structure but partially the same content (for example, publication of certain
objects from one vault to another)
If you want to publish only certain objects and metadata in the so-called publishing vault, you should create
the metadata structure of the publishing vault separately from that of the source vault.
In this case, aliases must be defined for all other metadata structures than built-in ones, so that metadata
can be associated when the synchronization is performed.
Associating Metadata
By default, M-Files associates metadata by the following methods (in order of relevance):
1. The built-in metadata definitions are always automatically associated, regardless of the manner
of creation of the vault metadata structures or methods of performing the association. These metadata
definitions might be Name or title, Created by, Last modified by, Keywords, and so on. In publishing
operations, you may want to hide some of these. For example, you may not want to show the document
creator in the publishing vault. You can edit the built-in metadata to suit the publishing operation via the
registry settings and permissions.
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2. All the items have a GUID (globally unique identifier). If there is a GUID match across vaults, the
metadata definitions are always mapped automatically.
3. If the aliases match between the vaults, the association of the metadata definitions is always
performed. The alias must be manually defined in each vault for the metadata definition in question. For
more information, refer to Aliases for Associating Metadata Between Vaults.
4. If both metadata definition's ID and the name match, the association of the metadata is performed
automatically. This default setting can be changed from the registry settings. Note that when the
association is performed with name, the names in line with the default languages for vaults are used.
Also note that if the metadata structures have been separately created in different vaults, the IDs are
not the same and the association must be performed via aliases.
5. You can also use the name of imported metadata definition as its alias if there are no other aliases
available. In this case, you need to define the alias only in the target vault using the name of the
metadata definition from the source vault. For more information, refer Use the name of an imported
element as its alias if no other alias is available under Importing Content.
6. If, in addition to those mentioned above, you want to have associations using the name only, you
can include this definition in the registry settings. Then the name of the metadata definition, such as
Telephone number, must be the same across vaults. When default settings are used, the name alone is
not sufficient for association of the metadata. Note that when the association is performed by means of
name, the names in line with the default languages for the vaults are used.
Aliases for Associating Metadata Between Vaults
Because only the built-in metadata definitions and those matching the GUID or ID and name are
associated automatically, for other metadata definitions the association must be performed by using
aliases.
Aliases can be used for identifying semantically equivalent metadata. For example, when importing objects
from another vault, their Date and Description properties can be mapped to the target vault's equivalent
properties on the basis of aliases even if the properties' internal IDs and/or names are different. That is,
the aliases refer to semantically equivalent metadata in different vaults. In other words, alias is a common
identifier for the same metadata definition between several vaults.
The alias is defined as a common ID with the same name in both source and target vault.
When defining the alias, you can use various external data type and archive standards, such as SÄHKE2,
MoReq2, and Dublin Core.
Check that there are sufficient definitions for all desired metadata definitions so that the association can
be performed. Check the following: object types, value lists, property definitions, classes and class groups,
workflows and workflow states, user groups, and named access control lists. In the properties of these
metadata definitions, you can find the Advanced tab, where you can define the alias(es) for the metadata
definitions.
For example, the source vault has the property definition Telephone number, whose vault-specific ID
is 1001. The semantically equivalent property definition is also in the target vault, but the vault-specific ID
is 1005 – the name can be the same (Telephone number) or different (for example Phone and Phone
number) in the default language. If you want to associate these, you must define a common alias for this
property definition in both vaults. The alias can be anything you want, such as Telephone number or
dc.PhoneNumber, with the exception that it cannot contain both dots and spaces.
The alias is not shown to the users in M-Files Desktop; that is, the users see the name of the vault-specific
property definition, just as before.
Note: If there are several metadata definitions with the same alias in the target vault, the
association is bypassed for these and the data will not be imported to the target vault.
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Assigning Aliases for Metadata Definitions
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and select the type of metadata definition, for example
Property Definitions, for which you want to assign an alias or aliases.
The list of metadata definitions is opened in the right-side panel.
6. From the list, right-click the instance for which you want to assign an alias and select Properties from
the context menu.
The Properties dialog for the selected metadata definition is opened.
7. Go to the Advanced tab.
8. In the Aliases field, type in the name of the alias for the selected metadata definition.
Use the same aliases for semantically equivalent metadata in both the source and the target
vault.
9. Click OK to close the Properties dialog.
The alias is displayed in the Aliases column of the metadata definition listing.
Login Accounts
Depending on the purpose of use of the target vault, the users of the target vault may be the same as, or
entirely different from, those of the source vault. If you want to grant certain users permissions for both
vaults, synchronize the metadata for the Users value list, or do both, you should create user accounts with
the same name for these users for both vaults. User accounts are not automatically synchronized between
vaults.
Related Objects in Separate Vaults
The interaction between several vaults enables creation of relationships between objects across vaults.
The objects are not exported from one vault to another; instead, the relationship is created by reference
to an object in another vault; that is, a link is created to the original object. The object types of the objects
must be associatable, but synchronization of the objects (replication of content) is not required, because
the objects are not transferred from one vault to another. For more information, see Relationships Between
Objects in Separate Vaults.
Synchronization of Objects and Their Values Between Vaults
This section provides further information on synchronization of objects and their values. We recommend
studying this section before defining any synchronization jobs. Synchronization is implemented via Content
Replication and Archiving.
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Synchronizing Objects
When the metadata structures of vaults have been defined according to your needs and the required
metadata definitions can be associated with them, the actual synchronization of objects and values can be
performed between vaults. Synchronization of data between vaults is performed with replication of content.
For more information, refer to Content Replication and Archiving and Replication and Archiving User's
Guide.
Note: Only the values for which there is a built-in object type are synchronized automatically. For
other object types, either the alias or the combination of ID and name must match, so that objects
of this object type are imported to the target vault during import. You should check that these
definitions are in proper order. For more information, see Associating the Metadata Definitions.
Conflicts and their resolution
If users edit an object at the same time in multiple vaults, a conflict can occur during synchronization of
data between vaults. For example, from source vault A to target vault B. When M-Files detects a conflict, it
creates a conflict object.
Unresolved conflicts are shown in object relationships. In the listing area, expand an object with the arrow
button. If the object has unresolved conflicts, they are shown under the Conflicts node.
To see all conflict objects of the vault, go to the Conflicts view. By default, the view is hidden. For
information on unhiding views, see Using the Clean View, Hide View, and Unhide Views commands.
In manual conflict resolution, you decide which object version you want to keep. To resolve a conflict, you
must have editing rights to the object and the conflict object in the same vault. Right-click the conflict object
and click Resolve Conflict: Keep These Changes to replace the local changes with the contents of the
conflict object or Resolve Conflict: Discard These Changes to keep the local version.
If two-way synchronization (replication of contents) is used, you must resolve the conflict in both vaults.
Publishing selected objects of one vault in another vault
If you want to publish only certain objects from a vault by using another vault, you can do this by using a
search filter when defining the content export. You should also check that the object types of the published
objects can be associated either automatically or based on aliases.
Synchronizing Metadata Values
Value list values
When the metadata structures of vaults have been defined according to your needs and the required
metadata definitions can be associated, the actual synchronization of objects and their values can be
performed between vaults. Data synchronization between different vaults is performed with replication of
contents.
However, you should note that if the value does not exist in the target vault or you cannot create it as
a normal value-list value during import (for example, in the case of built-in values, such as classes,
workflows, and users), the value name is displayed in metadata in the form "Value name XYZ (deleted)". In
other words, if the value does not exist in the metadata structure of the target vault after import, it is shown
as a "Value name XYZ (deleted)" value.
Note: The default permissions for the imported values are the target vault's default permissions for
new values set from value lists. This means that the name of the value may be shown regardless of
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its permissions in the source vault. For example, the name of the document creator is shown in the
metadata of the published document via the "Created by: User XYZ (deleted)" value. If necessary,
check the permissions and association of the metadata definitions if you do not want to display this
information in the other vault.
Related objects
The object metadata contains information on other, related objects. For example, a document might be
related to a project or a customer.
When objects are exported to another vault, you may not want to export their related objects to the target
vault. For example, you export documents to the target vault but not projects or customers (for instance,
in publishing operations, you publish price lists and brochures but not customer information). Then the
related object is shown as a shortcut in the object's metadata (or, less frequently, with the "Value name
XYZ (deleted)" value). The object refers to the source vault and has not been imported as a genuine object
to the target vault. For further information, refer to Relationships between objects in separate vaults under
Object Relationships.
Note: The default permissions for the related object are the target vault's default permissions
for new objects set in the import by object type. This means that the name of the related object
is shown in the metadata of the imported/published object regardless of its permissions in the
source vault. For example, the name of the customer or project may be shown in metadata of
the published document as a shortcut or as a "Value name XYZ (deleted)" value. If necessary,
check the permissions and association of the metadata definitions if you do not want to display this
information in the other vault.

3.2. Configuring M-Files
This section offers guidance on personalizing the system to function and behave according to the
requirements of your organization. In addition to instructions on modifying the metadata structure of your
vault, the topics under this section deal with themes such as adding and editing workflows, installing and
using vault applications, editing notification settings, and making use of event handlers and scripts.

In this chapter
•
•
•
•
•
•
•
•
•
•
•
•

Editing the Vault Metadata Structure
Managing Users and User Groups
Configuring Workflows
Named Access Control Lists
Installing and Managing Vault Applications
Using the Configurations Editor
Editing Notification Settings in M-Files Admin
Setting Up Web and Mobile Access to M-Files
Reporting and Data Export
Event Handlers and Scripts
Intelligent Metadata Layer
Customizing Server and Vault Behavior

3.2.1. Editing the Vault Metadata Structure
M-Files Admin enables you to modify the metadata elements of the vault, such as object types, value lists,
property definitions and classes. Classes can also further be categorized into class groups. The document
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and object metadata is utilized almost everywhere in M-Files, such as in views and search functions, and
therefore the metadata structure of the vault should be carefully planned.

Figure 68: The vault metadata structure consists of object types, class groups, classes, property definitions, and value lists. The
example above illustrates the hierarchy of a metadata structure that contains the Customer and Document object types and various
classes for the two object types.

You can browse and edit the vault metadata structure either as a hierarchical view or as a flat view.
Complete the following steps to browse and edit your vault metadata structure:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Hierarchical View) or Metadata Structure (Flat View).
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In the Metadata Structure (Hierarchical View) and Metadata Structure (Flat View) sections, you can
create new metadata elements, such as object types, to the vault metadata structure or modify existing
ones. See the subtopics in this section for further information on different types of metadata elements and
how you can specify them.

In this chapter
•
•
•
•
•

Object Types
Value Lists
Property Definitions
Classes
Class Groups

Object Types
M-Files uses object types to define the objects to be stored. Built-in object types include documents and
document collections, but depending on the needs of the organization, you can also define object types
like customer, contact, or project in the vault. They can then be managed via M-Files, storing the change
history of these objects as well.
Besides versioning, M-Files enables sorting in dynamic views, protection against concurrent editing, easyto-use permissions functionality, and extremely versatile search capabilities for all objects.
The metadata card is provided both for documents as well as for other object types. Other object types
differ from documents in that they need not contain any files whereas documents are always based on at
least one file (such as a Word document).

In this chapter
•
•
•
•

Creating a New Object Type
Advanced Object Type Properties
Object Type Permissions
Connections to External Databases for Object Types

Creating a New Object Type
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View)
6. Click Object Types.
7. In the task area, click New Object Type.
The Object Type Properties dialog is opened.
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8. In the Name (singular) field, write a name for the object type in the singular form.
9. In the Name (plural) field, write the same name in the plural form.
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10.Optional: To change the icon of the object type, click Change Icon.
a) Select an icon from the list or click Browse to browse for a different icon file.
b) Click OK.
If you want to restore the default icon, click Use Default.
11.Optional: If you want that users can create objects of this type in M-Files, select the Users can create
objects of this type check box.
a) If you want the object type to appear under the Create menu in the top pane and the task area,
select Show the creation command in the task area.
12.Optional: If you want that users can add files into objects of this type, select Objects of this type can
have files.
13.Optional: In the The types of objects that users can browse for objects of this type list, select
the object types that users can browse when they right-click an object of this type and select Browse
Relationships in M-Files.
This setting does not affect the related objects displayed in the listing view (search results or a
view) below the main object.
14.In the Default permissions for new objects drop-down menu, select the default permissions for new
objects of this type.
To adjust any permission settings, click the ... button.
15.Optional: Select the Allow this object type to be used as a grouping level in views check box so
that users can use this object type to define a grouping level within a view.
16.Optional: To define an object type hierarchy, automatic permissions, a separate metadata search index,
or aliases for the object type, click the Advanced tab.
For more instructions, see Advanced Object Type Properties.
17.Optional: To refine the permissions for the new object type, click the Permissions tab.
For more instructions, see Object Type Permissions.
18.Optional: To use an external database as the source of the objects for the new object type, define the
external database connection on the Connection to External Database tab.
For more instructions, see Connections to External Databases for Object Types.
19.Click OK.
You can see the object type that you have just created in the Object Types list. You can now create
objects of this type in M-Files.
Advanced Object Type Properties
On the Advanced tab of the Object Type Properties dialog, for the selected object type, you can:
•
•
•

define an object type hierarchy
define automatic permissions
enable a separate metadata search index
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•

define aliases

Defining an Object Type Hierarchy
Object types can have hierarchical relationships. For example, the relationship between a customer
company and its contact person can be defined so that the Contact Person object type is a subtype of the
Customer object type. Viewing the value list for the Customer object type also displays the contact persons
filtered by customer.
Note: You cannot define an internal hierarchy for an object type.
To define an object type hierarchy:
1. In M-Files Admin, go to the Advanced tab of the Object Type Properties dialog for the object type that
you want to modify.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Expand Metadata Structure (Flat View) and then select Object Types.
The Object Types list is opened in the right pane.
f) Double-click the object type that you want to modify.
The Object Type Properties dialog is opened.
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g) Click the Advanced tab.
2. Do one or both of the following:
If you want to

Do the following task

Define subtypes for this object type

Click the Add button, then select the object types
to be added as subtypes of this object type, and
click Add.
Note: You can select more than one item
at once. Hold down the Ctrl key to select
multiple individual items or hold down the
⇧ Shift key to select adjacent items on the
list.
Note: To remove a subtype, click
Remove.
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If you want to

Do the following task

Define this object type as a subtype of another Select the This object type is a subtype of the
object type
following object type check box and select the
object type from the drop-down menu.
3. Click OK.
An object type hierarchy is created between the selected object types. In M-Files, when you create a new
object that you have defined as a subtype of another object type, you will need to select an owner object
for it. Thus a relationship is created between the owner and the subobject when the new object is created.
Defining Automatic Permissions for an Object Type
An object receives automatic permissions when a value with automatic permissions is added to the object
metadata. You can define automatic permissions for an object type so that when an object of the selected
type is referred to in the metadata of another object, the object inherits the permissions of the object that it
references.
Note: The automatic permission settings that are specific to a value list item always have priority
over the settings made at value list and object type level. For more information on automatic
permissions for value list items, see Automatic Permissions for Value List Items.
Note: Micro Focus IDOL and Smart Search: If more than four automatic ACL sources control the
permissions of an object, only administrators can see it in search results.
To define automatic permissions for an object type:
1. In M-Files Admin, go to the Advanced tab of the Object Type Properties dialog for the object type that
you want to modify.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Expand Metadata Structure (Flat View) and then select Object Types.
The Object Types list is opened in the right pane.
f) Double-click the object type that you want to modify.
The Object Type Properties dialog is opened.

M-Files | 3. System Administration | 373
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

g) Click the Advanced tab.
2. Click the Define button next to Default automatic permissions from this object type.
The Automatic Permissions dialog is opened.

M-Files | 3. System Administration | 374
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.

3. Select the Restrict the permissions of objects that refer to this value check box to enable automatic
permissions for the selected object type.
4. Do one of the following:
If you want to

Do the following task

Use the object permissions defined on the
metadata card as automatic permissions

Select the Use the object's own permissions
check box.

Use a predefined named access control list as
automatic permissions

Select the Use named access control list check
box and then select a predefined named access
control list from the drop-down menu.

Use custom permission settings as automatic
permissions

Click the Add button, then select the users or
user groups to be added to the custom permission
settings, and click Add.
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If you want to

Do the following task
Note: You can select more than one item
at once. Hold down the Ctrl key to select
multiple individual items or hold down the
⇧ Shift key to select adjacent items on the
list.
Note: To remove a user or group from
the settings, click Remove.
Select a user or group in the Users and user
groups list and grant permissions in the
Permissions list with the Allow and Deny check
boxes.

5. Optional: Select the Allow users to deactivate these restrictions check box if you want vault users to
be able to disable the automatic permissions granted by these settings.
6. Click OK to close the Automatic Permissions dialog.
7. Back in the Object Type Properties dialog, click Apply or OK.
The selected object type now has automatic permissions. Now when an object of this object type is
referred to in the metadata of another object, the referring object inherits the permissions of the object that
has automatic permissions set.
Using a Separate Metadata Search Index for an Object Type
You might want to enable the Use a separate metadata search index for this object type option for
essential object types that are frequently used and that are found in large number in the vault.
Since these essential object types vary from organization to organization, the option is disabled by default.
In document management, for example, the Document object type is naturally the most important object
type. In CRM vaults, however, the most important object types are usually something different, such as
Customer, Project, and Contact person.
If you select this option, M-Files uses a separate search structure for the objects of the selected object
type. This improves search speed for both the objects of the selected object type and for other objects –
especially if the vault contains a high number of objects representing this key object type.
Note: Enabling this option might take a long time to complete, from a couple of minutes up to a few
hours. The vault is also taken offline for the duration of this operation and the users cannot access
the vault.
To enable a separate metadata search index for an object type:
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1. In M-Files Admin, go to the Advanced tab of the Object Type Properties dialog for the object type that
you want to modify.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Expand Metadata Structure (Flat View) and then select Object Types.
The Object Types list is opened in the right pane.
f) Double-click the object type that you want to modify.
The Object Type Properties dialog is opened.

g) Click the Advanced tab.
2. Select the Use a separate metadata search index for this object type check box.
3. Click OK.
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M-Files now uses a separate search index for the objects of the selected object type.
Defining Aliases for an Object Type
Aliases can be used for identifying semantically equivalent metadata. For example, when importing objects
from another vault, their Date and Description properties can be mapped to the target vault's equivalent
properties on the basis of aliases even if the properties' internal IDs, names, or both are different. That
is, the aliases refer to semantically equivalent metadata in different vaults, or in other words, alias is a
common ID for the same metadata definition between several vaults.
The alias is defined as a common ID with the same name in both source and target vault.
When you define the alias, you can use various external data type and archive standards, such as
SÄHKE2, MoReq2, and Dublin Core.
For more information, see Associating the Metadata Definitions.
To define aliases for an object type:
1. In M-Files Admin, go to the Advanced tab of the Object Type Properties dialog for the object type that
you want to modify.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Expand Metadata Structure (Flat View) and then select Object Types.
The Object Types list is opened in the right pane.
f) Double-click the object type that you want to modify.
The Object Type Properties dialog is opened.
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g) Click the Advanced tab.
2. In the Aliases field, enter the aliases for the selected object type.
If you need to define more than one alias, separate the aliases using semicolons (;).
ObjectType.Customers; OT.Customers
When you have automatic aliases in use and you write a name on the General tab, the Aliases
field on the Advanced tab is automatically filled in. The alias has the format <predefined
prefix>.<name>. Define automatic aliases for your vault in the configurations editor.
3. Click OK.
Object Type Permissions
Access for viewing this object type and creating objects of this type can be defined on the Permissions
tab.
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If the user does not have the permission to view the name of the object type, it is not available for selection
in M-Files Desktop (for example when you are creating a new object or search). Even if the object type
name is hidden, the user can see the objects themselves in views or search results, for example.
If you cannot see the object type name, you do not have the permission to create objects of this type
either. However, the user may have the permission to see the name without having permission to create
new objects.
Adjusting Permissions
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click a node that contains items that you want to edit. For example, Users.
Permissions settings are available for these items:
•
•
•
•
•
•
•
•
•

Users
User groups
Object types
Value lists
Property definitions
Classes
Class groups
Workflows
Named access control lists

6. Select an item in the listing area.
7. Right-click the item and click Properties.
8. Go to the Permissions tab.
9. In Users and user groups, select the user or user group whose permissions you want to adjust.

If the user or user group is not on the list, click Add to add the user or user group to the list.
10.Select one of these options:
a. Select the Allow check box to allow the selected user to see this item.
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or
b. Select the Deny check box to deny the selected user from seeing this item.
11.Optional: If you want to adjust additional permissions, repeat the steps from 7 to 10.
12.Click OK.
Connections to External Databases for Object Types
You can set M-Files to update object types to and from an external database.
This section tells you how to define object types to use an application connection to an external database.
To use the legacy database connection, see the section "Using the Legacy Database Connection for
Object Types".
Note: It is not possible to include the configuration for External Object Type Connector to
replication packages.
If you use replication and application connection to an external database service, you must configure the
connection separately for each vault in the replication scheme. Make sure that the necessary configuration
changes are also made to each vault.
Before you set up the application connection to an external database, make sure that:
•

You have an external object type connector installed and enabled. If you use the Ground Link service,
the connector must be enabled on the Ground Link proxy. If you use a local service, the connector must
be enabled in the vault.
•

•

By default, M-Files OLE DB External Object Type Connector is installed but disabled. To use M-Files
OLE DB External Object Type Connector, a license is not necessary.
• For instructions on adding connectors and managing vault applications, see Adding a Connector and
Installing and Managing Vault Applications.
The connector supports the application connection.

To use a connection to external database and to open the service configuration:
1. Open M-Files Admin and go to a vault.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
2. Expand Metadata Structure (Flat View).
3. Click Object Types.
The object type listing is opened in the right pane.
4. In the right-pane listing, double-click the object type.
The Object Type Properties dialog is opened.
5. Go to the Connection to External Database tab and enable the option Use a connection to an
external database to import and modify objects that reside in the external database.
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6. Select Application connection.
7. In Service, select the service.
Option

Description

M-Files OLE DB at vault <name of the
vault>

Select this option to use the local service.

M-Files OLE DB from Ground Link proxy Select this option to establish the connection
using a remote service via Ground Link.
<name of the Ground Link proxy>
The services that have the (OK) suffix, have a configuration for the object type.
Information of the service configuration with possible errors is shown.
8. Click Configure.
The External Object Type Connector dialog is opened.
To specify the connection settings and to get the source columns:
9. Expand Service-Specific Settings > Connection to External Database.
10.In Provider, select the provider for the external database connection.
Microsoft OLE DB Driver for SQL Server.
Note: The list of providers shows all the available providers on the server machine that
runs the external object type connector. Thus, it can include providers that cannot be
used in external database connections.
The syntax of the connection string is different for each Object Linking and Embedding Database
(OLE DB) supplier used for establishing the connection to the external database. If Open
Database Connectivity (ODBC) is necessary to create the connection, the data store must
be accessed over OLE DB and ODBC. For a list of recommended providers, see Provider
Recommendations for External Database Connections.
11.Optional: If you selected Custom provider (manual configuration), in Custom provider, specify the
provider.
12.Under Connection to External Database, complete one of these steps:
Option
Specify the other settings.

Description
The correct values are different for each provider
and external database.
For more information, select a setting and see the
Info tab.

In Advanced Options, enter the connection
string.

Use this option if it is not possible to use the other
settings with the selected provider. When you
enter the connection string, make sure that all
values are correctly enclosed and the connection
string has the necessary formatting.
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13.Optional: Under Optional SELECT Statements, define the settings.
Note: The application connection does not support the Connections to External
Databases settings in the Advanced Vault Settings section in M-Files Admin. To use
these settings, define them here.
14.Under Service-Specific Settings, in SELECT Statement, write the SELECT statement for getting
source columns from the external database.
Examples of SELECT statements:
SELECT CustomerNumber, CustomerName FROM Customer
SELECT ID, Name + ' ' + Department FROM Company
SELECT ID, Name, CustomerID FROM Contacts
SELECT * FROM Customer
Tip: You can write a multi-line statement.

15.Click Save.
16.Optional: To configure a remote service:
a) Click Apply.
The Enter Password dialog is opened.
b) Enter the password that is defined in the Ground Link proxy configuration.
c) Click OK.
17.To authenticate the common user, open the Dashboard tab and click Authenticate.
The Log In dialog is opened.
18.Enter the common user credentials and click Log In.
Note: The ODBC driver does not support all special characters. If your connection uses
ODBC, the values that contain special characters must be enclosed in curly brackets.
The correct format is {username or password}.
19.In the dialog that is opened, click OK.
20.Click Save to get the source columns.
a) Optional: To configure a remote service, repeat step 16.
Note: You cannot save the configuration if there are no changes.
The dialog closes and the configuration refreshes. On the Configuration tab, the Column
Mappings section shows the source columns that your SELECT statement returned from the
external database.
To map the source columns with M-Files properties:
21.On the Configuration tab, go to Column Mappings and expand a source column node.
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22.In Mapping Type, specify how the source column is mapped to M-Files. Complete one of these steps:
a. To map a source column as the external ID, select Object ID.
or
b. To map the source column to an M-Files property, select Property. In Target Property, select the
M-Files property.
Note: When you want to map multiple values to a property of the Choose from list
(multi-select) data type, the values must be recorded on their own rows in the external
database. For example, if you want to map multiple values to the Industry property, the
values must be recorded like this:
ID

Customer
name

City

Industry

Active

ABC-123

ESTT
Corporation

New York

100

1

ABC-123

ESTT
Corporation

New York

101

1

ABC-123

ESTT
Corporation

New York

108

1

In this case, however, data can only be read from, not recorded to the external database.
23.Optional: If the Mapping Type is Property, specify the settings Use in Update Operation and Use in
Insert Operation and define the related statements.
If you want to...

Complete the following steps:

Allow read-only access

Set the Use in Update Operation and Use in Insert Operation
settings to No. Do not specify the statements in this table.

Allow users to update but not
create or delete information

Allow users to update, create,
and delete information

a. Set the Use in Update Operation to Yes.
b. Under Service-Specific Settings, in UPDATE statement, write
the UPDATE statement.

a. Set the Use in Update Operation and Use in Insert Operation
settings to Yes.
b. Under Service-Specific Settings, write the four statements in
this table.

Statement

Definition

UPDATE

When you edit an object in MFiles, M-Files Server edits the
corresponding record in the external
database using an UPDATE
statement. Use a question mark (?) to
signal columns to be updated.

Examples
UPDATE Customers SET
CustomerName = ? WHERE
CustomerID = ?
UPDATE Contact SET Name
= ?, CustomerID = ? WHERE
ContactID = ?
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Statement

Definition

INSERT INTO

When you create a new object in
M-Files, M-Files Server adds a
corresponding record into the external
database using an INSERT INTO
statement. Use a question mark (?) to
indicate the value of each column.
Note: The INSERT INTO
statement input to M-Files
does not define a value for
the ID column. The external
database should be set up to
automatically provide an ID
for new records. For example
in SQL Server databases,
set the type of the ID column
as identity. If the external
database cannot produce new
ID values, the INSERT INTO
statement cannot be used.

Get ID SELECT

After a new record has been created
with the INSERT INTO statement, MFiles Server gets the ID of the newly
created record with this SELECT
statement.

DELETE

When you delete an object from MFiles, M-Files Server deletes the
corresponding record in the external
database using a DELETE statement.
Use a question mark (?) for the ID of
the record to be deleted.

Examples
INSERT INTO
Customers( CustomerName )
VALUES( ? )
INSERT INTO
ContactPersons( Name,
CustomerID )
VALUES( ?, ? )

SELECT MAX( CustomerID )
FROM Customer

DELETE FROM Customers
WHERE CustomerID = ?
DELETE FROM Contacts
WHERE ContactID = ?

24.Repeat the steps from 21 to 23 for all the necessary source columns.
To take the configuration into use:
25.Under General Settings, set Enabled to Yes.
Tip: You can enable and disable the external database connection also with the
Disabled check box on the Connection to External Database tab of the Object Type
Properties dialog.
If the connection is disabled, information between the vault and the external database is
not synchronized.
26.Optional: To configure a remote service:
a) Click Apply.
The Enter Password dialog is opened.
b) Enter the password that is defined in the Ground Link proxy configuration.
c) Click OK.
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27.Click OK to close the Object Type Properties dialog.
The object type is now updated to and from the external database.

In this chapter
•
•
•

Using the Legacy Database Connection for Object Types
Refreshing External Object Types
Provider Recommendations for External Database Connections

Using the Legacy Database Connection for Object Types
1. Do the steps from 1 to 5 in Connections to External Databases for Object Types.
2. In M-Files Admin, in the Connection to External Database tab of the Object Type Properties dialog,
select Legacy database connection.
3. Click Configure.
The Configure Connection to External Database dialog is opened.
4. Click the Define button next to the OLE DB connection string (from server) field.
The syntax of the connection string is different for each Object Linking and Embedding Database
(OLE DB) supplier used for establishing the connection to the external database. If Open
Database Connectivity (ODBC) is necessary to create the connection, the data store must
be accessed over OLE DB and ODBC. For a list of recommended providers, see Provider
Recommendations for External Database Connections.
Note: M-Files Admin only displays OLE DB providers that are available on the computer
running M-Files Admin. If your M-Files Server resides on a different host, make sure that
the selected OLE DB connection string works from the computer running M-Files Server
as well.
The Data Link Properties dialog is opened.
5. On the Provider tab, select Microsoft OLE DB Driver for SQL Server from the list and click Next >>.
Other providers can have different options on the Connection and Advanced tabs. The All tab
contains all the available connection properties as a name–value table.
Note: We do not recommend the use of Microsoft Access Database Engine
Redistributables to import value lists or object types from an Excel file.
The Connection tab of the Data Link Properties dialog is opened.
6. To the Select or enter a server name field, write the name of your Microsoft SQL Server.
7. In the Enter information to log on to the server section, select:
a. Windows Authentication: Select this option to use a Microsoft Windows account for logging in. In
this case, the connection uses the credentials that are used for running the M-Files Server service.
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or
b. SQL Server Authentication: Select this option to use a Microsoft SQL Server login. Enter the
credentials in the User name and Password fields, and select the Allow saving password check
box.
Note: The ODBC driver does not support all special characters. If your connection uses
ODBC, the values that contain special characters must be enclosed in curly brackets.
The correct format is {username or password}.
8. For the Select the database section, complete one of these steps:
a. Use the drop-down menu to select the database on the specified server.
or
b. Enter a database name to the Attach a database file as a database name field and click the ...
button to select a Microsoft SQL Server Database (MDF) file.
9. Optional: Click Test Connection to make sure that your database connection operates correctly.
10.Optional: On the Advanced tab, define a timeout period for the database connection.
11.Click OK to close the Data Link Properties dialog.
The connection string is added to the OLE DB connection string (from server) field.
12.In the Configure Connection to External Database dialog, to the SELECT statement field, enter the
SELECT statement for getting source columns from the external database.
Examples of SELECT statements:
SELECT CustomerNumber, CustomerName FROM Customer
SELECT ID, Name + ' ' + Department FROM Company
SELECT ID, Name, CustomerID FROM Contacts
SELECT * FROM Customer
13.Click Refresh Columns to get the source columns.
The Columns listing shows correspondences between columns retrieved from the external
database (Source Column) and M-Files properties (Target Property).
14.Map the Source Column properties with properties in your M-Files vault (listed in the Target Property
column).
Note: When you want to map multiple values to a property of the Choose from list
(multi-select) data type, the values must be recorded on their own rows in the external
database. For example, if you want to map multiple values to the Industry property, the
values must be recorded like this:
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ID

Customer
name

City

Industry

Active

ABC-123

ESTT
Corporation

New York

100

1

ABC-123

ESTT
Corporation

New York

101

1

ABC-123

ESTT
Corporation

New York

108

1

In this case, however, data can only be read from, not recorded to the external database.
15.Select the check boxes in the Update and Insert columns and define the four statements below the
Columns listing.
If you want to...

Complete the following steps:

Allow read-only access

Do not select the check boxes and leave the statements empty.

Allow users to update but not
create or delete information

Allow users to update, create,
and delete information

a. Select the check boxes in the Update column for the necessary
properties.
b. Click the Default button next to the UPDATE statement field.
You can also enter your statements to the fields.

a. Select the check boxes in the Update and Insert columns for
the necessary properties.
b. Click the Default button next to the UPDATE, INSERT INTO,
SELECT, and DELETE statement fields. You can also enter
your statements to the fields.

The table below explains the use of the four statements mentioned above.
Statement

Definition

UPDATE

When you edit an object in MFiles, M-Files Server edits the
corresponding record in the external
database using an UPDATE
statement. Use a question mark (?) to
signal columns to be updated.

Examples
UPDATE Customers SET
CustomerName = ? WHERE
CustomerID = ?
UPDATE Contact SET Name
= ?, CustomerID = ? WHERE
ContactID = ?
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Statement

Definition

INSERT INTO

When you create a new object in
M-Files, M-Files Server adds a
corresponding record into the external
database using an INSERT INTO
statement. Use a question mark (?) to
indicate the value of each column.
Note: The INSERT INTO
statement input to M-Files
does not define a value for
the ID column. The external
database should be set up to
automatically provide an ID
for new records. For example
in SQL Server databases,
set the type of the ID column
as identity. If the external
database cannot produce new
ID values, the INSERT INTO
statement cannot be used.

SELECT

After a new record has been created
with the INSERT INTO statement, MFiles Server gets the ID of the newly
created record with this SELECT
statement.

DELETE

When you delete an object from MFiles, M-Files Server deletes the
corresponding record in the external
database using a DELETE statement.
Use a question mark (?) for the ID of
the record to be deleted.

Examples
INSERT INTO
Customers( CustomerName )
VALUES( ? )
INSERT INTO
ContactPersons( Name,
CustomerID )
VALUES( ?, ? )

SELECT MAX( CustomerID )
FROM Customer

DELETE FROM Customers
WHERE CustomerID = ?
DELETE FROM Contacts
WHERE ContactID = ?

16.Click OK to close the Configure Connection to External Database dialog.
17.Optional: Select the Disabled check box to temporarily disable the external database connection.
If the connection is disabled, information between the vault and the external database is not
synchronized.
18.Click OK to close the Object Type Properties dialog.
The object type is now updated to and from the external database.
Refreshing External Object Types
There are two types of refresh operations for external object types:
•
•

full refresh
quick refresh

A full refresh detects new items, compares and updates existing items, and deletes items that have
disappeared from the external database. A quick refresh, by default, only detects new items in the external
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database. It does not compare existing items. It does not delete items, either, because undeleting them
would require a full refresh.
The quick refresh operation is notably quicker than the full refresh operation. For reference, the full refresh
operation for 120,000 items takes about two minutes, while the quick refresh operation finishes in about
seven seconds. For simple value lists, refreshing data is fast even with large amounts of data and therefore
a full refresh is always used. This guarantees up-to-date data.
Refreshing external object types manually
External object types can be refreshed in M-Files Desktop by pressing the Alt key and selecting Settings >
Refresh External Objects and then by selecting a suitable external object type from the submenu. You
can select either the Quick Refresh or the Full Refresh operation.
If you try to refresh an external object type at the same time with M-Files Server, the operation started by
you begins after the one started by M-Files Server.
Refreshing external object types via M-Files Admin
You can initiate or stop the full refresh operation for any external object type in M-Files Admin. To start the
operation, right-click the object type under Metadata Structure (Flat View) and click Refresh Now.
The full refresh operation is also triggered if you edit the object type definitions in M-Files Admin. If you
update the object type definition before the previous refresh operation has completed, M-Files starts the
operation again.
Automatic refresh operations and configuration options
The quick refresh operation is started automatically if an external object type is requested by a client (for
instance, the metadata card containing a property that uses an external object type is viewed) and if the
latest refresh was executed more than 15 minutes ago.
A full refresh operation is initiated for all external object types at 4:30 AM server time every night. This
operation is executed as one part of the daily maintenance routine.
A full refresh operation is automatically triggered instead of a quick refresh operation if an external object
type is requested by the client and if a full refresh has not been performed within the last 25 hours.
For configuration options available for refreshing external object types automatically, see the document
Default Refresh Logic and Configuration Options for External Value Lists and Object Types.
Automatic property values ignored during refresh operations
When M-Files updates objects to and from an external database, it compares object properties in the
external database to the ones in the vault. If M-Files finds differences in the properties, it updates the
objects. During the comparison, properties with an automatically calculated value are ignored, which
causes these scenarios:
•
•

If all the object's property values to be updated to or from an external database are set to have an
automatically calculated value in M-Files, the object is not updated.
If the refresh operation creates an object in M-Files, all property values of the object are filled with
the values from the external database. This includes properties that are set to have an automatically
calculated value.
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•

If the refresh operation updates the object's properties in M-Files, all the object's property values to be
updated get their value from the external database. This includes properties that are set to have an
automatically calculated value.

Provider Recommendations for External Database Connections
The table below lists the recommended OLE DB providers to be used for an external database connection
(see Connections to External Databases for Object Types).
Database

Provider

Microsoft
SQL
Server

Microsoft OLE DB Driver for SQL Server (MSOLEDBSQL)
Note: Using the following, deprecated providers is not recommended:
•
•

MySQL

Microsoft OLE DB Provider for SQL Server (SQLOLEDB)
SQL Server Native Client OLE DB Provider (SQLNCLI)

Microsoft OLE DB Provider for ODBC Drivers (MySQL Connector/ODBC).
•
•
•
•

Use the Data sources (ODBC) administrative tool to configure a new system data source.
Select MySQL Connector/ODBC as the ODBC driver.
Define the data source.
Under driver properties, select the Disable Transactions check box.

In connection settings, select Microsoft OLE DB Provider for ODBC Drivers as the provider
and the system data source you defined as the data source. The default collection in the
connection settings remains empty. Thus you only define the database in the driver settings.
You can also use MySql.OLEDB Provider with MySQL.

Value Lists
A value list contains various values, such as city names. The same value list can be utilized in several
different properties.
A value list is one of the M-Files data types. Creating and using value lists makes it significantly faster
to specify metadata for a document. In many cases, selecting a value from the list is more sensible than
typing it in each time. On the other hand, not all values can reasonably be selected from a list, such as the
title of the object.
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Figure 69: Value lists can be used for storing and selecting preset values for metadata properties. Several different properties can be
based on the same value list.

Complete the steps below to view the value lists in your vault:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and then select Value Lists.
You should now be able to see the available value lists in the right-side listing view. To also display the
built-in value lists, click Show All Value Lists in the task area.

In this chapter
•
•
•
•
•

New Value List
Value List Contents (Individual Values)
Advanced Value List Properties
Value List Permissions
Connections to External Databases for Value Lists

New Value List
A value list can either be internal or external.
The contents of an internal value list are saved in the document vault database, meaning that the list is
used only inside the document vault. An external value list, on the other hand, can be updated from an
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external database. In this case, you need to define how the server is to retrieve the value list contents from
the other database. For example, an employee database running on an external database server can be
connected to the M-Files value lists by defining the database connection. See Connections to External
Databases for Value Lists.
Creating a New Value List
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View), and then select Value Lists.
6. In the task area, click New Value List.
The Value List Properties dialog is opened.
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7. In the Name (singular) and Name (plural) fields, enter the name of the new value list respectively in
singular (for example, Client) and plural (for example, Clients) forms.
8. Optional: Check the Allow users to add new values to this list if you want to allow users to add new
values to the value list.
9. From the Default permissions for new values drop-down menu, select the default permissions for
new values in this value list.
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10.Optional: Check the Allow this value list to be used as a grouping level in views check box to allow
this value list to used for defining a grouping level within a view.
11.Optional: On the Advanced tab, set hierarchical relationships for the value list.
See Advanced Value List Properties for more information.
12.Optional: On the Permissions tab, you can specify the users who may see this value list or add new
values to it.
See Value List Permissions for more information.
13.Optional: On the Connection to External Database, set the connection to an external database for
importing value list contents from an external database source.
For further instructions, Connections to External Databases for Value Lists.
14.Click OK to finish creating the value list.
The new value list is added to the Value Lists list.
Converting a Value List to an Object Type
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and then select Value Lists.
6. From the Value Lists list, select the value list that you want to convert to an object type.
7. In the task area, click Convert to Object Type.
The Convert to Object Type dialog appears.
8. You are prompted to confirm that you want to convert the selected value list to an object type. Click
Yes.
Once you have clicked Yes, you cannot undo the conversion.
The selected value list is converted to an object type and removed from the Value Lists list and added to
the Object Types list.
Value List Contents (Individual Values)
You can create new items for the value list as well as new subitems for internally hierarchical values. You
can also define hierarchical relationships between value list items (see Defining a Hierarchical Relationship
Between Value Lists). Additionally, you can set value-specific permissions as well as default permissions
for objects that use the item.
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Figure 70: The "Contact persons" value list used as a sublist for the "Customers" value list.

Permissions
By selecting a value list item and clicking the Permissions... button, you can specify the users who may
see this value list item. This way, you can make a value list value to be visible to a specific target group
only.
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Automatic permissions
An object receives automatic permissions when a value with automatic permissions is added to the object
metadata.
You can activate the automatic permissions by value, value list, object type, or class by clicking
Permissions... in the Value List Contents dialog and then selecting the Automatic Permissions tab. For
more information, see Automatic Permissions for Value List Items.

In this chapter
•
•

Adding Values to a Value List
Automatic Permissions for Value List Items

Adding Values to a Value List
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View).
6. Click Value Lists.
The Value Lists list is opened in the right pane.
7. Right-click a value list to which you want to add individual values and select Contents... from the
context menu.
The Value List Contents dialog is opened.
8. Click the New Item button.
A new value titled New Item is added to the selected value list.
9. Type in an appropriate name for the new value.
You can rename existing values by selecting a value from the list and clicking the Rename
button.
10.Optional: Click Permissions... to specify the users who may see this value list item.
For detailed instructions, see Value List Permissions and Automatic Permissions for Value List
Items.
11.Optional: Click Change Icon... to change the icon of the value list item.
In addition to being able to add icons for object types, you can add, change, and remove icons
for value list items. This allows you to further increase the clarity of the M-Files user interface.
Specific icons can be assigned to, for instance, workflow states and meeting types. Since
workflow states can be changed directly with the shortcuts in the task area or from the metadata
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card, icons can be used to make the states visually more distinguishable. For more instructions,
see Changing the Icon of a Value in a Value List.
12.Optional: Repeat steps from 6 to 9 to add another value.
13.Click Close when you are done.
The new values are added to the selected value list.
Changing the Icon of a Value in a Value List
In addition to being able to add icons for object types, you can add, change, and remove icons for value list
items. This allows you to further increase the clarity of the M-Files user interface.
Specific icons can be assigned to, for instance, workflow states and meeting types. Since workflow states
can be changed directly with the shortcuts in the task area or from the metadata card, icons can be used to
make the states visually more distinguishable.
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and then select Value Lists.
The Value Lists list is opened in the right pane.
6. Optional: To show the built-in value lists, click Show All Value Lists.
7. Right-click a value list that you want to edit and select Contents from the context menu.
The Value List Contents dialog is opened.
8. Select a value from the list and click the Change Icon button.
The Change Icon dialog is opened.
9. Either:
a. Select an icon from the list of icons.
or
b. Click Browse to browse for a different icon file and then select an icon from the list of icons.
10.Click OK to change the icon and close the Change Icon dialog.
11.Repeat the steps from 6 to 8 to change the icon for another value.
12.Click Close when you are done to close the Value List Contents dialog.
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Automatic Permissions for Value List Items
You can use automatic permission settings to pass permissions for an object when the object has a
property value, object type or class that uses automatic permissions. The object receives automatic
permissions when a value with automatic permissions specified is added to the object metadata.
Note: Micro Focus IDOL and Smart Search: If more than four automatic ACL sources control the
permissions of an object, only administrators can see it in search results.
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Figure 71: The "Automatic Permissions" dialog for a value list item.

In the above example, automatic permissions have been activated. Read-only access has been granted to
all users and a separate access to project managers.
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Restrict the permissions of objects that refer to this value
Activate the function Restrict the permissions of objects that refer to this value when you want to activate
the automatic permissions.
Use the value's own permissions
You can use the permissions of a value or object, such as a project, as automatic permissions.
In this type of case, for example, a project plan inherits the permissions of the project that is added as a
value to the metadata of the project plan. For example, the user has defined permissions for the project
House project Haven that allow access for the project manager and project group only. When this project is
added to the metadata of a project plan, the same permissions are granted to the plan.
Note: Automatic permissions are not inherited indirectly. Let's say we have the object "Hugh Brent"
that inherits automatic permissions via the "Look Up Company" property. These permissions are no
longer inherited by the "CRM Application Development" object that has "Hugh Brent" as one of its
property values.
Name
Give as descriptive a name as possible to the automatic permissions set, because this information will be
displayed in the client software.
Specify permissions
You can then specify the automatic permissions that are always activated automatically for the object when
a value, object, or class using automatic permissions is added to the object's metadata.
For more information on permissions, see Object Permissions. Also refer to the specification of pseudousers in Pseudo-users.
Note: If you do not explicitly allow any permissions, using this kind of value or object restricts all
permissions for the final object.
Allow users to deactivate these restrictions
You can also specify whether the users are allowed to deactivate the automatic permission restrictions
created via this value, so that the users can delete the preset automatic permissions if they so desire.
Remarks about using automatic permissions
The specified value providing automatic permissions must be selected on the metadata card for the explicit
property definition for which you have enabled automatic permissions. See Verifying Which Properties
Have Automatic Permissions Enabled.
Note: The value-specific settings always have priority over the settings made at value list and
object type level.
Enabling Automatic Permissions for a Value List Item
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
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3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and then select Value Lists.
The Value Lists list is opened in the right pane.
6. Right-click a value list that you want to edit and select Contents... from the context menu.
The Value List Contents dialog is opened.
7. Select a value list item that you want to edit and click the Permissions... button.
The Permissions dialog is opened.
8. On the Automatic Permissions tab, check the Restrict the permissions of objects that refer to this
value check box.
9. Do one of the following:
If you want to

Do the following

Use the existing permissions of the value as
automatic permissions

Check the Use the value's own permissions
check box.

Use an existing named access control list as
automatic permissions

Check the Use named access control list check
box and, using the drop-down menu, select a
named access control list.

Define new permissions to be used as
automatic permissions

In the Name field, type in a name for the
permissions, click Add... to add users or user
groups affected by these permissions, and select
the appropriate Allow or Deny check boxes on
the Permissions list.

10.Optional: Select the Allow users to deactivate these restrictions check box if you want to give users
the option to disable the automatically set permissions and employ user-defined permissions instead.
11.Click OK to close the Permissions dialog.
12.Click Close to close the Value List Contents dialog.
The selected value now has automatic permissions defined. When this value is added to the metadata of
an object, the object receives the automatic permissions defined for the value.
Verifying Which Properties Have Automatic Permissions Enabled
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View).
6. Select Property Definitions.
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You can see which properties have automatic permissions enabled in the Automatic Permissions column
of the listing area.
Advanced Value List Properties
Value list hierarchy
Value lists can have two types of hierarchical relationships:
•
•

Internal hierarchies withing individual value lists
Hierarchies between separate value lists
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Figure 72: In the advanced settings, various hierarchical relationships can be defined.

Defining an Internal Hierarchy for a Value List
A value list can be hierarchical in itself, meaning that it can contain items and subitems. A parent item
collects related subitems. This way, you can create, for example, a value list containing all drawing types
hierarchically. The parent object can be for instance a floor plan, with floor plans in different scales as its
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subobjects. Regardless of their internal hierarchy, all items in the hierarchical value list represent the same
concept (for example, the parent item Floor plan and its subitems Floor plan 1:100 and Floor plan 1:50).
Do the following steps to define an internal hierarchy for a value list:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and then select Value Lists.
The Value Lists list is opened in the right pane.
6. Double-click the value list that you want to edit.
The Value List Properties dialog is opened.
7. Open the Advanced tab, and check This value list is a sublist of the following value list check box.
8. Using the drop-down menu, select the Same list (defines a value list with internal hierarchy) option.
9. Click the Contents... button.
The Value List Contents dialog is opened.
10.Select an item on the list for which you want to create a subitem and click New Subitem.
11.Type in an appropriate name for the new item.
You can also rename the item later by selecting the item in the list and clicking Rename.
12.Optional: If you want to create additional subitems, repeat the steps 10 and 11.
13.Click Close when you are ready.
The value list items that you have just created are added to the value list as subitems of the selected
owner value list items. When you assign a value to a property from the aforementioned value list, you can
select a subitem by clicking the down arrow next to a value list item to expand its subitems.
Defining a Hierarchical Relationship Between Value Lists
If a parent item and subitems represent different concepts, such as countries and their cities, separate
value lists must be created for the items and the value lists must be defined as two hierarchically related
value lists. In such a case, the item in the Countries value list (country name) is the owner value for the
items in the Cities value list. The Countries value list is then the higher-level list and the Cities list is its
sublist.
Do the following steps to define a hierarchical relationship between two value lists:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.

M-Files | 3. System Administration | 405
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and then select Value Lists.
The Value Lists list is opened in the right pane.
6. Double-click the value list that you want to define as a sublist of a higher-level list.
Make sure that the property definition using this value list uses automatic filtering. For more
information, see Property Definitions.
The Value List Properties dialog is opened.
7. Open the Advanced tab, and check This value list is a sublist of the following value list check box.
8. Using the drop-down menu, select the value list that you want to set as the owner of this value list.
9. Click OK to save your changes and close the Value List Properties dialog.
10.In the Value Lists list, find the value list that you have just set as the owner of the previous value list,
right-click it, and select Contents... from the context menu.
The Value List Contents dialog is opened.
11.In the upper list, select the owner item for which you want to add a subitem.
12.Next to the lower list, click New Item.
A new value list item is added to the lower list.
13.Type in an appropriate name for the new subitem.
You can also rename the item later by selecting the item in the list and clicking Rename.
14.Optional: If you want to create additional subitems, repeat the steps from 11 to 13.
15.Click Close when you are ready to save your changes and close the Value List Contents dialog.
The selected value list is defined as a sublist of the selected owner value list. When you assign a value to a
property from the owner value list in M-Files, you can then also assign any associated subvalues from the
sublist.
Default for automatic permissions
You can activate the automatic permissions by value, value list, object type, or class. You can specify the
automatic permissions for each value list in the same way as for each value. The automatic permissions
are attached to an object when a value with automatic permissions is added for the object.
Note: The value-specific settings always have priority over the settings made at value list and
object type level.
The contents of this value list can be translated
Enable this option to allow the contents of the selected value list to be translated to different languages.
For more information, see Languages and Translations.
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Value list aliases
Using the Aliases field, you can define an alias for the value list. For more information, see Associating the
Metadata Definitions.
When you have automatic aliases in use and you write a name on the General tab, the Aliases field on
the Advanced tab is automatically filled in. The alias has the format <predefined prefix>.<name>. Define
automatic aliases for your vault in the configurations editor.
Value List Permissions
Access for viewing this value list and creating items to the list can be defined on the Permissions tab.
If the user does not have the permission to view the name of the value list, it is not available for selection in
M-Files (for example, when you are creating a new search).
If the user cannot see the value list, the user does not have the permission to create items to it either.
However, the user may have the permission to see the list without having the permission to create new
items.
Adjusting Permissions
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click a node that contains items that you want to edit. For example, Users.
Permissions settings are available for these items:
•
•
•
•
•
•
•
•
•

Users
User groups
Object types
Value lists
Property definitions
Classes
Class groups
Workflows
Named access control lists

6. Select an item in the listing area.
7. Right-click the item and click Properties.
8. Go to the Permissions tab.

M-Files | 3. System Administration | 407
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
9. In Users and user groups, select the user or user group whose permissions you want to adjust.

If the user or user group is not on the list, click Add to add the user or user group to the list.
10.Select one of these options:
a. Select the Allow check box to allow the selected user to see this item.
or
b. Select the Deny check box to deny the selected user from seeing this item.
11.Optional: If you want to adjust additional permissions, repeat the steps from 7 to 10.
12.Click OK.
Connections to External Databases for Value Lists
You can set M-Files to update value lists to and from an external database.
This section tells you how to define value lists to use an application connection to an external database. To
use the legacy database connection, see the section "Using the Legacy Database Connection for Value
Lists".
Note: It is not possible to include the configuration for External Object Type Connector to
replication packages.
If you use replication and application connection to an external database service, you must configure the
connection separately for each vault in the replication scheme. Make sure that the necessary configuration
changes are also made to each vault.
Before you set up the application connection to an external database, make sure that:
•

You have an external object type connector installed and enabled. If you use the Ground Link service,
the connector must be enabled on the Ground Link proxy. If you use a local service, the connector must
be enabled in the vault.
•

•

By default, M-Files OLE DB External Object Type Connector is installed but disabled. To use M-Files
OLE DB External Object Type Connector, a license is not necessary.
• For instructions on adding connectors and managing vault applications, see Adding a Connector and
Installing and Managing Vault Applications.
The connector supports the application connection.

To use a connection to external database and to open the service configuration:
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1. Open M-Files Admin and go to a vault.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
2. Expand Metadata Structure (Flat View).
3. Click Value Lists.
The value list listing is opened in the right pane.
4. In the right-pane listing, double-click the value list.
The Value List Properties dialog is opened.
5. Go to the Connection to External Database tab and enable the option Use a connection to an
external database to import and modify objects that reside in the external database.
6. Select Application connection.
7. In Service, select the service.
Option

Description

M-Files OLE DB at vault <name of the
vault>

Select this option to use the local service.

M-Files OLE DB from Ground Link proxy Select this option to establish the connection
using a remote service via Ground Link.
<name of the Ground Link proxy>
The services that have the (OK) suffix, have a configuration for the value list.
Information of the service configuration with possible errors is shown.
8. Click Configure.
The External Object Type Connector dialog is opened.
To specify the connection settings and to get the source columns:
9. Expand Service-Specific Settings > Connection to External Database.
10.In Provider, select the provider for the external database connection.
Microsoft OLE DB Driver for SQL Server.
Note: The list of providers shows all the available providers on the server machine that
runs the external object type connector. Thus, it can include providers that cannot be
used in external database connections.
The syntax of the connection string is different for each Object Linking and Embedding Database
(OLE DB) supplier used for establishing the connection to the external database. If Open
Database Connectivity (ODBC) is necessary to create the connection, the data store must
be accessed over OLE DB and ODBC. For a list of recommended providers, see Provider
Recommendations for External Database Connections.
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11.Optional: If you selected Custom provider (manual configuration), in Custom provider, specify the
provider.
12.Under Connection to External Database, complete one of these steps:
Option

Description

Specify the other settings.

The correct values are different for each provider
and external database.
For more information, select a setting and see the
Info tab.

In Advanced Options, enter the connection
string.

Use this option if it is not possible to use the other
settings with the selected provider. When you
enter the connection string, make sure that all
values are correctly enclosed and the connection
string has the necessary formatting.

13.Optional: Under Optional SELECT Statements, define the settings.
Note: The application connection does not support the Connections to External
Databases settings in the Advanced Vault Settings section in M-Files Admin. To use
these settings, define them here.
14.Under Service-Specific Settings, in SELECT Statement, write the SELECT statement for getting
source columns from the external database.
Examples of SELECT statements:
SELECT CustomerNumber, CustomerName FROM Customer
SELECT ID, Name + ' ' + Department FROM Company
SELECT ID, Name, CustomerID FROM Contacts
SELECT * FROM Customer
Tip: You can write a multi-line statement.

15.Click Save.
16.Optional: To configure a remote service:
a) Click Apply.
The Enter Password dialog is opened.
b) Enter the password that is defined in the Ground Link proxy configuration.
c) Click OK.
17.To authenticate the common user, open the Dashboard tab and click Authenticate.
The Log In dialog is opened.
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18.Enter the common user credentials and click Log In.
Note: The ODBC driver does not support all special characters. If your connection uses
ODBC, the values that contain special characters must be enclosed in curly brackets.
The correct format is {username or password}.
19.In the dialog that is opened, click OK.
20.Click Save to get the source columns.
a) Optional: To configure a remote service, repeat step 16.
Note: You cannot save the configuration if there are no changes.
The dialog closes and the configuration refreshes. On the Configuration tab, the Column
Mappings section shows the source columns that your SELECT statement returned from the
external database.
To map the source columns with M-Files properties:
21.On the Configuration tab, go to Column Mappings and expand a source column node.
22.In Mapping Type, specify how the source column is mapped to M-Files.
•
•
•
•

To map a source column as the external ID, select Object ID.
To map the source column as the name of the value list item, select Name or Title.
To map the the source column as the ID of the owner value list item, select Owner.
To map the the source column as the ID of the value list's parent item, select Parent.

For more information on value list hierarchy, see Value list hierarchy.
23.Optional: If the Mapping Type is Name or Title, specify the setting Use in Insert Operation and define
the related statements.
If you want to...

Complete the following steps:

Allow read-only access

Set the Use in Insert Operation setting to No. Do not specify the
statements in this table.

Allow users to create but not
update or delete information

a. Set the Use in Insert Operation to Yes.
b. Under Service-Specific Settings, in INSERT INTO statement,
write the two statements in this table.

Statement

Definition

UPDATE

When you edit an object in MFiles, M-Files Server edits the
corresponding record in the external
database using an UPDATE
statement. Use a question mark (?) to
signal columns to be updated.

Examples
UPDATE Customers SET
CustomerName = ? WHERE
CustomerID = ?
UPDATE Contact SET Name
= ?, CustomerID = ? WHERE
ContactID = ?
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Statement

Definition

INSERT INTO

When you create a new value list
item in M-Files, M-Files Server adds a
corresponding record into the external
database using an INSERT INTO
statement. Use a question mark (?) to
indicate the value of each column.
Note: The INSERT INTO
statement input to M-Files
does not define a value
for the ID column. The
database should be set up to
automatically provide an ID
for new records. For example
in Microsoft SQL Server
databases, set the type of
the ID column as identity. If
the external database cannot
produce new ID values, the
INSERT INTO statement
cannot be used.

Get ID SELECT

After a new record has been created
with the INSERT INTO statement, MFiles Server gets the ID of the newly
created record with this SELECT
statement.

DELETE

When you delete an object from MFiles, M-Files Server deletes the
corresponding record in the external
database using a DELETE statement.
Use a question mark (?) for the ID of
the record to be deleted.

Examples
INSERT INTO
Customers( CustomerName )
VALUES( ? )
INSERT INTO
ContactPersons( Name,
CustomerID )
VALUES( ?, ? )

SELECT MAX( CustomerID )
FROM Customer

DELETE FROM Customers
WHERE CustomerID = ?
DELETE FROM Contacts
WHERE ContactID = ?

24.Repeat the steps from 21 to 23 for all the necessary source columns.
To take the configuration into use:
25.Under General Settings, set Enabled to Yes.
Tip: You can enable and disable the external database connection also with the
Disabled check box on the Connection to External Database tab of the Value List
Properties dialog.
If the connection is disabled, information between the vault and the external database is
not synchronized.
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26.Optional: To configure a remote service:
a) Click Apply.
The Enter Password dialog is opened.
b) Enter the password that is defined in the Ground Link proxy configuration.
c) Click OK.
27.Click OK to close the Value List Properties dialog.
The value list is now updated to and from the external database.

In this chapter
•
•
•

Using the Legacy Database Connection for Value Lists
Refreshing External Value Lists
Provider Recommendations for External Database Connections

Using the Legacy Database Connection for Value Lists
1. Do the steps from 1 to 5 in Connections to External Databases for Object Types.
2. In M-Files Admin, in the Connection to External Database tab of the Value List Properties dialog,
select Legacy database connection.
3. Click Configure.
The Configure Connection to External Database dialog is opened.
4. Click the Define button next to the OLE DB connection string (from server) field.
The syntax of the connection string is different for each Object Linking and Embedding Database
(OLE DB) supplier used for establishing the connection to the external database. If Open
Database Connectivity (ODBC) is necessary to create the connection, the data store must
be accessed over OLE DB and ODBC. For a list of recommended providers, see Provider
Recommendations for External Database Connections.
Note: M-Files Admin only displays OLE DB providers that are available on the computer
running M-Files Admin. If your M-Files Server resides on a different host, make sure that
the selected OLE DB connection string works from the computer running M-Files Server
as well.
The Data Link Properties dialog is opened.
5. On the Provider tab, select Microsoft OLE DB Driver for SQL Server from the list and click Next >>.
Other providers can have different options on the Connection and Advanced tabs. The All tab
contains all the available connection properties as a name–value table.
Note: We do not recommend the use of Microsoft Access Database Engine
Redistributables to import value lists or object types from an Excel file.
The Connection tab of the Data Link Properties dialog is opened.
6. To the Select or enter a server name field, write the name of your Microsoft SQL Server.
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7. In the Enter information to log on to the server section, select:
a. Windows Authentication: Select this option to use a Microsoft Windows account for logging in. In
this case, the connection uses the credentials that are used for running the M-Files Server service.
or
b. SQL Server Authentication: Select this option to use a Microsoft SQL Server login. Enter the
credentials in the User name and Password fields, and select the Allow saving password check
box.
Note: The ODBC driver does not support all special characters. If your connection uses
ODBC, the values that contain special characters must be enclosed in curly brackets.
The correct format is {username or password}.
8. For the Select the database section, complete one of these steps:
a. Use the drop-down menu to select the database on the specified server.
or
b. Enter a database name to the Attach a database file as a database name field and click the ...
button to select a Microsoft SQL Server Database (MDF) file.
9. Optional: Click Test Connection to make sure that your database connection operates correctly.
10.Optional: On the Advanced tab, define a timeout period for the database connection.
11.Click OK to close the Data Link Properties dialog.
The connection string is added to the OLE DB connection string (from server) field.
12.In the Configure Connection to External Database dialog, to the SELECT statement field, enter the
SELECT statement for getting source columns from the external database.
Examples of SELECT statements:
SELECT CustomerNumber, CustomerName FROM Customer
SELECT ID, Name + ' ' + Department FROM Company
SELECT ID, Name, CustomerID FROM Contacts
SELECT * FROM Customer
13.Click Refresh Columns to get the source columns.
The Columns listing shows correspondences between columns retrieved from the external
database (Source Column) and M-Files properties (Target Property).
14.Map the Source Column properties with properties in your M-Files vault (listed in the Target Property
column).
Note: When you want to map multiple values to a property of the Choose from list
(multi-select) data type, the values must be recorded on their own rows in the external
database. For example, if you want to map multiple values to the Industry property, the
values must be recorded like this:
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ID

Customer
name

City

Industry

Active

ABC-123

ESTT
Corporation

New York

100

1

ABC-123

ESTT
Corporation

New York

101

1

ABC-123

ESTT
Corporation

New York

108

1

In this case, however, data can only be read from, not recorded to the external database.
15.Select the check boxes in the Insert column and define the two statements below the Columns listing.
If you want to...

Complete the following steps:

Allow read-only access

Do not select the check boxes and leave the statements empty.

Allow users to create but not
update or delete information

a. Select the check boxes in the Insert column for the necessary
properties.
b. Click the Default button next to the INSERT INTO and SELECT
statement fields. You can also enter your statements to the
fields.

The table below explains the use of the two statements mentioned above.
Statement

Definition

INSERT INTO

When you create a new value list
item in M-Files, M-Files Server adds a
corresponding record into the external
database using an INSERT INTO
statement. Use a question mark (?) to
indicate the value of each column.
Note: The INSERT INTO
statement input to M-Files
does not define a value
for the ID column. The
database should be set up to
automatically provide an ID
for new records. For example
in Microsoft SQL Server
databases, set the type of
the ID column as identity. If
the external database cannot
produce new ID values, the
INSERT INTO statement
cannot be used.

Examples
INSERT INTO
Customers( CustomerName )
VALUES( ? )
INSERT INTO
ContactPersons( Name,
CustomerID )
VALUES( ?, ? )
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Statement

Definition

Examples

SELECT

After a new record has been created
with the INSERT INTO statement, MFiles Server gets the ID of the newly
created record with this SELECT
statement.

After a new record has been
created with the INSERT INTO
statement, M-Files Server gets the
ID of the newly created record with
this SELECT statement.

16.Click OK to close the Configure Connection to External Database dialog.
17.Optional: Select the Disabled check box to temporarily disable the external database connection.
If the connection is disabled, information between the vault and the external database is not
synchronized.
18.Click OK to close the Object Type Properties dialog.
The object type is now updated to and from the external database.
Refreshing External Value Lists
There are two types of refresh operations for external value lists:
•
•

full refresh
quick refresh

A full refresh detects new items, compares and updates existing items, and deletes items that have
disappeared from the external database. A quick refresh, by default, only detects new items in the external
database. It does not compare existing items. It does not delete items, either, because undeleting them
would require a full refresh.
The quick refresh operation is notably quicker than the full refresh operation. For reference, the full refresh
operation for 120,000 items takes about two minutes, while the quick refresh operation finishes in about
seven seconds. For simple value lists, refreshing data is fast even with large amounts of data and therefore
a full refresh is always used. This guarantees up-to-date data.
Refreshing external value lists manually
External value lists can be manually refreshed via the metadata card by selecting a property that uses an
external value list and clicking the Refresh icon

in M-Files Desktop and in the classic M-Files Web.

If you try to refresh an external value list at the same time with M-Files Server, the operation started by you
begins after the one started by M-Files Server.
Refreshing external value lists via M-Files Admin
You can initiate or stop the full refresh operation for any external value list in M-Files Admin. To start the
operation, right-click the value list under Metadata Structure (Flat View) and click Refresh Now.
The full refresh operation is also triggered if you edit the value list definitions in M-Files Admin. If you
update the value list definition before the previous refresh operation has completed, M-Files starts the
operation again.

M-Files | 3. System Administration | 416
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
Automatic refresh operations and configuration options
The quick refresh operation is started automatically if an external value list is requested by a client (for
instance, the metadata card containing a property that uses an external value list is viewed) and if the
latest refresh was executed more than 15 minutes ago.

A full refresh operation is automatically triggered instead of a quick refresh operation if an external value
list is requested by the client and if a full refresh has not been performed within the last 25 hours.
For configuration options available for refreshing external value lists automatically, see the document
Default Refresh Logic and Configuration Options for External Value Lists and Object Types.
Automatic property values ignored during refresh operations
When M-Files updates objects to and from an external database, it compares object properties in the
external database to the ones in the vault. If M-Files finds differences in the properties, it updates the
objects. During the comparison, properties with an automatically calculated value are ignored, which
causes these scenarios:
•
•

•

If all the object's property values to be updated to or from an external database are set to have an
automatically calculated value in M-Files, the object is not updated.
If the refresh operation creates an object in M-Files, all property values of the object are filled with
the values from the external database. This includes properties that are set to have an automatically
calculated value.
If the refresh operation updates the object's properties in M-Files, all the object's property values to be
updated get their value from the external database. This includes properties that are set to have an
automatically calculated value.

Provider Recommendations for External Database Connections
The table below lists the recommended OLE DB providers to be used for an external database connection
(see Connections to External Databases for Value Lists).
Database

Provider

Microsoft
SQL
Server

Microsoft OLE DB Driver for SQL Server (MSOLEDBSQL)
Note: Using the following, deprecated providers is not recommended:
•
•

Microsoft OLE DB Provider for SQL Server (SQLOLEDB)
SQL Server Native Client OLE DB Provider (SQLNCLI)
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Database

Provider

MySQL

Microsoft OLE DB Provider for ODBC Drivers (MySQL Connector/ODBC).
•
•
•
•

Use the Data sources (ODBC) administrative tool to configure a new system data source.
Select MySQL Connector/ODBC as the ODBC driver.
Define the data source.
Under driver properties, select the Disable Transactions check box.

In connection settings, select Microsoft OLE DB Provider for ODBC Drivers as the provider
and the system data source you defined as the data source. The default collection in the
connection settings remains empty. Thus you only define the database in the driver settings.
You can also use MySql.OLEDB Provider with MySQL.

Property Definitions
Property definitions are used for determining properties associated with classes. A property definition
specifies the property name (which should naturally be as descriptive as possible) and the data type, which
determines the type of the data entered (in relation to the property).
Various properties can be combined to create classes (refer to Classes). For example, Contract of
Employment is a document class with the associated properties Title, Document Date, Employee,
Keywords and Description.
The property definitions are used for determining the metadata on the metadata card. The properties that
are associated with the document class are displayed on the metadata card after class selection.

In this chapter
•
•
•
•
•
•

New Property Definition
Property Definition Automatic Values
Automatically Validating Property Values
Built-in Property Definitions
Property Definition Permissions
Hierarchical Property Values

New Property Definition
In a new property definition, you need to specify the data type after assigning a name to the property. For
example, if you are creating a property with the name Document Date, the logical data type choice is
Date.
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Figure 73: The New Property Definition dialog.

Property definition data types

Text

Any typed text, for instance, a heading.
This type of property accepts a maximum of 100 characters entered
via the user interface. More characters can be entered via the M-Files
API but values of over 100 characters will be cut and the full value is
lost.
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Text (multi-line)

Any typed text. The text can have multiple lines.
This type of property accepts a maximum of 10,000 characters
entered via the user interface. More characters can be entered via
the M-Files API, but this may cause the value to not be shown in its
entirety, as well as other unwanted behavior in the user interface. For
instance, attempting to insert property values containing more than
10,000 characters into a Microsoft Office document causes an error.

Choose from list

You can select one value from the options on the value list.

Choose from list (multi-select)

You can select several values from the options on the value list.

Date

You can select a date. As a default, M-Files suggests the current
date.

Time

You can select a time.

Timestamp

This data type can be used for generating a timestamp with a script.
Note: The timestamp needs to be defined as a calculated
value. Go to the Automatic Values tab of the Property
Definition Properties dialog and select the Calculated
value (VBScript) option and click Edit Code... to add the
VBScript code for generating the timestamp.

Number (integer)

You can enter the desired integer.
The value can be anything between -2,147,483,648 and
2,147,483,647.

Number (real)

You can enter the desired real number.
308

308

The value can be anything between -1,79 x 10
and 1,79 x 10 .
You can enter the value in the format XEY, where X is the number
to be multiplied, E represents the base number 10 and Y is the
exponent. For instance, entering -12E3 would result in the value
-12,000.
Note: This data type can present a wider range of numbers
than Number (integer) but at the cost of precision.
Consequently, Number (real) should not be used when
the number value has to be absolutely accurate, such
as with values representing money. In those cases, it is
recommended to use Number (integer) as the data type.

M-Files | 3. System Administration | 420
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
Boolean (yes/no)

You can specify the Boolean value yes or no for the desired variable.

The data type indicates the type of the property. For example, if you create a new property named
Confidential and specify Boolean (yes/no) as its data type, you need to select yes or no when filling in the
Confidential field on the metadata card. This happens only if the property Confidential has been associated
with the document class (Report, Memo, Agenda, etc.) to which the document you are creating belongs.
After creating this property, you can create a new view that lists the documents on the basis of whether
they are confidential or not. You can group the documents into the Yes and No property folders by using
the view hierarchy.
Value lists can be efficiently utilized in property definitions. For example, the Customers value list is utilized
in several property definitions in the M-Files sample vault.
When specifying, for example, the Author Organization, the options are retrieved from the Customers value
list, to which you can easily add new values (customers). This way, the same company names need not
be entered again, but the existing list can be utilized instead. The lists decrease the number of input errors
and make work more efficient.
Pre-filtering of properties
You can specify pre-filtering for property definitions to show a subset of the objects. This way, the list of
objects to be displayed can be limited by certain criteria, and the user can more quickly find the desired
object when, for example, adding a customer to the metadata card.
For example, pre-filtering can be used to divide:
•
•
•
•
•

Customers into prospective and actual customers.
Customers into buyers and suppliers.
Customers into persons and companies.
Projects into internal and external projects.
Projects into current and past projects.

The customer class may also be used as a pre-filter for customer listing. Likewise, the project class, for
example, may be used as a pre-filter for a project listing.
Filter the list by using the value of the following property
A property definition using a value list that is filtered by some other value list can be defined to be filtered
by some other property definition that uses the main value list of the filtered one. This is a case of dynamic
filtering, which depends on what the user selects in the metadata card.
Example: The properties Customer (Buyer) and Customer's Contact Person are filled in the metadata card.
Selecting the correct Customer (Buyer) also filters values available in the Customer's Contact Person value
list to show only contact persons of this selected customer. The Customer (Buyer) property may use the
Customers value list and Customer's Contact Person may use the Contact Persons value list. The Contact
Persons value list is filtered by customer.
In addition, the Customer (Buyer) property is defined to be filtered by the Buyer property. For more
information about hierarchical relationships between value lists and object types, refer to Value Lists and
Object Types.
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Also, you can select an automatic filter allowing M-Files to search for the best metadata card filter selection
to filter the property in question. In this case, for example, the two-way filtering of value lists between ZIP
codes and cities functions in a user-friendly manner: In the metadata card, you can choose a ZIP code first,
and M-Files then chooses an appropriate city from the list automatically. If you choose the city first, M-Files
filters the available ZIP codes automatically according to the city.
Sort values in the list in the following order
You can define whether you want the value list used for the property definition to be ascending or
descending.
Allow using this property with the following object type
You can also limit the use of this functionality to just one object type.
Enable automatic permissions via this property
For you to be able to use the automatic permissions via a specific property, you should allow this in the
property definition's properties. For the Class property definition, the automatic permissions are active by
default, so activation is not needed in this case.
When you have added automatic permissions to a value, value list or object type, M-Files will display the
property definitions in which the automatic permissions are enabled and those in which they are disabled.
Make sure that the automatic permissions are enabled for the desired property definition.
Note that the specified value must be selected for the explicit property definition for which you have
enabled automatic permissions.
Allow this property to be used as a grouping level in views
Enable this option to allow the property to be used for defining a grouping level within a view. It is advisable
to disable this option for properties that may contain classified information.
Allow searching for objects by this property
If you disable this option, searches based on the values of the selected property do not generate any
results. However, the property can still be shown in the list of additional property conditions. If you enable
this option and use the Do not search for old object versions suboption, users can only search for the
latest versions of objects on the basis of the values of this property.
If you think the property is a relevant search criterion, this option should be enabled. Otherwise, it is best to
leave it disabled to allow the search to perform optimally.
Aliases (Advanced tab)
Via the Advanced tab, you can define an alias for the property definition. For more information, see
Associating the Metadata Definitions.
When you have automatic aliases in use and you write a name on the General tab, the Aliases field on
the Advanced tab is automatically filled in. The alias has the format <predefined prefix>.<name>. Define
automatic aliases for your vault in the configurations editor.
Creating a New Property Definition
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1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and then select Property Definitions.
The Property Definitions list is opened in the right pane.
6. Click New Property Definition... on the task pane.
The Property Definition Properties dialog is opened.
7. In the Name field, enter a name for the new property definition.
The name will be displayed on the metadata card when you add this property to the metadata
card.
8. Use the Data type drop-down menu to select the data type for the new property definition.
For more information on data types, see Property definition data types.
9. Optional: If you chose Text or Text (multi-line) as the data type, select a content type for the text data
type using the Content drop-down menu.
10.Optional: If you chose Choose from list or Choose from list (multi-select) as the data type, carry
out the steps from 10.a to 10.d:
a) Use the Show values from the following list drop-down menu to select the value list from which a
value is to be chosen for the property.
You can also filter the values in the value list by clicking Filter... and specifying the conditions
that must be met in order for a value list item to be a selectable value for the property.
b) Use the Filter the list by using the value of the following property drop-down menu to select
the property by which available values are filtered. If you do not want to filter the values, select (no
filtering).
For more information, see Filter the list by using the value of the following property.
c) Use the Sort values in the list in the following order drop-down menu to select the sorting order
for the values.
d) Check the Enable automatic permissions via this property check box if you want to allow
automatic permissions for this property.
For more information, see Automatic Permissions for Value List Items.
11.Use the Allow using this property with the following object type drop-down menu to select the
object type that this property is used with, or select the All object types option if you do not want to
restrict the use of this property to a specific object type.
12.Optional: Check the Allow this property to be used as a grouping level in views check box to allow
this property to be used for defining a grouping level within a view.
It is advisable to disable this option for properties that may contain classified information.
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13.Optional: Check the Allow searching for objects by this property check box to allow the values of
this property to be used as criteria for searching for objects and object versions.
a) Optional: Select the Do not search for old object versions check box to allow the values of this
property to be used as criteria for searching for the latest versions of objects only.
The new property definition that you have just defined is added to the Property Definitions list and the
property can be added to the metadata of objects in M-Files.
Property Definition Automatic Values
An automatic value can be set for a property. This means that, for example, invoices can be consecutively
numbered. An automatic value can also contain text, in which case it is a combination of other properties.
For example, to create proposal headings in a set format such as Class/Product/Customer, these
properties (Proposal/Mach20A/ESTT Corporation) can be used to automatically create the headings.
Automatic values offer increased utilization of document and object metadata in storing and searching
for information. In addition, using automatic values makes the naming of documents and objects more
consistent and reduces the need for repeated data entries.
Automatic values are especially useful for naming objects (for more information, see New Class) and in
automatically including metadata in document content (for more information, see Add M-Files Property).
Automatic numbers and values
A property can have an automatic number or an automatic value.
An automatic number is calculated once and it does not change. Such automatic numbering is useful, for
instance, in various company internal processes and record-keeping.
An automatic value can contain other properties, usually by concatenating two or more properties. For
example, a document name (automatic value) can be defined as Class (Customer), which would return, for
instance, Proposal (ESTT). The automatic value changes when the object is edited. If the automatic value
is created using the class and customer name (Proposal (Customer A)), the automatic value changes
when another customer is selected (Proposal (Customer B)).
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Figure 74: Property definition with automatic numbering.

The example above illustrates a property with consecutive numbering in single whole number increments
(increment: 1). The last value used is set as 1000. Thus, the next object to use this property will be
numbered as 1001. The calculation order value is 100 (see Calculation order below).
Simple automatic numbering
Generates an incrementing numerical value. The increment can also be specified in the Increment field.
The default value is one (1).
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Customized automatic numbering (VBScript)
Generates an automatic number that can contain letters, numbers, or both. Creating a customized
automatic number is specified in more detail by using the M-Files API and generic features of VBScript.
The following M-Files variables can be used with this script: PropertyDef, Output,
LastUsed, ObjVer, DisplayID, Vault, CurrentUserID, CurrentUserSessionInfo,
PropertyValues, VaultSharedVariables, SavepointVariables, TransactionCache,
MFScriptCancel, GetExtensionObject, MasterTransactionID, CurrentTransactionID,
ParentTransactionID. For more information about the variables, refer to Available VBScript Variables.
The desired custom value is assigned to the Output variable, for example Output = "Automatic
value". For more information on specifying customized automatic numbering, see Specifying an
Automatic Property Value Using VBScript.
Simple concatenation of properties
Conjoins selected properties (for instance Proposal/Device/Customer). Any characters or text can be
inserted between the selected properties. For example: Proposal: Customer (Project) or Proposal,
Customer, Project.
A list of available placeholders can be opened when specifying an automatic value for a property. The Add
Placeholder… button opens the list of property definitions and other placeholders available for use.
Alternatively, you can add the placeholders to the field manually. They are used by bracketing them with %
characters. For instance, %PROPERTY_23% (%PROPERTY_21%) could give us "John Smith (09/25/2016
12:39 PM)", assuming that 23 is the ID for the Last modified by property and 21 the ID for the Last modified
timestamp property.
Besides the ID, you can also add the placeholders using aliases. To specify an alias placeholder, use the
syntax %PROPERTY_{Property.Definition.Alias}%. For more information on defining aliases, see
Assigning Aliases for Metadata Definitions.
Indirect placeholders
Indirect placeholders are metadata indirectly related to an object. For example, if a contract is related to a
customer object, the country of the customer is indirect metadata for the document.
To specify the customer's country as an indirect placeholder the syntax
%PROPERTY_1079.PROPERTY_1090% is used, where 1079 is the property definition ID for Customer and
1090 is the property definition ID for Country.
Alternatively, you can add indirect placeholders using aliases. In the previous example, the syntax with
aliases would be %PROPERTY_{PD.Customer}.PROPERTY_{PD.Country}% , where PD.Customer
is the alias for the Customer property definition and PD.Country is the alias for the Country property
definition.
Calculated value (VBScript)
Creating an automatic value can be specified in more detail by using the M-Files API and generic features
of VBScript.
The following M-Files variables can be used with this script: PropertyDef, Output, ObjVer,
DisplayID, Vault, CurrentUserID, CurrentUserSessionInfo, PropertyValues,
VaultSharedVariables, SavepointVariables, TransactionCache, MFScriptCancel,
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GetExtensionObject, MasterTransactionID, CurrentTransactionID,
ParentTransactionID. For more information about the variables, refer to Available VBScript Variables.
The desired custom value is assigned to the Output variable, for example Output = "Automatic
value". For more information on specifying calculated values, see Specifying an Automatic Property
Value Using VBScript.
Last value used
The starting value for consecutive numbering or values. The default is zero (0). The value can be changed;
for example, consecutive numbering can start at 3000.
Calculation order
Calculation order determines the order in which automatic values are calculated (from smallest to
greatest). This is significant when several automatic values are used and their combinations form new
automatic values.
For example, calculation order is crucial if the name of an object is an automatic property value consisting
of two other automatic values. These two automatic values should be calculated first and their combined
value afterward.
The values themselves make no difference other than that the calculation order proceeds from smallest
to greatest. The calculation order values for different properties can be, for example, 10, 12, 17 and 20.
The property with the calculation order number 10 is thus calculated first, followed by the property with the
calculation order number 12, and so on.
Recalculate
The Recalculate command is available in M-Files Admin task area (or by right-clicking a property in the
Property Definitions list and selecting Recalculate) when a property with an automatic value is selected.
You can choose between recalculating empty values or recalculating all values.
Recalculate Empty Values
Calculates automatic values for properties that have not been calculated yet. This is the default for
calculating automatic values. Changes to settings only apply to new values. For example, if you edit the
Last value used field, only new objects will have the new value. Old values are preserved; that is, once
defined, a value does not change.
Recalculate All Values
Recalculates the automatic values of all properties. Recalculate All Values thus also recalculates
previously defined values. For example, if consecutive numbering is used and the Last value used is
changed, this function renumbers all existing objects.
Naming a template without using automatic values
Document templates work differently when automatic values are used. All properties in the template
metadata work without the calculation of an automatic value. Thus, in templates, automatic property values
work as if they were not automatic. Their values can be defined normally and the server does not calculate
an automatic value for the property.
For example, objects in the Proposal class may use automatic values in their titles (such as Proposal
<number> - <customer name>). However, it makes sense to name the Proposal class templates as
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templates; titles using automatic properties only make sense for actual proposals, not templates. Thus,
the template might be called Proposal Template, while the actual proposal documents created using the
template will have names formulated with automatic values, such as Proposal 35 - ESTT.
For more information, refer to Using Document Templates and New Class.

In this chapter
•
•

Specifying an Automatic Value for a Property
Specifying an Automatic Property Value Using VBScript

Specifying an Automatic Value for a Property
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and then select Property Definitions.
The Property Definitions list is opened in the right pane.
6. Double-click the property definition that you want to edit.
The Property Definition Properties dialog is opened.
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7. Go to the Automatic Values tab, and select one of the following:
If you want to

Do the following

Specify automatic incremental numbering for
a property.

Select the Simple automatic numbering option,
and specify the size of the increment for each new
value in the Increment field.

Specify for a property customized automatic
numbering using VBScript.

Select the Customized automatic numbering
(VBScript) option, and click Edit Code... to add
the code for automatic numbering.
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If you want to

Do the following
Note: For more information, see
Specifying an Automatic Property Value
Using VBScript.

Specify a combination of text and property
placeholders as an automatic property value.

Select the Simple concatenating of properties
option, and enter the combination of text and
property placeholders in the text field. You can
add property placeholders by clicking the Add
Placeholder... button.
Note: For more information on
placeholders, see Simple concatenation
of properties.

Specify for a property an automatic calculated
value using VBScript.

Select the Calculated value (VBScript) option,
and click Edit Code... to add the code for
calculating the property value.
Note: For more information, see
Specifying an Automatic Property Value
Using VBScript.

8. Optional: In the Last value used field, enter the starting value for automatic numbering if you want to
use some other value than the default zero (0).
9. In the Calculation order field, enter the number that determines the order in which this automatic value
is calculated in relation to other automatic values. The smaller the number, the earlier the calculation
order.
For more information, see Calculation order.
10.Click OK to save your changes and close the Property Definition Properties dialog.
The selected property now has an automatic value. When you add this property to the metadata card, the
value is calculated and generated automatically.
Specifying an Automatic Property Value Using VBScript
Creating customized automatic values and calculated values can be specified in more detail by using
M-Files API and generic features of VBScript ("Microsoft Visual Basic Scripting Edition"). This section
provides instructions for using VBScript with automatic values.
Note: For the VBScript user's guide and language reference, see the VBScript MSDN article.
The VBScript code for a calculated value is executed whenever a property value is edited. The VBScript
code is used for calculating the automatic value, after which the result of the calculation must be assigned
to a variable called Output. This value is stored as the value of the property in the object metadata.
The simplest piece of VBScript for formulating an automatic value might therefore look like this:
Output = "Automatic value"
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Usually an automatic value uses other object properties, for example, by concatenating them. VBScript
code can utilize the property values and basic information of the same or another object with the aid of the
following VBScript variables:

•
•
•
•

CurrentUserID
DisplayID
LastUsed
MFScriptCancel

•
•
•

ObjVer
Output
PropertyDef

•
•
•

PropertyValues
Vault
VaultSharedVariables

For the variable descriptions, see Available VBScript Variables.
Note: Some property definitions are not shown when using the PropertyValues variable in
scripts (see Property definitions not shown for scripts).
Do the following steps to use VBScript for calculating an automatic value for a property:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View) and then select Property Definitions.
The Property Definitions list is opened in the right pane.
6. Double-click the property definition that you want to edit.
The Property Definition Properties dialog is opened.
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7. Go to the Automatic Values tab.
The Automatic Values tab is opened.
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8. Select either:
a. Customized automatic numbering (VBScript): Select this option if you want to define automatic
numbering using VBScript.
or
b. Calculated value (VBScript): Select this option if you want to define any other type of automatic
value using VBScript.
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9. Click the Edit Code... button.
The Edit VBScript Code window is opened.

10.Specify the VBScript code for calculating the automatic value.
The following code creates an automatic value for the "Proposal Title" property by utilizing the
proposal number and customer information in the object metadata. The ID of the Proposal
Number property is 1156 and the ID of the Customer property is 1288. If a document has the
proposal number 5577 and the customer is ESTT, the code below creates the following string as
the title of the proposal: "Proposal #5577 / ESTT".
Option Explicit
' Get proposal number.
Dim szNumber
szNumber = PropertyValues.SearchForProperty( 1156
).TypedValue.DisplayValue
' Get customer.
Dim szCustomer
szCustomer = PropertyValues.SearchForProperty( 1288
).TypedValue.DisplayValue
' Create proposal title.
Dim szName
szName = "Proposal #" & szNumber & " / " & szCustomer
' Set result.
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Output = szName
11.Close the Edit VBScript Code window once you are done.
12.Back in the Property Definition Properties dialog, click OK to save your changes and to close the
Property Definition Properties dialog.
The selected property now has an automatic value which is calculated by the VBScript code that you have
specified.
Automatically Validating Property Values
On the Validation tab of the Property Definition Properties dialog, you can define the criteria that
the values of a specific property should meet. For example, with validation you can ensure that the
property value contains a required number of characters. In this way, you can verify that the customer
phone number or invoice number is added correctly on the metadata card. You can also validate that, for
instance, the value can be accepted in relation to other properties or that the value is not empty.
Validation is specified by using variables, generic features of VBScript, and M-Files API. The following MFiles variables can be used for validating property values: PropertyDef, PropertyValue, ObjVer,
DisplayID, Vault, CurrentUserID, CurrentUserSessionInfo, VaultSharedVariables,
SavepointVariables, TransactionCache, MFScriptCancel, GetExtensionObject,
MasterTransactionID, CurrentTransactionID, ParentTransactionID. For more information
about the variables, refer to Available VBScript Variables.
By default, validation is considered successful. Invalid values are thus detected using conditional
statements and should any of the conditions specified in the validation be met, then an error should be
raised, prompting the user to correct the invalid value (for instance, Err.Raise MFScriptCancel,
"The property must have a value of at least 10 characters.").
Complete the following steps to add value validation for a property:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View).
6. Click Property Definitions.
7. Either:
a. In the Property Definitions list, right-click the property, the values of which you want to be
automatically validated, and select Properties from the context menu.
or
b. In the task area, click New Property Definition to create a new property definition with automatic
value validation.
The Property Definition Properties dialog is opened.
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8. Go to the Validation tab.
The Validation tab is opened.
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9. Select the Validation with VBScript option and click the Edit Code... button.
The Edit VBScript Code window is opened.
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10.In the Edit VBScript Code window, type in the VBScript code for validating the values of this property.
If the values of this property must have at least 10 characters, you could use the following code:
Option Explicit
Dim propertyName, value
propertyName = PropertyDef.Name
value = PropertyValue.GetValueAsUnlocalizedText
If Len(value) < 10 Then
Err.Raise MFScriptCancel, "The property """ & propertyName & """
must have a value of at least 10 characters."
End If
Note: The M-Files API documentation is available online: M-Files API. For more
information about using VBScript in M-Files, see the How do I write VBScript code for MFiles purposes? tutorial.
11.Close the Edit VBScript Code window and then click Apply in the Property Definition Properties
dialog to save your changes.
The values entered for the selected property are now automatically validated. When entering a value for
the property on the metadata card, the value is validated and if it does not meet the criteria specified, the
action specified in the validation script is executed (such as displaying an error message).
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Built-in Property Definitions
The following table lists the descriptions for built-in property definitions that come included in the metadata
structure of every vault implementation. These property definitions are essential elements of every vault
metadata structure, and therefore modifying these definitions is restricted by design.
Built-in property definition

Data type

Description

Accessed by me

Timestamp

The last time the object was
accessed by the current user.

Additional classes

Choose from list "Classes" (multi- A list of additional classes for the
select)
object.

Assigned to

Choose from list "Users" (multiselect)

A list of users to whom an
assignment is assigned.

Assignment

Choose from list
"Assignments" (multi-select)

An assignment related to the
selected object.

Assignment description

Text (multi-line)

The assignment description for an
assignment.

Class

Choose from list "Classes"

The class of the object.

Class groups

Choose from list "Class
groups" (multi-select)

The class group of the object.

Collection members (document
collections)

Choose from list "Document
collections" (multi-select)

A list of document collections
belonging to the document
collection.

Collection members (documents)

Choose from list
"Documents" (multi-select)

A list of documents belonging to
the document collection.

Comment

Text (multi-line)

Comment text for an object.

Completed

Boolean (yes/no)

Specifies whether the assignment
has been completed.

Conflict resolved

Timestamp

The date and time a conflict
was last resolved in favor of the
selected object.

Conflicted version

Number (integer)

Indicates the conflicted object
version.
When M-Files detects a conflict
in the vault, M-Files creates a
conflict object and adds this
property to it. The conflict object
is automatically removed when
the conflict has been resolved.

Created

Timestamp

The creation date and time of an
object.

Created by

Choose from list "Users"

Identifies the user who created
the object in M-Files or imported
the object into M-Files.
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Built-in property definition

Data type

Description

Created from external source

Choose from list "External
sources"

The external source from which
the object was imported.

Deadline

Date

The deadline date for the current
assignment.

Deleted

Timestamp

The deletion date and time of the
object.

Deleted by

Choose from list "Users"

Identifies the user who deleted
the object.

Deletion status changed

Timestamp

The date and time the object was
last deleted or undeleted.

Document

Choose from list
"Documents" (multi-select)

A document related to the
selected object.

Document collection

Choose from list "Document
collections" (multi-select)

A document collection related to
the selected object.

Favorite view

Number (integer)

The ID of the Favorites view
where the object is shown.

Is template

Boolean (yes/no)

A Boolean property identifying
whether the object is a template.

Last modified

Timestamp

The last modification date and
time of an object.

Last modified by

Choose from list "Users"

Identifies the user who last
modified the object.

Marked as complete by

Choose from list "Users" (multiselect)

A list of users who have
completed the current
assignment.

Marked as rejected by

Choose from list "Users" (multiselect)

A list of users who have rejected
the current assignment.

Marked for archiving

Boolean (yes/no)

A Boolean property identifying
whether the object is marked for
archiving.

Message ID

Text

The Message-ID value of an email extracted from the Internet
header.

Monitored by

Choose from list "Users" (multiselect)

A list of users who are monitoring
the current assignment.

Moved into current state

Timestamp

The date and time when the
object was moved to its current
state.
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Built-in property definition

Data type

Description

Name or title

Text

The name of title of the current
object.
Tip: If your M-Files
system administrator
has enabled translated
object titles, you can
use the translated object
titles in searches. The
translated object titles
are also shown in the
title area of the metadata
card, in the listing area, in
notifications, and in value
lists.

Object changed

Timestamp

The date and time of the last
change to the object.

Original path (1/3)

Text

The location from which the
object was imported to M-Files.

Original path (2/3)

Text

The location from which the
object was imported to M-Files
(continued).

Original path (3/3)

Text

The location from which the
object was imported to M-Files
(continued).

Owner (Assignment)

Choose from list "Assignments"

The owner value of the selected
object.

Owner (Class group)

Choose from list "Class groups"

The owner value of the selected
object.

Owner (Class)

Choose from list "Classes"

The owner value of the selected
object.

Owner (Document collection)

Choose from list "Document
collections"

The owner value of the selected
object.

Owner (Document)

Choose from list "Documents"

The owner value of the selected
object.

Owner (External source)

Choose from list "External
sources"

The owner value of the selected
object.

Owner (Report)

Choose from list "Reports"

The owner value of the selected
object.

Owner (State transition)

Choose from list "State
transitions"

The owner value of the selected
object.

Owner (State)

Choose from list "States"

The owner value of the selected
object.

Owner (Traditional folder)

Choose from list "Traditional
folders"

The owner value of the selected
object.
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Built-in property definition

Data type

Description

Owner (User group)

Choose from list "User groups"

The owner value of the selected
object.

Owner (User)

Choose from list "Users"

The owner value of the selected
object.

Owner (Version label)

Choose from list "Version labels"

The owner value of the selected
object.

Owner (Workflow)

Choose from list "Workflows"

The owner value of the selected
object.

Permissions changed

Timestamp

The date and time when the
permissions of the object were
last changed.

Reference

Choose from list
"Documents" (multi-select)

A list of referenced documents.

Remote vault GUID

Text

Reply to

Choose from list
"Documents" (multi-select)

Reply to (ID)

Text

Report

Choose from list "Reports" (multiselect)

A report related to the selected
object.

Report placement

Number (integer)

Specifies the placement of the
selected report.

Report URL

Text

Specifies the URL of the selected
report.

Shared files

Text (multi-line)

The shared location paths of
the shared files of the selected
object.

Signature manifestation

Text (multi-line)

Electronic signature manifestation
of the selected assignment.

Single file

Boolean (yes/no)

A Boolean property identifying
whether the object is a single-file
object.

Size on server (all versions)

Number (integer)

The total size of all versions of
the selected object.

Size on server (this version)

Number (integer)

The size of the selected object
version.

State

Choose from list "States"

The workflow state of the object.

State transition

Choose from list "State
transitions"

The workflow state transition of
the object.

Status changed

Timestamp

The date and time of the last
status change of the object.

Traditional folder

Choose from list "Traditional
folders" (multi-select)

A traditional folder containing the
selected object version.
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Built-in property definition

Data type

Description

Version comment changed

Timestamp

The date and time of the last
change to the comment of the
object version.

Version label

Choose from list "Version
labels" (multi-select)

The version label for the object.

Version label changed

Timestamp

The date and time of the last
change to the version label of the
object version.

Workflow

Choose from list "Workflows"

The workflow of the selected
object.

Workflow Assignment

Choose from list
"Assignments" (multi-select)

A property that indicates the
assignment related to the
workflow of the object.

Property Definition Permissions
Access for viewing this property and editing the property in object metadata can be defined on the
Permissions tab.
If the user does not have the permission to view the property, it is not available for selection in M-Files (for
example, when you are creating a new search or when More properties is selected).
If the user cannot see the property, the user also does not have the permission to edit it. However, the user
may have the permission to see the property without having the permission to edit it. Editing in this case
refers to the user being able to edit the property in the object metadata in all possible ways: edit its value,
or add or delete the property.
Adjusting Permissions
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click a node that contains items that you want to edit. For example, Users.
Permissions settings are available for these items:
•
•
•
•
•
•
•
•
•

Users
User groups
Object types
Value lists
Property definitions
Classes
Class groups
Workflows
Named access control lists
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6. Select an item in the listing area.
7. Right-click the item and click Properties.
8. Go to the Permissions tab.
9. In Users and user groups, select the user or user group whose permissions you want to adjust.

If the user or user group is not on the list, click Add to add the user or user group to the list.
10.Select one of these options:
a. Select the Allow check box to allow the selected user to see this item.
or
b. Select the Deny check box to deny the selected user from seeing this item.
11.Optional: If you want to adjust additional permissions, repeat the steps from 7 to 10.
12.Click OK.
Hierarchical Property Values
Instead of having the property value selection field show a flat list of values, you can set it to show a
hierarchically ordered list, which can be built either on top of value lists or real object types. This section
explains how you can set up the property value selection field to show an object type based hierarchy. If
you would like to specify and use hierarchical value lists instead, see Value list hierarchy.
Tip: The values of a real object type based value list consist of actual objects in your vault,
whereas a simple value list only contains items that are added to the list manually, either via MFiles Admin or via the M-Files clients by end users.
Before you can set a hierarchy to be used by a property, you of course must have one available to you.
See the example in Creating an Object-Based Hierarchy to get started. After you have finished creating the
hierarchy, you can put it to use as explained in Specifying Hierarchical Properties.
Note: This feature is available for M-Files Desktop only.

In this chapter
•
•

Creating an Object-Based Hierarchy
Specifying Hierarchical Properties
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Creating an Object-Based Hierarchy
This example describes a scenario where a construction company wants to use a single hierarchically
ordered list of values for three separate properties referring to the location of a construction site. They want
the hierarchical value list to be based on actual objects in their vault.
To create the required metadata structure and objects for this kind of scenario, follow the steps provided
below. The names of the structure elements are examples only, and you can freely name them as you like.
First, open M-Files Admin and create the required metadata structure elements as instructed below.
1. Create an object type with the names Area (singular) and Areas (plural).
For instructions on creating object types, see Creating a New Object Type.
2. Create four property definitions that have the names listed below. All of them should be of the data type
Choose from list and should show values from the value list Areas, essentially consisting of various
Area objects in your vault.
•
•
•
•

Belongs to area
Construction site continent
Construction site country
Construction site city

For instructions on creating property definitions, see Creating a New Property Definition.
Tip: You can optionally set the following filters for the continent and country properties if
you want the continent property to only show continents and the country property to hide
cities from the list:
•
•

Construction site continent: Class = Continent
Construction site country: Class != City

3. Create the following three classes:
•
•
•

Continent
Country
City

As the value of the Object type setting for each one, select Area.
Under the Properties section, add the Belongs to area property for all the three classes. This
way, the property is automatically added to the metadata card when you are creating these
objects later on.
For detailed instructions on creating classes, see Creating a New Class.
Next, open M-Files Desktop and create a hierarchy of continent, country, and city objects using the newly
created metadata structure elements.
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4. Create a set of continents:
a) Click the Create button in the top pane and select Area... in the context menu.
b) To the Class field, enter Continent.
c) To the Name or title field, enter the name of the continent, such as Asia.
d) Leave empty the value of the Belongs to area field as this is a top-level object.
The top-level object must contain this property as well because it defines that it belongs to
the same hierarchy as its descendant objects (in this example, countries and cities).
e) Click Create once you are done.
f) Repeat these steps for as many objects of this class as you require.
5. Create a set of countries:
a) Click the Create button in the top pane and select Area... in the context menu.
b) To the Class field, enter Country.
c) To the Name or title field, enter the name of the country, such as India.
d) To the Belongs to area field, enter the name of the continent in which this country is located, such
as Asia.
e) Click Create once you are done.
f) Repeat these steps for as many objects of this class as you require.
6. Create a set of cities:
a) Click the Create button in the top pane and select Area... in the context menu.
b) To the Class field, enter City.
c) To the Name or title field, enter the name of the city, such as Mumbai.
d) To the Belongs to area field, enter the name of the country in which this city is located, such as
India.
e) Click Create once you are done.
f) Repeat these steps for as many objects of this class as you require.
Finally, open M-Files Admin again and, by following the instructions in Specifying Hierarchical Properties,
set the property definitions Construction site continent, Construction site country, and Construction
site city to use the Belongs to area hierarchy. The configuration should look similar to the one presented
below.
•

Hierarchies
•

Construction site continent

•

• Hierarchy Name = Construction site continent
• Target Property = Construction site continent
• Hierarchy Property = Belongs to area
Construction site country

•

• Hierarchy Name = Construction site country
• Target Property = Construction site country
• Hierarchy Property = Belongs to area
Construction site city
•
•
•

Hierarchy Name = Construction site city
Target Property = Construction site city
Hierarchy Property = Belongs to area

7. Click Save and close M-Files Admin once you are done.
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Now, when you add the properties Construction site continent, Construction site country, and
Construction site city to the metadata of an object, they all show the same hierarchical list of areas that
you can use to select the location of the construction site.

Figure 75: An example of a hierarchical, object-based value list on the metadata card.

Specifying Hierarchical Properties
To set a property of your choice to use an object-based hierarchy, do the following steps:
1. Open M-Files Admin and go to a vault.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
2. Select Configurations and expand Advanced Vault Settings.
3. Expand the Configuration node and select Real Object Type Hierarchies.
4. Select the Hierarchies > Add Hierarchy.
5. Expand the newly created node and specify the values according to the information in the table below.
Setting name

Description

Example value

Hierarchy Name

The name of this hierarchy definition. The name is only
shown in the configurations editor.

Construction site
continent
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Setting name

Description

Example value

Target Property

The property that uses the value list hierarchy specified
via the Hierarchy Property setting. Can be the same
as Hierarchy Property. The property must be of the
data type Choose from list or Choose from list
(multi-select).

Construction site
continent

Hierarchy
Property

Specifies the real object type based value list hierarchy
to be used. The property selected here is automatically
set to be hierarchical as well. The property must be of
the data type Choose from list.

Belongs to area

6. Click Save.
When the property specified via the Target Property setting is added to object metadata, the value
selection drop-down menu shows a hierarchically ordered list of values based on the property specified via
the Hierarchy Property setting. For an example, see Creating an Object-Based Hierarchy.
Note: After the changes have been saved and M-Files Server has been restarted, end users must
log out from and log back in to the vault to be able to use these type of lists. You can log out all
vault users by restarting the vault, but taking a vault offline should always be done in a controlled
manner and the vault users should be notified beforehand.
Classes
A class is a metadata structure element designed to help categorize objects, improve consistency, and
speed up the process of filling in the object metadata. You can create new classes and specify properties
for each class via M-Files Admin. When you select the class in the client, M-Files shows on the metadata
card the properties that the system administrator has specified for the class.
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Figure 76: Classes shown on the metadata card for a new document.

In this chapter
•
•

New Class
Permissions and Automatic Permissions

New Class
To create a new class in M-Files Admin, go to a vault in the left-side tree view and expand Metadata
Structure (Flat View) > Classes. In the task area, click New Class.
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Figure 77: The properties dialog of a new "Purchase Invoice" class.

In the example shown above, a new class is being created. You can add new properties by clicking
the Add... button. If the Required checkbox for the property is active, users need to assign a value for
the property when creating a new object in that class. Otherwise, the object cannot be created. The
Purchase Invoice class being created in the above image dictates that the Name or title and Document
date properties would need to be filled in for users to be able to create a Purchase Invoice object.
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Set As Name
Any property of the class can be defined as the name of the object; that is, the property is selected as
the name property for the objects of this class. Then the name of the object does not have to be entered
separately; instead, a certain property can be set up to always be the name or "title" of the object belonging
to the class in question. This makes the naming of objects in a class more consistent.
This property is very useful for working with automatic values (see Property Definition Automatic Values).
The automatic value of the property may at the same time be the name of the proposal document
("Proposal/ESTT").
Note: Templates are named without automatic values.
The Update names function (found on the M-Files Admin task area for a class) can be used to update the
names of all existing objects in the class to conform to the new definition.
Default workflow for new objects
You can define a default workflow for new objects in this class. For example, all invoices can be set to use
the invoice circulation workflow.
Force this workflow for new objects
If a specific workflow is forced for new objects in the class, the workflow cannot be deleted or changed.
For example, the Purchase Invoice Approval workflow can be specified as compulsory for a new document
created in the Purchase Invoice class.
Templates
You can define templates to be used when creating new objects in this class. To specify a document or
other object as a template, add the property Is template and set it to Yes. Templates are class-specific.
You can specify the template to be a part of several classes by specifying multiple classes for the object
being used as a template, with the Additional Classes property.
Aliases (Advanced tab)
Via the Advanced tab, you can define an alias for the class. For more information, see Associating the
Metadata Definitions.
Creating a New Class
Follow the steps provided below to create a new class to your M-Files vault.
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View), and then select Classes.
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6. In the task area, click New Class.
The Class Properties dialog for a new class is opened.
7. In the Name field, type in a descriptive name for the new class.
8. Using the Object type drop-down menu, select the object type that the class is to be associated with.
The class can be selected only for objects of this type.
9. Optional: Using the Properties table, define which properties are to be automatically added to the
metadata card when this class is selected.
For more information, see New Class.
10.Optional: Using the Default workflow for new objects drop-down menu, specify the default workflow
to be associated with the class.
Enable Force this workflow for new objects to require the selected workflow to be used for any
new objects with this class.
11.Optional: On the Permissions tab, you can specify the users who may see this class or attach objects
to it.
For more information, see Permissions and Automatic Permissions.
12.Optional: On the Automatic Permissions tab, you can specify whether or not objects of this class
receive automatic permissions.
For more information, see Permissions and Automatic Permissions.
13.Optional: On the Advanced tab, you can define aliases for the class using the Aliases field.
For more information, see Aliases for Associating Metadata Between Vaults.
When you have automatic aliases in use and you write a name on the General tab, the Aliases
field on the Advanced tab is automatically filled in. The alias has the format <predefined
prefix>.<name>. Define automatic aliases for your vault in the configurations editor.
14.Click OK.
The new class is added to the list of classes in M-Files Admin and can be selected for objects in M-Files
Desktop.
Assignment Class
When you are creating a new class with the object type Assignment, an additional tab appears to the
Class Properties dialog, the Assignment Details tab. It enables you to select the assignment type and
certain conditions related to the completion or approval of the assignment.
Assignment types
There are two types of assignments, task assignments and approval assignments. The assignees of the
task assignments simply mark the assignment complete when they have successfully carried out the task,
whereas the assignees of approval assignments have more say in the actual approval process: they can
use the assignment for approving or rejecting the target object.
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In both cases, you can set the completion of the assignment to require action from all or any assignees.
You may also want to require an electronic signature.
Permissions and Automatic Permissions
Permissions
On the Permissions tab, you can specify the users who may see this class.
Automatic permissions
An object receives automatic permissions when a class with automatic permissions specified is added to
the object metadata.

You can activate the automatic permissions by value, value list, object type, or class. You can specify
the automatic permissions for each class in the same way as for each value. For more information, see
Enabling Automatic Permissions for a Value List Item.
Note: Micro Focus IDOL and Smart Search: If more than four automatic ACL sources control the
permissions of an object, only administrators can see it in search results.
Adjusting Permissions
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click a node that contains items that you want to edit. For example, Users.
Permissions settings are available for these items:
•
•
•
•
•
•
•
•
•

Users
User groups
Object types
Value lists
Property definitions
Classes
Class groups
Workflows
Named access control lists

6. Select an item in the listing area.
7. Right-click the item and click Properties.
8. Go to the Permissions tab.
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9. In Users and user groups, select the user or user group whose permissions you want to adjust.

If the user or user group is not on the list, click Add to add the user or user group to the list.
10.Select one of these options:
a. Select the Allow check box to allow the selected user to see this item.
or
b. Select the Deny check box to deny the selected user from seeing this item.
11.Optional: If you want to adjust additional permissions, repeat the steps from 7 to 10.
12.Click OK.
Class Groups
You can create class groups to combine document classes into categories. This makes it easier to select a
class when creating a new document. Note that you can create class groups only for the document object
type.
Complete the following steps to create a class group:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Hierarchical View), then right-click Document and select New Class
Group.
The Class Group Properties dialog is opened.
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6. In the Name field, enter the name of the new class group.
The name can be, for instance, 4. Meetings if you are creating a class group that contains
classes for documents related to meetings, such as Memo, Meeting Notice or Agenda. Class
groups are shown in the class selection drop-down menu in numerical order when you fill in the
metadata card. You can easily change the order of the list by using numbers in the beginning of
the class group names.
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7. Click Add... to add a class to the new group.
The Select Classes dialog is opened.
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8. Optional: If you want to create a new class and add it to the new class group, click New Class.
For more instructions, see Creating a New Class.
9. Select the classes that you want to add to the new class group and then click Add.
You can select more than one item at once. Hold down the Ctrl key to select multiple individual
items or hold down the ⇧ Shift key to select adjacent items on the list.

10.Optional: In the Members list, you may select a class and click the ↑ or the ↓ button to rearrange the
order of the classes in the group.
The ordering affects the order in which the classes in the group are displayed in the class
selection drop-down menu when creating a new document.
11.Optional: In the Members list, select a class and click Edit... to modify its properties.
For more information on class properties, see New Class.
12.Optional: If you need to remove a class from the class group, in the Members list, select the group to
be removed and click Remove.
Note that this only removes the class from the class group. It does not delete the class from your
vault.
13.Optional: Open the Permissions tab to specify the users who may see the new class group.
For further instructions, see Adjusting Permissions.
14.Click OK to create the class group.
The new class group is from now on shown in the class selection drop-down menu when creating a new
document.
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In this chapter
•

Adjusting Permissions

Adjusting Permissions
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.

M-Files | 3. System Administration | 458
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
4. Expand a vault.
5. Click a node that contains items that you want to edit. For example, Users.
Permissions settings are available for these items:
•
•
•
•
•
•
•
•
•

Users
User groups
Object types
Value lists
Property definitions
Classes
Class groups
Workflows
Named access control lists

6. Select an item in the listing area.
7. Right-click the item and click Properties.
8. Go to the Permissions tab.
9. In Users and user groups, select the user or user group whose permissions you want to adjust.

If the user or user group is not on the list, click Add to add the user or user group to the list.
10.Select one of these options:
a. Select the Allow check box to allow the selected user to see this item.
or
b. Select the Deny check box to deny the selected user from seeing this item.
11.Optional: If you want to adjust additional permissions, repeat the steps from 7 to 10.
12.Click OK.

3.2.2. Managing Users and User Groups
This section deals with managing vault users and user groups in M-Files Admin.

In this chapter
•
•

Users
User Groups
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•
•

External Repository Users
External Repository User Groups

Users
Under the Users node of a vault in M-Files Admin, you can add users to the vault, thus assigning a name
to the user and specifying the user's permissions. Each user object is based on a server login account (see
Login Accounts).
M-Files assigns each user a unique ID, which can be found via the user's properties in M-Files Admin.
Deleting users
As a general rule, users should not be deleted from the vault because they contain a lot of information
that might still be needed later on. The user objects hold, among other things, user interface preferences,
information about the favorite objects of the user, and records about notifications related to the user. MFiles Admin does not allow the delete operation to be undone, so it should be carried out only if you are
absolutely certain the user information will no longer be needed. You might, instead, want to consider
disabling the user. For more information about disabled users, go to Creating a User and search for
disabled in step 9.

In this chapter
•
•
•

Creating a User
Importing Users
Vault User Permissions

Creating a User
Do the following steps to create a new user to a selected document vault:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click Users.
Tip: If the list contains a large number of items, you might want to filter it. To filter the
view, open the View menu and click Filter. Enter a desired text to filter the column
contents.
6. Click New User on the task area.
The New User dialog is opened.
7. Use the Login account drop-down menu to select a login account for the user or select New login
account... from the same drop-down menu to create a new login account for the user.
For instructions on creating a new login account, see Creating a Login Account.
The Full name field is updated with the full name information of the selected login account.
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8. Use the Vault language drop-down menu to select the default vault language for the user from the list
of available vault languages.
For instructions on adding a new vault language, see Languages and Translations.
9. Set the properties and administrative rights for the new user in the selected vault by checking or
unchecking the relevant check boxes:
Option
External user

Description
Users can be grouped into external and internal users. A user can
be defined as an external user by enabling the External user option.
External users cannot see or access any documents other than those
specifically marked for them. By default, they do not have permissions
to view any documents. For example, you can define your customers as
external users and grant them access to customer-specific documents in
the document vault.
As stated above, external users do not, by default, have permissions for
accessing any documents. To share a document with an external user,
access must be explicitly granted in the permissions of the document.
Note: Object permissions are updated as an asynchronous
background task. Object permissions may be updated when,
for example, a named access control list, a user, a user group,
or the value of a pseudo-user (such as a project manager) is
modified. You may monitor the progress of the task in M-Files
Admin in the Background Tasks section. For more information,
see Monitoring Background Tasks.

User account is disabled

When the account is disabled, the user cannot access the document
vault. Logging in to the document vault has been disabled, but the user
information is retained. The account can be easily enabled again by
unchecking this check box when necessary. For example, you may
want an employee's account to be disabled during her vacation for data
security reasons.

User cannot create
documents or other
objects

The user cannot create documents or other objects in the vault but can,
for example, read them if provided with the necessary permissions.

User cannot create
or modify traditional
folders

The user cannot create traditional folders in the vault or modify existing
traditional folders.

User cannot create or
modify private views or
notification rules

The user cannot create or modify private views or private notification
rules. Private views and notification rules are visibile only to the user who
created them, whereas common ones are visible to all vault users.

Full control of vault

With this option, the user is assigned all administrative permissions in the
vault.
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Option

Description

See and read all vault
content (including
deleted objects)

Regardless of the permissions specified for a document or object, a user
with this permission can see and read all objects, including deleted ones.

See and undelete
deleted objects

Destroy objects

Force undo checkout

Change permissions for
all objects

The user has the permission to restore documents and other objects
marked as deleted.

The user has the permission to permanently destroy objects.

A user with this permission can undo the checkout made by another
user. For example, if a user has forgotten to check in a document that
others should be able to edit, a user with this permission can check in the
document. In this case, the changes made to the document during the
checkout will not be saved on the server.

The user has the right to change the permissions for any object that
they are permitted to see. You can edit the permissions for an object, for
instance, remove the write permission to a document from other users.
Note: The user with this permission has the power to obtain edit
rights to documents that they would normally be able to only read.

Change metadata
structure

The user has the permission to modify document vault metadata, such
as add new document classes or value lists. For example, if you want
to change the Invoice document class so that the Project property field
must be filled in for each invoice, you can make the change if you have
this permission. Even if the user does not have the permission to do this,
the user can still add new metadata fields to individual objects using the
metadata card.
Note: With this permission, users may be allowed to view
metadata structure items and other vault information that they
would not otherwise be permitted to view, such as value lists,
object types, and named access control lists.

Manage workflows

Manage user accounts

Manage common views
and notification rules

This permission enables the user to create, edit and delete workflows in
M-Files Admin.

The user has the permission to manage login accounts in the selected
document vault. With this permission, you can, for instance, add or
remove users from the document vault.

With this permission, you can create views visible to all vault users. You
can also define common notification rules. You can create common views
and notification rules via M-Files Desktop.
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Option

Description
Note: For more information on common views, see Using Views.
For more information on common notification rules, see Editing
Notification Settings in M-Files Desktop.

10.Optional: On the Permissions tab, specify the users or user groups who may see this user.
The system administrator and all users with full control of the document vault in question always
see all users.
a) On the Users and user groups list, select the user or the user group for which you wish to set the
permissions for seeing this user.
If the desired user or user group is not on the list, click Add... to add the user or user group to
the Users and user groups list.
b) Check either the Allow or Deny check box to modify the permissions of the selected user.
11.Click OK once you are done.
A new user is created and it is listed in the Users list. The new user can now access the selected
document vault with the permissions that you have defined.
Note: You can also import domain users to M-Files. For instructions, see Importing Users.
Importing Users
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click Users.
6. In the task area, click Import Individual Users.
The Import Individual Users dialog is opened.
7. Select either:
a. Choose from list to select the user group using drop-down menus. In Domain, select the desired
domain. In Organizational unit, select the desired organizational unit within that domain. Finally, in
User group, select the user group that you want to import.
or
b. Enter Name. This option is especially useful if you have so many user groups that searching the
correct one from list is hard. Enter the name of the user group in the format <domain>\<user group>
and click Show.
The list area in the dialog is populated with the members of the selected user group.
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8. Optional: Check the Include users from nested groups check box to be able to import login accounts
from nested groups within the selected user group.
The list area in the dialog is populated with the members of the selected user group and the
members of any user group nested within the selected user group.
9. Select the user to be imported by clicking its username on the list.
You can select more than one item at once. Hold down the Ctrl key to select multiple individual
items or hold down the ⇧ Shift key to select adjacent items on the list.

10.Using the License type for new login accounts drop-down menu, select the license type for the login
accounts that are created for the imported users.
For more information about license types, see License type.
11.Click OK to import the selected users.
The users are imported to the selected vault and added to the Users list.
Vault User Permissions
The Permissions tab enables you to specify who may see this user.
Note: The system administrator and all users with full control of the document vault in question
always see all users.
Adjusting Permissions
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click a node that contains items that you want to edit. For example, Users.
Permissions settings are available for these items:
•
•
•
•
•
•
•
•
•

Users
User groups
Object types
Value lists
Property definitions
Classes
Class groups
Workflows
Named access control lists

6. Select an item in the listing area.
7. Right-click the item and click Properties.
8. Go to the Permissions tab.
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9. In Users and user groups, select the user or user group whose permissions you want to adjust.

If the user or user group is not on the list, click Add to add the user or user group to the list.
10.Select one of these options:
a. Select the Allow check box to allow the selected user to see this item.
or
b. Select the Deny check box to deny the selected user from seeing this item.
11.Optional: If you want to adjust additional permissions, repeat the steps from 7 to 10.
12.Click OK.
User Groups
You can create, edit, remove and import user groups to your vault. Creating user groups makes it easier
to specify permissions for documents. You can combine into user groups individual users with a certain
common feature, such as their position in the organization (management, research and development, and
so forth).
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Figure 78: User groups simplify the management of access rights.

You can manage the user groups in your vault by completing the following steps:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select User Groups.

In this chapter
•
•
•

Creating a User Group
Importing User Groups
User Group Permissions

Creating a User Group
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
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3. Expand Document Vaults.
4. Expand a vault.
5. Click User Groups.
Tip: If the list contains a large number of items, you might want to filter it. To filter the
view, open the View menu and click Filter. Enter a desired text to filter the column
contents.
6. On the task pane, click New User Group....
The User Group Properties dialog is opened.
7. In the Name field, enter a name for the new user group.
8. Click Add... to add users to this group.
The Select Users or User Groups dialog is opened.
9. Select the users to be added to the user group and click Add.
You can select more than one item at once. Hold down the Ctrl key to select multiple individual
items or hold down the ⇧ Shift key to select adjacent items on the list.

10.Optional: Enable the Group members are synchronized from the domain and click Define... if you
want to retrieve the users from a domain.
For more information, see Importing User Groups.
11.Optional: On the Advanced tab, define an alias for the user group.
For more information, see Associating the Metadata Definitions.
When you have automatic aliases in use and you write a name on the General tab, the Aliases
field on the Advanced tab is automatically filled in. The alias has the format <predefined
prefix>.<name>. Define automatic aliases for your vault in the configurations editor.
12.Click OK to finish creating the user group.
The user group that you have just created is added to the User Groups list.
Note: Object permissions are updated as an asynchronous background task. Object permissions
may be updated when, for example, a named access control list, a user, a user group, or the value
of a pseudo-user (such as a project manager) is modified. You may monitor the progress of the
task in M-Files Admin in the Background Tasks section. For more information, see Monitoring
Background Tasks.
Importing User Groups
User groups can be imported by domain and by organizational unit. This makes importing user groups into
M-Files quicker and easier. M-Files can check for new and deleted user group members periodically.
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Figure 79: User groups can be imported from the domain to the vault, allowing existing user groups in the domain to be used for
specifying permissions to vault content.

Complete the following steps to import user groups:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click User Groups and then click Import User Group in the task area.
The Import User Group dialog is opened.
6. Select either:
a. Choose from list to select the user group using drop-down menus. In Domain, select the desired
domain. In Organizational unit, select the desired organizational unit within that domain. Finally, in
User group, select the user group that you want to import.
or
b. Enter Name. This option is especially useful if you have so many user groups that searching the
correct one from list is hard. Enter the name of the user group in the format <domain>\<user group>
and click Show.
The list area in the dialog is populated with the members of the selected user group.
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7. Optional: Check the Include users from nested groups check box to be able to import login accounts
from nested groups within the selected user group.
The list area in the dialog is populated with the members of the selected user group and the
members of any user group nested within the selected user group.
8. Using the License type for new login accounts drop-down menu, select the license type for the login
accounts of the users to be imported.
For more information about license types, see License type.
9. Optional: Select the Check for new and deleted members every 15 minutes check box if you want to
keep the user group up to date and import new users automatically when they are added to the group.
10.Click OK to import the selected user group.
The selected user group is imported to the selected vault and it is added to the User Groups list. In
addition, new login accounts are created for new users.
Defining, Editing or Disabling Import Settings of Existing User Groups
You can also import users to existing user groups in M-Files.
Or you can edit the synchronization settings of previously imported user groups. If the user group on the
domain is changed (it is for instance renamed or the grouping is changed), the earlier imported M-Files
user group can be merged with the new user group on the domain. This preserves the identity of the MFiles user group regardless of changes in the domain user group, and the permissions related to it can
remain the same.
if you no longer wish to import users to a specific user group, you can also disable user group
synchronization altogether.
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click User Groups and then, on the User Groups list, double-click a user group that you want to edit.
The User Group Properties dialog is opened.
6. Either:
If you want to

Do the following

Import to users an existing user group

Check the Group members are synchronized
from the domain check box, click the Define...
button and then define the import settings in the
dialog that is opened. See Importing User Groups
for specific instructions on import settings. After
you are done, click OK.

Edit the import settings of a previously
imported user group

Click Define... and modify the settings in the
dialog that is opened. See Importing User Groups
for specific instructions on import settings. After
you are done, click OK.
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If you want to

Do the following

Disable user group synchronization for a user
group

Uncheck the Group members are synchronized
from the domain check box.

7. Click OK to save your changes and close the User Group Properties dialog.
Users in Synchronized Active Directory Groups
When new users are added to Active Directory (AD) groups that are synchronized to M-Files:
•
•

•

The users are added as vault users to the vault in which the user group is located.
If the added users do not yet have M-Files login accounts, new login accounts are automatically created
for the users and the license specified in the synchronization settings is applied to the new login
accounts.
No changes are made to existing M-Files login accounts. If users have been assigned concurrent
licenses, and they are added to a group for which named licenses are specified, the users retain their
concurrent licenses.

When users are removed from all the AD groups that are synchronized to M-Files:
•
•
•

The users are removed from the user group in M-Files, losing all permissions that were granted to them
through the group membership.
The user accounts remain in M-Files but are disabled.
The login accounts remain active, keeping the licenses assigned to them.
Note: Users will not be automatically disabled as long as they are members of at least one
synchronized AD group.

User Group Permissions
The Permissions tab enables you to specify who may see this user group.
Note: The system administrator and all users with full control of the document vault in question
always see all user groups.
Adjusting Permissions
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click a node that contains items that you want to edit. For example, Users.
Permissions settings are available for these items:
•
•
•
•
•

Users
User groups
Object types
Value lists
Property definitions
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•
•
•
•

Classes
Class groups
Workflows
Named access control lists

6. Select an item in the listing area.
7. Right-click the item and click Properties.
8. Go to the Permissions tab.
9. In Users and user groups, select the user or user group whose permissions you want to adjust.

If the user or user group is not on the list, click Add to add the user or user group to the list.
10.Select one of these options:
a. Select the Allow check box to allow the selected user to see this item.
or
b. Select the Deny check box to deny the selected user from seeing this item.
11.Optional: If you want to adjust additional permissions, repeat the steps from 7 to 10.
12.Click OK.
External Repository Users
When you connect a document vault to an external repository using the Intelligent Metadata Layer
technology, users in the external repository are imported to M-Files Server.
The External Repository Users view in M-Files Admin allows you to manage and refine associations
between M-Files users and external repository users. When you associate an M-Files user with an external
repository user, the M-Files user inherits the access rights of the external repository user. This way you
can refine the access rights of an M-Files user to external repository content.
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Figure 80: You can refine the access rights to external repository content, such as files and folders obtained via a network folder
connection, by associating external repository users with M-Files users in M-Files Admin.

Depending on your connector configuration, automatic associations between M-Files users and external
repository users may be established in external repository connections. See Automatic Association for
more information.
For more information on Intelligent Metadata Layer, see Intelligent Metadata Layer.
Note: External Repository Users is visible only if the selected vault has one or more active
external repository connections.
Complete the following steps to associate an M-Files user with an external repository user:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select External Repository Users.
Tip: If the list contains a large number of items, you might want to filter it. To filter the
view, open the View menu and click Filter. Enter a desired text to filter the column
contents.
6. Double-click an external repository user.
The User Properties dialog is opened.
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7. To associate an M-Files user with the selected external repository user, click the Add... button.
The Select Users dialog is opened.
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8. Select the M-Files user or users that you want to associate with the selected external repository user
and then click Add.
You can select more than one item at once. Hold down the Ctrl key to select multiple individual
items or hold down the ⇧ Shift key to select adjacent items on the list.

9. Click OK to close the User Properties dialog.

The selected M-Files user is now associated with the selected external repository user, and the M-Files
user has the same access rights to the external repository content as the external repository user when the
M-Files user accesses the external repository via M-Files.
External Repository User Groups
When you connect a document vault to an external repository using the Intelligent Metadata Layer
technology, all or some of the user groups in the external repository are imported to M-Files Server,
depending on your connector configuration.
The External Repository User Groups view in M-Files Admin allows you to manage and refine
associations between M-Files users or M-Files user groups and external repository users or external
repository user groups. When you associate an M-Files user or user group with an external repository user
group, the M-Files user or user group inherits the access rights of the external repository user group. This
way you can refine the access rights of an M-Files user to external repository content.
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Figure 81: You can refine the access rights to external repository content, such as files and folders obtained via a network folder
connection, by associating external repository user groups with M-Files users and user groups in M-Files Admin.

Depending on your connector configuration, automatic associations between M-Files users or M-Files user
groups and external repository users or external repository user groups may be established in external
repository connections. See Automatic Association for more information.
For more information on Intelligent Metadata Layer, see Intelligent Metadata Layer.
Note: External Repository User Groups is visible only if the selected vault has one or more
active external repository connections.
Complete the following steps to associate an M-Files user or user group with an external repository user
group:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select External Repository User Groups.
Tip: If the list contains a large number of items, you might want to filter it. To filter the
view, open the View menu and click Filter. Enter a desired text to filter the column
contents.
6. In the task area, double-click an external repository user group.
The User Group Properties dialog is opened.
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7. To associate an M-Files user or user group with the selected external repository user group, click the
Add... button.
The Select Users or User Groups dialog is opened.
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8. Select the M-Files user or user group that you want to associate with the selected external repository
user group and then click Add.
You can select more than one item at once. Hold down the Ctrl key to select multiple individual
items or hold down the ⇧ Shift key to select adjacent items on the list.

9. Click OK to close the User Group Properties dialog.

The selected M-Files user or user group is now associated with the selected external repository user
group, and the M-Files user or user group has the same access rights to the external repository content as
the external repository user group when the associated M-Files user accesses the external repository via
M-Files.

3.2.3. Configuring Workflows
M-Files integrates with the organization's administrative and executive processes. Defining and monitoring
tasks is easiest where the task documents are located. With workflows, the routines of the organization can
be widely automated and tasks can be assigned to the right people at the right time. Users receive email
notifications about task-related issues, and managers can monitor task progress and approve completed
tasks.
See this video for tips on creating useful workflows:
Workflows can be used, among many other processes, for purchase invoice circulation. Workflow states
could in that case include:
•
•
•
•

Awaiting approval
Approved
Rejected
Paid in full

You can define who is allowed to transfer the object from one state to the next and who is responsible for
the next workflow task. For example, invoices could only be approved for payment by a member of the
management group.
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When the invoice is in the Approved state, the department responsible for money transactions would
automatically be informed that a new invoice is awaiting payment. When the invoice has been paid, it is
transferred to the Paid in full state.

Figure 82: Workflows make routine tasks of the organization easier. For example, processing purchase invoices.

Graphical Workflow Designer
M-Files comes with a graphical user interface for managing workflows. See Graphical Workflow Designer
for more details.

In this chapter
•
•

Graphical Workflow Designer
Creating and Editing Workflows

Graphical Workflow Designer
You can use the graphical workflow designer in M-Files Admin to create and edit workflows. To use the
designer in M-Files Admin, select the vault connection and then the vault in the left-side tree view. Finally,
click Workflows.
Note: The designer requires Internet Explorer 9 or later to be installed on the computer.

Workspace
The Workflows window has two sections:
•
•

The top section lists the available workflows and the task area commands New Workflow, Make Copy,
Delete and Properties.
The bottom section displays the graphical workflow designer. The designer-related task area
commands are explained in Using the designer and Task pane commands.
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Figure 83: The graphical workflow designer in M-Files Admin.

The Save and Discard commands are located in the top-right corner of the workspace, on the title bar of
the selected workflow. The Save command stores all the modifications to the workflow, including the layout
of your graphical representation.
You can modify the workspace proportions by dragging the workflow title bar up or down.
Using the designer
The designer has been designed to work very intuitively. You can use the task area and/or interact with the
graphical designer and context menus.
Creating new states
You can create new states either via the task area or by double-clicking an empty space on the canvas.
This opens up the dialog for a new workflow state.
Note: If a class has a default workflow and a new object is created in the class, the first state is
chosen automatically only if the first state is the first on the States list of the Workflow Properties
dialog. The order of states on the list overrides the order of states in the graphical workflow
designer.
Editing states
You can open the properties dialog for an existing state simply by double-clicking the state, by selecting it
and then clicking Edit State via the task area, or via the context menu for the state.
Deleting states
States can be deleted via the task area command Delete, via the context menu of the state, or by selecting
the state and pressing the Delete key on your keyboard.
Modifying the layout
The workflow states can be freely moved around on the canvas by dragging and dropping.
Connectors (state transitions)
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You can add arrow connectors between the states by moving your cursor on the edge of a state rectangle
and by using drag and drop. The state rectangle has green edges and the cursor changes into a cross (+)
when a connector can be drawn. The connectors represent workflow state transitions.

Figure 84: A state transition being drawn from "Testing" to "Released".

Sometimes the connectors may overlap with each other or with the state rectangles. The connectors can
also be modified to make the layout more readable. Just select a connector and use the two handles for reshaping the connector.
The context menu for a connector allows you to Edit or Delete the state transition in question, as well
as to Straighten the connector. Double-clicking the connector opens the properties dialog for the state
transition.
Zooming and dragging the canvas
You can zoom in and out by scrolling, as well as drag the canvas around. The context menu for an empty
space on the canvas allows you to reset the zoom level.
Task pane commands
In addition to context-specific task area commands, such as Edit State or Straighten, there are also a few
actions that affect the designer or your workflow as a whole.
Re-layout
With the Re-layout command you can "clean up" the canvas. This basically makes M-Files suggest a
default positioning for the workflow components.
Show Grid and Hide Grid
The Show Grid and Hide Grid commands toggle the grid shown on the background.
Print
You can create a paper copy of the workflow by using the Print command in the task area.
Note: The print function uses the Page setup settings of Internet Explorer for the page header and
footer. You can set the settings for the header and footer to empty if you want to remove them from
the printout. For instance with Internet Explorer 10, you can open the Page setup dialog by clicking
the tools button in the top-right corner of the browser and by selecting Print > Page setup.
Export as Image
In addition to creating a print-out, you can export the workflow as a PNG file. Clicking the Export as Image
command opens the common Windows save dialog for the image file.
Tooltips
The state rectangles and connectors may display a tooltip while the cursor is hovered above them.
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In addition to the title of the element, the tooltips may contain a description as well as information on the
state transition conditions and special actions related to the transition or workflow state.
Creating and Editing Workflows
The Workflow feature enables automating company processes. To create a workflow, click Workflows in
the left-side tree view of M-Files Admin and select New Workflow in the task area.

In this chapter
•
•
•

Creating a New Workflow
Workflow States
Workflow State Transitions

Creating a New Workflow
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Workflows.
6. In the task area, click New Workflow.
The Workflow Properties dialog is opened.
7. In Name, enter a name for the workflow.
8. Optional: In Description, enter a description.
9. Optional: Click Add... to add states to the workflow.
You can also add states with the New State command in the graphical workflow designer. Use
the arrow buttons to change the order of the states.
Note: If a class has a default workflow and a new object is created in the class, the
first state is chosen automatically only if the first state is the first on the States list of the
Workflow Properties dialog. The order of states on the list overrides the order of states
in the graphical workflow designer.
10.Optional: In Allow using this workflow with the following class, select a class if you want to let
users select this workflow for objects of that class only.
11.Optional: On the Permissions tab, change who can see the workflow.
12.Optional: On the Advanced tab, enter an alias for the workflow.
When you have automatic aliases in use and you write a name on the General tab, the Aliases
field on the Advanced tab is automatically filled in. The alias has the format <predefined
prefix>.<name>. Define automatic aliases for your vault in the configurations editor.
13.Click OK.
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The workflow you have just created is added to the Workflows list. You can add workflow states and state
transitions to it by selecting the workflow from the list and using the tools on the Tools pane.
•
•

For instructions on adding workflow states to a workflow, see Adding States to a Workflow.
For instructions on adding state transitions between states in a workflow, see Adding State Transitions
to a Workflow.

Workflow States
Workflow states are used for dividing workflows into smaller stages. You can create a new workflow state
by double clicking the canvas in the Graphical Workflow Designer or by clicking the Add... button on the
General tab of the Workflow Properties dialog (see Creating and Editing Workflows).
Individual states allow a variety of settings. The General tab contains the name and the description of
the state. The properties dialog for a workflow state also includes the tabs Conditions, Actions, and
Advanced. The Advanced tab allows you to assign an alias for the state. When you have automatic
aliases in use and you write a name on the General tab, the Aliases field on the Advanced tab is
automatically filled in. The alias has the format <predefined prefix>.<name>. Define automatic aliases
for your vault in the configurations editor. For more information on aliases, see Associating the Metadata
Definitions.
Note: In versions 2015 and earlier, the State Properties dialog contains the State Transition tab.
This can be enabled in M-Files 2015.1 and later by using a Windows registry setting. Ask your MFiles consultant for more information, or write to our customer support at support@m-files.com.

In this chapter
•
•
•

Adding States to a Workflow
Workflow State Conditions
Workflow State Actions

Adding States to a Workflow
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Workflows.
6. Select a workflow from the Workflows list and click New State on the Tools pane.
The State Properties dialog is opened.
7. In the Name field, enter a name for the workflow state and, in the Description field, enter an optional
description for the state.
8. Optional: In the Conditions tab, specify the preconditions and postconditions that must be met before
an object can be moved in or out of this state.
For more information on workflow state conditions, refer to Workflow State Conditions.

M-Files | 3. System Administration | 482
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
9. Optional: In the Actions tab, specify the actions that are performed when an object is moved to this
state.
For more information on workflow state actions, refer to Workflow State Actions.
10.Click OK to close the State Properties dialog.
11.Click Save to save your changes.
The new state you have just defined is added to the workflow. The state can be seen in the graphical
workflow designer.
•
•

•

For instructions on adding state transitions between states in a workflow, see Adding State Transitions
to a Workflow.
To change the icons of the workflow states, open Metadata Structure (Flat View) > Value Lists. Then
click Show All Value Lists, double-click Workflows, and finally click Contents. Select the workflow
and the state and click Change Icon. For more information, see Changing the Icon of a Value in a
Value List.
For instructions on creating a new workflow, see Creating a New Workflow.

Workflow State Conditions
On the Conditions tab you can specify different pre- and post-conditions for the state transitions. For
example, you can define specific properties or their values that a document should meet before it can
moved to this state. The conditions can also specify that, for instance, the basic documents related to
the project (specification document, implementation and project timetable instructions, etc.) must be on a
certain level before moving to the next level is possible.
The conditions can be specified in broader scope and detail using variables, generic features of VBScript,
and M-Files API. The following variables can be used in advanced conditions: VaultSharedVariables,
MFScriptCancel, CurrentUserID, Vault, DisplayID, ObjVer, PropertyValues, StateID,
PropertyDef, SavepointVariables, TransactionCache, and GetExtensionObject. For more
information about variables, refer to Available VBScript Variables.
Note: The M-Files API documentation is available online: M-Files API. For more information about
using VBScript in M-Files, see the How do I write VBScript code for M-Files purposes? tutorial.
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Figure 85: The Conditions tab of the workflow state properties.
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Preconditions
The state preconditions specify the object properties that are required in order for the object to be moved to
this state.
For example, you can specify that the Approved by information must be entered before the document can
be moved to the Approved state.
Postconditions
The state postconditions specify the object properties that are required in order for the object to be moved
out of this state.
For example, you can specify that the Cost center information in a purchase invoice must be entered
before the document can be moved from the Awaiting definition of cost center state.
Workflow State Actions
The Actions tab is used for setting the actions to be performed when the object enters to a certain state.
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1.
2.
3.
4.
5.
6.

Set permissions, Delete, and Mark for archiving
Send notification and Set properties
Convert to PDF format
Run script
Assign to user
Create separate assignments

The actions are executed in the following order:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Mark for archiving
Assign to user
Create separate assignments
Send notification
Set properties
Convert to PDF format
Set permissions
Run script
Delete

In this chapter
•
•
•
•
•
•

Set permissions, Delete, and Mark for archiving
Send notification and Set properties
Convert to PDF format
Run script
Assign to user
Create separate assignments

Set permissions, Delete, and Mark for archiving
You can define new permissions to be set, the object to be deleted, and/or archiving to be performed as a
result of a state transition. Several options of the Actions tab can be selected at the same time.
Do not use automatic permissions
As a result of this state transition, the object bypasses the automatic permissions that would normally
be applied to the object, and the effective permissions for the object version are configured with the Set
permissions feature.
Ignore the permissions of the latest checked-in version for this version
The permissions of the objects are version-specific in M-Files. In order for you to access the latest object
version, you must have at least read access to it. To access any of the previous versions, you must have
at least read access to that specific version and to the currently latest version. Enabling this check box
ignores the permissions of the latest checked-in version and grants users access to prior versions of the
object to which they have at least read access rights – regardless of the permission settings of the latest
version.
This feature merits an example: Let's suppose that we have an SOP and an SOP workflow with the states
Draft, Waiting for Approval and Approved. All three states have different permissions, as a draft is shown
only to the user who created the document, and an approved document is shown to all users.
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The document is now at version 3 and in the Approved state (and thus visible and accessible to all users).
As modifications need to be introduced, it is moved back to the Draft state and the permissions are
changed so that only the creator of the document can see it. If the check box Ignore the permissions of
the latest checked-in version for this version was active when the new version was created, all users
would still be able to access the document version 3, but not the newest one. If the check box was not
active, however, only the creator of the document would be able to see the document version 3.
Note: Even if the Ignore the permissions of the latest checked-in version for this version
option was enabled, the document would still not be visible in searches and views if they do not
have the Look in the metadata of all versions option enabled.
Send notification and Set properties
Send notification
To send a notification, first define the recipient users and user groups. Then enter the notification subject
and the message. You can also specify the user from metadata or state transitions.
The Add Placeholder... buttons can be used to insert values from the object metadata to the subject line
or message content (see also the placeholder descriptions under Personalizing Notification Messages).
Set properties
You can define different object properties and values to be applied when an object's state is changed. For
example, you can make the Published version label to be assigned to a drawing when the drawing moves
to the Approved state.
Convert to PDF format
Files of the object can be automatically converted into PDF form on the server when the object changes
state. Conversion to PDF on the server can be done for files in such source formats as Microsoft Word,
Microsoft Excel, Microsoft PowerPoint, Microsoft Outlook, and Visio, as well as RTF and OpenOffice files.
When converting to PDF, M-Files updates the M-Files property fields, if any, in Microsoft Word and
Microsoft Excel documents by using the current metadata of the object.
Conversion settings
When you activate the Convert to PDF function from the Actions tab, M-Files converts the files in a
single-file or multi-file document to PDF form automatically when the object's state changes. You can
define advanced settings for the conversion.
Store each PDF file as a separate file next to the original file: If you also want to keep the file in its
original format, select to store the PDF file next to the original file. Then the PDF file does not replace
the original. The PDF file is created with the same name as the original file. If this function is applied to a
single-file document, M-Files changes it into a multi-file document when creating the PDF file.
Overwrite existing PDF files: If there are already PDF files with this name in the multi-file document,
select this option if you want to overwrite the identically named existing PDF files with the versions created
via this function. If this option is not selected and the multi-file document already has a PDF file with the
same name, M-Files will notify of the error and the PDF file will not be created.
Convert to PDF/A-1b: Select storage in PDF/A-1b form when you want to comply with ISO standard
19005-1:2005 for long-term preservation of electronic documents. PDF/A-1b is a more restricted format
than that of standard PDF files, so files converted to PDF/A are often bigger than files converted to
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standard PDF. In addition, in export to PDF/A, certain advanced appearance settings may be omitted.
You should use conversion to PDF/A form only if it is particularly necessary on account of, for example,
requirements for long-term preservation.
Prevent state transition if the object contains files in an unsupported format: Select this if you want
to prevent the state transition in cases wherein the PDF conversion function encounters files with formats
that cannot be exported as PDF files (for instance, ZIP files). An error message is displayed and the state
transition is prevented.
Run script
Operations can be specified in more detail using variables, generic features of VBScript, and M-Files API.
For example, you can set consecutive numbers for different publication versions or add the send date for a
document when it moves to the Sent state.
The following variables can be used in this script: VaultSharedVariables, MFScriptCancel,
CurrentUserID, Vault, DisplayID, ObjVer, PropertyValues, StateID, SavepointVariables,
TransactionCache, PropertyDef, and GetExtensionObject. For more information about variables,
refer to Available VBScript Variables.
Note: The M-Files API documentation is available online: M-Files API. For more information about
using VBScript in M-Files, see the How do I write VBScript code for M-Files purposes? tutorial.
Assign to user
Assignments are an important part of workflows. They transfer information and responsibility for task
execution to the correct person automatically during a state transition. M-Files offers two types of
assignments for use in connection with workflows.
By selecting Assign to User, you can create an assignment that does not result in a separate object. An
assignment created with this option is switched to the "complete" state when one of the persons to whom
the task was assigned changes the document state in the workflow (usually by moving the object to the
next state).
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Figure 86: Define the task in the Assignment dialog.

In the object's properties, you can see whom it has been assigned to, provided that the object is in a state
to which an assignment is related. The person to whom the task was assigned can change the state by
using the functions in the task area or metadata card or in the context menu.
Note: If a user creates the assignment, only this user and users with full control of the vault can
edit the Assigned to property value. However, if the assignment is created via a workflow, only
users with full control of the vault can edit the property value.
Create separate assignments
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You can also have separate assignments created once the object workflow is moved to a certain state. To
create such assignments, enable Create separate assignments and click Add... on the Actions tab of
the State Properties dialog.
If you want the workflow state to be automatically changed after the completion of the separate
assignment(s), you need to define that in the Trigger options of the state transition.
Adding and Removing users
You can manage the persons responsible for completing the task by using the Add... and Remove buttons
in both the Assign to User dialog and the Create separate assignment dialog. In addition to adding
users via the Users or user groups list, you can add users based on metadata or a state transition.
For example, a person who has been specified in the property Approved by in the object's metadata
can automatically be specified as the person to whom the task is assigned. For more information, see
Permissions under Workflow State Transition Permissions and Pseudo-users.

Figure 87: Selecting a user based on an earlier state transition.

Monitoring
In the Monitoring section (Actions > Create separate assignments > Monitoring), you can define
the users that you want to notify each time a task has been completed. The assignment submitter is
automatically defined as a task monitor.
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There are separate icons for uncompleted and completed assignment objects, making it easy to distinguish
between uncompleted and completed assignments.
Assignment class
The assignment class determines the assignment type and assignment completion conditions. See
Assignment Class for more information.
Assignment description
Add a free-form description of the task. The assignment notice by email displays the description to the
person to whom the task was assigned. Notification templates supported by M-Files can also be included
in the description. For more information on notification templates and placeholders, refer to Editing
Notification Settings in M-Files Admin.
Deadline
If desired, you can specify a deadline for the assignment. An automatic reminder is sent if the assignment
has not been marked complete when the deadline is approaching. The reminder will be sent using a
common notification rule which can be deleted by the administrator.
Tip: The deadline can also be useful for creating views. You can create a view to display any
assignments with an approaching deadline. For more information about views, refer to Creating a
View.
Creating a Workflow State with a Separate Assignment
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Workflows.
6. Select a workflow that you want to edit from the Workflows list.
The workflow is opened in the graphical workflow designer.
7. In the graphical workflow designer, right-click a workflow state to which you want to add a separate
assignment and select Edit.
The State Properties dialog is opened.
8. In the Actions tab, check the Create separate assignments check box and click the Add... button.
The Create Separate Assignment dialog is opened.
9. Click Add... to add the user or users the separate assignment is assigned to.
10.Optional: Click Monitoring... to add a user or users who will receive a notification once this assignment
is marked complete, approved, or rejected.
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11.From the Select assignment class drop-down menu, select the assignment class for the separate
assignment.
12.In the Title field, enter a title for the assignment and, in the Assignment description field, enter an
optional description for the assignment.
By clicking the Add Placeholder... button, you can add placeholders for metadata properties in
the Title and Assignment description fields.
13.Optional: Check the Deadline check box and select the number of days to define a deadline for the
separate assignment.
14.Click OK to close the Create Separate Assignment dialog.
15.Click OK to close the State Properties dialog.
16.Click Save to save your changes.
The separate assignment is added to the workflow state. When an assignment with the aforementioned
workflow is moved to the aforementioned state, the separate assignment is created and added as a linked
assignment under the primary assignment.
Workflow State Transitions
Workflow state transitions are used for moving from one workflow state to another. The transitions can be
intiated manually by users or triggered automatically by M-Files Server. They may also be set to require an
Electronic Signatures.
The General tab
The General tab contains the name of the state transition as well as an optional description for the state
transition.
The Electronic Signature tab
The Electronic Signature tab allows you to enable eSigning for a state transition. If enabled, an electronic
signature must be signed by the user before the state transition is performed. See Electronic Signatures for
more information.
The Trigger tab
On the Trigger tab, you can define conditions for automatic state transitions. See Trigger for more
information.
The Advanced tab
On the Advanced tab, you can set an alias for the state transition. For more information about using
aliases, see Associating the Metadata Definitions.

In this chapter
•
•
•
•
•

Adding State Transitions to a Workflow
Parallel State Transitions
Workflow State Transition Permissions
Electronic Signatures
Trigger

M-Files | 3. System Administration | 493
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
Adding State Transitions to a Workflow
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Workflows.
6. Select a workflow that you want to edit from the Workflows list.
The workflow is opened in the graphical workflow designer.
7. In the graphical workflow designer, place your cursor on the border of the state from which you want to
create a state transition so that your cursor changes to a crosshair.
8. Holding down the left mouse button, draw a state transition by dragging the mouse cursor from the
selected state to another.
9. Right-click the state transition arrow that you just created and select Edit from the context menu.
The State Transition dialog is opened.
10.In the Name field, enter a name for the state transition and, in the Description field, enter an optional
description for the transition.
11.Optional: In the Electronic Signature tab, you can specify an electronic signature that must be
provided before completing this state transition.
For more information on electronic signatures, refer to Electronic Signatures.
12.Optional: In the Trigger tab, you can define a condition that triggers this state transition once the
condition is fulfilled.
For more information on triggers, refer to Trigger.
13.Click OK to close the State Transition dialog.
14.Click Save to save your changes.
The state transition is added to the workflow between the selected workflow states. This is manifested by
the arrow between the states in the graphical workflow designer.
•
•

For instructions on adding states to a workflow, see Adding States to a Workflow.
For instructions on creating a new workflow, see Creating a New Workflow.

Parallel State Transitions
You can define multiple workflow state transitions between two states. This is useful, for instance, if
you need to define multiple automatic transitions based on different criteria. For more information about
creating state transitions, see Adding State Transitions to a Workflow.
Example: Creating a Workflow with a Parallel State Transition
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The target in this example is to modify an existing sample vault workflow, such as Reviewing drawings,
to be automatically moved to the Rejected state if no one moves it to the Approved (or Rejected) state
within 10 days after the transition to the Listed for approval state.

Figure 88: The workflow moves to the Rejected state automatically if if nobody moves it to the Approved state.

To modify the workflow, do the following steps:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Workflows.
6. In the Workflows list, select one of the existing workflows, such as Reviewing drawings.
The workflow is shown as a flowchart in the graphical workflow designer below the Workflows
list.
7. Click New State in the Tools pane to create a new state for the workflow.
If you already have a state called Rejected in your workflow, you can skip this and the next step,
and proceed to step 8.
The State Properties window is opened.
8. Enter the name Rejected in the Name field and click OK to close the State Properties window.
9. In the graphical workflow designer, place your cursor on the border of the Listed for approval state (or
any other intermediary state, if your workflow does not have the Listed for approval state) so that your
cursor changes to a crosshair.
10.Hold down the left mouse button and drag the crosshair to the Rejected state to draw a state transition
between the Listed for approval and Rejected states.
11.Repeat step 8 to draw another state transition between the Listed for approval and Rejected states.
12.Right-click one of the state transition connector arrows and select Edit.
If you are seeing only one connector arrow between the states, the connectors are most likely
on top of each other. Click the topmost connector to select it and click and drag the handles to
reshape the connector.
13.Go to the Trigger tab, select the Trigger the state transition after option, and enter 10 in the days
field.
14.Click OK to close the State Properties window.
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15.Click Save in the upper-right corner of the graphical workflow designer to save the changes you have
made to your workflow.
You should now have a workflow with two parallel state transitions from the Listed for approval state to the
Rejected state: one that is initiated by users and another that is triggered automatically after 10 days if it is
not initiated by users in 10 days.
Workflow State Transition Permissions
You can access the state transition permissions by adding and selecting a state transition, clicking the Edit
Transition... button and selecting the Permissions tab.
Permissions
On the Permissions tab, you can specify which users are allowed to perform an explicit state transition.
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Figure 89: Define permissions for changing state by means of state transitions.

The Select Users or User Groups dialog under the Add... button also contains the options User from
metadata and User from state transition.
User from metadata
You can also utilize pseudo-users in state transitions. For example, you can specify that invoices are to be
accepted only by the project manager of the project linked to the invoice. In other words, you can define
users via the object's metadata. Then the right to perform state transitions is not bound to a certain named
person; it is instead determined dynamically on the basis of an object's metadata.
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User from state transition
You can also select users on the basis of previous state transitions. You can specify that the document
can be moved from the Approved state to Approval undone only by the user who originally moved the
document into the Approved state.
Electronic Signatures
The electronic signature features offered by the Electronic Signatures and Advanced Logging module
expands the M-Files workflows: the state transition can be certified with user credentials. You can use
electronic signatures to certify, for example, approval of documents.
If you specified an electronic signature for the state transition, the signature is always required from the
user before the change in state. The state changes when the object is checked in. The change of state with
a signature can only be done one object at a time. Only users that have Windows authentication in use can
do state changes that require an electronic signature. The user adds an electronic signature to the state
transition when they enter their identification data and log in. The electronic signature does not refer to an
electronic "fingerprint". The electronic signature always requires the user to enter the user identification
and to log in.

Figure 90: You can require users to give their electronic signature before they can make a specific state transition in a workflow.

The Electronic Signatures and Advanced Logging module is available for a separate fee. This module
includes event logging extensions and electronic signature functionality. For more information, see
Electronic Signing and Compliance.
Electronic signature for workflow state transitions
To incorporate an electronic signature with a workflow state transition:
1. Select a transition in the Graphical Workflow Designer.
2. In the task area, click Edit Transition.
3. Move to the Electronic Signature tab.
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Figure 91: The Electronic Signature tab for a state transition.

Select Require electronic signature for this action to modify the options.
Signature meaning
With the Signature meaning options, you can select either a predefined signature reason-meaning
pair or specify multiple meanings for the signer to choose from. The signature reason is a brief headinglevel description for the signature, such as Approval of instruction document or Approval of invoice. The
signature meaning is a description that tells the signer what will be approved. The maximum number of
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characters is 500, and you can use placeholders. The placeholders are listed in Placeholders for Signature
meaning, Signature reason, and Additional information fields.
Examples
If you entered "Signed by %SIGNED_BY%" in the Signature meaning, the actual signature description
that the user sees is, for example, Signed by Alex Kramer.
If you want the substitute user's name to be shown, use the %SIGNED_BY_WITH_PROXY% placeholder.
If you entered "Signed by %SIGNED_BY_WITH_PROXY%" in the Signature meaning and Alex Kramer
signs, the signature description will be Signed by Alex Kramer. If the signer is a substitute user of Alex, the
signature description will be Signed by Andy Nash, on behalf of Alex Kramer.
In the image, the user has defined this signature meaning: "By moving this drawing from state
%SIGNED_FROM_STATE% to %SIGNED_TO_STATE%, I confirm the drawing to be ready for the
delivery to the client."

Figure 92: The signature meaning displayed on an electronic signature prompt.

Signature metadata
You can set the electronic signature to require the signer to add a value for a selected metadata property,
such as Comment. The text is saved either to a separate signature object (see Create a separate
signature object) or to the object with the workflow. You can also add more information to the Additional
information text box. In Additional information, you can use placeholders (listed in Placeholders for
Signature meaning, Signature reason, and Additional information fields).
Create a separate signature object
Select this option if you want to create a new object for the signature. Then the signature object is
automatically in relationship with the object where the state transition is in use.
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Note: M-Files can create the signature objects only when you set up certain metadata definitions.
For more information, see Metadata Definitions for an Electronic Signature Object.
Identifier
The identifier is free-form text. You can set, for example, Purchase Invoice Approval as the identifier. In the
creation of the signature object, the identifier becomes a part of the metadata for the object. The Identifier
property can be used in, for example, scripts for state-transition functions or in searches to individualize a
certain type of signature.

Figure 93: A signature object with information on the signer, the signing date, the meaning of the signature and other elements.
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Save signature manifestation as text to a property
Select the property that you want the signature to be associated with. Then the specified content of the
signature is shown as the property value in the metadata of the object. The default property is Signature
manifestation. The text content of the signature property consists of the reason, meaning and additional
information for the signature.
Note: If you use the same property for signatures of all state transitions in the workflow, such as
the default property Signature manifestation, you can see only the latest signature manifestation
in the metadata of the object's latest version. You can find other signatures with their contents
(manifestations) from the version history of the relevant object.
You can also create a separate property definition of your own for each signature of the relevant state
transition in the workflow. Then you can see all of the properties created and their signature content
(manifestations) in the metadata of the object's latest version.
Note: If you first create a property in the Property definitions area, specify its permissions in such a
way that the users can see the property used in the signatures but cannot edit it.
Placeholders for Signature meaning, Signature reason, and Additional information fields
The available placeholders to be used with the Signature meaning, Signature reason, and Additional
information fields are listed in this table.
Placeholder

Description

%SIGNED_AT_UTC%

The UTC time at the time of signing. You can use this
placeholder only with the Additional information field.

%SIGNED_AT_LOCAL%

The time on the client computer at the time of signing.
You can use this placeholder only with the Additional
information field.

%SIGNED_AT%

The time on the server computer at the time of signing.
You can use this placeholder only with the Additional
information field.

%SIGNED_BY%

The signer name.

%SIGNED_FROM_STATE%

The source state.

%SIGNED_TO_STATE%

The target state.

%SIGNED_FOR_STATETRANSITION%

The title of the state transition for which the electronic
signature is required.

%SIGNED_BY_WITH_PROXY%

Shows the name of the signer and the user on behalf
of whom an assignment is electronically signed. For
example: "Preston Present, on behalf of Abraham Absent".
See the usage examples.

In this chapter
•
•

Metadata Definitions for an Electronic Signature Object
Inserting the Signature Property to Microsoft Office Documents

Metadata Definitions for an Electronic Signature Object

M-Files | 3. System Administration | 502
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
In order for automatic signature objects to be created in M-Files, aliases must be created for the new object
type as well as for the required property definitions. The aliases are used for creating objects at the time of
signing. If you are using M-Files Compliance Kit, these definitions should already be available. Otherwise,
you should create the metadata definitions below to activate the separate signature objects.
Object type
Create a new object type and name it, for example, the Signature object type. In the advanced settings,
specify the object type alias:
M-Files.QMS.Signature.ObjectType
Required property definitions for the signature object
When you have created the new object type, M-Files automatically creates an equivalent property
definition. Select this property definition in the property definitions and add the following alias:
M-Files.QMS.Signatures
In addition to this, add the property definitions listed below:
Suggested property
name

Alias

Data
type

Description

Identifier

M-Files.QMS.Signature.Id Text
entifier

The identifier property is added to the
electronic signature when the electronic
signature object is created. The
identifier property value is specified in
the electronic signature settings in MFiles Admin.

Reason for signature

M-Files.QMS.Signatur
e.Reason

Text

A brief heading-level description for the
signature.

Signature meaning

M-Files.QMS.Signatur
e.Meaning

Text
(multiline)

A description enabling the signer to
understand what is being approved.

Signer

M-Files.QMS.Signature.Si Choose
gner
from list
"Users"

The vault user electronically signing the
state transition.

User

MChoose
Files.QMS.Signature.User from list
"Users"

The vault user to whose identity the
signature is bound when the signature
is used for moving an assignment to
a terminal state, such as Completed,
Accepted, or Rejected.

You can freely name the required property definitions mentioned above, but you should use the most
descriptive names possible, since this information is shown in the metadata of the signature object.
Optional property definitions for the signature object
You can also create various optional property definitions for the signature object. For example, you may
want to create a new property definition for additional signature information with the data type Text (multiline) and add the following alias:
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M-Files.QMS.Signature.AdditionalInfo
The rest of the optional properties are listed below:
Alias

Data type

Description

M-Files.QMS.Signature.Signer
.Name

Text

Contains the full name of the signer.

M-Files.QMS.Signature.Signer.Acc
ount

Text

Contains the M-Files account name of the
signer.

M-Files.QMS.Signature.LocalTimes
tampText

Text

The local time of the signature as text,
including the timezone information.

M-Files.QMS.Signature.UTCTimesta Text
mpText

The UTC time of the signature as text,
including the timezone information.

M-Files.QMS.Signature.UTCTimesta Timestamp
mp

The UTC timestamp of the signature.

M-Files.QMS.Signature.Date

Date

The signature date in local (server) time.

M-Files.QMS.Signature.FromState

Choose from list
"States"

The workflow state prior to the state
transition. Available only when signing state
transitions.

M-Files.QMS.Signature.ToState

Choose from list
"States"

The workflow state after the state transition.
Available only when signing state
transitions.

M-Files.QMS.Signature.StateTrans
ition

Choose from list
"State Transitions"

The workflow state transition that has been
executed. Available only when signing state
transitions.

Executed, empty, and invalidated signature objects and how to utilize them
You can also create so-called empty signature objects and use them to monitor which signatures have not
yet been signed and which signatures have already been executed. You can utilize these empty, executed,
and invalidated signature objects creating different classes for the signature object type.
Here are the aliases which, if specified for classes of the Signature object type, are utilized by M-Files in
various phases of electronic signing:
M-Files.QMS.Signature.Class.Empty
M-Files.QMS.Signature.Class.Executed
M-Files.QMS.Signature.Class.Invalidated
Permissions
Metadata definitions (object type and property definitions) created for the automatic signature object should
be secure; it should not be possible to create signature objects manually or change their metadata. Also
the property definition that binds the signed object to the signature must be secure. If you are using M-Files
Compliance Kit, these definitions are already available.
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Separate signature object
When you have created the necessary definitions and chosen creation of a separate object for the
signature, the object will be automatically created after signing.
The name of the signature object is created automatically from the signature reason, signer and
timestamp.
Other metadata for the signature object are created automatically on the basis of the signature definitions.
Inserting the Signature Property to Microsoft Office Documents
The text content of the signature property can be added to a Microsoft Word, Microsoft Excel, or Microsoft
PowerPoint document in the same way as other M-Files properties.
When the user selects the added property from the list, the property name, such as the name of the builtin property Signature manifestation, is displayed. This is why it is recommended to make the name of the
property as unambiguous as possible.
When the property is selected, M-Files automatically adds the text content to the document. You should
bear this in mind when you define the reason and meaning for the signature.

Figure 94: The signature content (manifestation) can be added to Microsoft Office documents by using the Insert Property function.

Note: If the signature is inserted in the Microsoft Office document and you want to cancel the state
transition, you should cancel it manually by removing the property value (signature manifestation)
or the property itself, in order for the cancellation to apply for the document. In most cases, rolling
back this kind of state transition to the previous state requires system administrator rights.
Trigger
On the Trigger tab, you can define a trigger to automatically start a state transition when certain conditions
are fulfilled. For example, you can define a state transition to occur when all the assignments of the current
workflow state are completed or approved.
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Figure 95: An automatic state transition for an object can occur for example on the basis of the property values of the object.

The server does automatic state transitions. User permissions are ignored. This means that you can
use permissions to prevent users from manually starting a state transition. M-Files Server does the state
transition when all the assignees have completed the task.
Using various criteria for the automatic transition
You can define an automatic state transition to occur when an object fulfills certain conditions. You can
configure, for example,that the object is moved to the next state when a user gives it a certain property or
certain property value. For example, in the message process workflow, you can define that when a user
adds a date to the Sent field for the document, the document will automatically be moved to the Sent state.
You can also define that the state is changed after users have completed, approved, or rejected all
separate assignments. As an alternative, you can specify custom criteria for the state change. For more
information about filter settings, see Status-Based Conditions, Property-Based Conditions, File Information
Based Conditions, and Permissions-Based Conditions.
Using a user-defined script for the automatic transition
You can also write a script that makes the state transitions occur. This allows you to specify the transition
conditions in more detail with variables, generic features of VBScript and M-Files API. For example, you
can define several state transitions related to the properties and property values at the same time.
In this script, you can use these M-Files variables: StateID, StateTransitionID,
AllowStateTransition, NextStateID, ObjVer, DisplayID, Vault, CurrentUserID,
CurrentUserSessionInfo, PropertyValues, VaultSharedVariables, SavepointVariables,
TransactionCache, MFScriptCancel, GetExtensionObject, MasterTransactionID,
CurrentTransactionID, ParentTransactionID. For more information about variables, see Available
VBScript Variables.
Note: The M-Files API documentation is available online: M-Files API. For more information about
using VBScript in M-Files, see the How do I write VBScript code for M-Files purposes? tutorial.
Evaluation priority
With the evaluation priority, you can define the priority of parallel state transitions on M-Files Server. The
priority is sorted from the lowest to the highest number. Zero (0) represents the highest priority.
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Defining vaults for state transitions
You can define in which vaults the state transition occur. Enter the vault GUIDs separated by semicolons
(;).
Evaluation of the triggering criteria
M-Files evaluates the state transition trigger every 60 minutes and every time the object is changed.

3.2.4. Named Access Control Lists
A named access control list is a list of permissions that can be attached to an object. It is a list consisting of
one or more subjects (users, user groups, or pseudo-users) and operations (delete, edit, read, or change
permissions) that are either allowed or denied to those particular subjects. Named access control lists
make managing permissions in M-Files very quick and effortless.
Tip:
The best practice to define access rights in named access control lists is via user groups instead of
individual users.
Making changes to named access control lists in large vaults can be very slow and may therefore
sometimes cause lock conflicts. Therefore, it is recommended that changes to named access
control lists and, in turn, to object permissions are made during off-peak hours when user access to
the vault is limited.

In this chapter
•
•
•

Creating a New Named Access Control List
Modifying Named Access Control Lists
Named Access Control List Permissions

Creating a New Named Access Control List
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click Named Access Control Lists.
6. In the task area, click New Named Access Control List.
The Named Access Control List Properties dialog is opened.
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7. In the Name field, enter a descriptive name for the named access control list.
It is recommended to name the named access control list according to the members of the list
and the permissions given to them, such as Visible to company management only.
8. Click Add to add users or user groups to this named access control list.
The Select Users or User Groups dialog is opened.
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9. Select one of these options:
a. The Users or user groups option and select the users or user groups that you wish to add to this
named access control list.
Tip:
The best practice to define access rights in named access control lists is via user groups
instead of individual users.
Making changes to named access control lists in large vaults can be very slow and may
therefore sometimes cause lock conflicts. Therefore, it is recommended that changes to
named access control lists and, in turn, to object permissions are made during off-peak hours
when user access to the vault is limited.

or

Tip: You can select more than one item at once. Hold down the Ctrl key to select multiple
individual items or hold down the ⇧ Shift key to select adjacent items on the list.

b. The User from metadata option and use the drop-down menu to select the property containing
users or user groups on the basis of which permissions are granted. For more information, see
Pseudo-users.
10.Click Add to add the selected users or user groups to the named access control list and to close the
Select Users or User Groups dialog.
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11.Back in the Named Access Control List Properties dialog, select the user or user group whose
permissions you want to adjust from the Users and user groups list.

12.Select the permission that you want to adjust and check either:
a. The Allow check box if you want to allow the selected permission for the user or user group.
or
b. The Deny check box if you wanto to deny the selected permission for the user or user group.
Tip: For optimal performance in large vaults, named access control lists should only be used
to allow access rights instead of explicitly denying them.

13.If you want to adjust additional permissions, repeat the steps 11 and 12.
14.Optional: On the Permissions tab, you can specify the users who can see this named access control
list.
15.Optional: On the Advanced tab, you can specify an alias for the named access control list.
For more information, see Associating the Metadata Definitions.
When you have automatic aliases in use and you write a name on the General tab, the Aliases
field on the Advanced tab is automatically filled in. The alias has the format <predefined
prefix>.<name>. Define automatic aliases for your vault in the configurations editor.
16.Click OK.
The new named access control list containing a set of permissions can now be attached to an object using
the permission control on the metadata card.
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Modifying Named Access Control Lists
When you modify a named access control list, the modified permissions are applied to either new
and existing objects to which the named access control list is already attached or to new objects only,
depending on your choice.
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click Named Access Control Lists.
The list of named access control lists in the selected vault is opened in the right-side pane.
6. In the Named Access Control Lists list, right-click the item that you want to edit and select Properties
from the context menu.
The Named Access Control List Properties dialog is opened.
7. Optional: On the General tab, click Add... if you wish to add a new user or user group to this named
access control list.
a) Select the user or user group that you want to add to the named access control list.
Tip:
The best practice to define access rights in named access control lists is via user
groups instead of individual users.
Making changes to named access control lists in large vaults can be very slow and
may therefore sometimes cause lock conflicts. Therefore, it is recommended that
changes to named access control lists and, in turn, to object permissions are made
during off-peak hours when user access to the vault is limited.
Tip: You can select more than one item at once. Hold down the Ctrl key to select
multiple individual items or hold down the ⇧ Shift key to select adjacent items on the
list.
a) Optional: Select the User from metadata option if you want to add users based on metadata
properties to the named access control list. Use the drop-down menu to select the desired property.
For more information, see Pseudo-users.
b) Click Add to add the users or user groups to the named access control list.
8. Select the user or user group whose permissions you wish to adjust from the Users and user groups
list.
9. Depending on your choice, select either the Allow or Deny option for the desired operations.
10.Click OK once you are done to close the Named Access Control List Properties dialog.
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11.Optional: If the selected named access control is already used in the permissions of one or more
objects, the Confirm Update dialog is opened.
a. Click Change Objects' Permissions if you wish to apply your changes to the permissions of
existing objects that use the selected named access control list in their permissions.
Note: Object permissions are updated as an asynchronous background task. Object
permissions may be updated when, for example, a named access control list, a user, a user
group, or the value of a pseudo-user (such as a project manager) is modified. You may
monitor the progress of the task in M-Files Admin in the Background Tasks section. For
more information, see Monitoring Background Tasks.
or
b. Click Preserve Objects' Permissions if you do not wish to apply your changes to the permissions
of existing objects that use the selected named access control list in their permissions.
The changes you have made are to the named access control list are saved and applied, depending on
your choice, to new and existing objects that employ the selected named access control list or to new
objects only.
Named Access Control List Permissions
Access for viewing the selected access control list can be defined on the Permissions tab. The selected
list can be made invisible to certain users.
Note: The system administrator and all users with full administrative access to the document vault
in question always see all the named access control lists.
Adjusting Permissions
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click a node that contains items that you want to edit. For example, Users.
Permissions settings are available for these items:
•
•
•
•
•
•
•
•
•

Users
User groups
Object types
Value lists
Property definitions
Classes
Class groups
Workflows
Named access control lists

6. Select an item in the listing area.
7. Right-click the item and click Properties.
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8. Go to the Permissions tab.
9. In Users and user groups, select the user or user group whose permissions you want to adjust.

If the user or user group is not on the list, click Add to add the user or user group to the list.
10.Select one of these options:
a. Select the Allow check box to allow the selected user to see this item.
or
b. Select the Deny check box to deny the selected user from seeing this item.
11.Optional: If you want to adjust additional permissions, repeat the steps from 7 to 10.
12.Click OK.

3.2.5. Installing and Managing Vault Applications
You can manage vault-specific client and server applications via M-Files Admin. These applications allow
you to modify and extend the behavior of your M-Files Desktop and M-Files Server. This way you can
choose to give priority to the functions that are the most important for the efficiency of your organization.
The application can be either a client application or a server application:
•
•

Client applications run on M-Files client computers and affect the behavior of M-Files Desktop.
Server applications run on the M-Files server computer and affect M-Files server behavior.
Note: Creating applications requires advanced programming skills. Instructions for the
programming are available from the M-Files technical staff for a separate fee. For more
documentation and sample applications, see the guide to M-Files UI Extensibility Framework.

To manage the applications of the document vault:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Do one of these:
a. Expand Document Vaults, and then right-click a vault.
or
b. Expand Ground Link Proxies, and then right-click a Ground Link proxy to configure the connector
over Ground Link.
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4. Select Applications from the context menu.
The Applications dialog is opened.

5. Perform one or more of the following operations, as necessary:
If you want to...
Install a new application

Do the following steps:

!

Warning: Do not install applications from
untrusted sources.

a. Click the Install... button.
b. Browse for the application package and click
Open.
c. Click Yes to restart the document vault.
Uninstall an application

Export an application

Disable an application and uninstall it from all
users

a. Select the application that you want to uninstall
in the applications listing.
b. Click Uninstall.
c. Click Yes to confirm uninstalling the
application.
d. Click Yes to restart the document vault.

a. Select the application that you want to export
in the applications listing.
b. Click the Export... button.
c. Select the location and the file name for the
export package and click Save.

a. Select the application that you want to disable
in the applications listing.
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If you want to...

Do the following steps:
b. Click Disable.
c. Click Yes to confirm uninstalling the
application.
d. Click Yes to restart the document vault.

Enable a disabled application

a. Select the disabled application in the
application listing.
b. Click Enable.
c. Click Yes to restart the document vault.

See the license status, or install or change the
a. Select the desired application in the
license of an application
applications listing.
b. Click the License button to open the
Application License Management dialog and
to view the license status and information of
the selected application.
c. If necessary, click the Install License...
button, browse for the license file, and then
click Open.

6. Click Close once you are done.
The changes you have made to the selected document vault should now be effective.
For information on enabling the applications in M-Files Desktop, see Managing Vault Applications in MFiles Desktop.

3.2.6. Using the Configurations Editor
The configurations editor in M-Files Admin allows you to define configurations for the following features of
the vault:
•
•
•
•
•
•
•

advanced vault settings
custom vault data
metadata card
federated authentication
intelligence services
external connectors
vault applications
Note: The configurations editor is available in English only. The editor requires Internet Explorer 9
or later to be installed.
Note: You must have the Full control of vault administrative right to use the configurations editor.
For more information, see Users.
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The configurations in the editor are hierarchical. You can select subsections of a configuration in the gray
navigation area, and the scope of the configuration shown in the Configuration or the Advanced tab
changes accordingly.
The configurations are defined in the Configuration tab. They may consist of configuration groups and
subgroups, and configurations keys and subkeys. Subitems in a group or a key can be expanded or
collapsed by clicking the arrow icon ( or ) next to the configuration key.
The Info tab provides you information about the use and purpose of the currently selected configuration
key:
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You may also hover your mouse cursor over the information icon (
the same information.

) next to the configuration key to see

You may comment a setting by selecting a setting and writing your comment in the Comment tab at the
bottom of the Configurations pane:

Commenting a setting may be useful if you, for example, want to inform other administrators as to why a
certain setting is used.
If there are errors in your configuration, they are shown in the Local or Server tab at the bottom of the
Configurations pane.
The Dashboard tab provides you information on the selected configuration category. It may also contain
an overview and status of your current configurations in the selected category.
The configurations are stored in JSON format. You may inspect, edit, as well as copy and paste the
configurations in plain JSON format in the Advanced tab.

In this chapter
•
•
•
•
•
•
•

Adding or Modifying Configurations
Adding Translations for Configuration Values
Exporting Configurations
Importing Configurations
Configuring Advanced Vault Settings
Configuring Custom Vault Data
Metadata Card Configuration

Adding or Modifying Configurations
Do the following steps to add or modify configurations in a vault:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Configurations.
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6. In the gray navigation area, expand the desired configuration category:

7. In the gray navigation area, locate and select the configuration key that you want to modify by
expanding and navigating the configuration tree:

8. In the right pane, either:
a. Modify the existing value.
or
b. Click the relevant Add button to add a new configuration value or subvalue.
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or
c. Open the Dashboard tab and click the relevant Add button to add a new configuration.
Configuration fields highlighted in red are required fields that must have a value.
If a configuration value requires a reference to a vault metadata structure item, you may
enter the first few letters of the name of the item in the configuration field and the editor then
suggests appropriate values. As you select an item from the available suggestions, the editor
automatically resolves the reference by the alias or ID of the item. You may change the type of
reference by clicking the value to the right of the equals sign and pressing the down arrow key:

9. When ready, click the Save button.
Your configurations are saved and are now effective.
Adding Translations for Configuration Values
You can add translations for certain configuration values.
If you are for example configuring a metadata card description for a certain object type, you may add
translations for the text used in the description, so that a vault user with the appropriate language settings
can see the description on the metadata card in the correct language.
Do the following steps to add translations for a configuration value:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Configurations.
6. In the gray navigation area, expand the configuration category that you want to edit and then locate the
configuration key for which you want to add translations.
The keys for which you can add translations can be identified by the cogwheel icon (
in the value field.
7. Click the cogwheel icon (

) on the right side of the configuration value field.

The Translate Content dialog is opened.

) shown
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8. Use the Default language drop-down menu to select the default language.
The translation for the default language is used if the requested translation is not available.
9. Use the Language drop-down menu to select the language of the value.
10.Enter the value in the text field in the selected value.
11.Click Add Translation to add a translation.
12.Repeat the steps 9 and 10.
13.Click OK when you are ready.
14.Click Save in the configurations editor to save your changes.
Exporting Configurations
You can export vault-specific configurations to a file and use the export file to import configurations, for
example, to another server computer.
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Do the following steps to export configurations:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Configurations.
6. In the gray navigation area, expand the configurations that you want to export.
7. In the gray navigation area, right-click a setting node and select Export to File... from the context
menu.
The Save As dialog is opened.
8. Specify a location and file name, and then click Save.
A confirmation dialog appears after the export is complete.
9. Click OK.
The configurations are exported to the specified location.
Importing Configurations
You can import vault-specific configurations from a configuration export file. This way you can, for example,
import configurations from one M-Files server computer to another.
Do the following steps to import configurations from a configuration export file:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Configurations.
6. In the gray navigation area, right-click a configuration category and select Import from File... from the
context menu.
The Open dialog is opened.
7. Locate and select the configuration export file, and then click Open.
A confirmation dialog appears after the import is complete.
8. Click OK.
9. Right-click the category and select Save All from the context menu to save the imported configurations.
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The selected configurations are imported to the server computer.
Configuring Advanced Vault Settings
The settings in the Advanced Vault Settings section of the M-Files Admin configurations editor allow you
to control how the vault functions. These settings were previously available as Microsoft Windows registry
settings. Settings added via the Advanced Vault Settings section are included in vault backups.
In the Advanced Vault Settings section, the system administrator can configure all the functionalities
listed in the table below. The table gives an overview of which settings also a user with the Full control of
vault administrative rights can adjust.
Configuration

Vault administrator

Assignments

Allowed

Automatic aliases

Allowed

Background tasks

Not allowed

Client

Partly allowed
Note: Set the Manage Client Settings
Centrally setting to Yes only after you have
read the description shown on the Info tab
in M-Files Admin.

Connections to external databases

Partly allowed

Connections to external sources

Partly allowed

Content replication and archiving

Partly allowed

Database

Partly allowed

Document comparison

Allowed

Duplicate detection

Allowed

Event log

Partly allowed

External repositories

Not allowed

File operations

Allowed

File previews

Not allowed

Ground Link

Partly allowed

M-Files add-in settings

Allowed

Multi-file documents

Allowed

Notifications

Partly allowed

PDF conversion

Partly allowed

Performance

Not allowed

Real object type hierarchies

Partly allowed

Reporting and data export

Not allowed

Scanning and OCR

Not allowed
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Configuration

Vault administrator

Scripting

Not allowed

Search

Partly allowed

Security

Not allowed

Thumbnails

Partly allowed

Translatable object titles

Allowed

User groups

Allowed

Views

Allowed
Note: Some of the settings in the Advanced Vault Settings section are for advanced
configuration and customization only, and therefore we recommend that you do not change any
settings unless you know what you are doing.

To configure vault settings:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a)
b)
c)
d)
e)
f)
g)

Open M-Files Admin.
In the left-side tree view, expand an M-Files server connection.
Expand Document Vaults.
Expand a vault.
Click Configurations.
In the navigation area, click Advanced Vault Settings.
Open the Configuration tab.
The advanced vault settings are shown.

2. Expand the section that you want to edit, and then edit settings that you want to change.
For more information, select a setting and see the Info tab.
Tip: Right-click a settings node to bring up a context menu with additional options, such
as Move Up, Move Down, and Make Copy.
3. When you are done, click Save to save the vault settings.
4. Some of the settings require that you restart the vault for the changes to take effect. For instructions,
see Restarting a Vault.
Example: Excluding Employee Objects from Metadata Searches
To configure your vault search engine so that Employee objects are not incuded in metadata searches:
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1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand Search > Excluded Object Types > Metadata-Based Searches.
3. Click Add Object Type.
4. In the Object Type field, press the down arrow key ↓ and then select Employee.
5. Click Save to save your settings.
After saving the setting, Employee objects are no longer included in metadata searches in the selected
vault.
Configuring Custom Vault Data
The Custom Vault Data section in the M-Files Admin configurations editor allows you to add and modify
custom vault data to affect the vault functionality. The most common type of custom vault data are custom
settings of the vault that allow you to add custom functionality to the vault. Sets of custom vault data are
registered within specific namespaces.
Note: This section of the configurations editor is intended for advanced configuration and
customization only, and therefore we recommend that you do not add custom vault data unless you
know what you are doing.
Registering a Namespace
To begin modifying custom vault data, you must first register a namespace for a new set of custom vault
data. Complete the following steps to register a namespace:
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1. In M-Files Admin, access the custom vault data section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, expand Custom Vault Data.

2. Select Namespace Registry > Configuration.
3. Expand the Namespaces node, click Add Namespace, and expand the newly added namespace
node.
4. In the Group field, enter an internal name of your choice for the group that uses the namespace that
you are about to register.
5. Use the Storage Type drop-down menu to select the storage type that the namespace uses.
6. In the Namespace field, enter the namespace that you are about to register, and in the Namespace
Label field, enter a custom label for the namespace shown in the Custom Vault Data configuration.
7. In the Namespace Description field, enter a description about the purpose of the namespace.
8. Click Save to save your configuration.
Adding Named Values
After you have registered a namespace, you can add named values within that namespace. Complete the
following steps to add named values:
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1. In M-Files Admin, access the custom vault data section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, expand Custom Vault Data.

2. In the gray navigation area, expand Custom Vault Data > Named Values, then expand a group that
you have registered in Registering a Namespace, and finally select the namespace of the group.
3. Open the Configuration tab.
4. Click Add Named Value, and expand the newly created named value node.
5. In the Name field, enter the name part of the named value.
The name can only contain letters, numbers, underscores, hyphens, and periods.
6. In the Value field, enter the value part of the named value.
7. Repeat the steps from 4 to 6 to add more named value pairs within the given namespace.
8. Click Save to save your configuration.
Example: Disabling the Sorting of Search Results by Their Relevance
By default, M-Files sorts search results by their relevance. For more information on how document
relevance in relation to the search term is determined, see Search result sorting.
This behavior can be prevented so that search results are sorted by user preference instead. Make the
following changes on the M-Files Server computer to prevent search results to be automatically sorted by
their relevance:
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1. In M-Files Admin, access the custom vault data section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, expand Custom Vault Data.

2. Select Namespace Registry > Configuration.
3. Expand the Namespaces node, click Add Namespace, and expand the newly added namespace
node.
4. In the Group field, type Search results.
5. Use the Storage Type drop-down menu to select the MFConfigurationValue storage.
6. In the Namespace field, enter the following value: M-Files.Core.Listing.SearchResults
7. In the Namespace Label field, type Search results.
8. In the Namespace Description field, enter for example Settings related to search results.
9. Click Save to save the namespace settings.
10.In the gray navigation area, select Named Values > Search results > Search results >
Configuration.
11.Click Add Named Value, and expand the newly created named value node.
12.In the Name field, enter the following value: RememberSearchResultsSortingCriteria
13.In the Value field, enter the following value: true
14.Click Save to save the configuration.
M-Files no longer forces search results to be sorted by their relevance, and therefore users can change the
column by which search results are sorted and the user preference is retained in subsequent searches.
Metadata Card Configuration
You can use the configurations editor in M-Files Admin to modify the behavior and appearance of the
metadata card. For instructions on how to use the configurations editor, see Using the Configurations
Editor.
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!

Warning: Always use property definition permissions to protect sensitive information. Metadata
card configuration rules can be used to hide property values from the display, but the values stay
available to client applications. Property definition permissions, in turn, make sure that property
values are not sent from the server to the client application of an unauthorized user.

With metadata card configurations, you can:
•
•
•
•
•
•
•

Add an additional header, including text and an image, for a certain object type or a class.
Add tooltips and description fields for individual properties.
Create collapsible property groups.
Control the order in which properties and groups are displayed on the metadata card.
Assign default values for properties.
Manage automatically added (mandatory and optional) properties based on, for instance, object type
and class.
Hide properties from the metadata card.

For information on how this feature is supported in different M-Files clients, refer to M-Files Feature
Comparison.
You must not use metadata card configurations for actual restrictions on metadata modifications because
the configurations are effective at the user interface level only. For example, you can change the workflow
state of an object with the Change State command without adding a required property value imposed by a
configuration rule. Instead, use the workflow state preconditions or postconditions to make sure that certain
property values are filled before state transitions occur.
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Figure 96: Metadata card configurations in the Configurations editor.

Metadata card configurations can be found in the Metadata Card section in the configurations editor.
You can add and remove rules by clicking the Add New button in the Rules section. The rules are
hierarchical, meaning that you can add subordinate rules in the Sub-Rules section for further specifying
main rules (or any superordinate rules).
The Name field should contain a descriptive name for the rule. The name is only visible in the rule editor.
The Filter section defines the scope of the rule. You may want to, for example, apply a metadata card
configuration of objects of a certain class only.
The Behavior section is for specifying what happens when the above-defined condition is met. For
instance, when the object class is Customer, you might want to add the property groups Contact
information, Subscription and Responsible employee to the metadata card.
The hierarchical rule list is evaluated from top to bottom. The higher a rule is in the list, the earlier it is
evaluated. You can change the evaluation order by right-clicking a rule and selecting one of the following
options:
•
•
•

Move Up to move the rule up in the list
Move to Top to move the rule to the top of the list
Move Down to move the rule down in the list
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•

Move to Bottom to move the rule to the bottom of the list
Note: When a rule becomes effective, it always overwrites any overlapping behaviors of rules
that have previously come into effect. In other words, a rule always overwrites any overlapping
behaviors of other rules higher up in the hierarchical rule list.

For more information on defining the rule condition and behavior, see the article Configuring the Metadata
Card (M-Files 2018).

3.2.7. Editing Notification Settings in M-Files Admin
M-Files can be requested to send email notifications to users about object-related actions. Users can
create new notification rules in M-Files Desktop (see Editing Notification Settings in M-Files Desktop and
Metadata card option ribbon). Note that you must have read permissions to a document to get notifications
related to it.
Note: For the notifications to be sent, event logging and M-Files Desktop notifications must be
enabled.
To enable email notifications, do these steps on the M-Files server computer:
1. Open M-Files Admin.
2. In the left-side tree view, right-click a connection to M-Files server.
3. Click Notification Settings.
The Notification Settings dialog is opened.
4. Select Enable notifications.
5. In SMTP server, enter the address of the SMTP server that sends the notification email messages.
6. Optional: Enable Use encrypted connection (SSL/TLS) if the connection to the SMTP server is
encrypted.
7. In SMTP server port, enter the port number for the SMTP server.
The default ports are 25 (without encryption), and 587 (with encryption), but you can change the
port number to, for example, 465.
8. Optional: Enable SMTP server requires authentication if the SMTP server requires the sender to be
authenticated.
a) In Account name, enter the username of the sender's email account.
b) In Password, enter the password of the sender's email account.
9. In Sender's e-mail address, enter the email address for the notification sender.
10.In Sender's display name, enter the name for the notification sender.
The name is shown in the From field of the notification messages.
11.In Digest message, specify the time when the daily digest messages are sent.
M-Files users can select to receive their notifications as individual messages or as a daily digest
message. For more information, see Editing Notification Settings in M-Files Desktop.
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12.Click OK to save your changes and to close the Notification Settings dialog.
Notifications are now enabled on the M-Files server.
•
•
•

Users must enable notifications in M-Files Desktop to be able to get notifications. See Editing
Notification Settings in M-Files Desktop.
The administrator and users can also create notification rules. See Editing Notification Settings in MFiles Desktop.
You can customize your notification messages. See Personalizing Notification Messages.

In this chapter
•
•

Personalizing Notification Messages
Setting Up Push Notifications for the M-Files Mobile Apps

Personalizing Notification Messages
M-Files uses customizable templates for email notifications, which you can modify to match the
requirements of your organization. You can, for instance, change the information provided along with
notifications about new or modified objects, assignments, and so on.
Follow the instructions in this section to access and edit the notification templates in M-Files Admin.
Accessing the Notification Template Settings
To access the notification template settings:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand Notifications > Notification Templates.
The list of available notification templates in this vault is displayed in the configurations editor. The
templates are divided under two sections, Email Templates and Push Notification Templates. The latter
are used for the M-Files mobile applications.
If the listing does not include at least a template called Default, try to restart the vault and M-Files Admin.
Taking a vault offline should always be done in a controlled manner and the vault users should be notified
beforehand.
Editing or Adding a Notification Template
To edit an existing notification template or to add a new one:
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1. Under Advanced Vault Settings > Notifications > Notification Templates, in the configurations
editor listing area, either:
a. Expand an existing template rule that you would like to edit.
or
b. Click Add Rule to add a new template rule, and expand the newly created node.
2. In Rule, select the notification rule to which you want this template to apply.
3. Expand the Template Sections node.
4. Either:
a. Expand an existing section node to edit a previously added section.
or
b. Click Add Section to add a new section, and expand the newly created node.
For any sections that your template does not include, the M-Files server uses the corresponding
sections of the special Default template. If the Default template cannot be found, M-Files
server uses the corresponding sections of a fallback template located in the installation directory.
5. In Template Section, select the section that you would like to modify.
Tip: Hovering the mouse cursor on top of the section names in the drop-down menu
displays a short description for each section.
6. Click the cogwheel icon (

) in the value field of the Template Entry setting.

The Placeholder Editor dialog is opened.
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7. To the text box, enter the content of the section.
Use the Insert Placeholder button to add a dynamically updated reference in your content.
Clicking the button adds a set of curly brackets in the text box. You can either start typing the
name of the placeholder or press the down arrow key to bring up a list of available placeholders,
such as the title or class of the object that triggered the notification. Some placeholders,
however, only work with specific sections.
8. Once you are done editing the template content, click OK to close the Placeholder Editor dialog.
9. Optional: Repeat the steps from 4 to 8 to edit or add as many sections as needed.
10.Once you are done with your changes, click Save.
Placeholders for Notification Templates
In addition to the object properties, such as the title or the class of the object, you can use a set of special
placeholders in your notifications. These placeholders are described in the table below.
Placeholder

Description

All referred objects()

All the referred objects in the properties of the object.

Caused

The name of the user who caused the event.

Caused by

by()
account()

The account name for the user who caused the event.

EventID()

The ID of the event.

FileName()

The name of the file.

ID()

The (external) ID of the object.
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Placeholder

Description

InternalID()

The (internal) ID of the object. The internal ID is always unique for each
object of a single object type and within a single vault.

NameAndLinks()

A plain text formatted text fragment containing URLs to the object for MFiles Desktop, M-Files Web, and M-Files Mobile.

NameAndLinksHtml()

An HTML-formatted hyperlink containing URLs to the object for M-Files
Desktop, M-Files Web, and M-Files Mobile.

Notification

The name of the notification rule that caused the event.

rule name()

ObjTitle()

The name or title of the object.

ObjType()

The type of the object.

OldProperty(

Undefined ) The old value of the specified property of the object. Undefined
is replaced with the property the old value of which you want this
placeholder to display in the notification.
After selecting this placeholder, open the References tab and select the
desired value via drop-down menu in the Item column.

Rolled back to

version()

The version that the object was rolled back to.

Timestamp()

The time when the event occurred.

URL()

A URL that shows the latest version of the object in M-Files Desktop.

UrlToLatestClassicWeb()

A URL that shows the latest version of the object in the classic M-Files
Web.

UrlToLatestMobile()

A URL that shows the latest version of the object in M-Files Mobile.

UrlToLatestWeb()

A URL that shows the latest version of the object in M-Files Web.

UrlToVersion()

A URL that shows the specific version of the object in M-Files Desktop.

UrlToVersionClassicWeb()

A URL that shows the specific version of the object in the classic M-Files
Web.

UrlToVersionMobile()

A URL that shows the specific version of the object in M-Files Mobile.

UrlToVersionWeb()

A URL that shows the specific version of the object in M-Files Web.

UserCausedState(
efined )

Und

The user who moved the object into a specific state. Undefined is
replaced with the target state.
After selecting this placeholder, open the References tab and select the
desired value via drop-down menu in the Item column.

VaultGuid()

The unique identifier (GUID) of the vault.

VaultName()

The name of the document vault.

Version()

The version of the object.

Setting Up Push Notifications for the M-Files Mobile Apps
Push notifications allow sending notifications from M-Files Server to iOS and Android devices that have the
M-Files mobile app installed. Push notifications are sent for the same events as email notifications except
for digest messages. Once they are enabled, you will receive a push notification, for instance, when a new
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assignment is created for you. You can also create personalized notification rules with M-Files Desktop
(see Editing Notification Settings in M-Files Desktop).
To enable push notifications
•

•
•

in an on-premises environment or in your own cloud environment, follow the instructions provided in the
sections Creating a notification hub in Azure, Setting up an Azure notification hub for push notifications,
and finally Enabling push notifications in M-Files vaults.
in M-Files Cloud, simply follow the steps from 9 to 16 under Enabling push notifications in M-Files
vaults. No other changes are needed.
Vault users should enable push notifications on their iOS or Android devices. They will receive push
notifications when they are logged in to a vault that has push notifications enabled. Note that vault users
do not have to keep the M-Files application running to receive push notifications from a vault, as long as
they are logged in to the vault ensures that they can receive push notifications.

Before you begin, note that notifications need to be enabled on the M-Files server (see Editing Notification
Settings in M-Files Admin).
Creating a notification hub in Azure
M-Files push notifications use Azure notification hubs for delivering the notifications (see Microsoft Azure
Notification Hubs). You therefore need to have a valid Microsoft Azure subscription before moving forward.
Visit https://azure.microsoft.com to create a subscription if you do not yet have one.
Do the following steps to create a new notification hub in Azure:
1. Sign in to Azure Portal.
2. Select Create a resource > Mobile > Notification Hub.

3. In the Notification Hub field, enter a unique name.
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4. In the Create a new namespace field, enter a namespace name.
If you do not yet have a service bus namespace, you can use the default one. It is automatically
created based on the hub name, provided that the namespace name is available.
If you already have a namespace that you want to create the hub in, click the Select existing
link and then select Create.
5. Select your Location, Resource Group (if you have one already), and Subscription.
6. Select a suitable price tier (for details, see Notification Hubs pricing).
Setting up an Azure notification hub for push notifications
After you have created an Azure notification hub, it needs to be configured for different mobile platforms.
You can find the settings for the available notification services by doing these steps:
1. Sign in to Azure Portal.
2. Select All services.
3. Under Mobile, select Notification Hubs.
4. From the list of notification hubs, select the hub that was created according to the instructions in
Creating a notification hub in Azure.
5. Under Notifications Settings, do one of the following, or both:
a. Enter the iOS configuration under Apple (APNS). You can request the configuration settings from
our customer support at support@m-files.com.
or
b. Enter the Android configuration under Google (GCM). You can request the configuration settings
from our customer support at support@m-files.com.
Enabling push notifications in M-Files vaults
After you have created a notification hub and set it up for push notifications, you need to enable push
notifications for the M-Files vaults in which you want them to be used, as well as to set up the connection
between M-Files and the Azure notification hub. You can store the connection settings to the Windows
registry of the M-Files server computer or set them separately for each vault via M-Files Admin, or both.
The server-level settings simply do not apply to any vaults for which the connection settings have been
defined via M-Files Admin.
First, you need to locate the connection details in your notification hub settings:
1. Sign in to Azure Portal.
2. Select All services.
3. Under Mobile, select Notification Hubs.
4. From the list of notification hubs, select the hub that was created according to the instructions in
Creating a notification hub in Azure.
If you want to store the connection details to the Windows registry of the server computer, do the following
steps:
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5. Optional: Under the notification hub settings, select Properties.
6. Optional: Copy the value of the Name field and enter it as the value of the following Windows registry
key on the M-Files server computer:
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server
\MFServer

Value
name

AzureNotificationHubName

Value type

REG_SZ

Description The name of the Azure notification hub to use for delivering the notifications.
Value

<the notification hub name>

7. Optional: Under the notification hub settings, select Access Policies.
8. Optional: Copy the value of the DefaultFullSharedAccessSignature field and enter it as the value of
the following Windows registry key on the M-Files server computer:
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server
\MFServer

Value
name

AzureNotificationHubConnectionString

Value type

REG_SZ

Description The connection string for the Azure notification hub.
Value

<the connection string for the notification hub>

To enable push notifications in a vault:
9. Open M-Files Admin.
10.In the left-side tree view, expand a connection to M-Files server.
11.Expand Document Vaults.
12.Expand a vault.
13.Select Configurations.
14.In the task area, select Advanced Vault Settings.
15.Expand Notifications and select Push Notifications.
16.Set the value of the Enabled setting to Yes.
If the connection details have not been stored to the Windows registry of the server computer, or if you
want to vault-specifically override the server-level settings, do the following:
17.Enter the notification hub name and the connection string as the values of the Notification Hub Name
and Connection String settings, respectively.
To get the value for Notification Hub Name, open your notification hub settings (see steps from
1 to 4), select Properties and enter the Name value to your configuration.
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To get the value for Connection String, open your notification hub settings (see steps from 1
to 4), select Access Policies and enter the DefaultFullSharedAccessSignature value to your
configuration.
18.Click Save to save your changes once you are done.
Finalize the process by doing either step 19 or steps 20 and 21, depending on where the connection
settings are stored. Note that restarting the vault or the server should always be done in a controlled
manner and users should be notified beforehand so that no work is lost.
19.If you saved the connection details to the vault (see step 17), restart the vault.
In this case, you can skip steps 20 and 21.
20.If the connection settings are stored on the server computer (see steps from 5 to 8), restart the
MFServer service as instructed in step 21.
21.Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
Your vault is now set up to send push notifications to vault users. Repeat the process for as many vaults as
needed.

3.2.8. Setting Up Web and Mobile Access to M-Files
This section tells you how to get access to the classic M-Files Web and M-Files Mobile.
For users to get access to your organization's on-premises vaults with a mobile device, configure the
access to the classic M-Files Web because it is the connection point for the mobile apps with its M-Files
Web Service REST API services. In cloud-based deployments, you can use mobile apps without any
configuration.
Tip: Administrators can create links to help the end users' vault connection process for mobile
devices. The end user only has to open the link with their mobile device and write their username
and password. After a successful connection, the vault connection information is saved to the
device. For more details and examples, see the document M-Files URL Properties.
Enabling push notifications for the M-Files mobile apps
You can enable push notifications for M-Files Mobile by following the instructions in Setting Up Push
Notifications for the M-Files Mobile Apps.
Federated authentication and pre-shared keys
For additional security, M-Files can be configured to require a pre-shared key in addition to the user's
username and password. This provides an additional level of security without requiring users to open a
VPN connection for accessing M-Files. For more information, see Accessing M-Files Vaults without VPN. If
your organization is using federated identity management, refer to Using Federated Authentication with MFiles.
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In this chapter
•
•
•
•

Enabling Internet Information Services (IIS) Components
Enabling Access for Classic M-Files Web and M-Files Mobile
Publication Settings for Classic M-Files Web
Publishing Documents with M-Files Web

Enabling Internet Information Services (IIS) Components
These Internet Information Services (IIS) components must be enabled on the M-Files server before web
and mobile access can be set up:
•
•
•
•
•
•
•
•

Internet Information Services Hostable Web Core
Common HTTP Features
ASP.NET features
Dynamic Content Compression
Windows Authentication
IIS Metabase and IIS 6 configuration compatibility
IIS 6 Management Console
Static Content

To enable the features:
1. Open the Windows Control Panel.
2. Open Programs and Features.
3. Click Turn Windows features on or off.
The Windows Features dialog is opened.
4. Enable Internet Information Services Hostable Web Core.
5. Go to Internet Information Services > World Wide Web Services and enable Common HTTP
Features.
6. Go to Internet Information Services > World Wide Web Services > Application Development
Features and enable the ASP.NET features.
7. Go to Internet Information Services > World Wide Web Services > Performance Features and
enable Dynamic Content Compression.
8. Go to Internet Information Services > World Wide Web Services > Security and enable Windows
Authentication.
9. Go to Internet Information Services > Web Management Tools > IIS 6 Management Compatibility
and enable IIS Metabase and IIS 6 configuration compatibility and IIS 6 Management Console.
10.Go to Internet Information Services > World Wide Web Services > Common HTTP Features and
enable the Static Content feature.
11.Click OK.
You now have the neccesary components installed and you are ready to enable web and mobile access on
the selected server computer.
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Enabling Access for Classic M-Files Web and M-Files Mobile
M-Files Web uses Microsoft Internet Information Services and Microsoft .NET Framework 4.7.2 or later.
These applications must be installed on the computer that runs M-Files Server before M-Files Web can
be enabled. For instructions on enabling Microsoft Internet Information Services, see Enabling Internet
Information Services (IIS) Components.
Note: If you want to enable classic web and mobile access without the use of a virtual private
network (VPN) for connections outside the private network of your organization, see Accessing MFiles Vaults without VPN.
To enable classic web and mobile access:
1. Open M-Files Admin on the server computer on which you intend to host web and mobile access.
2. In the left-side tree view, expand a connection to M-Files server.
3. Right-click the connection and select Configure Access to Classic Web and Mobile.
4. Select one of these options:
Select the option...

If you want to...

Use an existing
website

Modify an existing M-Files Web site. Select the existing site from the
Website drop-down menu.

Create a new website

Create a new M-Files Web site within IIS. Enter the name of the site in the
Name field and the TCP for connecting to the site in the TCP port field.
The TCP port is 80 by default as it is the most common TCP port for web
servers. If you use any other port, you must indicate the port in the URL
(http://<domain name>:<port>) to access the site.

Create a new virtual
directory

Create a new M-Files Web site under a virtual directory within an existing
website. From the Website drop-down menu, select the preferred existing
website and, in the Name field, enter the name of the virtual folder. The
URL for accessing the site is thus http://<domain name>/<virtual
folder name>.

5. Click OK.
You now have classic web and mobile access to the vaults under the selected connection. You can test if
your site is online when you type the URL of your site into your web browser.
Publication Settings for Classic M-Files Web
When documents are published online for customers or other interest groups, it is usually a good idea to
hide some of the object properties. For example, if the user has read-only access, the functions for editing
need not be displayed at all. With the publication settings, the users can be granted suitable and sufficient
functions that facilitate and simplify accessing and processing the published information.
Note: You can use the Get Hyperlink function in the task area when you want to send a link to the
document from M-Files Web.
Site for definition of the publication settings (site and vault specific)
You can specify different publication settings specific to the site and vault by using a separate configuration
site.
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Log in to the configuration page by using your company's M-Files Web URL (for instance "http://
www.publications.company.com") and by adding /configuration.aspx at the end of the address. For
example, "http://www.publications.company.com/configuration.aspx". If you have already logged in to MFiles Web in the browser, M-Files does not ask you to log in again.
Note: You must have system administrator's rights to be able to edit the publication settings

Site-specific settings
From the site-specific settings, you can make selections that apply to the configuration site and all vaults of
the site.

Figure 97: The publication settings configuration site.

Restrict access to configuration pages
You can specify the configuration site to be accessible for a certain IP address range only. Access to the
configuration site is usually allowed only for connections from inside the company.
Display options
Page title: You can freely name the page of the web site you are offering. The default title is M-Files Web.
Language: By default, M-Files uses Automatic as the language selection. This means that the M-Files
Web language is determined by the language of the user's browser settings. If the language in the browser
settings is not supported by M-Files, the language installed on the M-Files server will be used.
Alternatively, you can set a Specific language to be the M-Files Web language. For example, if your
company's instructions refer to functions that are in English or the users work in different languages, you
can specify English as the M-Files Web language. You can choose from all languages supported by MFiles.
Note:
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This applies to the user interface language only. For the full M-Files Web experience to be in the
language defined by a specific user, four prerequisites need to be met:
•
•
•
•

The vault has been localized to the target language.
The vault language has been set for the vault user.
The language setting has been set to Automatic as described further above.
The language preference settings of the user's browser have been set to the desired language.
For more information, see this W3C article.

Windows SSO
With Windows authentication enabled, M-Files Web can automatically use the user's Windows credentials
for login. The administrator can configure the single sign-on (SSO) setting so that the login credentials are
no longer required when users navigate to M-Files Web.
The automatic authentication is disabled by default, but can be enabled by setting the single sign-on value
to Use automatically. Alternatively, the choice of using single sign-on can be displayed on the login page
by selecting Show on login page.
Force M-Files User Login
Select this setting if you do not want to display the Windows login option to users. Then the user does not
have to consider which login option is appropriate and M-Files suggests logging in as an M-Files user. For
data security reasons, it may be advisable to disable Windows login in some cases.
Note: This does not prevent logging in to the configuration site with your Windows user account.
Automatic Login
Select Automatic Login and enter the authentication information if you do not wish to require the users to
enter their user ID for M-Files Web. This means that any user can access the site's vaults if authorized by
the user ID.
Authentication (username, password and domain): If automatic login is enabled, this is the authentication
information that M-Files uses for the automatic login. If you want M-Files to offer a specific ID for the user
by default, save the default ID in the authentication information and disable automatic login. The user is still
able to use other IDs, possibly granting more extensive web-based access.
Vault: You can also specify the vault to which the user is to be connected to. If the vault is not specified,
the users can see all the vaults accessible with the credentials.
Vault-specific settings
In the vault-specific settings you can specify, for example, these things:
•
•
•

Whether the vault is to be available for use with M-Files Web
The vault-specific default view
The configuration of the vault user interface

Allow access to this vault
Select this if you want the vault to be accessible via M-Files Web.
Note: In order to use a vault, the user must always have permissions for that vault.
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Default view
You can specify which view is to be opened by default. The home view is opened by default.
Layout
You can select the layout elements to be displayed in the vault. For example, you can hide the task area or
display the listing area only.
Microsoft Office for the web editor (cloud vaults only)
If you use M-Files Cloud, enable this option to edit documents in M-Files Web using Microsoft Office for the
web.
Note: To set up the Microsoft Office for the web editor, write to our customer support at
support@m-files.com to enable the Microsoft Office for the web tools for your vault or vaults.
Prevent navigation outside default view
You can prevent navigation beyond the default view by choosing Prevent navigation outside default view.
In this case, navigation is not possible, even if the breadcrumb is used.
Default search criteria and settings
You can select whether the latest search criteria and settings selected by users are to be kept or if you
would prefer to use a specific criterion and setting. The same options as in M-Files Desktop are available.
Navigation within the vault
You can display or hide the top menu (New, Operations, and Settings) and/or breadcrumb.
Note: When M-Files Web is displayed in the "Listing pane only" mode, object metadata and search
functions are hidden from the users. This allows the users to only read and edit objects displayed in
the listing pane, according to their permissions.
Vault controls
These settings allow you to control which functions are available for the users of the vault.
•

Save view settings. If several users have the same user ID (for example, during automatic login), it is
recommended to prevent saving of the column settings.

•
•

Workflow shortcut in properties pane.
Checkout prompt. If the M-Files Web users are granted read-only access and no edit permission,
displaying the Check Out dialog is not necessary.

•

•

Hidden properties. Some properties may be hidden from external users. In these cases, the information
(hidden) is displayed in the properties pane or on the metadata card. It is recommended to hide this
(hidden) information.
State transition prompt.

•
•
•
•

Save search terms.
Context menu.
Advanced Search.
Search in right pane. With this option enabled, the search functions can be placed into the right pane.
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Task area operations
The options in the task area settings allow you to decide which links are to be displayed in thetask area.
Note: If you hide the New commands, users cannot create new objects. Additionally, if the View
and Modify commands are hidden, they are not accessible via the context menu either.
Example: Modifying the Appearance of the Classic M-Files Web
1. Open the M-Files Web configuration page by entering the URL http://<Your M-Files Web domain>/
configuration.aspx into your web browser and then enter your credentials if you are not already
logged in.
If you are already logged in, you will be redirected directly to the configuration page. Otherwise
the configuration page will be opened after the login screen.
2. In the left-side tree view, under Vault-specific settings, expand the additional settings of the vault that
you want to modify by clicking the arrow before the vault icon.
3. By clicking the folder beneath the selected vault, select the category that you want to modify:
a. Select the Controls folder, if you want to show or hide various M-Files Web user interface controls.
or
b. Select the Task area folder, if you want to show or hide various elements in the M-Files Web task
area.
4. Select the Show or Allow radio button for the elements that you want to enable.
If you want to show the Log Out button in the task area, go to the Task area settings, and select
Show for the Log Out option.
5. Select the Hide or Disallow radio button for the elements that you want to disable.
Publishing Documents with M-Files Web
You can use M-Files Web to publish documents to people that do not use M-Files. You can, for example,
share on your website a price list that is saved to M-Files and is always up to date.
Normally, you always need a username and a password to use a vault with M-Files Web. To let users
access the vault without user credentials and have read access to the content, follow the instructions in this
section.
New M-Files Web and M-Files Mobile
If you use the new M-Files Web or M-Files Mobile, enable the Anonymous Authentication feature. You do
not need to do the rest of the steps in this section.
Classic M-Files Web
If you use the classic M-Files Web, do the steps given in the subsections. Before you start, make sure that
M-Files Web is correctly configured and that you have the External Connector license.

In this chapter
•

Creating a Login Account for Publishing
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•
•
•
•

Adding the Login Account as a User to the Publishing Vault
Giving Read Permissions to the Publishing Vault User
Enabling the Login Account to Log In Automatically
Creating Direct Web Links

Creating a Login Account for Publishing
First, create a login account that will be used to automatically log in to a specific vault:
1. Open M-Files Admin on the M-Files server used for publishing.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Login Accounts.
4. In the task area, click New Login Account.
The New Login Account dialog is opened.
5. In Username, enter a username.
For example, Publishing.
6. In Authentication, select M-Files authentication
7. In Password, enter a password.
8. In Confirm password, enter the same password.
9. In License type, select a license.
For information about the license types, see License type.
10.Click OK.
The created login account is added to the Login Accounts list.
For information on the next step, see Adding the Login Account as a User to the Publishing Vault.
Adding the Login Account as a User to the Publishing Vault
Second, add the created login account as a user to the publishing vault:
1. Open M-Files Admin on the M-Files server used for publishing.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click Users.
6. Click New User on the task area.
The New User dialog is opened.
7. In Login account, select the login account that you created.
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8. Enable External user.
9. Optional: Enable User cannot create documents or other objects.
10.Optional: Enable User cannot create or modify traditional folders.
11.Optional: Enable User cannot create or modify private views or notification rules.
12.Click OK.
The user is added to the Users list.
For information on the next step, see Giving Read Permissions to the Publishing Vault User.
Giving Read Permissions to the Publishing Vault User
Third, give the user read permissions to published documents:
1. Open M-Files Admin on the M-Files server used for publishing.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Click Named Access Control Lists.
6. Do one of these steps:
a. Click New Named Access Control List to create a named access control list for the user.
or
b. Double-click an existing named access control list on the Named Access Control Lists list to edit
the permissions of the user.
7. If you started to create a named access control list, in Name, enter a name for the list.
8. Click Add.
9. In Users or user groups, select the user.
10.Click Add.
11.Select the user and specify these permissions:
Permission

Allow / Deny

Change Permissions

Deny

Delete

Deny

Edit

Deny

Read

Allow

M-Files | 3. System Administration | 546
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
12.Optional: Do this step if your named access control list has all permissions set to Allow for the All
internal users user group. Otherwise, skip this step.
a) Click Add.
b) Select All internal users and click Add.
c) In the Users and user groups list, select All internal users.
d) In the Permissions section, set the All permission to Allow.
13.Click OK.
14.Set the named access control list to all documents that you want to be accessed without credentials.
For information on the next step, see Enabling the Login Account to Log In Automatically.
Enabling the Login Account to Log In Automatically
Finally, set M-Files to log in to the classic M-Files Web automatically:
1. On the M-Files server, use Registry Editor to create this registry key, where <version> is the M-Files
version number (for example 11.1.4310.92) and <web site ID> is a unique ID given to the MFiles Web site by Internet Information Services (IIS):
HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server\MFWA\Sites
\<web site ID>\
•
•

•

If there is only one website, the site ID is usually 1.
If the M-Files Web site runs in the virtual directory of the website, add a colon and the name
of the virtual directory after the site ID. For example, if the application is in the M-Files Web
virtual directory of this single website, the website ID is 1:MFWA.
The IIS server software in Windows 2003 shows the ID as one column.

2. Specify the registry key values to be used for automatic login. This table contains the values available
for specification:
Value

Type

Description

Domain

REG_SZ

If the authentication method in use is Windows
authentication, specify the domain in this value.

Password

REG_SZ

The login password.

UserName

REG_SZ

The login account name.

Vault

REG_SZ

The document vault ID. The value can be for example
{A8DCB561-913F-4318-A276-E7E171EAFBE6}.
The value can be found in the Document Vault
Properties window of a vault in M-Files Admin.

WindowsUser

REG_DWORD

Specifies the authentication method. False is for MFiles authentication, and True is for Microsoft Windows
authentication.

3. Close Registry Editor.

M-Files | 3. System Administration | 547
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
4. Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
The selected login account can now automatically log in to the classic M-Files Web, and the account can
access published documents without user credentials.
Creating Direct Web Links
When automatic login is enabled, you can create direct weblinks between, for example, the company
website and documents. You can give the opening page, openfile.aspx, these parameters:
Parameter

Description

objtype

The object type ID of the document that contains the file to be opened. This
parameter is required. To see the list of object type IDs, do the first four steps of the
Creating a New Object Type task.

docid

The ID of the document that contains the file to be opened. This parameter is
required.

docver

The version of the document that contains the file to be opened. If this parameter is
not set, the link always refers to the latest version of the document.

fileid

The ID of the file to be opened. This parameter is only required when the document
that contains the file is a multi-file document.

filever

The version number of the file.

showopendialog

Specifies whether the browser shows an opening dialog. By default, the value is 1
and the dialog is shown. If the value is set to 0, the dialog is not shown.

Here are some examples:
•
•
•
•

https://<server>/openfile.aspx?objtype=0&docid=71
https://<server>/openfile.aspx?objtype=0&docid=71&docver=7
https://<server>/openfile.aspx?objtype=0&docid=71&docver=7&fileid=71
https://<server>/openfile.aspx?objtype=0&docid=71&showopendialog=0

Replace <server> with the web address of your own server.

3.2.9. Reporting and Data Export
Saving and protecting data is important, but the saved data must also be available for analysis. In addition
to being able to save many types of data in M-Files, you can use it to create various reports.
The reports can be used to gather information on, for example, sales processes, completed projects, the
size of the proposal base, volumes of orders, participation in training, and sales by each salesperson
itemized by customer. Graphical reports make the data analysis quick and easy. In real-world operation,
reports can be generated from any metadata.
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Updating the license code for reporting
The reporting module is an M-Files add-on product available for a separate fee. It can be activated with an
accompanying license code. The reporting module enables data export from M-Files to create reports and
display them in the M-Files user interface.
For you to activate the reporting module, the license code must be activated on your system. The license
is provided on a subscription basis. Activate or update the license code in M-Files Admin (for more
information, refer to Managing Server Licenses).
To find out how M-Files can support your business with M-Files reports, please contact us at sales@mfiles.com.
Report object type and class
To display the reports, M-Files has a built-in object type and class for reports. By default, the Report object
type is hidden from the users. Provide the required access rights for the Report object type so that actual
reports can be created in the client software.

In this chapter
•
•
•

Creating a New Data Set
Specifying the Report Access Identity
Creation of Reports and the Required Software
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•
•

Creating a Report Object for a Report
Exporting a Report

Creating a New Data Set
M-Files Reporting Data Services enable data exporting from M-Files to external databases (SQL Server).
The administrator can specify manually which data will be exported, or export data on a scheduled basis
from M-Files for reporting or other purposes. The M-Files Reporting Data Services functionality is installed
in conjunction with M-Files Server. Once you have exported a data set, you can use it to generate a report.
Start by specifying a data set that you want to export for reporting. Do the following steps to create a new
data set:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Reporting and Data Export and then click New Data Set on the task area.
The Data Set Properties dialog is opened.
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6. In the Name field, enter a name for the new data set.
7. In the Data to export section, click Add Objects... to select the objects to be exported.
The Add Objects to Data Set dialog is opened.
8. Use the Objects to export drop-down menu to select the objects to be exported on the basis of the
object type.
You can click Filter Objects... to refine the selected objects by specifying property conditions
that the objects must meet to be exported. For more information on filtering objects by
properties, see Property-Based Conditions.
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9. Optional: Select the object that you just added to the Data to export section and click Add Property...
to add for the selected object type a property that you want to be exported.
a) Use the Property to export drop-down menu to select the property to be exported.
b) Go to the History and Old Values tab.
On the History and Old Values tab you can define whether you want to export the change
history and previous values of the selected property.
The History and Old Values tab is opened.

c) Check the Export the change history of this property check box if you want to export the change
history of the selected property.
The change history adds an entry of each change in the property value to the data set. This
makes it possible to answer questions such as "What was the total value of deals closed in
August?" by exporting the change history of the property value Closed and pinpointing the
objects for which the value of said property changed from No to Yes during August.
d) Check the Export the old values of this property, using sampling check box if you want to export
previous values of the selected property and use the Sample at drop-down menu to define the
frequency of the sampling (daily, weekly, monthly, or yearly).
e) Select either Full history, Fixed-length period, or Starting from date option to define the history
length for the change history and old values of the selected property.
If the frequency of sampling is high (for instance daily), it is recommended to restrict the
length of the history period to avoid expanding the database unnecessarily and to increase
the speed of the export function.
f) Click OK to close the Property to Export dialog.
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10.In the OLE DB connection string field, enter the connection string for connecting to the target
database or click Define... to define the connection string.
If you use Microsoft SQL Server as the target database, it is advised to use Microsoft OLE DB
Driver for SQL Server (MSOLEDBSQL) as the data provider, and to use either Simple or Bulklogged as the Recovery model setting in the target database. This will significantly improve the
speed and performance of exporting data sets.
For more information on database connection strings, see Connections to External Databases
for Object Types.
11.Go to the Advanced tab.
The Advanced tab is opened.
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12.In the Use the identity of the following user when reading data drop-down menu, select the user
whose identity you want to use for transferring data from M-Files to the reporting services.
The most suitable user is a "regular" user without any extended rights. If you use, for example,
your own user identity that has a system administrator role, data that you do not want to expose
to all users could end up in the reports displayed by the client software.
If the metadata structure of the vault is translated into multiple languages, the metadata
language of the exported data set depends on the vault language settings of the user whose
identity is used for reading data.
If you have the Electronic Signatures and Advanced Logging module in use, you must select (MFiles Server) as the user.
13.Optional: Check the Export data on a scheduled basis option check box and click Schedule... if you
want to export this data set on a scheduled basis.
It is recommended to schedule the data export to be performed once a day/week/month. The
reports are updated at the same time. If you do not select scheduling, the data will not be
updated after export. You can also create a separate update link in the reporting services so that
the user can update the report in the client software whenever desired. For more information,
write to our customer support at support@m-files.com.
14.Optional: On the Advanced tab, define an alias for the data set.
When you have automatic aliases in use and you write a name on the General tab, the Aliases
field on the Advanced tab is automatically filled in. The alias has the format <predefined
prefix>.<name>. Define automatic aliases for your vault in the configurations editor.
15.Optional: Click Export Now to export the data set right away.
You can click Status of Exporting... to view the status of the exporting process when the
exporting is in progress.
16.Click OK to finish creating the new data set.
The data set that you have just defined is added to the Reporting and Data Export list. The data set is
exported either automatically on a scheduled basis or manually, depending on the settings that you have
provided.
Now that you have created a data set, you can use it to create a report (see Creation of Reports and the
Required Software) and then create a report object in M-Files to read the report (see Creating a Report
Object for a Report).
Specifying the Report Access Identity
The report access identity is the identity that is used for transferring reports from the reporting services to
M-Files Desktop and for reading them.
Follow these steps to specify the report access identity:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
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5. Select Reporting and Data Export and then click Specify Report Access Identity in the task area.
The Specify Report Access Identity dialog is opened.

6. Select either:
a. Windows user identity: Select this option to access reports via the Windows user account. This is
the recommended choice in a Windows domain environment.
or
b. Specific identity: To define a specific identity for accessing reports, select this option and enter
the username and password of the identity in the Username and Password fields. The identity can
be a local Windows account, a domain account, or some other account recognized by the reporting
service. The reporting account to be specified should have only limited access permissions to the
reporting services. Check the The account specified is an external account (e.g., Microsoft
Azure SQL Reporting) check box if the specified account is an external account.
7. Click OK to close the Specify Report Access Identity dialog.
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The report access identity that you have specified is now used for transferring reports from the reporting
services to M-Files Desktop and for reading them.
Creation of Reports and the Required Software
The reports from M-Files to an external database are created by using the Microsoft SQL Server Reporting
Services infrastructure, which must be implemented and configured correctly.
When reports have been created and they are to be used in M-Files, the SQL Server Reporting Services
system contacts the database to which the data export was done from M-Files, creating a report when MFiles Desktop so requires.
Microsoft's SQL Server Reporting Services infrastructure can be installed with the SQL Server installation
package (Microsoft SQL Server 2012 or later).
The free SQL Server Express versions can also be used in reporting. If you are going to use SQL Server
Express, you need the SQL Server Express with Advanced Services edition, which includes the necessary
reporting services module. You can download it via Microsoft's web site at https://www.microsoft.com/enus/sql-server/sql-server-editions-express.
For more information, refer to http://msdn.microsoft.com/en-us/library/ms159106.aspx (SQL Server Books
Online).
In planning the reports, you also need Business Intelligence Development Studio or, a simpler tool,
Report Builder. The person planning the reports must be experienced in this and have the skills required
for creating reports. Please contact our consulting services personnel, and we will be happy to help you
with planning of the reports (sales@m-files.com).
For more information on installing Microsoft's reporting services, please consult Microsoft's web pages or
write to our customer support at support@m-files.com.
Note: Instructions for planning and creating reports and for using third-party software are available
via the M-Files consulting services for a separate fee.
Creating a Report Object for a Report
When a report has been created (for more information, see Creation of Reports and the Required
Software), it can be retrieved for use in M-Files Desktop.
For displaying reports, Microsoft .NET Framework 4.7.2 or later (or the most recent available Client Profile
version) is required. If the client computer does not have an appropriate .NET Framework installed,
the report is not shown and the user is prompted to install the framework. You can download the most
recent .NET Framework version via Microsoft Download Center.
Follow these steps to create a report object:
1. In M-Files, right-click on the listing area and select Create > Report... from the context menu.
The New Report dialog is opened.
2. In the Name or title field, enter a name describing the report.
If the report is used for calculating yearly revenue, the title of the report object could be Revenue
by Year.
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3. In the Report URL field, enter the URL to be used for retrieving the report from the reporting services to
M-Files. The URL must be in the form http://servername/instance?/report_path.
The same URL can be used to retrieve the report in the browser. Note, however, that this
address will not be displayed in the browser address field after opening the report. For more
information, write to our customer support at support@m-files.com.
4. Optional: To define the placement of the report in the M-Files user interface, click Add property and
select Report placement from the drop-down menu, and the select an appropriate value for Report
placement using the drop-down menu.
5. Click Create to create the report object.
The report object you have created is added to the vault. You can view the report by selecting the object in
M-Files.
You can attach a report object to a specific view. For instructions, see Attaching a Report Object to a View.
Attaching a Report Object to a View
You can attach a report object to a specific view, such as Sales by customer or Proposals by salesperson.
Do the following steps to attach a report object to a view:
1. In M-Files, navigate to the view to which you want to attach a report object.
2. Optional: If you want your settings to be applied for all users, right-click on an empty area in the view
and select Properties from the context menu.
a) In the Properties dialog, check the Common to all users check box, if it is not already checked.
b) Click OK to close the Properties dialog.
3. Press Alt and select one of the following options from the context menu:
a. View > Reports > Attach Report to This View (full view)...: Select this option if you want the
report to be displayed in the full view mode, covering the listing area and the right pane.
or
b. View > Reports > Attach Report to This View (right)...: Select this option if you want the report to
be displayed in the right pane.
or
c. View > Reports > Attach Report to This View (bottom)...: Select this option if you want the report
to be displayed at the bottom of the listing area.
The Select Report dialog is opened.
4. Select the report object that you want to attach to the selected view and click Open.
The selected report is attached to the selected view. When you navigate to the view, the report is displayed
automatically.
Associating the Report Object with Other Objects
You can associate the Report object with other objects, such as Customers. You can display the report
data by customer by selecting a customer from the list if you so specify in the reporting services settings
(see Creation of Reports and the Required Software). Then M-Files will show the data (for instance sales
by month) for only this specific customer in the report. When you select another customer, the report will be
updated with data related to the second customer.
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Bringing the Report Up to Date
The data in the report is based on the latest data from M-Files to the reporting service. The data can
exported either manually or on a scheduled basis. If a separate update link is created for a report in the
reporting services, the report can be updated whenever desired via M-Files Desktop. For more information,
write to our customer support at support@m-files.com.
Exporting a Report
Once a report is readable in M-Files, it can also be exported in various file formats. The supported file
formats are:
•
•
•
•
•
•
•

XML file with report data
CSV (comma delimited)
PDF
MHTML (web archive)
Excel spreadsheet.
TIFF file
Word document
Note: The exported report is static and cannot be edited in other applications.

Do the following steps to export a report:
1. In M-Files, locate the report that you want to export by using either the search or the views.
2. Right-click on the displayed report and select Export and then select a suitable file format from the
context menu.
The Save As dialog is opened.
3. Select a suitable directory and enter a suitable file name in the File name field and then click Save.
The report is exported in the selected file format.

3.2.10. Event Handlers and Scripts
This section describes how to create new event handlers and how to use scripts in M-Files. You might also
want to see the FAQ article How do I write VBScript code for M-Files purposes?.

In this chapter
•
•
•

Event Handlers
Available VBScript Variables
Execution Order of Scripts

Event Handlers
With event handlers, you can define different operations that are executed when certain events occur, such
as after an object is modified or before a new value list item is created. The operations are specified using
variables, generic features of VBScript, and M-Files API.
Examples of event handler use:
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•
•
•
•
•
•
•

Object permissions can be set to change automatically when the object properties are changed.
Certain basic documents can be added to every new project via a pre-defined project model.
Specified Word documents can always be saved as PDFs, so that when a Word file is checked in, it is
saved to the server in PDF format as well.
Data related to photos, such as date and image size, can be automatically added to the metadata of the
photo document.
If the user adds a new value to the value list, the event handler can be used to check that the added
value is entered correctly.
Logging in to M-Files can be prevented outside working hours, for instance during night time and
weekends.
Downloading certain files can be monitored, downloading large numbers of files can be prevented, or
an alarm of suspicious downloads can be sent to the administrator.
Note: The M-Files API documentation is available online: M-Files API. For more information about
using VBScript in M-Files, see the How do I write VBScript code for M-Files purposes? tutorial.

Do the following steps to create a new event handler:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Right-click a vault.
4. Click Event Handlers.
The Event Handlers dialog is opened.
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5. Click the Add Event Handler... button.
The Add Event Handler dialog is opened.

6. Use the Select event drop-down menu to select the event for which you want to create an event
handler.
If you want to create an event handler that is invoked whenever a new object is about to be
created, select the BeforeCreateNewObjectFinalize event.
For the list of available events and their descriptions, see Available Event Handlers
7. In the Name field, enter a descriptive name for the new event handler and click OK to close the Add
Event Handler dialog.
Check for duplicate titles.
If you have more than one event handler of the same type, you may change their execution
order by selecting the event handler in the Event Handlers dialog and clicking either the up or
down arrow button along the right corner of the dialog.
8. Back in the Event Handler dialog, click Edit Code.
The Edit VBScript Code window is opened.
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9. Enter the code to be executed when the event handler is invoked, and then close the Edit VBScript
window.
The following code in the BeforeCreateNewObjectFinalize event could be used to display an
error message to the user when they are about to create a new object (that is, the metadata card
is filled with the necessary information and the user clicks the Create button) and the document
vault already contains an object with the same title:
' The ID of the title property.
Dim titleProperty
titleProperty = MFBuiltInPropertyDefNameOrTitle
' Find the title property of the current object.
Dim currentTitleProp
currentTitleProp = PropertyValues.SearchForProperty(titleProperty)
' Get the title of the object.
Dim currentTitle
currentTitle = currentTitleProp.Value
' Search for objects on the basis of title.
Dim titleSearch
Set titleSearch = CreateObject("MFilesAPI.SearchCondition")
Dim titleExpression
Set titleExpression = CreateObject("MFilesAPI.Expression")
titleExpression.SetPropertyValueExpression titleProperty,
MFParentChildBehaviorNone, Nothing
Dim titleTypedValue

M-Files | 3. System Administration | 561
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
Set titleTypedValue = CreateObject("MFilesAPI.TypedValue")
titleTypedValue.SetValue MFDatatypeText, currentTitle
titleSearch.Set titleExpression, MFConditionTypeEqual,
titleTypedValue
Dim SearchResults
Set SearchResults
= Vault.ObjectSearchOperations.SearchForObjectsByCondition(titleSearch, false)
' If an existing object with the same title was found, raise an
error.
If SearchResults.Count > 1 Then
Err.Raise MFScriptCancel, _
"The document vault already contains an object with the same
title. Please choose another title."
End if
10.Back in the Event Handlers dialog, click OK to save your changes and to close the Event Handlers
dialog.
The new event handler is added to the selected document vault and the code that you have defined is
executed whenever the event handler is invoked.

In this chapter
•

Available Event Handlers

Available Event Handlers
Below you can find the available event handlers, with their variables and explanations. For more
information about variables, see Available VBScript Variables.
Vault-level event handlers
The event handlers listed in this section are triggered by operations on the vault level.
Note: An exception in an event handler prevents the triggering operation from being executed.
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Event handler

Variables

Execution

BeforeSetProperties

•
•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
PropertyValues
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are executed
when the property values
of the object stored in the
document vault are re-set.
Properties can be inspected
during BeforeSetProperties
before they are set. It is not,
however, recommended
to modify properties during
BeforeSetProperties as they may
be overwritten after the event
handler has been executed.
Properties, on the other hand,
can be modified during the
AfterSetProperties event.

•
•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
PropertyValues
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are
executed when a new object is
created in the document vault,
regardless of whether the new
object has been checked in
or not. When executing the
AfterCreateNewObjectFinalize
event handler, the object may
have already been checked in.
For this reason, the metadata or
files can no longer be modified
during operation of the event
handler, and thus the event
handler is only suitable for
validating changes.

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are executed
when an object which has never
been checked in is removed
from the document vault. The
execution takes place, for
instance, when the user performs
the "Undo Checkout" function on
the object or removes the object
from the document vault.

AfterSetProperties

BeforeCreateNewObjectFinalize
AfterCreateNewObjectFinalize

BeforeCancelCreateObject
AfterCancelCreateObject
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Event handler

Variables

Execution

BeforeCheckInChanges

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are executed
when the user checks the object
in. The event handlers are not
executed if the object was not
modified, in which case the
BeforeCancelCheckOut and
AfterCancelCheckOut event
handlers are executed. It is still
possible to modify the object
during BeforeCheckInChanges.
These event handlers are also
executed when the user creates
a new object with the Check in
immediately option unchecked,
and checks in the object without
making any changes to the file.
These event handlers are not
executed when a new object
is created with the Check in
immediately option enabled.
During the execution of the
AfterCheckInChanges event
handler, the object can no longer
be modified as the object has
already been checked in, and
thus the event handler is only
suitable for validating changes.

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are executed
when modifications of a checked
out object are undone using, for
example, the Undo Checkout
function. The event handlers
are also executed if the object
is checked in without any
modifications. During execution
of the AfterCancelCheckOut
event handler, the object cannot
be modified as the object is no
longer checked out.

AfterCheckInChanges

BeforeCancelCheckOut
AfterCancelCheckOut
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Event handler

Variables

Execution

AfterCancelCheckoutFinalize

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

An event triggered after the undo
checkout operation is complete,
meaning that the object is no
longer checked out. A script
can be used for performing
the checkout operation and
for performing further object
operations with the checked out
object version.

BeforeCheckOut

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are executed
when a document vault object is
checked out. During execution
of the BeforeCheckOut event
handler, the object has not been
checked out, so the object cannot
be modified.

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are executed
when an object is marked as
deleted.

AfterCheckOut

BeforeDeleteObject
AfterDeleteObject
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Event handler

Variables

Execution

BeforeDestroyObject

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are executed
when an object is destroyed from
the document vault.

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are executed
when an individual version of
the object is destroyed from the
document vault.

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are executed
when the object permissions are
changed.

•

ObjectAccessControlList

AfterDestroyObject

BeforeDestroyObjectVersion
AfterDestroyObjectVersion

BeforeSetObjectPermissions
AfterSetObjectPermissions
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Event handler

Variables

Execution

BeforeFileUpload

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handler is executed
when the user starts a file transfer
to M-Files Server.

•

FileTransferSessionID

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•
•

FileTransferSessionID
FileVer

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•
•
•

FileTransferSessionID
ObjID
FileVer

AfterFileUpload

BeforeFileDownload
AfterFileDownload

The event handler is executed
when the file transfer to the server
is completed.

The event handlers are executed
when the user loads the file
from M-Files Server to the
client machine's local cache. If
necessary, these event handlers
can be used to prevent transfer
of certain files to the users'
machines.
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Event handler

Variables

Execution

BeforeCreateNewValueListItem

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handlers are executed
when new values are added to a
certain value list of the document
vault. These event handlers can
be used to, for example, ensure
that all values entered in the
value list are in a specified form
as desired.

•

ValueListItem

•
•
•
•
•
•
•
•
•

Vault
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•

LoginAccount

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•

LoginAccount

AfterCreateNewValueListItem

BeforeLoginToVault

AfterLoginToVault

The event handler is executed
immediately prior to logging in of
the user to the document vault. At
this stage, the user has already
been identified against M-Files
Server, so the event handler is
not executed, for instance, if a
user who attempts to log in does
not have a login account on the
server.

The event handler is executed
when the user has successfully
logged in to the document vault.

M-Files | 3. System Administration | 568
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
Event handler

Variables

Execution

BeforeLogoutFromVault

•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handler is executed
immediately before the user is
logged out of the document vault.
The logout cannot be interrupted
during this event handler. The
client software does not react
to any error messages received
from this event handler.

AfterLogoutFromVault

•
•
•
•
•
•
•
•

Vault
VaultSharedVariables
SavepointVariables
TransactionCache
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handler is executed
when the user has been logged
out of the document vault. The
logout cannot be interrupted
during this event handler. The
client software does not react
to any error messages received
from this event handler.

•

LoggedOutUserID

•
•
•
•
•
•
•
•
•

Vault
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•
•

RestoredVersions
ObjVer

Replication:
AfterCheckInChanges

The event handlers are invoked
when new versions are imported
to the existing object from the
content package or when a
conflict between two objects
is resolved in favor of the
source-vault version. When the
AfterCheckInChanges event
handler is invoked, the object
has already been checked in. For
this reason, the metadata or files
can no longer be modified during
operation of the event handler.
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Event handler
Replication:
AfterCreateNewObjectFinalize

VaultExtensionMethod

BeforeCreateLoginAccount
AfterCreateLoginAccount

Variables

Execution

•
•
•
•
•
•
•
•
•

Vault
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event handler is invoked
when a new object is imported
to the document vault from the
content package. On invoking of
the AfterCreateNewObjectFinalize
event handler, the object has
already been checked in. For
this reason, the metadata or files
can no longer be modified during
operation of the event handler.

•
•

RestoredVersions
ObjVer

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•
•

Input
Output

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•

LoginAccount

The event handler is invoked
explicitly by the client (the socalled vault extension method).
The developer of the vault
extension method must make
sure that the user can be allowed
to execute the method. In other
words, the method should check
the identity of the calling user and
terminate if they do not have the
required administrative rights in
the vault.

BeforeCreateLoginAccount: The
event is triggered before a vaultlevel login account is created in
the vault database.
AfterCreateLoginAccount: The
event is triggered after a vaultlevel login account is created in
the vault database.
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Event handler

Variables

Execution

BeforeModifyLoginAccount

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeModifyLoginAccount: The
event is triggered before a vaultlevel login account is modified in
the vault database.

•

LoginAccount

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•

LoginAccount

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•

UserAccount

AfterModifyLoginAccount

BeforeRemoveLoginAccount
AfterRemoveLoginAccount

BeforeCreateUserAccount
AfterCreateUserAccount

AfterModifyLoginAccount: The
event is triggered after a vaultlevel login account is modified in
the vault database.

BeforeRemoveLoginAccount: The
event is triggered before a vaultlevel login account is removed
from the vault database.
AfterRemoveLoginAccount: The
event is triggered after a vaultlevel login account is removed
from the vault database.

BeforeCreateUserAccount: The
event is triggered before a user
account is created in the vault
database.
AfterCreateUserAccount: The
event is triggered after a user
account is created in the vault
database.
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Event handler

Variables

Execution

BeforeModifyUserAccount

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeModifyUserAccount: The
event is triggered before a user
account is modified in the vault
database.

•

UserAccount

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•

UserAccount

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•

UserGroupAdmin

AfterModifyUserAccount

BeforeRemoveUserAccount
AfterRemoveUserAccount

BeforeCreateUserGroup
AfterCreateUserGroup

AfterModifyUserAccount: The
event is triggered after a user
account is modified in the vault
database.

BeforeRemoveUserAccount: The
event is triggered before a user
account is removed from the vault
database.
AfterRemoveUserAccount: The
event is triggered after a user
account is removed from the vault
database.

BeforeCreateUserGroup: The
event is triggered before a user
group is created in the vault
database.
AfterCreateUserGroup: The event
is triggered after a user group is
created in the vault database.

M-Files | 3. System Administration | 572
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
Event handler

Variables

Execution

BeforeModifyUserGroup

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeModifyUserGroup: The
event is triggered before a user
group is modified in the vault
database.

•

UserGroupAdmin

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•

UserGroupAdmin

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

AfterModifyUserGroup

BeforeRemoveUserGroup
AfterRemoveUserGroup

AfterBringOnline
BeforeTakeOffline

AfterModifyUserGroup: The event
is triggered after a user group is
modified in the vault database.
Note: The
AfterModifyUserGroup
event handler is not
executed when the All
internal users group is
modified.

BeforeRemoveUserGroup: The
event is triggered before a user
group is removed from the vault
database.
AfterRemoveUserGroup: The
event is triggered after a user
group is removed from the vault
database.

AfterBringOnline: The event is
triggered after the vault is brought
online.
BeforeTakeOffline: The event
is executed before the vault is
taken offline. An exception in
any of the two event handlers
does not prevent the online/offline
transition.

M-Files | 3. System Administration | 573
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
Event handler

Variables

Execution

AfterCheckInChangesFinalize

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

The event is triggered when
an object has been completely
checked in (or when an object
is immediately checked in after
it has been created) after all the
operations occurring after the
check-in, such as any automatic
state transitions, have been
completed.

BeforeCreateView

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeCreateView: The event is
triggered before a new view is
created in a vault.

•

View

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•

View

AfterCreateView

BeforeModifyView
AfterModifyView

AfterCreateView: The event is
triggered after a new view has
been created in a vault.

BeforeModifyView: The event is
triggered before changes made to
a view become effective.
AfterModifyView: The event is
triggered after changes made to a
view have become effective.
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Event handler

Variables

Execution

BeforeDeleteView

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeDeleteView: The event is
triggered before a view that is set
to be deleted is actually deleted.

•

View

•
•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

•

View

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

AfterDeleteView

BeforeReturnView

BeforeUndeleteObject
AfterUndeleteObject

AfterDeleteView: The event is
triggered after a view has been
deleted.

This event handler is triggered
after a view has been retrieved
from the vault but before it is
returned to the client. It enables
you to modify a view, for instance,
by filtering it with dynamic search
conditions, such as ones based
on the current user.

BeforeUndeleteObject: The event
handler is triggered before an
object is undeleted.
AfterUndeleteObject: The event
handler is triggered after an
object is undeleted. A script
can be used for performing
the checkout operation and
for performing further object
operations with the checked out
object version.
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Event handler

Variables

Execution

AfterUndeleteObjectFinalize

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

This event is triggered after the
object undelete operation is
complete and you are able to
work with the undeleted object.

BeforeModifyMFilesCredentials

•
•
•
•
•
•
•
•
•
•

Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeModifyMFilesCredentials:
The event handler is triggered
before the password of the MFiles login account is changed.

•

ActivityID

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

AfterModifyMFilesCredentials

BeforeCheckinChangesFinalize

AfterModifyMFilesCredentials:
The event handler is triggered
after the password of the M-Files
login account is changed.

The
BeforeCheckinChangesFinalize
event handler is triggered before
an object is checked in, but
after the state transitions and
signatures have been finalized.
Workflow changes are not
allowed.
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Event handler

Variables

Execution

BeforeAddUserGroupMember

•
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeAddUserGroupMember:
The event is triggered before
a member is added to a user
group in the vault database.
AfterAddUserGroupMember: The
event is triggered after a member
is added to a user group in the
vault database.

•
•

MemberID
GroupID

AfterAddUserGroupMember

BeforeRemoveUserGroupMember •
•
AfterRemoveUserGroupMember •
•
•
•
•
•
•
•
•
•
•
•
•

ObjVer
DisplayID
Vault
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeRemoveUserGroupMember:
The event is triggered before
a member is removed from a
user group in the vault database.
AfterRemoveUserGroupMember:
The event is triggered after a
member is removed from a user
group in the vault database.

MemberID
GroupID

Server-level event handlers
This section lists event handlers that are triggered by server-level operations. These operations also cause
a corresponding event to be executed in all online vaults of the server.
Note: An exception in a server-level event handler prevents the triggering operation from being
executed, but any vault-level event handler exceptions do not affect server-level operations.
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Event handler

Variables

Execution

BeforeRunScheduledJob

•
•
•

CurrentUserID
CurrentUserSessionInfo
GetExtensionObject

•
•
•

MFScriptCancel
ScheduledJob
ScheduledJobOutputInfo

The event handler is executed
when one of the timed jobs of
the server is performed. These
event handlers can be used
to automatically monitor the
execution of the automatically
timed jobs. In case of error, the
event handler can automatically
send an e-mail notification to
the administrator to facilitate
resolution of the problem.

•
•
•
•
•
•
•
•
•
•
•

LoginAccount
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeCreateLoginAccount: The
event is triggered for all online
vaults before a login account is
created on the server.

•
•
•
•
•
•
•
•
•
•
•

LoginAccount
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeModifyLoginAccount: The
event is triggered for all online
vaults before a login account is
modified on the server.

AfterRunScheduledJob

BeforeCreateLoginAccount
AfterCreateLoginAccount

BeforeModifyLoginAccount
AfterModifyLoginAccount

AfterCreateLoginAccount: The
event is triggered for all online
vaults after a login account is
created on the server.

AfterModifyLoginAccount: The
event is triggered for all online
vaults after a login account is
modified on the server.
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Event handler

Variables

Execution

BeforeRemoveLoginAccount

•
•
•
•
•
•
•
•
•
•
•

LoginAccount
CurrentUserID
CurrentUserSessionInfo
VaultSharedVariables
SavepointVariables
TransactionCache
MFScriptCancel
GetExtensionObject
MasterTransactionID
CurrentTransactionID
ParentTransactionID

BeforeRemoveLoginAccount: The
event is triggered for all online
vaults before a login account is
removed from the server.

•
•
•

CurrentUserID
CurrentUserSessionInfo
GetExtensionObject

BeforeModifyMFilesCredentials:
The event handler is triggered
for all online vaults before the
password of an M-Files login
account is changed.

AfterRemoveLoginAccount

BeforeModifyMFilesCredentials
AfterModifyMFilesCredentials

AfterRemoveLoginAccount: The
event is triggered for all online
vaults after a login account is
removed from the server.

AfterModifyMFilesCredentials:
The event handler is triggered
for all online vaults after the
password of an M-Files login
account is changed.

Available VBScript Variables
VBScript code is edited in the Edit VBScript code window available in the following dialogs:
•
•
•
•
•
•

Property Definition Automatic Values
Automatically Validating Property Values
Trigger
Workflow State Actions
Workflow State Conditions
Event Handlers

The available variables are described in the table below.
Note: The M-Files API documentation is available online: M-Files API. For more information about
using VBScript in M-Files, see the How do I write VBScript code for M-Files purposes? tutorial.
Variable

Data type

Mode Use

ActivityID

MFilesAPI.TypedValue

In

The unique ID of the operation that is being
processed. Can be used for identifying
which events are caused by a certain
server operation.

AllowStateTransition

Boolean

Out

Can be used to allow or deny automatic
state transition when running the automatic
state transition script.
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Variable

Data type

Mode Use

CurrentTransactionID

MFilesAPI.TypedValue

In

The ID of the transaction. If event handlers
are executed recursively (so that executing
one causes another to be executed), the ID
changes on every recursion level.

CurrentUserID

MFilesAPI.Number

In

Contains the ID of the user who performed
the action that triggered the script.

CurrentUserSessionInfo

MFilesAPI.SessionInfo

In

Contains information about the login
session of the user who caused the
operation.

DisplayID

MFilesAPI.TypedValue

In

Contains the object's unique ID. This
ID is displayed to users in the property
area of M-Files Desktop when the object
is selected in the list. DisplayID can
contain both numbers and letters. Often,
DisplayID is the same as the object's
internal ID whose value can be retrieved
with the ObjVer variable. The internal ID
can only contain numbers. DisplayID
and the internal ID are usually different
when the object has been imported from an
external database.

FileTransferSessionID

MFilesAPI.Number

In

Contains the user-specific data transfer
identifier. The data transfer identifier
is created when the data transfer is
being started on the server and, at
the same time, the same identifier is
given to the BeforeFileUpload and
BeforeFileDownload event handlers.
After completion of the data transfer,
the same data transfer identifier will be
given to the AfterFileUpload and
AfterFileDownload event handlers.
This way it is possible to attach the event
handlers of type "Before" to the event
handlers of type "After".

FileVer

MFilesAPI.FileVer

In

Contains the complete unique ID of the
target file, consisting of the file ID and file
version.
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Variable

Data type

Mode Use

GetExtensionObject

(method)

N/A

A method for retrieving the extension object
defined by the vault application.
Use: GetExtensionObject( <object
name> [, application GUID]),
where the part [, application GUID]
is optional.
For example: Set CK =
GetExtensionObject("MFiles.ComplianceKit",
"{0CAC5452-631F-4646AC95-4A06BFB8147E}")
If the application GUID has not been
specified, the extension object is searched
from all the applications of the vault.

GroupID

MFilesAPI.Number

In

The ID of the target user group.

Input

MFilesAPI.TypedValue

In

A client-defined parameter for the
VaultExtensionMethod event handler.

IsCancellable

MFilesAPI.BooleanValue

In

Normally, scripts can cancel a server
operation and revert the associated
transaction by raising an error in the script.
The IsCancellable variable specifies
whether the script is allowed do this.
If the value of the variable is false, MFiles Server will ignore any errors raised
in the script. If the script raises an error
while the value of the variable is false,
however, an error is written to the Windows
event log and all the changes made via the
script are reverted. The server operation
then proceeds to completion.
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Variable

Data type

Mode Use

LastUsed

MFilesAPI.TypedValue

In

Available only if a customized automatic
number is being calculated for a property.
The value of an automatic number usually
depends on the previous calculation.
For example, in ordinary consecutive
numbering, the automatic value is
incremented by one each time. When
you are setting up customized automatic
numbering, the result of the previous
calculation can be retrieved by using the
LastUsed variable.
For example, simple automatic numbering
that increments by one could be
implemented with the following simple
VBScript code: Output = LastUsed +
1

LoggedOutUserID

MFilesAPI.Number

In

Contains the logged out user ID after
logout.

LoginAccount

MFilesAPI.LoginAccount

In

Contains the user account data in the login.

MasterTransactionID

MFilesAPI.TypedValue

In

The ID of the transaction. If event handlers
are executed recursively (so that executing
one causes another to be executed),
this transaction ID is the ID of the first
transaction.

MemberID

MFilesAPI.Number

In

The ID of the member who is added to or
removed from a user group. The value is
negative if the member is a user group.

MFScriptCancel

MFilesAPI.Number

In

Contains the error code which is used by
the scripts for displaying error messages to
users. M-Files often adds detailed data to
error messages; this can be prevented with
the error code of the MFScriptCancel
variable.
Example: Err.Raise
MFScriptCancel, "This is the
error message shown to the
user."

NextStateID

MFilesAPI.Number

Out

During the automatic state transition, the
NextStateID variable contains the ID
of the state for which the automatic state
transition will be performed. By changing
the value of this variable, you can define
the next state in the automatic state
transition script. By default, the target state
is the same as set in the Next State option
in the user interface.
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Variable

Data type

Mode Use

ObjectAccessControlList MFilesAPI.ObjectAcce
ssControlList

In

Contains the current permissions of the
viewed object.

ObjID

MFilesAPI.ObjID

In

The ID of the object being processed.

ObjVer

MFilesAPI.ObjVer

In

Contains the complete unique ID of the
target version, consisting of the object type
ID, object internal ID, and object version.

Output

MFilesAPI.TypedValue

Out

Available only if a customized automatic
number is being calculated for a property.
When VBScript code starts to run, the
Output variable contains the current value
of the property being calculated (but not for
automatic numbering).
The main purpose of VBScript code is
usually to create a new value and assign
it to the Output variable, which is then
stored in the object's metadata. If the
VBScript code does not set the value of the
Output variable, the property value in the
metadata remains the same.
The value of the Output variable can,
in simple cases, be set with a simple
statement, for example: Output = 123
If the data type of the value being
calculated is, say, Choose from list, the
SetValue method is recommended
for setting the value of the Output
variable (see M-Files API), for example,
as follows: Output.SetValue
MFDatatypeLookup, 101

ParentTransactionID

MFilesAPI.TypedValue

In

The ID of the transaction. If event handlers
are executed recursively (so that executing
one causes another to be executed), this
transaction ID is the ID of the previous
(calling) transaction.

PropertyDef

MFilesAPI.PropertyDef

In

Contains the information about the property
value being calculated, such as the
property value definition ID, name, and data
type.

PropertyValue

MFilesAPI.PropertyValue

In

Contains a property value. Each property
value is stored in the PropertyValues
variable as a variable of the type
PropertyValue. A certain property
value can be retrieved with the
SearchForProperty method.
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Variable

Data type

Mode Use

PropertyValues

MFilesAPI.PropertyValues In

Contains all the property values of the
target version that were affected by the
current action. Each property value is
stored in the variable PropertyValues as
a variable of the type PropertyValue. A
certain property value can be retrieved with
the SearchForProperty method.
Note: Some property definitions
are not shown when using the
PropertyValues variable in
scripts (see Property definitions not
shown for scripts).

RestoredVersions

MFilesAPI.IDs

In

Contains object versions of the exported
object that were imported from the content
package.

SavepointVariables

MFilesAPI.NamedValues

In/
Out

A container for optional name-value
pairs stored for the duration of a single
transaction. The container automatically
reverts the modifications caused by failed
operations in the container.

ScheduledJob

MFilesAPI.ScheduledJob

In

Contains a description of the scheduled job
which is being performed.

ScheduledJobOutputInfo MFilesAPI.ScheduledJ
obOutputInfo

In

Contains information of the scheduled job
result after the job has been performed.

StateID

MFilesAPI.Number

In

Contains the workflow state identifier which
can be used to recognize the process state
in scripts related to the workflows.

StateTransitionID

MFilesAPI.Number

In

The ID of the state transition.

TransactionCache

MFilesAPI.NamedValues

In/
Out

A container for optional name-value
pairs stored for the duration of a single
transaction. The container retains all the
modifications, even if they were caused by
an operation that was later canceled due to
an error.

UserAccount

MFilesAPI.UserAccount

In

Vault user information.

UserGroupAdmin

MFilesAPI.UserGroupA
dmin

In

Vault user group information.

ValueListItem

MFilesAPI.ValueListItem

In

Contains the value list value which is being
processed in the event handler.
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Variable

Data type

Mode Use

Vault

MFilesAPI.Vault

In

Represents the document vault used in
running the script. With the identifier, the
script is able to handle the document vault
contents in the same way as is possible
with the M-Files API interface. In an
error situation, all changes made to the
document vault through the Vault entity
will be cancelled.
The use of the Vault entity with scripts
entails certain limitations. The scripts
cannot, through the Vault entity, change
the state of the object which the script is
run to. The state change refers to checking
out the object, checking in the object,
undoing the check-out, and deleting and
destroying the object. Also, all other objects
that are checked out in the script must be
checked in during running of the same
script.

VaultSharedVariables

MFilesAPI.NamedValues

In/
Out

A collection of named values stored in
the document vault database. With the
variable, the scripts can store their own
values in the database so that they are
also available to other scripts. The allowed
data types for the named values are integer
variables, Booleans, and strings.
In the following example, the value 123 is
stored as a named value and the numberbased calculated value is then set as the
value.
VaultSharedVariables( "Message" )
= 123
Output =
VaultSharedVariables( "Message" )

View

MFilesAPI.View

In

Contains the view which is being processed
in the event handler.

Property definitions not shown for scripts
The property definitions listed in the following table are not shown by using the PropertyValues variable
in scripts:
Name

ID

Status changed

24

Single file

22
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Name

ID

Deleted

27

Deleted by

28

Comment

33

Version label

29

Size on server (this version)

30

Size on server (all versions)

31

Marked for archiving

32

Collection members (documents)

46

Collection members (document collections)

47

Class groups

101

Assignment description

41

Deadline

42

Monitored by

43

Assigned to

44

Marked as complete by

45

Marked as rejected by

97

Workflow Assignment

79

Accessed by me

81

Favorite view

82

Object changed

89

Permissions changed

90

Version label changed

91

Version comment changed

92

Deletion status changed

93

Conflict resolved

96

Object changed for export

105

Object version changed for export

106

For example, the following piece of script results in a "not found" error:
Dim DeadlineValue
DeadlineValue = PropertyValues.SearchForProperty(42).TypedValue.DisplayValue
Tip: You can use the GetProperties method to get all the properties of a specific object.

Execution Order of Scripts
User-specified scripts in M-Files are executed in a specific order and the point in which they are executed
depends on the event for which the script is written. See the lists below for the order in which events are by
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default executed when a user performs a certain action in a vault. Note that the exact order and number of
events that are triggered after a specific user action depend on the vault structure and the types of scripts
used in the vault.
The user creates an object and immediately checks it in:
1.
2.
3.
4.
5.
6.
7.

Property value validation
Calculating automatic property values
The BeforeCreateNewObjectFinalize event
Workflow state preconditions
Workflow state actions
The AfterCreateNewObjectFinalize event
The AfterCheckInChangesFinalize event

The user creates an object, then modifies its property values, and after that checks the object in:
1. Property value validation
2. Calculating automatic property values
3. The BeforeCreateNewObjectFinalize event
4. The AfterCreateNewObjectFinalize event
5. The BeforeSetProperties event
6. Property value validation
7. Calculating automatic property values
8. The AfterSetProperties event
9. The BeforeFileUpload event
10.The AfterFileUpload event
11.The BeforeSetProperties event
12.Calculating automatic property values
13.The AfterSetProperties event
14.The BeforeCheckInChanges event
15.Workflow state preconditions
16.Workflow state actions
17.The BeforeCheckinChangesFinalize event
18.The AfterCheckInChanges event
19.The AfterCheckInChangesFinalize event
The user modifies the property values and changes the workflow state of an object:
1. The BeforeCheckOut event
2. The AfterCheckOut event
3. The BeforeSetProperties event
4. Property value validation
5. Calculating automatic property values
6. The AfterSetProperties event
7. The BeforeCheckInChanges event
8. Previous workflow state postconditions
9. New workflow state preconditions
10.Workflow state actions
11.The BeforeCheckinChangesFinalize event
12.The AfterCheckInChanges event
13.The AfterCheckInChangesFinalize event
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14.The BeforeReturnView event
If you have more than one event handler of the same type, you may change their execution order by
selecting the event handler in the Event Handlers dialog and clicking either the up or down arrow button
along the right side of the dialog:

3.2.11. Intelligent Metadata Layer
Intelligent Metadata Layer, abbreviated as IML, is a repository-neutral approach to intelligent information
management that unifies information across different sources based on context, not on the system or folder
in which the information is stored.
IML allows an M-Files user to connect to multiple different external repositories in addition to the traditional
M-Files document vaults. By means of special vault applications known as connectors, the user can
browse and edit content residing in external sources within the M-Files user interface.
IML provides automatic classification and metadata to your documents with the aid of so-called intelligence
services that add a layer of artificial intelligence to M-Files. Intelligence services are vault applications that
classify documents for you by determining the class of the document and suggesting metadata values by
analyzing file content semantically and visually.
For a more thorough overview of IML, see the document Intelligent Metadata Layer.
Note: To use IML features, you need an appropriate Intelligent Metadata Layer license and
Microsoft .NET Framework 4.7.2 or later installed on the M-Files server computer.
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Note: Some M-Files applications that were released before M-Files 2018 may not be compatible
with external repository content. Before taking IML into use, ensure that all your business-critical MFiles applications are compatible with content stored in external repositories.
Architecture of IML
The architecture of IML can be divided into three separate layers: the unified user experience layer on the
top, the intelligent metadata layer in the middle, and the multi-repository backend at the bottom.

The top layer, the unified user experience layer, serves to offer a unified user experience regardless of
the repository in use. It allows information to be viewed and edited with the familiar M-Files Desktop, MFiles Web and M-Files Mobile user interfaces, no matter where the information resides.
The middle layer, also known as Intelligent Metadata Layer, is the central component in the IML
architecture. It consists of all the essential enterprise content management capabilities, such as a versatile
search interface, workflows, version history, checking out documents for editing, and a multi-repository
search. The M-Files approach of classifying documents with metadata and categorizing content into
metadata-based views allows documents to be found on the basis of what they are about instead of where
they reside. The multi-repository search is the M-Files version of an enterprise search, allowing documents
to be searched for across repositories.
The middle layer also adds artificial intelligence into the M-Files system. The so-called intelligence services
offer means for automatic metadata suggestions and document classification by performing text and image
analytics on content that is added to M-Files, and by applying machine learning on vault user behavior
patterns. Intelligence services are vault applications that, when installed, can shoulder the burden of
specifying metadata and classifying documents. Additionally, the IML application programming interface
allows intelligence services to be developed by third parties so that they can be tailor-made to suit specific
needs and environments of diverse organizations and businesses.
For more information on intelligence services, see Intelligence Services.
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The bottom layer, the multi-repository backend, acts as an interface between M-Files and external
repositories. By means of vault applications known as connectors, M-Files users are able to view
and modify content in external repositories by using the M-Files user interface. Connectors establish
connections between M-Files and external repositories and allow the user to view and edit content from
various different external sources as though the user was operating within a single document vault.
For more information on connectors, see Connectors.

In this chapter
•
•
•

Intelligence Services
Connectors
Connection to On-Premises Data with M-Files Ground Link

Intelligence Services
Intelligence services are vault applications that are designed to analyze and classify documents and offer
metadata suggestions based on file contents, existing metadata, and even user behavior. Intelligence
services make use of technologies such as text analytics and machine learning to define and maintain
document metadata for the user.
Intelligence services can operate in many ways and come into play in different situations. They can be
tailor-made for M-Files, they can take advantage of a third-party component or an API, or connect to a
third-party service to perform content analysis for M-Files.
Tip: Developers can build and customize their own intelligence services. For more information,
refer to Visual Studio Template for Building Intelligence Services.
Intelligence services are at work in the background, for example, when the user drags and drops a new
document to M-Files or modifies a specific property value on the metadata card. In such instances,
intelligence services analyze the contents of new documents and metadata modifications and offer
metadata suggestions based on the analyses that they conduct.
If you for instance add a contract to M-Files, the intelligence service may automatically suggest contract
to be used as the document class and propose values for customer and contact details, among other
metadata fields, by deducing the information from the file contents. Users may then add suggested values
as they see fit. This type of automation can significantly speed up the process of adding metadata for MFiles objects.

Figure 98: Intelligence services aid you in tagging documents with metadata.
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As another example, when an image is added to M-Files, an intelligence service can conduct a visual
analysis on the new image before the user fills in the metadata. The analysis identifies individual objects,
concepts and human faces as well as facial features in the image and generates a textual description
and subject labels of the image contents. The description and labels are in turn offered as metadata
suggestions for the description and keywords fields on the metadata card. The user can then add any
suggestions that she deems appropriate as metadata values and optionally edit the added values to further
specify the metadata.
Note: Metadata suggestions are not shown for users with a read-only license.

In this chapter
•
•

Adding an Intelligence Service
Configuring an Intelligence Service

Adding an Intelligence Service
Complete the following steps to add an intelligence service to a vault on the M-Files Server computer:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Right-click a vault.
5. Click Applications.
The Applications window is opened.

6. Click the Install... button.
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7. Locate the application package stored on your computer and click Open.
You are prompted to restart the document vault.
8. Click Yes at the prompt.
9. If you have any open sessions in the selected vault, you are prompted to close any open sessions.
Click Yes.
The selected intelligence service is installed and should be listed in the Applications window. After the
intelligence service has been successfully installed, it should be configured. For instructions on configuring
an intelligence service, see Configuring an Intelligence Service.
Configuring an Intelligence Service
Intelligence services are configured in the M-Files Admin configurations editor. For instructions on using
the editor, see Using the Configurations Editor.
Complete the following steps to configure an intelligence service:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Configurations.
6. In the gray navigation area, expand Intelligence Services and then select the intelligence service that
you want to configure.

7. Open the Configuration tab, and then expand the General Settings section and edit the configuration
as applicable:
Setting

Description

Enabled

Specifies whether the intelligence service is
enabled or not.

Suggestions

These settings are used for mapping metadata
suggestions with M-Files properties.
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Setting

Description

Maximum Processing Time in Seconds

The maximum amount of time in seconds
that the intelligence service waits for the
suggestions to be processed and generated
before canceling the operation.

8. Expand the Service-Specific Settings section and edit the configuration as applicable.
The settings under Service-Specific Settings vary across intelligence services. See servicespecific instructions for more information.
9. Click Save to save your configuration.
10.Restart the vault.
Your configurations should now be effective and the intelligence service should be ready for use.
Connectors
Connectors establish a connection between M-Files and external repositories. They bring external data
into the M-Files user interface and allow it to be viewed and modified in the same fashion as information is
commonly processed in M-Files.
In other words, files in an external repository, such as a network folder, are displayed in M-Files like any
other M-Files objects and they can be edited and enriched with metadata in the same manner as any other
information residing in an M-Files document vault.
Objects in external repositories are by default unmanaged, but they can be promoted to managed objects.
For more information, see Unmanaged and Managed Objects and Promoting Unmanaged Objects.

Figure 99: Connectors allow you to integrate M-Files with external repositories so that you can view and modify external repository
content via M-Files. By adding metadata, you can promote files and folders in external repositories to M-Files objects so that they can
be, for example, organized into metadata-driven views.
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Adding a Connector
Complete the following steps to add a connector to a vault on the M-Files Server computer:
1. Open M-Files Admin.
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2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Right-click a vault.
5. Click Applications.
The Applications window is opened.

6. Click the Install... button.
7. Locate the application package stored on your computer and click Open.
You are prompted to restart the document vault.
8. Click Yes at the prompt.
9. If you have any open sessions in the selected vault, you are prompted to close any open sessions.
Click Yes.
The selected connector is installed and should be listed in the Applications window. After the connector
has been successfully installed, it should be configured. For instructions on configuring a connector, see
Configuring a Connector.
Configuring a Connector
Connectors are configured in the M-Files Admin configurations editor. For instructions on using the editor,
see Using the Configurations Editor.
Complete the following steps to configure a connector:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
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4. Expand a vault.
5. Select Configurations.
6. In the gray navigation area, expand External Repositories and then select the connector that you want
to configure.

7. In the Dashboard tab, either:
a. Click Add Connection to add a new connection.
Note: You cannot add more connections than specified in the external repositories
configuration. To increase the limit, see Increasing the Number of Allowed External
Repository Connections.
or
b. Select an existing connection and click Configure.
8. Expand General Settings and edit the configuration as applicable:
Setting

Description

Enabled

Specifies whether the connection is enabled or not.

Display Name

The display name for the connection, shown in the listing area under
External Views.

Authentication

Specifies the authentication type used for connecting to the external
repository. The available options are:
•
•
•

Personal
Common
Anonymous

See External Repository Authentication for further information.
Permissions

These options allow you to use a default M-Files NACL for the objects
in the external repository.
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Setting

Description

Automatic Association These options allow you to automatically associate M-Files users with
external users and user groups. This section consists of the following
options:
•

Association Methods: Allows you to specify association
methods if common authentication is used. Supported values:
username: Forms an association if an external username
matches an M-Files username.
User Association during Login: Allows the M-Files user to
be associated with the external repository user when the user logs
in to the repository via M-Files. This setting can be used if personal
authentication is enabled.
User Association with User Groups during Login:
Allows external repository group memberships to be synchronized
in M-Files when the user logs in to the repository using personal
authentication.
Replicate All User Groups: If enabled, all available user
groups and the group hierarchy of the external repository is
replicated to M-Files.
•

•

•

•

Mapping

These options are used for mapping objects in the external repository
with M-Files objects, and external metadata with M-Files properties.
You can enter the value * in the External Type field of an object
type mapping to use the same object type for all the external objects
available via this connection.
Note: External files should be mapped to an M-Files object
type that has the option Objects of this type can have files
enabled. For more information on object type properties, see
Creating a New Object Type.
You can use the file extension based filtering settings under object
type mappings to specify which external repository objects should
be listed in M-Files. The file extensions should be entered without a
preceding period (for instance: bmp), and only a single one should be
specified per value field. Excluded external objects are not indexed,
either.

Search Indexing

These options affect the way content in the external repository is
indexed for searching.

9. Expand the Connector-Specific Settings section and edit the configuration as applicable.
The settings under Connector-Specific Settings vary across connectors. See connectorspecific instructions for details.
10.Optional: In the gray navigation area, right-click the connection and select Authenticate Common
User from the context menu to add the common user credentials for accessing the repository.
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11.Optional: In the gray navigation area, right-click the connection and select Authenticate Indexer User
from the context menu to add the credentials that are used for indexing the contents of the repository.
12.In the gray navigation area, right-click the connection and select Authenticate Permissions Retriever
from the context menu to add the credentials for fetching the external repository object permissions.
The option is displayed in the connector context menu only if the connector requires a
permissions retriever to be assigned. Otherwise, only the options for authenticating a common
user and an indexer user are shown.
13.Click Save to save your configuration.
14.Restart the vault.
Your configuration should now be effective. You can inspect the Dashboard tab to see the status of the
external repository connection.

In this chapter
•

External Repository Authentication

External Repository Authentication
Administrators must specify the type of authentication to be used for each external repository connection
via M-Files Admin. The Authentication setting specifies the credentials that are used for accessing the
external repository. Administrators can specify that anonymous, common, or personal authentication is
used.
See also External Repository Users and External Repository User Groups for instructions on associating
external repository users and user groups with M-Files users and user groups.
Anonymous Authentication
You must set the Authentication setting to Anonymous for repositories that do not need to authenticate
users at all.
Common Authentication
The administrator specifies credentials that are stored in the M-Files vault database in encrypted format.
These credentials are used for every M-Files user when they access the external repository via M-Files.
Common is the recommended authentication type in two scenarios:
•

•

The external repository contains data that can be accessed by every M-Files vault user or a certain
subset of vault users. Using this authentication type saves users from having to log in to the repository
manually.
The external repository must be made accessible for users that do not have credentials to the
external repository. This might be the case, for example, when an organization wants to grant external
subcontractors access to a network folder via M-Files that they would otherwise not have access to.
•

Using common authentication for this purpose may also require that the external users are granted
access to the content via named access control list, as the common authentication only allows the
users to access the repository, not the actual content. Alternatively, the vault users that should be
able to access the external content can be associated with the common external user.
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Personal Authentication
When the type of authentication is set to Personal, the user is prompted to provide their credentials in the
M-Files client when they access the external repository:

Logging out from or Logging in to an External Repository
To log out from or to log back in to an external repository that uses user-specific authentication, perform
the following steps:
1. In M-Files Desktop, click the username in the top-right corner of the user interface.
2. Select External Repositories from the context menu.
The External Repositories dialog is opened.

3. Select the external repository connection and either:
a. Click Log In to log in to the repository to which you are no longer connected.
or
b. Click Log Out to log out of the repository to which you are currently connected.
4. Click Close to close the External Repositories dialog.
Increasing the Number of Allowed External Repository Connections
If you use M-Files Cloud, request our customer support (support@m-files.com) to increase the maximum
number of connections if necessary.
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To change the Maximum Number of Connections setting, you need to have the system administrator
permissions.
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand External Repositories.
3. In Maximum Number of Connections, speficy the number of allowed external repository connections.
4. Click Save.
Unmanaged and Managed Objects
External files that do not have M-Files metadata are unmanaged objects in M-Files terminology. You can
view and edit them in M-Files, but the changes are saved only to the external repository, and M-Files
Server does not keep a version history for these objects.
When you add metadata properties for an unmanaged object, it is promoted to a managed object in MFiles. Managed objects can be edited in the external system or in M-Files, but M-Files keeps a version
history only of the changes made in M-Files. Because the external repository does not necessarily support
version history, M-Files Server saves all object versions in M-Files and only the latest version in the
external system.
Note: Unmanaged objects that are checked out cannot be promoted. Before you promote an
object, make sure that the object is not checked out to you or someone else. For more information,
see these instructions.
Reasons to promote objects to managed objects
You can use these essential M-Files features with managed objects:
•
•
•
•
•
•
•
•
•
•
•
•
•

Version history
Object relationships
Document collections
Workflows
Assignment features
Check out and check in
Co-authoring
Converting single-file document to multi-file documents
Object comments
Scanning and text recognition
Annotations
Sharing objects with hyperlinks and public links
Offline availability
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Unmanaged objects are also not part of replication packages.
Creating objects with metadata
You can use the features given here to create M-Files objects with metadata. Make sure that you use only
one of them. If you use more than one feature, the same content is migrated to the vault more than once.
•
•
•
•
•

Promote unmanaged objects
Create a connection to an external source
Save folders to M-Files
M-Files Smart Migration
M-Files Importer

Promoting Unmanaged Objects
To convert an unmanaged object to a managed object:
1. In M-Files Desktop, locate and select an unmanaged object either by using the search or External
Views.
The metadata card of an unmanaged object looks something like the following:

2. Make sure the object is not checked out for editing.
a. If the object is checked out to you, you can right-click the object and select Check In or Undo
Checkout from the context menu.
or
b. If the object is checked out to someone else, see the metadata card of the object to identify the user
who has checked out the object, and then ask them to check it in.
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3. Use the Class drop-down menu to change the class of the object.

4. Once you have changed the class, you may enrich the object with metadata as you see fit. The class
that you select determines the default metadata properties of the object.

5. Click Save to save your changes.
The selected object in the external repository has now been promoted into a managed object.
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Connection to On-Premises Data with M-Files Ground Link
With M-Files Ground Link, you can get access to on-premises data or business applications. M-Files
Ground Link lets you establish a safe connection to external repositories in private networks. Thus, a direct
network path or content migration is not necessary.
With the Ground Link feature, you can get access to on-premises repositories from a cloud vault in the
same way as in on-premises environment. You can also use Ground Link to connect an on-premises vault
to external data or business applications. To do one of these two, connect a Ground Link proxy on M-Files
Server to the vault.

Figure 100: A Ground Link proxy lets a vault connect to private repositories, such as network folders, without a direct network path.
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Setting up M-Files Ground Link
Before you set up the Ground Link feature, make sure that:
•
•

gRPC connections are permitted on the M-Files server.
The server has a valid TLS certificate for the encryption of the gRPC connections.

For more information, refer to the knowledge base document Setting Up M-Files to Use gRPC.
To set up the Ground Link feature, you first install external repository connectors to a Ground Link proxy.
Then, you set up repository connections in the vault. After that, you can see and edit the on-premises data
directly from the vault.
Enabling Ground Link Connection
To set up the Ground Link feature, write to our customer support at support@m-files.com to enable the
feature for your environment.
Complete these steps to enable the channel connection for Ground Link in a vault:
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1. Open M-Files Admin and go to a vault.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
2. Click Configurations.
3. In the navigation area, expand Advanced Vault Settings > Configuration.
4. Click Ground Link.
5. On the Configuration tab, set Enabled to Yes.
6. Click Save.
7. Restart the vault for the settings to take effect.
Note: Taking a vault offline should always be done in a controlled manner and the vault
users should be notified beforehand.
8. In the gray navigation area, expand External Repositories > Ground Link and select Configuration.
9. On the Configuration tab, specify these settings:
Setting name

Description

Example value

Enabled

This setting specifies whether
Ground Link is enabled or not.

Yes

Remoting
Service

Shared Secrets

A shared secret lets a Ground
Link proxy authenticate the vault.
Make sure that the shared secret is
complex and long enough. You can
specify one or more shared secrets.
You must enter the shared secret
when you configure the Ground Link
proxy.

Timeouts

The timeout values specify in
seconds how long remote calls wait
for a response. Use the default
values.

Timeouts >
Quick

This timeout value is used for remote
15 (default value)
calls that will return quickly.

Timeouts >
Default

This is the standard timeout value
that is used for most of the remote
calls.

Timeouts >
Extended

This timeout value is used for remote
600 (default
calls that will take a long time to
value)
return.

60 (default value)
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Setting name

Description
Timeouts
> Custom
Timeouts

Keep Alive Interval

You can add custom timeout values
for specific remote method calls if
the method operates correctly but
it times out again and again. Add
custom timeout values only if you
know what to do.
This setting specifies in seconds
how frequently the vault makes sure
that the Ground Link services are
connected.

Example value
Method Name:
ICloudAgentV1.Ping()
Timeout: 100

60 (default value)

10.Click Save.
Now that the vault uses Ground Link, you can configure the Ground Link proxy.
Configuring a Ground Link Proxy
Before you begin, make sure that:
•
•
•

Your Ground Link proxy server has sufficient hardware resources. See the recommended hardware
setup.
You have M-Files Server and M-Files Admin installed on the Ground Link proxy server. However, a
separate license for M-Files Server is not necessary.
You are logged in to M-Files Server with a login account that has the System administrator server role.
To create a login account, see Creating a Login Account.

To configure a Ground Link proxy:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Click Ground Link Proxies.
4. On the right-side pane, click New Ground Link Proxy.
The New Ground Link Proxy dialog is opened.
5. Enter a name for the Ground Link proxy.
6. Select the database engine for storing Ground Link proxy data.
a. To use Firebird, select Use Firebird.
or
b. To use Microsoft SQL Server, select Use Microsoft SQL Server.
For more information, see Database engine and data storage.
7. Click Define.
The settings dialog for the search engine is opened.
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8. Complete one of these options:
Option

Description

On the Ground Link Proxy - Firebird dialog

On the Ground Link Proxy - Microsoft SQL
Server dialog

a. Click the ... button and select the file location
for the Ground Link proxy data.
b. Click OK to close the dialog.
Do the steps from 6 to 10 in Migrating the Ground
Link Proxy Database to Microsoft SQL Server.

9. Click OK to close the New Ground Link Proxy dialog.
10.Install those external repository connectors that your vault will use to the newly created Ground Link
proxy.
Note: If a valid vault application license is necessary for a connector, the license will be
for the vault and for the server that contains the vault.
For more information, see Installing and Managing Vault Applications.
To get access to on-premises network folders from M-Files Cloud, install M-Files Network Folder
Connector.
The Ground Link proxy is now ready for configuration.
11.In the left-side tree view, under Ground Link Proxies, select the newly created Ground Link proxy.
12.On the Configuration tab, specify these settings:
Setting name

Description

Example value

Enabled

This setting specifies whether
Ground Link is enabled or not.

Yes

Password

Enter a password that you will use
when you apply a configuration for a
Ground Link service in the vault.

Channel

Network
Address
Port number

Enter the network location of the
server to connect to.
Enter the port that the server listens.
If you use the gRPC protocol, use
the same port number that your MFiles client uses to connect to the
server. For more information, see
Adding a Vault Connection.
Make sure that the necessary ports
are open in the firewall.

7766 or 443
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Setting name
Secure

Vault GUID

Description

Example value

This setting specifies whether a
secure (SSL encrypted) channel
connection is used. In production
environments, insecure connections
are not recommended.

Yes

Enter the GUID of your vault.

{990827D8-8AF2-4A4EB1214C1A8AD8ECD0}

To see the vault GUID, right-click
the vault and select Properties.
The GUID is shown in the Unique
ID field in the Document Vault
Properties dialog.

13.Click Save.

Shared Secret

Copy the shared secret from the
vault configuration. The channel
connection cannot be established
if the shared secret does not match
one of the shared secrets specified
for Ground Link.

Reconnect
Interval

This value specifies in seconds how
frequently the Ground Link proxy
tries to connect when the vault is
disconnected.

Keep Alive
Interval

This value specifies in seconds how
frequently the Ground Link proxy
makes sure that the connection to
the vault operates correctly.

Timeouts

The timeout values specify in
seconds how long remote calls wait
for a response. Use the default
values.

Timeouts >
Quick

This timeout value is used for remote
15 (default value)
calls that will return quickly.

Timeouts >
Default

This is the standard timeout value
that is used for most of the remote
calls.

Timeouts >
Extended

This timeout value is used for remote
600 (default
calls that will take a long time to
value)
return.

Timeouts
> Custom
Timeouts

You can add custom timeout values
for specific remote method calls if
the method operates correctly but
it times out again and again. Add
custom timeout values only if you
know what to do.

60 (default value)

60 (default value)

60 (default value)

Method Name:
ICloudAgentV1.Ping()
Timeout: 100
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The connection between the vault and the Ground Link proxy is established. Next, you can set up
repository connections in the vault.
You can see the status of the vault connection on the Dashboard tab.
Configuring Connectors over Ground Link
This example tells you how to configure M-Files Network Folder Connector in a vault as a Ground Link
service. For information on support for other connectors, write to M-Files Customer Support at support@mfiles.com or the connector provider.
Before you begin, make sure that M-Files Network Folder Connector is installed to the Ground Link proxy
that is connected to your vault.
1. Open M-Files Admin and go to a vault for which you have enabled the Ground Link connection.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
2. Click Configurations.
3. In the navigation area, expand External Repositories.
4. Click Ground Link.
On the Dashboard tab, you see the connected Ground Link proxies with the available Ground
Link services. Make sure that the service that you want to configure, in this case Network
Folder, is online.
5. In the gray navigation area, expand first the Ground Link node and then the Ground Link proxy whose
service you want to use.
6. In the gray navigation area, select the Ground Link service, in this case Network Folder.
7. On the Dashboard tab, select Add Connection.
8. In the confirmation dialog that is opened, click OK.
9. On the Dashboard tab, click Configure to configure the new connection.
For more information, refer to Installing and Configuring M-Files Network Folder Connector.
10.Click Save.
11.Click Apply.
The Enter Password dialog is opened.
12.Enter the password that is defined in the Ground Link proxy configuration.
13.Optional: Authenticate background users. After you have given the credentials, save and apply the
settings again.
For more information, refer to Installing and Configuring M-Files Network Folder Connector.
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14.Click Save.
15.Optional: Repeat the steps from 5 to 12 to add more connections.
Now you have access to the on-premises network folders from the vault. The objects in the network folders
are shown in M-Files. You can edit them and give them metadata in the same way as objects that are
stored in the vault.
Backing Up and Restoring a Ground Link Proxy
We recommend that you back up the Ground Link proxy always after you have made changes to the
Ground Link proxy or to the connections over Ground Link. If a Ground Link proxy is destroyed or the data
gets corrupted, you can restore the Ground Link proxy from a backup file. The backup file includes the
Ground Link configuration and the connector configurations.
This section tells you how to back up and restore a Ground Link proxy.
For information on how to change the location of Ground Link proxies and Ground Link proxy services with
the backup and restore operations, see Changing the Location of Ground Link Proxy Services.
Backing Up a Ground Link Proxy
To back up a Ground Link proxy:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Ground Link Proxies.
4. Right-click a Ground Link proxy.
5. Click Operations > Back Up.
The Back Up Ground Link Proxy dialog is opened.
6. Click the ... button to select the file location for the M-Files backup file (MFP).
7. Optional: Click Set Account... to run the task with another account than the Local System account. If
the file location is on a network drive that the Local System account cannot get access to, you must set
another account. On the Set Account dialog:
a) Select This account.
b) In This account, enter the name of the user account.
c) In Password and Confirm password, enter the password of the user account.
d) Click OK to close the Set Account dialog.
8. Optional: Select the Overwrite existing files check box if you want to overwrite the existing file in the
file location.
9. Click OK to close the dialog and start the backup.
Restoring a Ground Link Proxy
To restore a Ground Link proxy from a backup file:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
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3. Right-click Ground Link Proxies.
4. Click Restore Ground Link Proxy.
The Restore Ground Link Proxy dialog is opened.
5. In Full backup, specify the location of the backup file from which you want to restore the Ground Link
proxy.
6. Select either:
a. Restore using original identity: Select this option to to restore the Ground Link proxy with
the existing ID. The existing Ground Link proxy services and the connections to them will be
automatically enabled.
or
b. Restore as a different Ground Link proxy (new identity): Select this option to restore the Ground
Link proxy with a new ID. In Name, enter a name for the Ground Link proxy.
To enable the connections to the Ground Link proxy services, you must remove the existing
connections to the original Ground Link proxy services. For more instructions on managing the
connections, refer to the connector instructions, such as Installing and Configuring M-Files Network
Folder Connector.
7. In Location for Ground Link proxy data on server, specify the location for the Ground Link proxy
data.
8. Optional: Select the Overwrite existing files check box if you want to overwrite the existing file in the
file location.
9. Optional: If you do not want to temporarily disable the vault applications, unselect the Disable vault
applications check box.
For data security reasons, we recommend to enable the vault applications separately after the
Ground Link has been restored.
10.Click OK.
The Ground Link proxy is restored from the backup file.
11.Optional: Enable the vault applications. For instructions, see Installing and Managing Vault Applications.
Migrating the Ground Link Proxy Database to Microsoft SQL Server
Before you begin, make sure that
•
•
•

your Ground Link proxy uses the Firebird database engine.
you have a Microsoft SQL Server connection.
you have backed up the Ground Link proxy.

You can migrate your Ground Link proxy database from Firebird to Microsoft SQL Server via M-Files
Admin.
To migrate the Ground Link proxy database to Microsoft SQL Server:
1. Open M-Files Admin.
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2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Ground Link Proxies.
4. Right-click a Ground Link proxy.
5. Click Operations > Migrate to Microsoft SQL Server.
The Ground Link Proxy - Microsoft SQL Server dialog is opened.
6. In Server name, enter the connection address to your Microsoft SQL Server, such as
mysqlserver.mydomain.local.
7. In Database name, enter a name for the Ground Link proxy database.
We recommend to use the same name as the Ground Link proxy has on M-Files Server.
8. In the Administrator credentials and Basic user credentials sections, enter the credentials. For
instructions, refer to this table.
9. Optional: Click Test Connection to test the connection to your Microsoft SQL Server.
10.Click OK.
A warning dialog is opened to tell you that the operation cannot be undone.
11.Click Yes to close the warning dialog and start the migration.
Your Ground Link proxy now uses the Microsoft SQL Server database engine. The database of your
Ground Link proxy is on the specified Microsoft SQL Server.
Disabling the Ground Link Connection
If you want to disable the Ground Link feature in a vault, follow the instructions below.
1. Open M-Files Admin and go to a vault.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
2. Select Configurations and expand Advanced Vault Settings.
3. Expand the Configuration node and select Ground Link.
4. On the Configuration tab, set the Enabled value to No.
5. Click Save.
6. Restart the vault for the settings to take effect.
Note: Taking a vault offline should always be done in a controlled manner and the vault
users should be notified beforehand.
Changing the Location of Ground Link Proxy Services
You can back up and restore a Ground Link proxy to:
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•
•

Move a Ground Link proxy to another server.
Move Ground Link proxy services to a new Ground Link proxy.

This section tells you how to complete these operations.
Note: Other use cases can have unwanted effects.
Moving a Ground Link Proxy to Another Server
Before you restore the Ground Link proxy on the new server, make sure that the Ground Link proxy is
offline.
To move a Ground Link proxy to another server:
1. In M-Files Admin, back up a Ground Link proxy.
2. In the left-side tree view, right-click the Ground Link proxy.
3. Click Take Offline.
4. Restore the Ground Link proxy on the new server.
5. Optional: To destroy the original Ground Link proxy, right-click the Ground Link proxy on the old server
and select Operations > Destroy from the context menu.
a) In the warning dialog that is opened, click Yes to close the dialog and destroy the Ground Link
proxy.
Moving Ground Link Proxy Services to a New Ground Link Proxy
Before you enable the restored Ground Link proxy, uninstall the unnecessary applications from the two
Ground Link proxies.
To move some Ground Link proxy services with all their connections to a new Ground Link proxy:
1. In M-Files Admin, disable a Ground Link proxy.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Ground Link Proxies and select a Ground Link proxy.
d) Open the Configuration tab.
e) Set Enabled to No.
f) Click Save.
2. Back up the Ground Link proxy.
3. Enable the Ground Link proxy.
a) In the left-side tree view, select the Ground Link proxy.
b) Open the Configuration tab.
c) Set Enabled to Yes.
d) Click Save.
4. Restore the Ground Link proxy as a different Ground Link proxy (new identity).
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5. Uninstall those applications from the original Ground Link proxy that you want to move to the restored
Ground Link proxy.
For more information, see Installing and Managing Vault Applications.
6. Uninstall those applications from the restored Ground Link proxy that you do not want to move to the
restored Ground Link proxy.
For more information, see Installing and Managing Vault Applications.
7. Enable the restored Ground Link proxy.
a) In the left-side tree view, select the Ground Link proxy.
b) Open the Configuration tab.
c) Set Enabled to Yes.
d) Click Save.

3.2.12. Customizing Server and Vault Behavior
This section collects Microsoft Windows registry settings, M-Files named value settings, and advanced
vault settings that you can apply on the M-Files server computer to customize the behavior of M-Files
Server and the vaults.
Note: You need M-Files Named Value Manager for distributing named value settings. For
downloading the application as well as for instructions on using it, see the document Distributing
Vault-Specific Registry Settings from M-Files Server.

In this chapter
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Enabling Co-Authoring
Preventing Users from Toggling the Location of the Metadata Card
Setting the Initial State of the Task Area
Hiding Properties in M-Files Desktop
Disabling the Comment Dialog for Assignments
Setting a Primary File Type for Multi-File Documents
Setting Character Limit for Inserted Properties
Enabling Automatic Updates for Metadata Fields
Changing the Appearance of Hyperlinks
Configuration Options for Public Links
Configuration Options for the "Send and Save to M-Files" Button
Disabling the Reference Direction Setting for Grouping Levels
Enabling Phonic and Fuzzy Searches
Setting Up Synonym Search
Disabling the Search for Inflected Forms
Disabling the Sorting of Search Results by Their Relevance
Configuring Search Facets
Modifying PDF Conversion Limitations
Defining File Types for Indexing
Configuring Mappings Between Incoming Connections and Vaults
Specifying Vault-Specific Locale Settings for Server-Side PDF Conversions
Preventing Linked Documents from Being Removed
Registry Setting for Extending Firebird Usability
Settings for Vault Performance Measurement
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•

Setting M-Files Services to Use a Managed Service Account

Enabling Co-Authoring
To use co-authoring in your vault as instructed in Checking Out a Document for Co-Authoring, you first
need to enable Microsoft Office for the web tools and co-authoring via Microsoft Office for the web in your
vaults.
If you use M-Files Cloud, request our customer support (support@m-files.com) to enable these features.
If you do not use M-Files Cloud, follow the instructions in the document Enabling Microsoft Office for the
Web Services for M-Files to get these results:
•
•

Office Online Server is deployed.
M-Files Web is set to use Microsoft Office for the web services.

If you do not use M-Files Cloud and do not want to set up Office Online Server in an on-premises
environment, your organization must be a part of Office Cloud Storage Partner Program. When you are
part of the program and have set up your Microsoft Office for the web integration, you must set M-Files
Web to use it (refer to Enabling Microsoft Office for the Web Services for M-Files).
Note: M-Files Desktop uses M-Files Web in the background for co-authoring. In other words,
although the above-mentioned document discusses M-Files Web only, the same procedures must
be done to enable co-authoring in M-Files Desktop as well.
After you are done with the tasks described in the above-mentioned document, follow the steps in this
section to set up your vault to use Microsoft Office based co-authoring.
1. In M-Files Admin, access the custom vault data section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, expand Custom Vault Data.

2. Select Namespace Registry > Configuration.
3. Expand the Namespaces node, click Add Namespace, and expand the newly added namespace
node.
4. In the Group field, type a suitable group name, such as Co-authoring.
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5. Use the Storage Type drop-down menu to select the MFConfigurationValue storage.
6. In the Namespace field, enter the following value: M-Files.Core.CoAuthoring.Configuration
7. In the Namespace Label field, type a suitable label, such as Co-authoring.
8. In the Namespace Description field, enter for example Settings related to co-authoring.
9. Click Save to save the namespace settings.
10.In the gray navigation area, expand Named Values.
11.Expand the namespace group you just created, then select the namespace node, and finally the
Configuration node.
12.Click Add Named Value, and expand the newly created named value node.
13.In the Name field, enter the value WOPI.
14.In the Value field, enter the co-authoring configuration according to the values explained in the table
below and the example given below the table.
Name

Description

Example value

WopiRESTServer

The address of the server hosting M-Files
myserver.mycompany.com
Server and M-Files Web. M-Files Desktop
communicates with this server via REST for
starting the co-authoring process, as well as
for opening the page hosting the Office Online
editor.
If your environment uses Multi-Server
Mode, use a vault DNS name that the
load balancer recognizes. For example:
customer1.cloudvault.m-files.com.

WopiRESTServerFolderThe REST server folder. This should be set to
/REST/ in most cases.

/REST/

UrlSrc

https://
myserver.mycompany.com/

The REST endpoint of M-Files Web
communicating with Office Online Server.
The value is entered in the following format:
https://<your M-Files Web server
address>
If your environment uses Multi-Server
Mode, use a vault DNS name that the load
balancer recognizes. For example: https://
customer1.cloudvault.m-files.com.

MainAppURL

A confirmation page is opened based on this
URL after the user closes the co-authoring
page.
If your environment uses Multi-Server
Mode, use a vault DNS name that the load

https://
myserver.mycompany.com/
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Name

Description

Example value

balancer recognizes. For example: https://
customer1.cloudvault.m-files.com.
UseHttps

Specifies whether HTTPS is used for
communication. This should be set to true in
most cases.

true

Note: The value must not contain
quotation marks.
WopiServerPort

The port used for REST requests. This should
be set to 443 in most cases.

443

OperationTimeoutInMs Specifies in milliseconds the time that M10000
Files Desktop should wait for Microsoft Office
operations to complete. If exceeded, M-Files
gives up and shows a timeout error. This is an
optional setting, and if it is not included in the
configuration at all, the default timeout of 10
seconds is used.
The configuration should be entered in the same format as the example below:
{

}

"WopiRESTServer": "myserver.mycompany.com",
"WopiRESTServerFolder": "/REST/",
"UrlSrc": "https://myserver.mycompany.com/",
"MainAppURL": "https://myserver.mycompany.com/",
"UseHttps": true,
"WopiServerPort": 443,
"OperationTimeoutInMs": 10000

15.Click Save to save the configuration.
16.Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
The integration with Microsoft Office for the web is now in use in the vault. End users can check out
documents for co-authoring as instructed in Checking Out a Document for Co-Authoring as soon as they
have logged out from and logged back in to the vault. You can log out all vault users by restarting the
vault, but taking a vault offline should always be done in a controlled manner and the vault users should be
notified beforehand.
Troubleshooting for Enabling Co-Authoring
No co-authoring command in M-Files Desktop
If the command for starting co-authoring is not visible in M-Files Desktop, make sure that
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•
•
•

the value for UseHttps does not contain quotation marks.
you are using neutral quotation marks (") in your configuration.
the values for UrlSrc, MainAppURL, and WopiRESTServer point to your M-Files Web server.

Preventing Users from Toggling the Location of the Metadata Card
You can prevent users from toggling the location of the metadata card between the right pane and the
bottom pane by disabling the Show Metadata in Bottom Pane option in the Display Mode menu.
Note: You can also hide the Toggle Metadata Card Location command in the metadata card
option ribbon by defining a metadata card configuration rule that sets Is Hidden to Yes for the
Location Button definition. For more information on metadata card configuration rules, see
Metadata Card Configuration.
To disable the Show Metadata in Bottom Pane option in the Display Mode menu:
1. Open M-Files Named Value Manager.
2. Use the Server drop-down menu to select the M-Files server and then the Vault drop-down menu to
select the document vault.
3. Use the Storage Type drop-down menu to select the MFConfigurationValue storage.
4. In the Namespace field, enter the following value: M-Files.Core.Client.Settings
5. Click Add... to add a new key.
6. In the left-side pane, double-click New Named Value Key and enter the following value:
MetaDataPositionOverride
7. Select the newly added key, and in the right-side pane, enter the following value:
{

}

"MFShell": {
"MetaDataPositionOverride": {
"DoNotShowMetadataInBottomPane": 1
}
}

Your configuration in M-Files Named Value Manager should now be similar to the example
shown below.
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8. Click Save and then close M-Files Named Value Manager if you no longer need it.
The Show Metadata in Bottom Pane option in the Display Mode menu is now disabled and grayed out in
the selected vault.
Setting the Initial State of the Task Area
By default, the task area is collapsed and it can be expanded by the user. Add this registry key on the
client computer to specify whether task area is visible or hidden when the user opens M-Files Desktop.
This setting must be added before the user has logged in to the vault for the first time.
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Client
\MFShell<vault name>

Value name

TaskPaneInitialState

Value type

REG_DWORD

Description

Specifies whether the task area is hidden, visible, or completely disabled when the
user opens M-Files Desktop.

Default value

1

The task area is hidden.

Valid values

0

The task area is disabled and cannot be opened by the user.

1

The task area is hidden but can be expanded by the user.

2

The task area is visible but can be hidden by the user.

Hiding Properties in M-Files Desktop
Use the settings in this section to make M-Files Desktop show only a selected set of properties in these
places:
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•
•
•

the Insert Column list for the listing area
the list of properties after you click Add property on the metadata card
the list of properties available in the search options

Selecting properties to be shown in the Insert Column list
To select which properties are shown in the Insert Column list:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand Columns > Insertable Columns.
3. Set Hide Default Insertable Columns to Yes.
4. Expand Visible Insertable Columns.
5. Click Add Column.
6. As the value of the Column setting, select a property that you want to add to the list.
7. Repeat steps 5 and 6 for as many properties as necessary.
8. Click Save.
Selecting properties to be shown in the Add property list
To select which properties are shown in the Add property list:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand Properties > Visible Properties.
3. Set Hide All Default Properties to Yes.
4. Expand Property Definitions.
5. Click Add Property definition.
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6. As the value of the Property definition setting, select a property that you want to add to the list.
7. Repeat steps 5 and 6 for as many properties as necessary.
8. Click Save.
Selecting properties to be shown for search options
To select which properties are shown for search options:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand Search > Advanced Search Properties.
3. Set Hide All Default Properties to Yes.
4. Expand Property Definitions.
5. Click Add Property Definition.
6. As the value of the Property Definition setting, select a property that you want to add to the list.
7. Repeat steps 5 and 6 for as many properties as needed.
8. Click Add Value List.
9. As the value of the Property Value List setting, select a value list that you want to add to the list.
10.Repeat steps 8 and 9 for as many value lists as necessary.
11.Optional: Change the value of the Checked out / Checked out to setting if you want to hide the
properties Checked out, Checked out to, or both from the list.
12.Click Save.
Disabling the Comment Dialog for Assignments
By default, users are prompted for comments when they mark an assignment complete in M-Files Desktop.
You can modify this behavior by using the custom vault data setting described here.
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1. In M-Files Admin, access the custom vault data section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, expand Custom Vault Data.

2. Select Namespace Registry > Configuration.
3. Expand the Namespaces node, click Add Namespace, and expand the newly added namespace
node.
4. In the Group field, type a suitable group name, such as Assignments.
5. Use the Storage Type drop-down menu to select the MFConfigurationValue storage.
6. In the Namespace field, enter the following value: M-Files.Core.Client.Settings
7. In the Namespace Label field, type a suitable label, such as Assignments.
8. In the Namespace Description field, enter for example Settings related to assignments.
9. Click Save to save the namespace settings.
10.In the gray navigation area, expand Named Values.
11.Expand the namespace group you just created, then select the namespace node, and finally the
Configuration node.
12.Click Add Named Value, and expand the newly created named value node.
13.In the Name field, enter the value ShowMarkCompleteUI.
14.In the Value field, enter a configuration similar to the example below.
{
"MFShell":{
"ShowMarkCompleteUI":<X>
}
}
Change the value of <X> according to how you want the user interface to behave:
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Value of
<X>

Description

0

The comment dialog is not shown.

1

The comment dialog is shown. This is the default behavior.

2

The comment dialog is shown for assignments when they are marked complete
in the task area.

3

The comment dialog is shown for assignments when they are marked complete
via the metadata card.

15.Click Save to save the configuration.
The new behavior is enabled for users as soon as they have logged out from and logged back in to the
vault. You can log out all vault users by restarting the vault, but taking a vault offline should always be done
in a controlled manner and the vault users should be notified beforehand.
Setting a Primary File Type for Multi-File Documents
You can set a file type of your choice to act as the primary file type for multi-file documents in the vault.
This has these effects:
•
•
•

The icon of the specified file type is shown as the icon of the multi-file document.
The Preview Tab shows the preview of the primary file when the multi-file document is selected.
Double-clicking the object does the default action of the primary file type.
Note: This feature is supported in M-Files Desktop only. The common Windows dialogs, such as
Open or Save As, are not affected by the primary file type settings.

To specify a primary file type to be used in a vault of your choice, do the following steps on the M-Files
server computer:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand Multi-File Documents and select Primary Files.
3. Click Add Document Class.
4. Expand the newly created node and select a class value for the Document Class setting.
This value specifies the object class to which the setting applies.
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5. Expand File Name Filters and click Add Filter.
These filtering settings specify the primary file type for the selected class.
6. Expand the newly created node and specify a value for the Filter setting.
The value can include wildcard characters, for example: order-?.txt or *.pdf.
Enter only a single value for each setting node. You can, however, add as many setting nodes
with the Add Filter command as you need.
The filtering values are evaluated from top to bottom. You can move a setting up or down by
right-clicking it (the node level under File Name Filters) and selecting Move Up or Move Down
in the context menu.
7. Click Save once you are done with your changes.
8. Restart the vault for the settings to take effect.
Note: Taking a vault offline should always be done in a controlled manner and the vault
users should be notified beforehand.
Multi-file documents of the selected class stored in this vault and any connected external repositories now
use the specified file type as their primary file and behave as described at the top of this section. If the
document contains more than one file matching the filtering conditions, the file that has been added first is
used as the primary file.
Setting Character Limit for Inserted Properties
You can set a limit for the maximum number of characters that a property value added to Microsoft Word
documents can contain. Add this Microsoft Windows registry setting to the client computer:
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Client
\MFOfficeAddin

Value name

LongValueInMultilineTextPropertyInWordAllowed

Value type

REG_DWORD

Description

Specifies whether users can add property values of over 255 characters to Microsoft
Word documents with the M-Files Insert Property feature.

Default value

1

Long values can be added.

Valid values

0

When a long property value is added to a Microsoft Word document, only the
first 255 characters are shown.

1

It is possible to add long values. The number of characters added can be higher
than 255 characters.

Enabling Automatic Updates for Metadata Fields
It is possible to add metadata properties to Microsoft Word, Microsoft Excel, and Microsoft PowerPoint
documents with the M-Files for Microsoft Office plugin. The Microsoft Office plugin is included in the MFiles Desktop installation package. For more information on this feature, see Add M-Files Property.
It is possible to enable automatic metadata field updates in M-Files Desktop, the classic M-Files Web and
M-Files Mobile.
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Note: When automatic metadata field updates are enabled, the performance can decrease in
some environments.
To enable automatic metadata field updates in M-Files Desktop, the classic M-Files Web and M-Files
Mobile:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand File Operations > Extension Filter for Embedded Metadata Update on Check-In.
3. Click Add Extension.
4. In the Extension field, enter the file extension, for example docx.
The valid values are doc, docx, xls, xlsx, and ALL. With the value ALL, it is possible to
update the metadata for all file types at the same time. If you set the value ALL, you must not
have any other file extensions set.
5. Repeat the steps 4 and 5 for each file extension.
6. Click Save to save your configuration.
Changing the Appearance of Hyperlinks
You can change the appearance of M-Files hyperlinks with registry settings. Add the registry settings to
HKEY_LOCAL_MACHINE for client-wide settings or to HKEY_CURRENT_USER for user and vault settings, or
to both. HKEY_CURRENT_USER is more important when registry settings are added for both.
In HKEY_LOCAL_MACHINE, the key name is: HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files
\<version>\Common\Settings\Hyperlinks.
In HKEY_CURRENT_USER, the key name is: HKEY_CURRENT_USER\SOFTWARE\Motive\M-Files
\<version>\Client\MFShell\<vault>\Hyperlinks.
Add these settings on the target computer to change the way hyperlinks are shown:
Value name: FriendlyNameModeForHTML
Value Type

REG_DWORD

Description

Defines if the object title is a link in the HTML version of the hyperlink. Values from 1 to 3
also define the type of the link.
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Value name: FriendlyNameModeForHTML
Value Data

•
•
•
•

0: No hyperlink
1: Desktop hyperlink (default)
2: Web hyperlink
3: Mobile hyperlink

Tip: M-Files also adds the link to your clipboard in the XML Spreadsheet format. This
lets you paste the link to a cell in Microsoft Excel. The type of the link is specified in the
FriendlyNameModeForHTML value. If its value is set to 0 or is not specified, the link opens the
object in M-Files Desktop.
Value name: CanShowSpecificLinks
Value Type

REG_DWORD

Description

Controls if the HTML version of the hyperlink can include client-specific links after the
object title.

Value Data

•
•

0: No client-specific links are appended.
1: Client-specific links are appended as specified via the "SpecificLinksMode" value (see
further below).

Value name: SpecificLinksMode
Value Type

REG_DWORD

Description

If CanShowSpecificLinks is set to "1", controls which of the client-specific links are
appended to the HTML version of the hyperlink after the object title.

Value Data

•
•
•
•
•
•
•
•

0: None
1: Desktop
2: Web
3: Desktop and Web
4: Mobile
5: Desktop and Mobile
6: Web and Mobile
7: Desktop, Web, and Mobile

Value name: PlainTextModeForClipboard
Value Type

REG_DWORD

Description

Controls the content of the plain-text version of the hyperlink copied to the clipboard.

Value Data

•
•
•
•

0: All hyperlinks
1: Desktop hyperlink only
2: Web hyperlink only
3: Mobile hyperlink only
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Configuration Options for Public Links
The registry settings listed here can be used to enable or disable the Share Public Link feature as well
as to enable or disable specific sharing options for public links. For more information on public links, see
Sharing Public Links.
Complete the following steps to configure the Share Public Link feature:
1. Add or modify the following registry setting on the M-Files Server computer:
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files
\<version>\Server\MFServer

Value name

EnableSharedPublicLinks

Value type

REG_DWORD

Description

Enables or disables the Share Public Link feature on the server side. When
disabled, public links cannot be generated via clients or APIs. Also, previously
shared public links stop working if the feature is disabled.
If you disable this feature, make sure that you also apply the corresponding
settings for M-Files Desktop and M-Files Web (see the steps 7 to 9:).

Default
value
Valid values

1
1

The Share Public Link option is enabled.

0

The Share Public Link option is disabled.

2. Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
After you have configured the Share Public Link feature for M-Files Server, use M-Files Named Value
Manager to configure public links for M-Files Desktop and M-Files Web:
3. Open M-Files Named Value Manager.
4. Use the Server drop-down menu to select the M-Files server and then the Vault drop-down menu to
select the vault.
5. Use the Storage Type drop-down menu to select the MFConfigurationValue storage.
6. In the Namespace field, enter the following value: MFiles.Core.Sharing.PublicLinks.Settings
To disable or enable the Share Public Link feature, complete the steps 7 to 9:
7. Click Add... to add a new key.
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8. In the left-side pane, double-click New Named Value Key and enter the following value: Enabled
9. Complete either of the following steps:
a. If you want to disable the Share Public Link feature, select the newly added key and add the
following value to the right-side pane:
false
Note: If you disable the Share Public Link feature, make sure that you also apply the
corresponding registry setting for M-Files Server (see the steps 1 to 2).
or
b. If you want to enable the Share Public Link feature, select the newly added key and add the
following value to the right-side pane:
true
Note: The Share Public Link feature is enabled by default, so normally you do not have to
explicitly enable the feature.
To specify whether public links are allowed to point to the latest version of shared files or only to the
specific version that user has shared, complete the steps from 10 to 12:
10.Click Add... to add a new key.
11.In the left-side pane, double-click New Named Value Key and enter the following value:
AllowSharingLatestVersion
12.Complete either of the following steps:
a. If you want to allow public links to point to the latest version of the shared file, select the newly
added key and add the following value to the right-side pane:
true
or
b. If you want public links to always point to the specific file version that the user has shared, select the
newly added key and add the following value to the right-side pane:
false
Note: By default, public links always point to the specific version that the user has shared,
so normally you do not have to set AllowSharingLatestVersion to false.
To specify the default expiration time for public links in M-Files Web, complete the steps 13 to 16:
13.In the Namespace field, enter the following value: M-Files.Core.Client.Settings
14.Click Add... to add a new key.
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15.In the left-side pane, double-click New Named Value Key and enter the following value:
DefaultExpireInDays
16.Select the newly added key and add the expiration time in days to the right-side pane as a integer, for
instance:
10
In the example above, the default expiration time for public links is 10 days. The user can always
change the expiration date in the Share Public Link dialog.
After you have configured the Share Public Link feature, the vault has to be taken offline and brought
back online for the changes to become effective.
17.Restart the vault.
The Share Public Link feature is now configured according to the configuration options that you have
specified.
Configuration Options for the "Send and Save to M-Files" Button
Using M-Files Named Value Manager, you may add the Send and Save to M-Files button to the Microsoft
Outlook composer window on all client computers, or disable the Send and Save to M-Files button
altogether. For more information on the Send and Save to M-Files function, see Functions in Microsoft
Outlook.
Note: You need M-Files Named Value Manager for distributing the settings. For downloading the
tool as well as for instructions on using it, see the document Distributing Vault-Specific Registry
Settings from M-Files Server.
Complete the following steps to configure the Send and Save to M-Files button for all client computers:
1. Open M-Files Named Value Manager.
2. Use the Server drop-down menu to select the M-Files server and then the Vault drop-down menu to
select the document vault.
3. Use the Storage Type drop-down menu to select the MFConfigurationValue storage.
4. In the Namespace field, enter the following value: M-Files.Core.Client.Settings
5. Click Add to add a new key.
6. In the left-side pane, double-click New Named Value Key and enter the following value:
MSOutlookRibbon
7. Select the newly added key, and then either:
a. If you want to display the Send and Save to M-Files button in the Microsoft Outlook composer
window on all client computers, add the following value to the right-side pane:
{

"Common": {
"MSOutlookRibbon": {
"ShowSendAndSaveInBuiltInTab": 1
}
}
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}
or
b. If you want to disable the Send and Save to M-Files button on all client computers, add the
following value to the right-side pane:
{

}

"Common": {
"MSOutlookRibbon": {
"ShowSendAndSaveInMFilesTab": 0
}
}

8. Click Save and then close M-Files Named Value Manager if you no longer need it.
The Send and Save to M-Files button settings you have specified affect all vault users in the selected
vault.
Disabling the Reference Direction Setting for Grouping Levels
When you are creating or editing a grouping level for a view, the Define Grouping Level dialog normally
shows the Reference direction setting that allows you to select the metadata reference direction between
the object type of the grouping level and the objects in the view. You can use a Windows registry setting to
disable this option and therefore only allow the To <selected object type> reference direction to be used.
Do the following to disable the Reference direction setting in the Define Grouping Level dialog:
1. Add the following setting to the Windows registry of the server computer:
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files
\<version>\Server\MFServer\VaultOptions\{<vault GUID>}

Value name

EnableReverseGroupingLevelsForViews

Value type

REG_DWORD

Description

Specifies whether the Reference direction setting is in use in the Define
Grouping Level dialog in this vault.

Default value

The default value is 1, meaning that the setting is enabled.

Valid values

1

The setting is in use.

0

The setting is not in use. The reference direction is always To
<selected object type>.

2. Repeat step 1 for as many vaults as needed.
3. Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
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Enabling Phonic and Fuzzy Searches
Phonic and fuzzy searches are disabled by default in a vault and you can enable them in M-Files Admin.
Note: To use this feature, your search engine must be dtSearch.
To enable phonic searches, fuzzy searches, or both:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a)
b)
c)
d)
e)
f)
g)

Open M-Files Admin.
In the left-side tree view, expand an M-Files server connection.
Expand Document Vaults.
Expand a vault.
Click Configurations.
In the navigation area, click Advanced Vault Settings.
Open the Configuration tab.
The advanced vault settings are shown.

2. Expand Search > Full-Text Search.
3. Set Enable Fuzzy Searching to Yes.
4. Set Enable Phonic Searching to Yes.
5. Click Save.
6. Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
Setting Up Synonym Search
You must set up the synonym search and create a custom thesaurus so that the vault users can find
documents using synonyms in the search query. If your thesaurus is large, the synonym search can have a
negative effect on the performance of the search.
Note: To use this feature, your search engine must be dtSearch.
To set up the synonym search:
1. Use a text editor to create your own custom thesaurus file that is similar to this:
<?xml version="1.0" encoding="UTF-8" ?>
<dtSearchUserThesaurus>
<Item>
<Name>Synonyms for announcement</Name>
<Synonyms>announcement notice bulletin statement publication</
Synonyms>
</Item>
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<Item>
<Name>Synonyms for contract</Name>
<Synonyms>contract agreement deal arrangement</Synonyms>
</Item>
</dtSearchUserThesaurus>
Each Item contains a synonym group. The Name element contains a description for the
synonym group and it has no effect on search. The Synonyms element contains a single
synonym group. Separate the synonyms with a space.
2. Save the file with the name thesaur.xml here:
C:\Program Files\M-Files\<version>\Server\<language code of the search
language>
3. Open M-Files Admin and go to a vault.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
4. Click Configurations.
5. In the navigation area, expand Advanced Vault Settings > Configuration > Search.
6. Click Full-Text Search.
7. In Thesaurus, enter thesaur.xml.
8. Click Save.
9. Close M-Files Admin.
10.Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
Now when users search for announcement, the search results list documents that contain the words
announcement, notice, bulletin, statement, or publication. Synonyms are identified in
document contents and metadata.
Disabling the Search for Inflected Forms
By default, M-Files searches for inflected forms of your search term (see Quick Search for more
information). This feature can be disabled by unchecking the option Look for different inflected forms of
the words in Quick Search in the Additional Conditions dialog. If you want this feature to be disabled by
default for all vault users, complete the steps below on the M-Files server computer.
Note: You need M-Files Named Value Manager for distributing these settings. For downloading
the application as well as for instructions on using it, see the document Distributing Vault-Specific
Registry Settings from M-Files Server.
1. Open M-Files Named Value Manager.
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2. Use the Server drop-down menu to select the M-Files server and then the Vault drop-down menu to
select the document vault.
3. Use the Storage Type drop-down menu to select the MFConfigurationValue storage.
4. In the Namespace field, enter the following value: M-Files.Core.Client.Settings
5. Click Add... to add a new key.
6. In the left-side pane, double-click New Named Value Key and enter the following value: SearchBar
7. Select the newly added key, and in the right-side pane, enter the following value:
{

}

"MFShell": {
"SearchBar": {
"DefaultStemmingEnabled": false
}
}

Your configuration in M-Files Named Value Manager should now be similar to the example
shown below.

8. Click Save and then close M-Files Named Value Manager if you no longer need it.
The search for inflected forms is now disabled by default in the selected vault for all vault users.
Disabling the Sorting of Search Results by Their Relevance
By default, M-Files sorts search results by their relevance. For more information on how document
relevance in relation to the search term is determined, see Search result sorting.
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Note: You need M-Files Named Value Manager for distributing some of the settings. For
downloading the application as well as for instructions on using it, see the document Distributing
Vault-Specific Registry Settings from M-Files Server.
This behavior can be prevented so that search results are sorted by user preference instead. Make the
following changes on the M-Files Server computer to prevent search results to be automatically sorted by
their relevance:
1. Open M-Files Named Value Manager.
2. Use the Server drop-down menu to select the M-Files server and then the Vault drop-down menu to
select the document vault.
3. Use the Storage Type drop-down menu to select the MFConfigurationValue storage.
4. In the Namespace field, enter the following value: M-Files.Core.Listing.SearchResults
5. Click Add... to add a new key.
6. In the left-side pane, double-click New Named Value Key and enter the following value:
RememberSearchResultsSortingCriteria
7. Select the newly added key, and in the right-side pane, enter the following value: true
Your configuration in M-Files Named Value Manager should now be similar to the example
shown below.

8. Click Save and then close M-Files Named Value Manager if you no longer need it.

M-Files | 3. System Administration | 632
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
9. Optional: If you use the classic M-Files Web, make the following registry change on the M-Files server
computer:
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server
\MFWA\Sites\1\Vaults\<vault GUID>\Configurations

Value
name

DefaultSearchSortPropertyID

Value type

REG_SZ

Description The ID of the property by which search results are sorted.
Value

<no value>

Empty the value to disable the sorting of search results by their
relevance in M-Files Web.

10.Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
M-Files no longer forces search results to be sorted by their relevance, and therefore users can change the
column by which search results are sorted and the user preference is retained in subsequent searches.
Configuring Search Facets
Search facets are filters that let users get better search results. These filters include customer, file type,
class, and date. Facets and faceted search are available in vaults that use Micro Focus IDOL or Smart
Search as the search engine. Only a system administrator can change these settings.
After the setup, the user will see search facets in the right pane in M-Files Desktop. When the user does a
search, the search criteria must include a minimum of one full-text search condition for the facets to show.
After you have defined the settings, vault restart is not necessary.
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Figure 101: Adding Facets

To add a search facet:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a)
b)
c)
d)
e)
f)
g)

Open M-Files Admin.
In the left-side tree view, expand an M-Files server connection.
Expand Document Vaults.
Expand a vault.
Click Configurations.
In the navigation area, click Advanced Vault Settings.
Open the Configuration tab.
The advanced vault settings are shown.

2. Expand Search > Facets.
3. Click Add Facet.
4. Expand the created facet.
5. In Type, select a facet that the user will see in M-Files Desktop as a filter.
6. Select values for the remaining type settings.
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7. Optional: Set Show More Link to Yes if you want the users to see the link in M-Files Desktop when
there are more than five facet values.
8. Optional: In Display Order, write an integer that defines the order of the filters in M-Files Desktop.
A facet with the value 1 is put before a facet with the value 2, and so on.
9. Click Save.
Modifying PDF Conversion Limitations
By default, the maximum allowed file sizes for PDF conversions for different file formats are the following:
•
•
•
•
•
•
•

E-mail messages: 10 MB
Microsoft Excel documents: 10 MB
Images: 10 MB
PDF documents: 10 MB
Microsoft PowerPoint documents: 10 MB
Visio documents: 10 MB
Microsoft Word documents: 10 MB

In addition to file size limits, another limitation for PDF conversions is time. By default, the maximum PDF
conversion processing time is 120 seconds.
To modify these values, complete the following steps on the M-Files server computer as a system
administrator:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand PDF Conversion, and then expand the file type (either Emails, Excel Files, Images, PDF
Files, PowerPoint Files, Visio Files, or Word Files) for which you want to specify the PDF conversion
file size limit.
3. In the Maximum Source File Size field, enter the file size limit for the selected PDF conversion in
bytes.
4. Define the other settings available for the file type you selected.
The help texts guide you with the settings.
5. Click Save to save your configuration.
6. Optional: To modify the PDF conversion time limit, in the Advanced Vault Settings section, expand
File Previews > Viewer Files and modify the value in PDF Conversion Timeout.
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7. Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
Defining File Types for Indexing
M-Files Server tries to index the contents of the most general file types when a new file version is checked
in to M-Files Server. Indexing enables users to search documents and objects from M-Files using the
words that can be found in the file content. This topic lists the files whose contents are indexed by default
and tells how to add file types to be indexed and how to exclude file types from indexing.
Note: Metadata is always indexed regardless of whether the file extension is in the list of file types
to be indexed or in the blacklist of file types not to be indexed.
The following table lists the extensions of files whose contents are indexed by default when dtSearch or
Micro Focus IDOL search engine is in use.
Table 1: Extensions of File Types Indexed by Default
File Extension

Information on File Extension

123

Lotus

CSV

Comma separated values file

DOC

Microsoft Word

DOCM

Microsoft Word Open XML, macro-enabled document

DOCX

Microsoft Word

DOT

Microsoft Word template

DOTM

Microsoft Word macro-enabled template

EML

Email message

HTM

Hypertext Markup Language file

HTML

Hypertext Markup Language file

ICS

Universal calendar file

KEY

Apple

MSG

Microsoft Outlook email message

NUMBERS

Apple

ODF

OpenDocument

ODG

OpenDocument

ODP

OpenDocument

ODS

OpenDocument

ODT

OpenDocument

ONE

OneNote
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File Extension

Information on File Extension

OTG

OpenDocument

OTP

OpenDocument

OTS

OpenDocument

OTT

OpenDocument

PAGES

Apple

PDF

Portable Document Format file created by Adobe Acrobat or another PDF
application

POT

Microsoft PowerPoint template

POTX

Microsoft PowerPoint template

PPT

Microsoft PowerPoint

PPTM

Microsoft PowerPoint, macro-enabled

PPTX

Microsoft PowerPoint

PTM

Microsoft PowerPoint, macro-enabled template

QPW

Corel Quattro Pro

RTF

Rich Text Format file

STC

StarOffice

STI

StarOffice

STW

StarOffice

SXC

StarOffice

SXD

StarOffice

SXG

OpenOffice

SXI

StarOffice

SXW

StarOffice

TXT

Standard text document

WB1

Corel Quattro Pro

WB2

Corel Quattro Pro

WB3

Corel Quattro Pro

VDX

Microsoft Visio

WKS

Lotus

WPD

WordPerfect

WPF

WordPerfect

WRI

Microsoft Write

VSD

Microsoft Visio

VSDX

Microsoft Visio

XLS

Microsoft Excel
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File Extension

Information on File Extension

XLSB

Microsoft Excel, binary format

XLSM

Microsoft Excel, macro-enabled

XLSX

Microsoft Excel

XLT

Microsoft Excel template

XLTM

Microsoft Excel, macro-enabled template

XLTX

Microsoft Excel template

XML

Extensible Markup Language data file

XPS

Microsoft page layout

XSL

XML style sheet

Using Blacklist in Indexing
If you do not want to use the default list of file types to be indexed, you can use the built-in blacklist
instead. The blacklist contains a predefined set of file extensions specifying the file types that are not
indexed.
Complete the following steps to set the built-in blacklist to be used in indexing:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a)
b)
c)
d)
e)
f)
g)

Open M-Files Admin.
In the left-side tree view, expand an M-Files server connection.
Expand Document Vaults.
Expand a vault.
Click Configurations.
In the navigation area, click Advanced Vault Settings.
Open the Configuration tab.
The advanced vault settings are shown.

2. Expand Search > Full-Text Search.
3. Set Use File Extension Blacklist Instead of Whitelist in Indexing to Yes.
4. Click Save.
Defining Additional File Types for Indexing
In addition to either the list of file types to be indexed or the list of file types not to be indexed, you can
define other file types to be indexed. Also, you can define some file types you do not want to be included
in indexing. For example, you have the list of file types to be indexed, but you would like to exclude one of
the file types from indexing. To exclude the file contents from indexing, you must define the file extension
according to the following instructions.
To define file types to be indexed or not to be indexed:
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1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand Search > Full-Text Search > Files to Index or Files Not to Index.
3. Click Add Extension.
4. In the Extension field, enter the file extension, for instance dwg.
5. Repeat the steps 3 and 4 for each file extension.
6. Click Save to save your configuration.
Configuring Mappings Between Incoming Connections and Vaults
To specify mappings between incoming connections and M-Files vaults, add this registry configuration on
the M-Files server computer.
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server\Common

Value name

VaultDNSConfig

Value type

Multi-String Value

Description

The value specifies mappings between incoming connections and vaults.

Value

https://<DNS name for the vault 1>={<vault GUID for the vault 1>}
https://<DNS name for the vault 2>={<vault GUID for the vault 2>}
For example:
https://vault1.company.com={990827D8-8AF2-4A4E-B121-4C1A8AD8ECD0}
https://vault2.company.com={F565EDFE-939E-4507-B078-D06902888C98}

You can write one entry per row. To map multiple DNS names to a single vault, write each connection
on a separate row. However, you cannot map the same DNS name to multiple vaults. If the list contains
the same DNS name multiple times, only the topmost entry in the list is effective.For the changes to take
effect, you must restart the M-Files Server service.
Specifying Vault-Specific Locale Settings for Server-Side PDF Conversions
When converting Microsoft Word documents that contain dynamic metadata fields (see Add M-Files
Property) to PDF using the server-side PDF conversion feature, M-Files refreshes the metadata fields
before the PDF conversion is executed. Number and date values are formatted upon refreshing using the
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locale settings of the M-Files server computer. If you need to change the locale of the dates and numbers
but cannot change the server locale, you can specify a locale for the vault to override the server locale.
To specify the vault locale, complete the following steps on the M-Files server computer:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand PDF Conversion > Word Files.
3. In the Formatting Locale field, enter the language culture name, for instance fi-FI, en-US, or svSE.
The value should be given as a Microsoft Windows language code identifier (LCID).
4. Click Save to save your configuration.
Number and date metadata fields in PDF conversions are now formatted according to the locale you have
specified.
Preventing Linked Documents from Being Removed
If the user groups All internal users or All internal and external users do not have edit permissions on a
linked document from an external file source, the document is removed from the external file source when
it is added to M-Files.
This behavior can be prevented by making the following changes on the M-Files Server computer:
1. Add the following registry key and value:
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server
\MFServer

Value
name

IgnoreACLsForExternalLinks

Value type

REG_DWORD

Description Prevents linked documents from being removed from the external file source if
document vault users do not have edit permissions to them.
Value

1

M-Files | 3. System Administration | 640
This content is no longer updated. For the latest content, please go to the user guide for M-Files Online.
For information on the supported product versions, refer to our lifecycle policy.
2. Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
Linked documents are now not removed from the external source even if document vault users do not have
edit permissions to the linked documents.
The default behavior can be restored by setting the IgnoreACLsForExternalLinks value to 0, and
then restarting the M-Files Server service via Windows Task Manager.
Registry Setting for Extending Firebird Usability
Make the following changes on the M-Files server computer to extend Firebird usability in 64-bit
installations:
1. Add the following registry entry:
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server
\MFServer\Vaults\<vault GUID>

Value
name

DBPageSize

Value type

REG_DWORD

Description Changes the usable memory of the Firebird vault.
Value

00004000 Sets the page file size at 16,384 bytes, which is the Firebird
maximum. This increases the database memory allocation and use
to two gigabytes.

2. Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
3. Run the Optimize Database (Thorough) operation for the vault (see Vault Maintenance for more
information).
Settings for Vault Performance Measurement
The vault performance tests (see Measuring Vault Performance for further information) have predefined
threshold times. The test results indicate if a test takes longer than the time specified by the threshold
value. See below for instructions on modifying the threshold values for vault performance tests.
Defining the threshold time for the database insert speed test
The default threshold time for the database insert speed test is 6,000 milliseconds. You may modify the
threshold time by completing the following steps on the M-Files server computer:
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1. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
2. Expand Performance > Server Tests > Database Insert Speed.
3. In the Threshold field, enter the threshold time for the database insert speed test in milliseconds.
4. Click Save to save your configuration.
Defining the threshold time for the network round-trip test
The default threshold time for the network round-trip test is 1,500 microseconds. You may modify the
threshold time by completing the following steps on the M-Files server computer:
1. In M-Files Admin, go to the Advanced Vault Settings section.
a)
b)
c)
d)
e)
f)
g)

Open M-Files Admin.
In the left-side tree view, expand an M-Files server connection.
Expand Document Vaults.
Expand a vault.
Click Configurations.
In the navigation area, click Advanced Vault Settings.
Open the Configuration tab.
The advanced vault settings are shown.

2. Expand Performance > Server Tests > Network Round Trip.
3. In the Threshold field, enter the threshold time for the network round-trip test in microseconds.
4. Click Save to save your configuration.
Setting M-Files Services to Use a Managed Service Account
You can set M-Files Server services to use a managed service account (MSA) or a group managed service
account (gMSA). The account must have local administrator permissions on the server.

!

Important: M-Files services normally use the Local System account for login. Use a different
account only when you have a reason to do so. The MFSetup service must use the Local System
account.

Do these changes before you install M-Files.
To set the M-Files Server services to use a service account:
1. Open Registry Editor.
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2. Refer to this table and add the required registry values:
Keys

•
•
•
•

Value

•
•
•
•

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\Common\Server
\MFServer
HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\Common\Server
\MFServerAux
HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\Common\Server
\MFDataExport
HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\Common\Server
\MFIndexingManager
Name: ServiceAccountName
Type: REG_SZ
Content: <domain>\<service account name>
Example content: testdomain\myMSA$

Note: All the services in the table must use the same service account.
3. Install M-Files.
4. Use Windows Task Manager to restart the MFServer service:
a) Right-click the taskbar and select Task Manager.
The Task Manager window is opened.
b) Open the Services tab.
c) Right-click the MFServer service and select Restart.
These services now use the service account:
•
•
•
•

M-Files Server
M-Files Server Auxiliary Services
M-Files Reporting Data Services
M-Files Indexing Services

4. Frequently Asked Questions
This section deals with some of the most common questions related to the use of M-Files.
This section deals with some of the most common questions related to the use of M-Files. The questions
have been divided into the categories below.
Daily use of M-Files
•
•
•
•

Can I do the same stuff with M-Files Mobile as with M-Files Desktop?
How can I add a new item to a value list?
How can I add a new property to a class?
How can I create a document that is only visible to me?
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•
•
•
•

How can I create a new view in which the objects are displayed by customer?
How can I find the documents I have created myself?
How do I change the name of my computer without interfering with M-Files functionality?
Why can't I edit a document that has been checked out?

Administration of M-Files
•
•
•
•
•
•
•
•
•

How can I add a new item to a value list?
How can I add a new user to a vault?
How can I add a new property to a class?
How do I change the login account of a user?
How do I format the date in M-Files?
How do I import e-mail messages from a specific IMAP folder?
Why are there objects with the same ID in the vault?
What is the difference between a user and a login account?
Why does the intelligence service not extract metadata from some of the files?

Maintenance of M-Files
•
•
•
•
•
•
•
•
•

How do I maintain the M-Files server machine?
Why is my M-Files not as fast as it used to be?
How do I migrate my document vaults to a new server?
How do the automatic updates work?
How much disk space do encrypting file data and taking backups require?
How often should I make backups?
How often should I reboot the M-Files server machine?
What is not included in the backups?
What kind of operations can I schedule to be run at specific intervals in M-Files?

Common problems for document vault users
•
•
•
•
•
•

Why can't I access the document vault?
Why can't I convert a document to PDF format or annotate a document?
Why can't I find the Checked Out to Me view?
Why can't I save an email message as an Outlook message to M-Files?
Why did a file with a grayed-out icon appear on the M-Files drive when I saved a new document in
Microsoft Word?
Why do document timestamps have the wrong time?

General questions
•
•
•
•
•
•
•

Where can I find more information when I need it?
What are the hardware requirements and recommendations?
What's new in this M-Files version?
How do the automatic updates work?
Can I use M-Files programmatically?
How do I write VBScript code for M-Files purposes?
What is the difference between a named access control list (NACL) and a user group?
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In this chapter
•
•
•
•
•

Daily Use of M-Files
Administration of M-Files
Maintenance of M-Files
Common Problems for Document Vault Users
General Questions

4.1. Daily Use of M-Files
This section contains frequently asked questions related to the daily use of M-Files.

In this chapter
•
•
•
•
•
•
•
•
•

Can I do the same stuff with M-Files Mobile as with M-Files Desktop?
How can I add a new item to a value list?
How can I add a new property to a class?
How can I create a document that is only visible to me?
How can I create a new view in which the objects are displayed by customer?
How can I find the documents I have created myself?
How do I change the name of my computer without interfering with M-Files functionality?
Why can't I edit a document that has been checked out?
How does the duplicate detection feature work?

4.1.1. Can I do the same stuff with M-Files Mobile as with M-Files Desktop?
M-Files Mobile is available for the iOS and Android operating systems. The table below summarizes the
differences between the mobile applications and M-Files Desktop.
For a more detailed description of the differences between the mobile applications, see M-Files Mobile
Apps Feature Comparison.
Feature

M-Files Desktop

M-Files Mobile for iOS

M-Files Mobile for
Android

Open object files

✔

✔

✔

View metadata

✔

✔

✔

Open objects from MFiles URLs

✔

✔

✔

Show subobjects

✔

✔

✘

Voice commands

✘

✘

✘

Edit metadata

✔

✔

✔

Edit files

✔

✔

✔

Add comments

✔

✔

✔

Add electronic
signatures

✔

✔

✔
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Feature

M-Files Desktop

M-Files Mobile for iOS

M-Files Mobile for
Android

Add handwritten
signatures

✘

✔

✔

Undo checkout

✔

✔

✔

Create new objects

✔

✔

✔

Mark assignments
complete

✔

✔

✔

Create a copy of an
object

✔

✘

✔

Create a template based ✔
on current object

✔

✘

Save documents from
other apps to M-Files

✔

✔

✔

Save email attachments
as new objects

✔

✔

✔

Scan documents using
✔
the camera of the device

✔

✔

Share public links

✔

✔

✔

Call phone numbers via
the metadata card

✘

✔

✔

Navigate to a website by ✔
clicking a hyperlink on
the metadata card

✔

✔

Create a new email
message by clicking an
email address on the
metadata card

✔

✔

✔

Read files and metadata
in offline mode

✔

✔

✔

Create objects in offline
mode

✔

✔

✔

Edit object metadata in
offline mode

✔

✔

✔

Mark objects for offline
availability

✔

✔

✔

Mark views for offline
availability

✔

✔

✔

View annotations

✔

✔

✔

Annotate documents
online

✔

✔

✔

Annotate documents
offline

✔

✘

✘
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Feature

M-Files Desktop

M-Files Mobile for iOS

M-Files Mobile for
Android

Manage multiple vault
connections

✔

✔

✔

Quickly access
assignments, favorites,
and recent objects

✔

✔

✔

View relationships to and ✔
from the selected object

✔

✔

Add objects to favorites

✔

✔

✔

Open objects from
.mflink attachments

✔

✔

✔

Access all views

✔

✔

✔

Add shortcuts to views

✔

✘

✘

Show document
collection members

✔

✔

✔

Participate in workflows

✔

✔

✔

Convert speech to text

✘

✔

✔

Create new objects via
M-Files URLs

✔

✔

✔

Add pictures or photos to ✔
existing objects

✔

✔

Attach other files to
existing objects

✔

✔

✔

Create subobjects via
the metadata card of the
parent object

✔

✘

✘

Do a quick search

✔

✔

✔

Filter search by object
type

✔

✔

✔

Limit search to metadata ✔
or file contents only

✔

✔

Share files as email
attachments

✔

✔

✔

Share objects and
files as M-Files link
attachments

✔

✔

✔

Share files via M-Files
URLs

✔

✔

✔

Share or copy files to
other applications

✔

✔

✔
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Feature

M-Files Desktop

M-Files Mobile for iOS

M-Files Mobile for
Android

Save phone numbers
to contacts via the
metadata card

✘

✔

✔

Send a text message via ✘
the metadata card

✔

✔

Delete offline content

✔

✔

✔

Add vault connections
via M-Files URLs

✘

✔

✔

Object type hierarchies

✔

✔

✔

Automatic filling of
properties

✔

✔ (partly supported)

✔ (partly supported)

4.1.2. How can I add a new item to a value list?
You can add values to a value list while filling in the metadata card via the Add Value button in the toolbar.
This function is available only if it has been defined in the value list properties that regular users can add
new values to this list.
If you are an M-Files system administrator, go to Value Lists in M-Files Admin, right-click the desired value
list, and select Properties in the context menu. Click the Contents... button and add a new item by clicking
the New Item button. If you do not have administrator rights, check with the system administrator that the
Allow users to add new values to this list check box is checked in the properties of the value list.
If the value list is based on an object type, the value list is edited through the object type. In this case, the
new object type is created using the M-Files Desktop user interface.

4.1.3. How can I add a new property to a class?
If you are a regular M-Files user, you can add properties while filling in the metadata card. You can click
Add property on the metadata card to add a new property for the object. Please note that this property is
only added to this particular object, not all objects of the class.
If you are an M-Files system administrator and want to add a property to all documents of the class, go
to Classes in M-Files Admin, right-click the desired class and select Properties from the context menu.
You can add default properties for the class by clicking the Add... button. If the desired property cannot be
found in the list, you need to create a new property definition (see Property Definitions).

4.1.4. How can I create a document that is only visible to me?
When filling in the metadata card, select Only for me in the Permissions field.

4.1.5. How can I create a new view in which the objects are displayed by customer?
1. In M-Files Desktop, click the Home tab to open the home view of the document vault.
2. Click the Create (

) button and then select View... from the context menu.

The Define View dialog is opened.
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3. In the Name field, enter a descriptive name for the view, such as Customers.
4. Click the Add... button.
The Define Grouping Level dialog is opened.
5. Use the Property drop-down menu to select the Customer property.
6. Click OK to close the Define Grouping Level dialog.
7. Click OK to close the Define View dialog.
Your new view is now listed in the My Views section.
For more information about views, see Using Views.

4.1.6. How can I find the documents I have created myself?
You can search for documents based on certain specifications via the Additional Conditions dialog.
1.

Click the Search options button (
) and then click the Additional Conditions... button.
2. Open the Properties tab.
3. Click the Add Condition button.
4. Specify Created by as the property, select the equals sign (=) as the operator, and your login account
as the value.
5.
).
Perform the search by clicking OK and then the Search button (
Note: You can also create a view that shows only the documents you have created. For more information,
see Property-Based Conditions and Creating a View.

4.1.7. How do I change the name of my computer without interfering with M-Files
functionality?
If documents are checked out to the client in question when its name changes, edited information may be
lost. This is because checkouts are user and computer-specific. The computer is identified by its name.
After the name is changed, M-Files considers the checkouts to belong to another computer and does not
allow the user to access the edited information.
Check in all documents and items from the computer before changing the computer's name.

4.1.8. Why can't I edit a document that has been checked out?
You cannot edit the document because it has been checked out by another user who has not yet checked
the document back in. This is to prevent the creation of several different copies in M-Files. With system
administrator permissions, the document can be forced to be checked in, but the changes made to the
document during the checkout will then be lost.
Sending a check-in request
If you need to edit a document that is currently checked out to some other user, you can send the user a
check-in request by right-clicking the document and selecting Send Check-in Request from the context
menu. The user then receives an e-mail message informing them that you are requesting the document to
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be checked in. The message also contains a link to the document in question. The check-in request is sent
to the e-mail address associated with the user's login account.

4.1.9. How does the duplicate detection feature work?
If you try to save a file that is already in the vault, M-Files lets you know. M-Files shows you the duplicate
documents to which you have permissions.
M-Files compares only the file content of the documents. Thus, their metadata can be different. For
example, the duplicate documents can have a different name, version history, permissions, and workflow.
The feature does the comparison on a binary level with MD5 checksums. M-Files shows duplicate file
content for documents that have the same MD5 value.
Note: In some cases, the MD5 value can be different even when the file content of the compared
documents is the same. This happens because some files formats store additional metadata in the
file which changes the MD5 value.

4.2. Administration of M-Files
This section contains frequently asked questions related to the administration of M-Files.

In this chapter
•
•
•
•
•
•
•
•
•

How can I add a new item to a value list?
How can I add a new user to a vault?
How can I add a new property to a class?
How do I change the login account of a user?
How do I format the date in M-Files?
How do I import e-mail messages from a specific IMAP folder?
What is the difference between a user and a login account?
Why are there objects with the same ID in the vault?
Why does the intelligence service not extract metadata from some of the files?

4.2.1. How can I add a new item to a value list?
You can add values to a value list while filling in the metadata card via the Add Value button in the toolbar.
This function is available only if it has been defined in the value list properties that regular users can add
new values to this list.
If you are an M-Files system administrator, go to Value Lists in M-Files Admin, right-click the desired value
list, and select Properties in the context menu. Click the Contents... button and add a new item by clicking
the New Item button. If you do not have administrator rights, check with the system administrator that the
Allow users to add new values to this list check box is checked in the properties of the value list.
If the value list is based on an object type, the value list is edited through the object type. In this case, the
new object type is created using the M-Files Desktop user interface.

4.2.2. How can I add a new user to a vault?
1. Open M-Files Admin.
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2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Users.
6. Click New User on the task area.
The User Properties dialog is opened.
7. Use the Login account drop-down menu to select a login account for the new user.
The Login account drop-down menu lists all login accounts that have not been added to the
document vault. If you want to create an entirely new login account, see Login Accounts.
8. Specify the permissions for the user and then click OK.
The new user is added to the document vault.
Note: For further instructions, see Creating a User.

4.2.3. How can I add a new property to a class?
If you are a regular M-Files user, you can add properties while filling in the metadata card. You can click
Add property on the metadata card to add a new property for the object. Please note that this property is
only added to this particular object, not all objects of the class.
If you are an M-Files system administrator and want to add a property to all documents of the class, go
to Classes in M-Files Admin, right-click the desired class and select Properties from the context menu.
You can add default properties for the class by clicking the Add... button. If the desired property cannot be
found in the list, you need to create a new property definition (see Property Definitions).

4.2.4. How do I change the login account of a user?
Sometimes it may be necessary to change the login account for a user. The user's login account may have
to be changed when, for example, the user needs a new login account due to his or her last name being
changed or when login accounts are moved from one domain to another.
When a user login account must be changed, it is important to preserve the vault user associated with
the original login account and to associate the same user with the new login account to preserve the user
history and the user's personal settings in the vault.
Note: It is important to distinguish between login accounts and users:
•

•

Login accounts are server-level (or in some cases vault-level) accounts that are used for
authenticating users to M-Files Server. A login account can be associated with multiple users,
but only one user per vault.
Users are vault-level objects that store user-specific settings and user history and that have
permissions to perform specific operations in a vault. A user is linked to one and only one login
account.

Do the following steps to correctly change a login account for a user after new login accounts have been
created in M-Files:
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1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Users.
The Users list is opened in the right-side pane.
6. Right-click the user whose login account you need to change and select Properties from the context
menu.
If new login accounts are synchronized from an Active Directory source, M-Files automatically
creates new users for the new login accounts. To associate the new login account with the
correct existing user, you must first delete the new, automatically created user.
The User Properties dialog is opened.
7. Use the Login account drop-down menu to select a new login account for the user.
8. Click OK to close the User Properties dialog and to save your changes.
The new login account is now correctly associated with the existing user. Now when the user logs in using
the new credentials, their previous user history and personal settings in the vault are available.

4.2.5. How do I format the date in M-Files?
The Date data type of a property is used for displaying a date and time as a property value. If you wish to
change the format of how date and time are displayed, you must modify the date and time format settings
of the client operating system.
Note: These instructions are for Windows 10, but the procedure is highly similar for other Windows
versions.
Complete the steps below on the M-Files client computer to change the date format.
1. Right-click the Windows Start button and select Settings from the context menu.
The Settings window is opened.
2. Click Time & language, and then click Additional date, time, & regional settings.
The Clock, Language, and Region window is opened.
3. Under the Region section, click Change date, time, or number formats.
The Region dialog is opened.
4. On the Formats tab, click the Additional settings... button.
The Customize Format dialog is opened.
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5. Open the Time tab, and enter a desired format in the Short time field.
6. Open the Date tab, and enter a desired format in the Short date field.
7. Click OK to close the Customize Format dialog.
8. Click OK to close the Region dialog.
All the properties that use the Date data type should now be displayed in the format that you have
specified in the steps above.
How do I format the date on the M-Files server computer?
Date and time information may be employed by various M-Files Server operations, such as script
executions or PDF conversions. The date and time format settings of the M-Files server computer's system
account determine how dates and times are displayed in such operations.
Complete the steps below on the M-Files server computer to change the date format.
1. Right-click the Windows Start button and select Settings from the context menu.
The Settings window is opened.
2. Click Time & language, and then click Additional date, time, & regional settings.
The Clock, Language, and Region window is opened.
3. Under the Region section, click Change date, time, or number formats.
The Region dialog is opened.
4. On the Formats tab, click the Additional settings... button.
The Customize Format dialog is opened.
5. Open the Time tab, and enter a desired format in the Short time field.
6. Open the Date tab, and enter a desired format in the Short date field.
7. Click OK to close the Customize Format dialog.
8. Open the Administrative tab.
9. Click the Copy Settings... button.
10.Enable the option Welcome screen and system accounts.
11.Click OK to close the dialog.
12.Click OK to close the Region dialog.
All dates and times generated by the M-Files server computer should now be displayed in the format that
you have specified in the steps above.
For instructions on specifying vault-specific locale settings for server-side PDF conversions, see Specifying
Vault-Specific Locale Settings for Server-Side PDF Conversions. You may use these instructions to
override the server locale settings for PDF conversions if you cannot change the server locale settings.
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4.2.6. How do I import e-mail messages from a specific IMAP folder?
M-Files allows you to automatically import e-mail messages from a specific e-mail folder on an IMAP
server to a document vault of your choice. You can accomplish this by using the Connections to External
Sources function in M-Files Admin and by specifying a new connection to a mail source.
For instructions on specifying a connection to an IMAP e-mail server, see Mail Sources.

4.2.7. What is the difference between a user and a login account?
The concepts of a user and a login account are both integral parts of M-Files, but there is an important
difference between them:
•

•

Users are vault-level objects that store user-specific settings and user history as well as permissions
for performing certain operations in a vault. A user object is always linked to one and only one login
account.
Login accounts are server-level (or in some cases vault-level) accounts that are used for authenticating
users to M-Files Server. A login account can be associated with multiple users, but only one user per
vault.

Example
A&A Consulting hires a new engineer, Amanda Reade, and she naturally needs to have access to the MFiles vaults of the company.
1. The M-Files administrator of the company creates the login account AmandaR via M-Files Admin.
• Amanda can now be authenticated to M-Files Server.
2. The administrator creates the vault user AmandaR to all the appropriate vaults.
•

Amanda now has access to the vaults specified by the administrator.

As a result, the login account AmandaR is linked to all the newly created users, and the vault user
AmandaR in all the appropriate vaults is linked to the said login account. The new engineer now also has
access to all the required M-Files vaults.

4.2.8. Why are there objects with the same ID in the vault?
Depending on where an object has originated from, it may have one or more of the following types of IDs:
•
•
•

Internal ID
External ID
Original ID

The ID that is displayed on the metadata card of an object, on the other hand, is called the display ID and it
can obtain the value of either the external ID, the original ID, or the internal ID.
Internal ID
Each object in the vault has an internal ID.
Internal ID is unique to each object per object type in a single vault. If the object is not imported from an
external database or replicated from another vault, it has an internal ID only. When referring to an object in
a vault, like for example in a script, you must refer to it by its internal ID.
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External ID
Objects imported from an external database have an external ID, which is the ID the object is identified by
in the external database.
Original ID
Objects replicated from another vault have an original ID, which is the ID that the object was given in the
vault in which the object was originally created.
Display ID
Display ID is the identifier that is displayed on the metadata card of an object. The display ID obtains its
value from one of the three aforementioned IDs in the following order of priority:
1. External ID
2. Original ID
3. Internal ID
In other words, if an object has an external ID, it is displayed as the ID of the object on the metadata card.
If an object has an original ID, but no external ID, the original ID is displayed as the ID of the object on the
metadata card.
If an object has no external or original ID, the internal ID is displayed as the ID of the object on the
metadata card.
A Case of Similar IDs
The three aforementioned types of IDs may use the same values to identify different objects within a vault.
An object in the vault may have an internal ID 100 while another object may have an external ID 100, and
thus the displayed ID for the two objects may be the same. Therefore there may be objects in the vault with
seemingly the same IDs.
Note: You may use the %INTERNALID% placeholder for a property of the Text data type to add
the internal ID to the object metadata as an automatic property value. For detailed instructions, see
Simple concatenation of properties and Specifying an Automatic Value for a Property.

4.2.9. Why does the intelligence service not extract metadata from some of the files?
In some situations, intelligence services such as M-Files Information Extractor are unable to produce
metadata suggestions based on the content of certain files. The issue may be caused by the simple fact
that M-Files Server is not able to read the file content, and therefore not able to provide the content to the
intelligence service for analysis.
You may come across this kind of issue, for example, if your organization is using password-protected
PDF files. If opening the PDF file without a password or copying content from it is restricted via the security
settings of the PDF file, M-Files will not be able to access the file content. For more information about
password-protected PDF files, see this Adobe article.

4.3. Maintenance of M-Files
This section contains frequently asked questions pertaining to the maintenance of M-Files.
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In this chapter
•
•
•
•
•
•
•
•
•
•

How do I maintain the M-Files server machine?
Why is my M-Files not as fast as it used to be?
How do I migrate my document vaults to a new server?
How do the automatic updates work?
How much disk space do encrypting file data and taking backups require?
How often should I make backups?
How often should I reboot the M-Files server machine?
What is not included in the backups?
What kind of operations can I schedule to be run at specific intervals in M-Files?
How do I check the location of the active search indexes?

4.3.1. How do I maintain the M-Files server machine?
The information on this page applies to an on-premises installation.The M-Files system administrator must
do these maintenance tasks on the M-Files server machine to maintain its operational efficiency.
Frequency

Task

Daily

Checking Windows Event Logs
Clearing Replication Conflicts

Monthly

Verifying Resource Usage

Quarterly

Manual Optimization

Biannual and annual

Running Verify and Repair
Rebuilding Search Indexes
Archiving M-Files Event Logs

Follow the links for further instructions on carrying out a specific task.

In this chapter
•
•
•
•
•
•
•

Checking Windows Event Logs
Verifying Resource Usage
Clearing Replication Conflicts
Manual Optimization
Running Verify and Repair
Rebuilding Search Indexes
Archiving M-Files Event Logs
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Checking Windows Event Logs
Check events related to M-Files in the Windows event log on a regular basis for any issues, especially
ones pertaining to backups. You might want to also consider using a PowerShell script or a third-party
application for sending e-mail notifications when aforementioned events occur.
1. Press ⊞ Win + R on the M-Files server computer.
The Run dialog is opened.

2. In the Open text field, type in eventvwr and click OK.
Event Viewer is opened.
3. Expand the Windows Logs node.
4. Select the Application node.
The application log is displayed:

5. Click Filter Current Log... on the Actions pane in the Application section to list only the entries that
are related to M-Files.
The Filter Current Log dialog is opened.
6. In the Event sources drop-down menu, select all the applications related to M-Files, such as M-Files,
M-Files Compliance Kit, and MFClient.
7. Click OK to close the Filter Current Log dialog.
The application event log should now list only the entries that are related to M-Files.
Note: If the disk space on the server computer allows, we recommend expanding the maximum log
size of the Application log to, for instance, 200,000 KB to cover more events. In some error cases,
a large number of events may be recorded to the log, thus filling the default log size of about 20
MB very quickly. This may make it impossible to track down the origin of the issue. You can change
the log size by right-clicking the Application node in the left-side tree view and then selecting
Properties from the context menu. Expanding the log size of the client computers is rarely needed,
but may be of use in some cases.
Verifying Resource Usage
It is important to keep track of how much resources are needed to run the M-Files system. If the resource
consumption reaches certain thresholds, it might be time to consider upgrading your system. See also
System Requirements and Technical Details for the hardware and system operating requirements.
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Monitor at least the following resource components:
•

vault metadata and file data size

•
•
•

Note: You can check the location of the metadata file and the file data folder in the Document
Vault Properties dialog in M-Files Admin. See Checking the Size of a Firebird Metadata File for
detailed instructions.
memory
disk space and health
backup size and duration (should not overlap with optimization)

Clearing Replication Conflicts
Regularly verify that all your scheduled replication tasks produce the expected results and that there are no
replication conflicts in any of the vaults. For instructions on how to find and resolve replication conflicts, see
Conflicts and their resolution.
Clear replication conflicts at least once a week, but it is a good idea to appoint a user to check the conflicts
every day.
Manual Optimization
If your organization uses Microsoft SQL Server as the database engine and you store the file data in a file
system folder (instead of the vault database), manually run the Optimize Database (Thorough) operation
from one to four times a year. This is the only way to remove any destroyed files from the file data server in
this type of setup. Run the operation also after an exceptionally large number of files have been destroyed
at once, for example after files are archived to another vault.
Note: Make sure that the optimization is not done between file data and metadata backups.
Note: The operation forces Firebird and Microsoft SQL Server vaults to be taken offline for the
duration of the operation. Before you run the operation for Firebird vaults, make sure that the server
has at least three times the amount of hard disk space required by the metadata file of the vault.
For instructions on how to check the size of the vault metadata file, see Checking the Size of a
Firebird Metadata File.
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Right-click a vault.
5. Click Maintenance > Optimize Database (Thorough).
6. Enable Delete the files of destroyed objects.
This option is available only when the files are in the file system and the vault uses Microsoft
SQL Server.
7. Click Yes at the prompt.
The database of the selected vault is optimized.
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Note: Depending on the size of the vault, the operation can take an extensive amount of time to
complete.
Running Verify and Repair
The Verify and Repair (Thorough) operation does these checks:
•
•
•

Makes sure that the database is intact.
Makes sure that all the data has been saved correctly to M-Files.
Makes sure that the file sizes and the file checksums of the physical files in the vault data server
location match those reported by the metadata database.

Important remarks
It is important to undestand these details before you start:
•

•

The operation can be long and it is good practice to plan a service break for it. The length of the
operation is mainly dependent on:
• Size of the file data database (for Firebird, see Checking the Size of a Firebird Metadata File)
• Number of files in the vault
• Number of object versions in the vault
• Performance of the server machine
M-Files can repair some errors automatically. If you see errors that cannot be repaired automatically, do
not try to repair them yourself and do not close the dialog. Instead, contact support@m-files.com.

Run the operation one or two times each year and before a migration from Firebird to Microsoft SQL
Server.
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Right-click a vault.
5. Click Maintenance > Verify and Repair (Thorough).
The selected document vault is verified and repaired.
Tip: The vault can be used when the Verify and Repair operation is finding issues in the vault.
If issues are found, run the operation when the vault is offline. To do this, enable this option with
Advanced Vault Settings: Database > Verification > Take the Vault Offline and then do the
operation. It can be useful to disable the Take the Vault Offline option when you are done.
Rebuilding Search Indexes
For small repositories, you can use the rebuild full-text search index operation in M-Files Admin. For more
information about the operation, see Vault Maintenance. During the operation, it is possible that the quick
search does not operate satisfactorily in the vault.
For large repositories, the operation time is longer.
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This page tells you how to rebuild Smart Search and Micro Focus IDOL search indexes. For instructions on
how to rebuild the index of a server when your search engine is dtSearch, refer to Rebuilding the dtSearch
Full-Text Search Index in M-Files knowledge base.
To rebuild the full-text search index in large repositories when your search engine is Smart Search or Micro
Focus IDOL:
1. Create a new index.
For instructions, see Creating a Search Index.
2. Under the old search index, set Enabled to No.
3. Click Save.
Archiving M-Files Event Logs
If your organization is using unlimited event logs, it is a good idea to archive M-Files event logs once or
twice per year. For instance, all installations using M-Files Compliance Kit also use unlimited event logs.
You can export all the events currently recorded in the event log by completing the following steps:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Select Event Log.
6. In the task area, click Export.
7. Click Export All Events.
The Browse For Folder dialog is opened.
8. Select the folder in which you want to export the events and click OK.
The Confirm Delete dialog is opened.
9. Click Delete to delete the exported events from the event log.
Once you have completed these steps, the events from the M-Files event log should be archived in the
location of your choice as an XML file.

4.3.2. Why is my M-Files not as fast as it used to be?
If M-Files users are experiencing noticeable performance issues in their day-to-day use of M-Files, carry
out the procedures outlined below to pinpoint the potential source or sources of the problem. System
slowness may be caused by various factors, such as hardware or infrastructure issues, vault structure or
periodic maintenance operations, or issues related to opening views or files, and so on.
When contacting our support about performance issues, consider attaching the following information to
your request:
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•
•
•
•
•

Windows application event log copy for M-Files events (see Saving a Copy of M-Files Errors in the
Windows Application Event Log for instructions)
an export of Server Activity Monitor data via M-Files Admin
screenshot of the Windows Task Manager tab displaying CPU and RAM usage
page file information
hardware specifications of the server(s)

Performance issues caused by factors related to hardware or infrastructure
Performance issues may be caused by hardware or infrastructure related problems. Inspect the following
performance counters on the M-Files Server computer as well as the Microsoft SQL Server computer (if
they are separate servers):
•

•
•
•

•

The page file usage: Use Performance Monitor to check the current and peak page file usage. Note that
Windows always uses the page file no matter how much RAM you have, but if the page file peak usage
is higher than around 10 percent, it may indicate that the system is at least periodically low on RAM or
that RAM usage is excessive. See Inspecting Page File Usage in Performance Monitor for instructions
on checking page file usage.
Current RAM usage via Windows Task Manager.
The CPU load via Windows Task Manager: If the load spikes close to 100 percent, the system may be
under-resourced or some of the processes may be hoarding excessive amounts of resources.
The network connectivity between the server computers if M-Files Server and Microsoft SQL Server are
running on separate servers. Network latency between the servers may cause noticeable slowness for
the end users.
Make sure the Microsoft SQL Server instance has been assigned a memory limit. It should be set high
enough to provide as much RAM for the SQL Server as possible but low enough to prevent the system
from swapping. In general, leave from 3 to 4 GB for the host operating system and its services, and
if M-Files Server runs on the same system, allocate from 2 to 3 GB for it and other processes. See
Modifying the Memory Limit for a Microsoft SQL Server Instance for instructions on setting the memory
limit for the Microsoft SQL Server instance.
Note: These values are approximates and depend on multiple factors, such as the number of
vaults, the use of server side vault applications, and so on.

Performance issues caused by vault structure or periodic maintenance operations
System slowness may also be caused by issues in the vault structure, and periodic maintenance
operations may be perceived as performance issues by the end user.
The following factors related to vault structure or maintenance operations may cause (temporary) system
slowness:
•
•
•
•
•

The metadata of the vault may not be optimal. There should not, for instance, be value lists with tens of
thousands of entries or classes with hundreds of obligatory properties.
Modifying named access control lists causes the permissions of every affected document to be updated
and may thus induce temporary system slowness.
Running background jobs like optimizations and backups may cause temporary slowness. These
operations should not be run during high usage hours.
Having a large number of export and import jobs running at short intervals may cause performance
issues.
The event log in M-Files Admin may be used to reveal instances of exceptional vault use, such as
excessive number of file downloads.
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•

For Firebird vaults, the metadata file size should be no larger than 2 GB per vault. See Registry
Setting for Extending Firebird Usability for instructions on defining the maximum metadata file size and
Checking the Size of a Firebird Metadata File for instructions on checking the metadata file size.

Performance issues in opening views or performing searches
Perform the following checks to verify if system slowness occurs in conjunction with opening views or
performing searches:
1. Use M-Files Desktop on the M-Files server computer and use Local Procedure Call as the protocol for
connecting to the vault to rule out potential network-related issues. See Adding a Vault Connection for
instructions on defining the vault connection and using Local Procedure Call as the protocol.
2. Log in to the vault as a normal user, not as administrator, so that permission checks are not bypassed
when using the vault and thus you can verify whether or not the issue is related to permission checks.
3. Try to change the properties of a view, and then press ⇧ Shift + F5 to fully refresh the view. Try to
modify different properties of views, such as filters or grouping levels, to see if the problem is related to
views.
Note: You can create a copy of an existing view so that you do not need to change the
properties of the original view. Right-click a view of your choice and select Copy from the
context menu, then right-click on an empty space in the listing area and select Paste from the
context menu.

In this chapter
•
•
•
•

Saving a Copy of M-Files Errors in the Windows Application Event Log
Inspecting Page File Usage in Performance Monitor
Modifying the Memory Limit for a Microsoft SQL Server Instance
Checking the Size of a Firebird Metadata File

Saving a Copy of M-Files Errors in the Windows Application Event Log
Note: These instructions are for Windows 10, but the procedure is highly similar for other Windows
versions.
If every M-Files user in your organization is experiencing the same issue, it is recommended to save a
copy of the application event log on the M-Files server computer. If the issue is an isolated one, on the
other hand, you should only save a copy of the log on the computer where the issue occurs. Complete the
steps below on the appropriate computer.
1. Right-click the Start icon and select Event Viewer from the context menu.
The Event Viewer window is opened.
2. Expand Windows Logs.
3. Click Application.
4. Click Filter Current Log on the Actions pane.
The Filter Current Log dialog is opened.
5. Open the Event sources drop-down menu and select M-Files and any other applications related to MFiles, such as M-Files Compliance Kit or MFClient.
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6. Click OK to close the Filter Current Log dialog.
7. Click Save Filtered Log File As on the Actions pane.
8. Specify a location and a file name, and then click Save.
A copy of the filtered application event log is saved to the location that you have specified. The copy
contains only the errors that are related to M-Files.
Inspecting Page File Usage in Performance Monitor
Do the following steps to inspect page file usage in Performance Monitor:
1. Via the Windows start menu, open Administrative Tools, and then open Performance Monitor.
2. Expand Monitoring Tools.
3. Click Performance Monitor.
4. Right-click on the graph and select Add Counters... from the context menu.
The Add Counters dialog is opened.
5. From the Available counters list, select Paging File.
6. Click on the down-arrow icon to the right of Paging File.
7. Select % Usage under Paging File and then click the Add button to add the counter on the Added
counters list.
8. Click OK to close the Add Counters dialog.
Modifying the Memory Limit for a Microsoft SQL Server Instance
Do the following steps to adjust the memory usage of a Microsoft SQL Server instance:
1. Open Microsoft SQL Server Management Studio.
2. Log in to your server.
3. In Object Explorer, right-click a server of your choice and select Properties from the context menu.
The Server Properties dialog is opened.
4. Click the Memory node.
5. Under Server memory options, enter the desired amounts in the Minimum server memory and
Maximum server memory fields.
6. Click OK to close the Server Properties dialog.
Checking the Size of a Firebird Metadata File
The metadata file of a Firebird vault is by default stored under the following location on the server
computer:
C:\Program Files\M-Files\Server Vaults\<vault name>\MetaData
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We recommend that you start to plan migration to Microsoft SQL Server when the size of the metadata file
for a vault is close to 1 GB.
Tip: You can change the amount of usable memory of a Firebird vault to two gigabytes. See
Registry Setting for Extending Firebird Usability.
Do the following steps to check the size of the metadata file:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Right-click a vault.
4. Click Properties.
The Document Vault Properties dialog is opened.
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5. Open the Advanced tab.
6. Under the Use Firebird option, click the Define... button.
The metadata file location along with the file data location is shown at the bottom of the dialog.
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7. Open the metadata file folder you have located in the previous step and select the metadata file.
8. Check the file size in the status bar.

4.3.3. How do I migrate my document vaults to a new server?
When migrating document vaults to a new server, use the same version of M-Files on both the old and the
new server. If you need to upgrade M-Files in conjunction with the migration, upgrade M-Files on the new
server only after the migration is complete and you have verified that the document vaults are functional on
the new server.
Migrating document vaults to a new server when using Firebird as the database engine
If your document vaults use Firebird, complete the following steps to migrate the vaults to a new server:
1. Make sure there are no documents checked out on any workstation.
You may create a view that contains all the documents that are currently checked out in the vault
by using the Checked out status filter for a view.
For instructions on specifying a view, see Creating a View.
2. Take the vaults offline.
For instructions, see Taking a Vault Offline.
3. Back up the master database and copy the backup file to the new server computer.
For instructions, see Backing Up the Master Database.
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4. Take full backups of your document vaults and copy the backup files to the new server computer.
The backup files contain file data regardless of whether the file data is stored in the default
location, or in a separately specified location, so there is no need to copy the file data
separately.
For instructions, see Backing Up a Document Vault.
5. Install M-Files to the new server computer:
a) In the M-Files Setup wizard, click Next, select I accept the license agreement, and then click Next
again.
b) Select the Evaluation installation option.
By selecting the Evaluation installation option, you do not have to install a license on
the new server because the existing license is taken into use when you restore the master
database.
c) Complete the installation.
6. Open M-Files Admin on the new server computer.
7. Restore the master database.
For instructions, see Restoring the Master Database.
8. Restore the document vaults from the backups using the option Restore using original identity.
Pay attention to file data locations when restoring the vaults. If in doubt, check the settings on
the old M-Files server.
For instructions, see Restoring a Document Vault.
9. Copy the search indexes from the old server computer to the new one:
a) In M-Files Admin, in the left-side tree view, right-click a vault and select Properties.
b) Open the Advanced tab, and then click Define.
By default, the Indexes folder can be found under the location specified in the Location for
vault data on server field.
In larger vaults, the search indexes might be placed in an alternate location. Check the index
location according to the instructions in How do I check the location of the active search
indexes?.
c) Copy the Indexes folder to the new server for each vault that you want to migrate.
10.Optional: Specify notification settings if you wish to enable notifications.
For instructions, see Editing Notification Settings in M-Files Admin.
11.Specify backup jobs and update the backup file locations if necessary.
For instructions, see Scheduled Backup Jobs.
12.Stop and disable the M-Files Server service on the old server computer to make sure no users
accidentally connect to it in the future.
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13.Either:
a. If you are using a DNS alias for your M-Files Server, update the alias to point to the new server
computer. This way you do not have to distribute new vault connection settings to client computers.
or
b. Edit the document vault connection settings on the client computers so that they connect to the new
server address. For instructions, see Adding a Vault Connection.
14.Make sure that any external systems that point towards M-Files use either the DNS alias, or the DNS
name or IP address of the new M-Files server.
15.Disconnect the old server computer.
Migrating document vaults to a new server when using Microsoft SQL Server as the database
engine
The instructions assume that Microsoft SQL Server is not changed during the migration. If Microsoft SQL
Server is installed on the same computer as M-Files Server and therefore also requires migration, see
Migrating the Vault Database from One Microsoft SQL Server to Another for further instructions. It does not
matter whether you migrate M-Files Server before migrating the document vaults or the other way around.
If your document vaults use Microsoft SQL Server, complete the following steps to migrate the vaults to a
new server:
1. Make sure there are no documents checked out on any workstation.
You may create a view that contains all the documents that are currently checked out in the vault
by using the Checked out status filter for a view.
For instructions on specifying a view, see Creating a View.
2. Take the vaults offline.
For instructions, see Taking a Vault Offline.
3. Back up the master database and copy the backup file to the new server computer.
For instructions, see Backing Up the Master Database.
4. In Microsoft SQL Server Management Studio, take full backups of your document vaults as a
precaution.
5. If the file data is stored on the file system, complete the following steps:
a) In M-Files Admin, in the left-side tree view, right-click a vault and select Properties.
b) Open the Advanced tab and click Define.
c) Click File Data Location.
The File Data Location dialog is opened.
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d) Click Define.
The File-System Folder dialog is opened.

e) Using File Explorer or any other file managing application, copy the file data folders from the location
shown in the File-System Folder dialog to the new server computer or network share.
6. Attach the document vaults to the new server in M-Files Admin using the original identities of the vaults.
If the file data is stored on the file system, make sure to specify the correct file data location
when attaching the vaults.
For instructions, see Attaching a Document Vault and Changing the Location of the Vault File
Data.
7. Copy the search indexes from the old server computer to the new one:
a) In M-Files Admin, in the left-side tree view, right-click a vault and select Properties.
b) Open the Advanced tab and click Define.
By default, the Indexes folder can be found under the location specified in the Location for
secondary data on the M-Files server field.
In larger vaults, the search indexes might be placed in an alternate location. Check the index
location according to the instructions in How do I check the location of the active search
indexes?.
c) Copy the Indexes folder to the new server for each vault that you want to migrate.
8. Optional: Specify notification settings if you wish to enable notifications.
For instructions, see Editing Notification Settings in M-Files Admin.
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9. Specify backup jobs and update the backup file locations if necessary.
For instructions, see Scheduled Backup Jobs.
10.Stop and disable the M-Files Server service on the old server computer to make sure no users
accidentally connect to it in the future.
11.Either:
a. If you are using a DNS alias for your M-Files Server, update the alias to point to the new server
computer. This way you do not have to distribute new vault connection settings to client computers.
or
b. Edit the document vault connection settings on the client computers so that they connect to the new
server address. For instructions, see Adding a Vault Connection.
12.Make sure that any external systems that point towards M-Files use either the DNS alias, or the DNS
name or IP address of the new M-Files server.
13.Disconnect the old server computer.
Additional configuration required for the classic M-Files Web
If M-Files Web is installed on the M-Files application server, you need to install Internet Information
Services and M-Files Web on the new server computer after installing M-Files Server on the new server
computer.
If M-Files Web is installed on a separate proxy server instead, the following steps must be completed.
1. If you upgrade M-Files Server after migrating to a new server computer, upgrade the M-Files Web proxy
server to the same M-Files version as the one you installed on the new application server.
2. In the Microsoft Windows registry of the M-Files Web proxy computer, update the following setting to
point to the new M-Files application server:
Key

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files
\<version>\Server\MFWA

Value name

Server

Value type

REG_SZ

Value

The DNS name of the M-Files application server.

Additional configuration required if you use RPC over HTTPS
On the RPC proxy computer, update the HOSTS file so that the server hostname (the one that clients use
for connecting to the M-Files server) points to the IP address of the new M-Files application server.
For further information, see the document Enabling RPC over HTTPS Connections to M-Files Server.

4.3.4. How do the automatic updates work?
M-Files automatically checks for software updates. When an M-Files upgrade covered by your subscription
becomes available, the upgrade is downloaded to your computer and can be installed whenever doing
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so is convenient for you. New M-Files versions normally become available as automatic updates about a
month after a new version has been officially released.
Note: See Installation preconditions for ensuring version compatibility.
Automatic updates are a useful way to keep your software up to date. However, system administrators may
opt to disable such functionality, because in larger organizations it is usually easier to handle updates in a
centralized manner. For more information on how to do so, refer to M-Files Setup: Advanced User's Guide.
The feature obtains the latest update information from the update server using HTTP on TCP port 80. This
means that normally you do not need to change any firewall settings.
See also Automatic updates.

4.3.5. How much disk space do encrypting file data and taking backups require?
If you enable encrypting file data at rest or backups on the M-Files server computer, it is essential that you
ensure that there is enough disk space on the server computer at all times to accommodate encrypted file
data and backup data.
Disk space needed for encrypting file data at rest
Encrypting file data at rest makes an encrypted copy of your file data while leaving the unenrypted file
data temporarily in place, which essentially doubles the space needed for vault file data on the disk. Thus
enabling encryption requires at least double the amount of disk space that your vault file data takes.
You can determine the location of the vault file data via the database engine settings located under the
advanced properties of your document vault.
We recommend that you run the Optimize Database (Thorough) operation after you have enabled
encryption and ensured that your vault content is accessible. The Optimize Database (Thorough)
operation removes the unencrypted file data of the vault.
Disk space needed for backups
As a general rule of thumb, the server machine should always have at least an equal amount of free disk
space as the overall disk space required for 1) the file data and metadata of your document vaults and 2)
the server-specific data of the M-Files Server instance. However, it is highly recommended that you keep
several backups of the vault and server data to give yourself several chances to recover data in the event
of system failure or data loss. Therefore the recommended disk space needed for backups is dependent
on the backup policy used in your organization.
For more comprehensive backup instructions, please see the M-Files knowledge base article M-Files
Backup Policy.

4.3.6. How often should I make backups?
The M-Files server is used to save important data, so it is very important to take care of backup
procedures. A regular backup should be made of each document vault and master database on the server.
Backups are easy to set up via the scheduled jobs in the M-Files Admin tool. We recommend setting MFiles to run backups every night.
Each backup produces files that should be transferred to a safe place.
Example: Your organization has a separate disk server. The master database and document vault
backups are run on the M-Files server every night using the scheduled jobs. The jobs are set up so that
each produces a single file that replaces the older one. Backup files are set to be transferred to the disk
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server and from there to a tape drive. In the event of problems, like hardware failure, the backups allow
quickly returning M-Files to working order.

4.3.7. How often should I reboot the M-Files server machine?
M-Files Server itself does not necessarily require the M-Files server machine to be rebooted, but you
should schedule periodic reboots of the server machine because of the added benefit and security of
installing Microsoft Windows updates. Keeping a server online without periodic updates and restarts leads
to potential vulnerabilities and even failures due to pending operating system updates.
For best practices on scheduling periodic reboots, the article Best Practices with Microsoft Windows Server
Update Services provides examples on better control on restarting the server after installing Microsoft
Windows updates when avoiding a reboot is not an option.

4.3.8. What is not included in the backups?
The vault backup operation can be used to store your vault file data and metadata so that in the event of
data loss, your document vault can be recovered from a backup. See Backing Up a Document Vault for
instructions on backing up a document vault.
Data that is collected or generated by someone or something else than vault users and administrators is
considered secondary data, and such data is not included in the backups as it is generally not needed for
succesfully restoring a document vault.
Below is a categorization of secondary data that is not included in the vault backup files. Note that you
generally do not need to worry about this type of data when considering backups as this data is always
automatically generated by the M-Files system whenever needed. Below information is therefore mainly for
your reference only.
Search indexes
M-Files generates and maintains indexes of your vault document contents and metadata by periodically
going through the contents of the document vault. These indexes are used for locating objects when the MFiles search function is used.
Index data may be stored in the following locations on the M-Files server computer:
C:\Program Files\M-Files\Server Vaults\Indexes
C:\Program Files\M-Files\Server Vaults\<vault>\Indexes\
This type of data need not be preserved for backups or when migrating document vaults to a new server
computer.
Image thumbnails
Image thumbnail files are generated by M-Files when the thumbnail view is used in M-Files Desktop. For
more information on different view modes, see Customizing M-Files Desktop User Interface.
Thumbnail data may be stored in the following locations on the M-Files server computer:
C:\Program Files\M-Files\Server Vaults\Thumbnails
C:\Program Files\M-Files\Server Vaults\<vault>\Thumbnails
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This type of data need not be preserved for backups or when migrating document vaults to a new server
computer.
Document preview files
Document preview data is generated by M-Files when documents are previewed in the Preview tab in the
M-Files client.
Document preview data may be stored in the following folders on the M-Files server computer:
C:\Program Files\M-Files\Server Vaults\ViewerFiles
C:\Program Files\M-Files\Server Vaults\<vault>\ViewerFiles
This type of data need not be preserved for backups or when migrating document vaults to a new server
computer.
Logs
M-Files creates log files in various locations on the M-Files server computer after certain processes are
run. The log files generally have either the LOG or the TXT file extension. Log files are often used for
troubleshooting purposes and may be requested by our customer support for further analysis of an issue.
This type of data need not be preserved for backups or when migrating document vaults to a new server
computer.

4.3.9. What kind of operations can I schedule to be run at specific intervals in M-Files?
The following operations can be scheduled and run by M-Files Server as background processes:
•
•
•
•
•
•
•
•
•

updating object workflow states
sending notifications
updating external object types
updating external value lists
making a backup of a vault
optimizing vault database
exporting content
importing content
backing up master database

See the links above for instructions on how you can specify a schedule to determine when each operation
is run.

4.3.10. How do I check the location of the active search indexes?
By default, the Indexes folder can be found under the location specified in the properties of the vault.
Check the index location:
1. In M-Files Admin, in the left-side tree view, right-click a vault.
2. Click Properties.
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3. Open the Advanced tab, and then click Define.
By default, the Indexes folder can be found under the location specified in the Location for
secondary data on the M-Files server field.
In larger vaults, the search indexes might be placed in an alternate location. Check the alternate index
location:
4. In M-Files Admin, go to the Advanced Vault Settings section.
a) Open M-Files Admin.
b) In the left-side tree view, expand an M-Files server connection.
c) Expand Document Vaults.
d) Expand a vault.
e) Click Configurations.
f) In the navigation area, click Advanced Vault Settings.
g) Open the Configuration tab.
The advanced vault settings are shown.
5. Expand Search > Indexes.
6. Check the active indexes from Active Metadata Index and Active Filedata Index or Active
Combined Index.
7. Check the path to the indexes from the Path field of the index.

4.4. Common Problems for Document Vault Users
This section contains frequently asked questions related to common issues that document vault users may
encounter.

In this chapter
•
•
•
•
•
•

Why can't I access the document vault?
Why can't I convert a document to PDF format or annotate a document?
Why can't I find the Checked Out to Me view?
Why can't I save an email message as an Outlook message to M-Files?
Why did a file with a grayed-out icon appear on the M-Files drive when I saved a new document in
Microsoft Word?
Why do document timestamps have the wrong time?

4.4.1. Why can't I access the document vault?
The cause of the problem can be either authentication or the network connection.
If there are problems with the network connection, an error message usually reveals the cause of the
problem. As regards authentication, there can be a few problems that should be solved by making the
following checks.
1. Check that you have an active login account in M-Files Admin (refer to Login Accounts) and that a user
(refer to Users) has been created for the login account in the document vault.
2. Ensure that your password is correct.
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3. Check that you are using the authentication method (Windows/M-Files) specified for your login account.
You can see your authentication method in the Authentication column in the login accounts.
If the problem cannot be solved, contact the M-Files system administrator.

4.4.2. Why can't I convert a document to PDF format or annotate a document?
This topic offers you guidance if you are experiencing problems in one of the following situations when
using M-Files Desktop:
•
•
•
•

You right-click a document and select Sharing, E-mail and PDF > Save as PDF... from the context
menu.
You right-click a document and select Sharing, E-mail and PDF and then select either Convert to PDF
(replaces original file) or Convert to PDF (adds separate file) from the context menu.
You right-click a document and select Scanning and Text Recognition (OCR) > Convert to
Searchable PDF... from the context menu.
You right-click a document and select Create > Annotation... from the context menu.

Issues surrounding PDF conversions and annotations may be related to the same root cause since
annotating a document requires that it is first converted to PDF format. See below for common solutions to
these issues.
Reinstall the PDF converter
You may need to reinstall the PDF converter used by M-Files if you receive one of the following error
messages after attempting to convert a document to PDF or after attempting to add annotations to a
document:
•
•

The M-Files PDF printer driver is not properly installed. Class not
registered.
Unspecified error.

First you need to uninstall PDF-XChange from your computer:
1. On the Windows Start menu, select Settings.
2. Select System > Apps & features.
3. Select PDF-XChange and click Uninstall.
Next, reinstall PDF-XChange:
1. Open the file C:\Program Files\M-Files\<version>\Client\PDFX6SA_sm.exe.
2. Follow the installer instructions to complete the installation.
Make sure that your computer has an application for opening the original document
To be able to convert a document to PDF format in M-Files, you need to have an application for opening
the document installed on your computer. So for instance, if you wish to convert a Microsoft Word
document to PDF, you need to have Microsoft Word installed on your computer. And similarly, if you want
to convert a Microsoft Excel workbook to PDF, you must have Microsoft Excel installed on your computer.
Make sure the document is not checked out
Ensure that the document you are trying to convert is not checked out by another user. You need to able to
check out the document to convert it to PDF format.
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Make sure the document is not protected by password
Ensure that the document that you are trying to convert is not password-protected. If the document is
protected by a password, M-Files is unable to open it and in such cases you are unable to convert the
document to PDF format or to add annotations to it.
Make sure the document is not too large
If you attempt to add annotations to your document but the annotation toolbar is not shown, the file size of
the document may be too large.
Similarly, your document may be too large if you try to convert it to PDF format but the conversion fails and
an error message similar to the following is displayed:
Conversion of the file "Document.docx" to PDF format failed.
The size of the file, [11437522] bytes, exceeds the maximum size 10485760
bytes specified for Word conversions.
By default, the maximum allowed file sizes for PDF conversions for different file formats are the following:
•
•
•
•
•
•
•

E-mail messages: 10 MB
Microsoft Excel documents: 10 MB
Images: 10 MB
PDF documents: 10 MB
Microsoft PowerPoint documents: 10 MB
Visio documents: 10 MB
Microsoft Word documents: 10 MB

Another limitation of converting large documents to PDF is time. If your PDF conversion takes more than
120 seconds to complete, the conversion fails with an error message similar to the following:
Conversion of the file "Document.docx" to PDF format failed.
The maximum execution time of 120 seconds was exceeded.
These limitations can be increased by modifying advanced vault settings on the M-Files server computer.
For instructions, see Modifying PDF Conversion Limitations.

4.4.3. Why can't I find the Checked Out to Me view?
Each user has the Checked Out to Me view, and it cannot be destroyed. However, the view may have
been hidden.
Note: You can hide views by clicking the view and selecting Hide View from the View menu.
Do the following steps to display hidden views:
1. In the listing area, right-click on an empty area and select Unhide Views... from the context menu.
The Unhide Views dialog is opened.
2. Select the hidden view from the list and click Unhide.
3. Click Close to close the Unhide Views dialog.
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4.4.4. Why can't I save an email message as an Outlook message to M-Files?
If you are an M-Files system administrator, you must enable saving attachments in Outlook format and
install Microsoft Exchange Server or a 32-bit MAPI client on the M-Files server computer that hosts the
vault. For more information, see Mail Sources.
If you are a vault user, inform your M-Files system administrator about this issue and refer the
administrator to this page.

4.4.5. Why did a file with a grayed-out icon appear on the M-Files drive when I saved a
new document in Microsoft Word?
The file became a temporary local file in the document vault. You can convert the temporary local file to a
document. For instructions, see Converting a temporary local file to a document.

4.4.6. Why do document timestamps have the wrong time?
If you create a document in M-Files, the Created timestamp shows the time when the document is created
in the vault. If you drag and drop a file to create a document in M-Files, the Created timestamp shows
when the document is added to M-Files. In other words, it is not the original creation time of the file. As a
result, the Last modified timestamp can be earlier than the Created timestamp.
For imported files, the Created timestamp shows the original creation time and not the time that the file
was imported to your M-Files vault.
When a document is added to M-Files, M-Files Server stores the Created timestamp in the UTC-0 format
and the M-Files client then adjusts the displayed timestamp according to the time zone settings of your
operating system.

4.5. General Questions
This section contains general questions about M-Files.

In this chapter
•
•
•
•
•
•
•

Where can I find more information when I need it?
What are the hardware requirements and recommendations?
What's new in this M-Files version?
How do the automatic updates work?
Can I use M-Files programmatically?
How do I write VBScript code for M-Files purposes?
What is the difference between a named access control list (NACL) and a user group?

4.5.1. Where can I find more information when I need it?
In addition to this guide, you can look for help in the Getting started with M-Files guide or consult your
organization's M-Files system administrator.
Customer Support
The M-Files upgrade agreement covers customer support (see also Contacting Support).
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Customer support e-mail: support@m-files.com, tel.: +358 3 3138 7500.
Please note that customer support does not provide instructions on using the software.
More Information
For more information, you may consult the following sources:
•
•

M-Files knowledge base
M-Files Community

If you are a developer or an M-Files system administrator, you might be interested in our documentation
for:
•
•
•

M-Files API
M-Files Web Service
M-Files UI Extensibility Framework

4.5.2. What are the hardware requirements and recommendations?
For technical specifications, refer to System Requirements and Technical Details.
In a system with fewer than 40 users, the M-Files server can be run on a computer meeting the Windows
operating system requirements. The higher the number of concurrent users, the more is required of the
hardware. Free space requirements depend on the number of documents and other objects. The version
history, however, does not expand the disk space requirement in a linear fashion, because M-Files Server
saves the data in the form of changes between different versions.
The M-Files server and its document vault can be easily transferred to another server machine as system
requirements increase.

4.5.3. What's new in this M-Files version?
For more information about new, version-specific M-Files features, refer to the M-Files website page
https://resources.m-files.com/news.

4.5.4. How do the automatic updates work?
M-Files automatically checks for software updates. When an M-Files upgrade covered by your subscription
becomes available, the upgrade is downloaded to your computer and can be installed whenever doing
so is convenient for you. New M-Files versions normally become available as automatic updates about a
month after a new version has been officially released.
Note: See Installation preconditions for ensuring version compatibility.
Automatic updates are a useful way to keep your software up to date. However, system administrators may
opt to disable such functionality, because in larger organizations it is usually easier to handle updates in a
centralized manner. For more information on how to do so, refer to M-Files Setup: Advanced User's Guide.
The feature obtains the latest update information from the update server using HTTP on TCP port 80. This
means that normally you do not need to change any firewall settings.
See also Automatic updates.
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4.5.5. Can I use M-Files programmatically?
M-Files includes an ActiveX/COM API. Supported languages include VB.NET, C#, Visual Basic, VBScript,
and C++. Additionally, M-Files includes the M-Files Web Service API that allows programmatic access to
M-Files through a REST-like interface. See Application programming interface (API).

4.5.6. How do I write VBScript code for M-Files purposes?
You may use VBScript ("Microsoft Visual Basic Scripting Edition") code in M-Files for the following
functions:
•
•
•
•
•
•

calculating automatic property values
validating property values automatically
triggering state transitions
executing custom actions in a workflow state
specifying custom conditions for workflow states for objects to be moved into or out of the said state
defining customized events that are executed when specific events occur

See the links above for instructions on adding VBScript code in each instance.
You can access and manage objects contained in the document vault by means of M-Files API and
VBScript in the above-mentioned circumstances.
VBScript basics
Below are some elementary basics of VBScript to get you started. Note that we are just scratching the
surface here. See Useful resources for further instructions. If you are new to scripting and unfamiliar with
concepts such as variables and functions, it might be helpful to first read a beginner's guide to scripting,
such as Learn Beginning Scripting.
Statements
In VBScript, a line break ends a statement and thus there is no separate termination character for ending
statements. The example below contains two statements:
Dim szPropertyName
szPropertyName = PropertyDef.Name
If you want to divide a statement into separate lines, you may use the underscore character (_) to indicate
that a statement is continued on the next line:
Err.Raise MFScriptCancel, _
"The document vault already contains an object with the same title.
Please choose another title."
Commenting
Always comment what you are doing in your code so that others reading your code understand what is
going on. You can add a comment in your code using the ' character:
' Get the title of the object.
Dim szCurrentTitle
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szCurrentTitle = oCurrentTitleProp.GetValueAsUnlocalizedText
It is a good approach to add a comment above any line of code that you may think is not immediately
obvious to the reader.
Variables
Variables are declared using the Dim keyword:
Dim szCurrentTitleProp
Values are assigned to variables using the equals (=) sign. You should always declare you variables
before assigning them new values:
Dim szCurrentTitleProp
szCurrentTitleProp
= PropertyValues.SearchForProperty( iTitleProperty ).GetValueAsUnlocalizedText
You may use the Option Explicit statement to force explicit declaration of all variables. If you attempt
to use an undeclared variable when Option Explicit is enabled in your script, your script will not work.
For instance, the following script would not work since the variable szValue has not been declared before
it is assigned a value:
Option Explicit
szValue = PropertyValue.GetValueAsUnlocalizedText
When you are scripting in M-Files, you have a number of predefined variables at your disposal. The
variable PropertyValue, for example, can be used for fetching the value of a property. See Available
VBScript Variables for the complete list of predefined variables.
Note: We recommend you to use the so-called Hungarian notation when naming variables. This
way you, or whoever reading your code, has a clear understanding of the data type of the value
stored in the the variable. You can use, for instance, the following notation:
•
•
•
•
•
•

"sz" for strings
"o" for objects
"i" for integers
"b" for Booleans
"f" for floating-point numbers
"d" for dates

Constants
You can use constants for storing values that must remain constant throughout the script:
Const iMaxNumberOfItems = 50
Note that you must assign a literal value to a constant. You cannot use a variable, another constant or a
function to initialize a constant.
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Objects
Objects are assigned to variables using the Set statement. You may create a new instance of an M-Files
API object and assign it to a variable in the following fashion:
Dim oTitleSearch
Set oTitleSearch = CreateObject( "MFilesAPI.SearchCondition" )
Objects are components that have their own properties and methods. Methods are functions that belong to
a specific object and that can be used in the context of the object. Properties, on the other hand, are used
to view or set values of an object. You access the properties and methods of an object using dot notation:
oTitleSearch.Set oTitleExpression, MFConditionTypeEqual, oTitleTypedValue
Method arguments, such as oTitleExpression, MFConditionTypeEqual, and oTitleTypedValue
in the above example, are listed after the method and separated by a comma. Parameters are passed
either by value or by reference. If a method takes a parameter by value, the method copies the value
passed as the argument and thus the original value is unchanged. If, on the other hand, a method takes
a parameter by reference, any changes the method may cause to the argument also impact the original
reference. The value Nothing should be used if the default value of the parameter is to be used.
When scripting in M-Files, you will take advantage of the objects available in VBScript, and more
importantly, the objects available in M-Files API. Refer to the M-Files API documentation for complete
details.
Concatenating strings
You may concatenate two or more strings into one using the & operator:
' Get proposal number.
Dim szNumber
szNumber = PropertyValues.SearchForProperty( 1156 ).TypedValue.DisplayValue
' Get customer.
Dim szCustomer
szCustomer = PropertyValues.SearchForProperty( 1288
).TypedValue.DisplayValue
' Create proposal title.
Dim szName
szName = "Proposal #" & szNumber & " / " & szCustomer
In the above example, the proposal title, stored in the variable szName, is the result of the concatenation of
the following strings:
•
•
•
•

string literal Proposal #
the proposal number, stored in the szNumber variable
another string literal /
the customer name, stored in the szCustomer variable

The resulting proposal title could thus be, for example, Proposal #5577 / ESTT.
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You can add a line break to your string by concatenating the VbCrLF constant with your strings:
Err.Raise MFScriptCancel, _
"The document vault already contains an object with the same title." &
VbCrLF & "Please choose another title."
Raising errors
If you need to, say, validate a property value with VBScript, it is necessary to display an error message to
the user if the value the user entered is invalid. You can raise an error in VBScript using the Raise method
of the Err object:
Err.Raise MFScriptCancel, "The property """ & szPropertyName & """ must have
a value of at least 10 characters."
The method takes the error number and description as parameters. For M-Files scripting purposes, the
MFScriptCancel variable is used as it stores the M-Files error number.
If statements
If statements are used for executing a group of statements if the condition specified in the If statement
evaluates to true:
If Len( szValue ) < 10 Then
Err.Raise MFScriptCancel, "The property """ & szPropertyName & """ must
have a value of at least 10 characters."
End If
The if block must end with an End If statement. All the statements between If and End If are
executed if the condition specified between If and Then evaluates to true. You can use the And operator
to specify multiple conditions that must all be true for the if block to be executed, or the Or operator to
specify multiple operators, one of which must be true for the if block to be executed. You can use the
following comparison operators for specifying the condition:
•
•
•
•
•
•

== checks if the value of two operands are equal or not, if yes, then the condition is true.
<> checks if the value of two operands are equal or not, if not, then the condition is true.
> checks if the value of the left operand is greater than the value of the right operand, if yes, then the
condition is true.
< checks if the value of the left operand is less than the value of the right operand, if yes, then the
condition is true.
>= checks if the value of the left operand is greater than or equal to the value of the right operand, if
yes, then the condition is true
<= checks if the value of the left operand is less than or equal to the value of the right operand, if yes,
then the condition is true

You can also nest an If statement inside another If or, say, an Else statement or use the ElseIf
statement to create a deeper branching logic in your script.
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Functions and subroutines
You can use a subroutine to define a section of code to be used multiple times by reference in your code:
Sub CloseFile()
oMyFile.Close
Set oMyFile = Nothing
End Sub
Or, you can define a function to use multiple times a section of code that returns a value of some kind:
Function IsOdd( iValue )
If iValue MOD 2 = 0 Then ' Even value.
IsOdd = False
Else ' Odd value.
IsOdd = True
End If
End Function
To call a subroutine or function in your script, just refer to it by name:
Closefile()
IsOdd( 5 )
Useful resources
Your most valuable sources of information on scripting within M-Files are the following:
•
•

M-Files API documentation
Available VBScript Variables

The M-Files API documentation is an exhaustive reference to the M-Files API objects, methods, interfaces,
properties, and enumerations that you can take advantage of within VBScript code. The latter resource,
on the other hand, lists and explains all the variables with preassigned values that you can readily utilize in
your VBScript code.
In addition to the two aforementioned resources, you may find the following external websites useful:
•
•
•

VBScript User's Guide
VBScript Functions
Learn Beginning Scripting

Example
The example below is a script that can be used for validating a property when the user attempts to save
metadata changes on the metadata card. The script ensures that the entered property value must be at
least 10 characters in length. Let us take a closer look at the script:
Option Explicit
Dim szPropertyName, szValue
szPropertyName = PropertyDef.Name
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szValue = PropertyValue.GetValueAsUnlocalizedText
If Len( szValue ) < 10 Then
Err.Raise MFScriptCancel, "The property """ & szPropertyName & """ must
have a value of at least 10 characters."
End If
First, the variables szPropertyName and szValue are declared, after which the name of the
property and its value we are validating are stored in the variables we have just declared. We use the
GetValueAsUnlocalizedText method (refer to the M-Files API documentation for more information) to
obtain the property value as unlocalized text.
Our condition for validating the property value is that the value must have at least 10 characters. We
evaluate that condition in an If statement. We have defined in the condition of the If statement that the
length of the property must be less than 10 characters for the statement inside the If statement to be
executed. If the property value is 10 characters or more, the If code block is not executed and the script
execution is finished.
In the if block, we send an error message to the user where we state that the property value that the
user entered must have at least 10 characters, thus instructing the user to add a longer value. After the
error message is displayed, the metadata card is displayed again, allowing the user to modify the invalid
property value.
For complete instructions on validating property values with VBScript, see Automatically Validating
Property Values.

4.5.7. What is the difference between a named access control list (NACL) and a user
group?
M-Files allows you to use named access control lists and user groups to manage information related to a
group of individuals, but they essentially serve a very different purpose.
With user groups, administrators can arrange individuals into separate groups based on common
features, such as their position in the organization (for example "HR" and "Managers"), their physical
location (for instance "Vermont office" and "Chicago office"), or their expertise (such as "Legal matters" and
"Translation"). User groups can be managed with M-Files Admin (see User Groups).
Named access control lists, on the other hand, can be used for specifying various access rights to
objects in a vault. They contain a list of subjects (individual users, user groups or pseudo-users) coupled
with a list of permissions, essentially controlling rights for reading, editing and deleting objects as well as
for changing their permissions. Named access control lists can also be managed with M-Files Admin (see
Named Access Control Lists).
Example: Employment agreements to be visible to the HR department only
The vault contains a large number employment agreements that are currently visible to all vault users. The
HR manager wants them to be visible to the HR team only.
The first thing she needs to do is create a user group for all the users that belong to the HR team. Now,
as she cannot use the user group to directly control any access rights, she also needs to create a named
access control list for associating the newly created user group with the access rights of her choice.
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Note: Users whose login account has the System administrator system role, and users who have
either the See and read all vault content or Full control of vault rights are able to see all vault
content.
Finally, the HR manager has to associate the newly created named access control list with the employment
agreements. She can achieve this via the properties of the employment agreement class.
Opening the properties dialog for a class:
1. Open M-Files Admin.
2. In the left-side tree view, expand a connection to M-Files server.
3. Expand Document Vaults.
4. Expand a vault.
5. Expand Metadata Structure (Flat View).
6. Click Classes.
7. In the listing area, select the class representing the employment agreements.
If there is no class for employment agreements, you can create a new class for this purpose.
8. From the task bar on the left side of the listing area, select Properties.
Setting the class to use the named access control list:
9. Open the Automatic Permissions tab.
10.Check the Restrict the permissions of objects that refer to this class check box.
11.Check the Use named access control list check box.
12.Select the newly created named access control list via the drop-down menu below the check box.
13.Click OK to close the Class Properties dialog.
14.Optional: If an information dialog about disabled automatic permissions for certain property definitions
is displayed, note down the property definitions mentioned in the Property definitions currently
disabled list and click OK.
To make sure that the permission settings are activated when the class for an employment
agreement is selected as the value of any of the properties mentioned in the list, you need to
explicitly allow automatic permissions to be used for these property definitions.
15.In the dialog changed automatic permissions, select either:
a. Change Objects' Permissions to apply the new access rights to all the objects that will be created
from this moment forward.
Note: Object permissions are updated as an asynchronous background task. Object
permissions may be updated when, for example, a named access control list, a user, a user
group, or the value of a pseudo-user (such as a project manager) is modified. You may
monitor the progress of the task in M-Files Admin in the Background Tasks section. For
more information, see Monitoring Background Tasks.
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or
b. Change and Activate Objects' Permissions to apply the new access rights to all the existing
objects as well as to all the objects that will be created from this moment forward.
or
c. Cancel to return to the Class Properties dialog.
Enabling automatic permissions to be used via related properties:
16.In the left-side tree view, under Metadata Structure (Flat View), select Property Definitions.
17.Double-click one of the property definitions that you noted down in step 14.
18.Select the Enable automatic permissions via this property check box and click OK.
19.Select either Change Objects' Permissions or Change and Activate Objects' Permissions (see
step 15).
20.Repeat the steps from 17 to 19 for all the property definitions noted down in step 14.
21.Close M-Files Admin.
Depending on what you selected in step 15, either a) only new objects or b) both new and existing objects
whose class represents the employment agreements are now visible only to the user group whose
members are part of the HR department. As explained in this note, this does not, however, apply to system
administrators and vault users with rights to see and read all vault content.

5. Contacting Support
See this section for information on contacting our customer support if you are unable to find the answer to
your question in the FAQ section.
If you cannot find a solution to your problem in the user guide, you may want to search the M-Files
knowledge base for an answer. You can also create a support ticket at M-Files Support or write to our
customer support at support@m-files.com.
When contacting support, in addition to a written description of the problem, please include as much of the
following information as possible to speed up the support process:
•
•

•
•
•
•

•

your Windows version and system type (64-bit or 32-bit)
the complete M-Files Desktop and M-Files Server version numbers (such as 11.3.4330.130, for
instructions on determining the version numbers, see Checking the Full Version Number of M-Files
Desktop and M-Files Server)
the number of affected users
the frequency of the problem
the exact sequence of steps for reproducing the problem
application-level error messages in Windows Event Viewer (for instructions on retrieving M-Files errors
from Windows Event Viewer, see Saving a Copy of M-Files Errors in the Windows Application Event
Log)
the name and complete version number of the installed antivirus software
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•

the contents of the M-Files error message dialog including a copy of the complete error stack trace, see
example:

•

•
•

The error stack trace can be displayed in the error dialog by clicking the Details button. Note that
the screenshot does not show the entire error stack trace and thus you should copy it as text in its
entirety.
When did you start experiencing the issue and have you made any significant changes to your M-Files
environment before the issue occurred?
If a file cannot be opened via M-Files, can it be dragged to desktop and accessed on the local drive?

You should also be able to describe the status of your document vault and answer the following questions:
•

•
•

•
•
•
•

Does the document vault use Firebird or Microsoft SQL Server as the database engine? If the latter is
used, is Microsoft SQL Server installed on the same computer as M-Files Server, or is it installed on a
separate computer?
Is the file data included in the database or stored in a separate location?
Has the document vault been optimized recently?
• Optimization procedures take the document vault offline.
Has the vault been verified and repaired recently?
If M-Files Admin is used for verifying and repairing the document vault, does it report any errors?
Has the document vault been indexed lately?
Does the M-Files installation include integrations or other add-ons (Dynamics, SharePoint, Salesforce,
and so on)?
•

Provide the full version information of any integrations or add-ons.

If your are having issues with using M-Files with Office products, provide the following additional details:
•
•

Microsoft Office version
the program (Word, Excel, Outlook, PowerPoint) causing the problem
Note: Any relevant screenshots of the situation and settings are always helpful. You may also
attach to your support request any files related to your issue.

In this chapter
•
•

Checking the Full Version Number of M-Files Desktop and M-Files Server
Saving a Copy of M-Files Errors in the Windows Application Event Log
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5.1. Checking the Full Version Number of M-Files Desktop and M-Files
Server
Note: These instructions are for Windows 10, but the procedure is highly similar for other Windows
versions.
Complete the steps below either on the M-Files Desktop client computer to identify the full version number
of M-Files Desktop or on the M-Files Server computer to identify the full version numbers for both M-Files
Desktop and M-Files Server.
1. Right-click the Windows taskbar and select Task Manager from the context menu.
The Task Manager window is opened.
2. Open the Services tab.
3. Locate the MFClient (M-Files Desktop) and MFServer (M-Files Server) services in the Name column.
4. Take note of the full version number of each service in parentheses in the Description column.

5.2. Saving a Copy of M-Files Errors in the Windows Application Event Log
Note: These instructions are for Windows 10, but the procedure is highly similar for other Windows
versions.
If every M-Files user in your organization is experiencing the same issue, it is recommended to save a
copy of the application event log on the M-Files server computer. If the issue is an isolated one, on the
other hand, you should only save a copy of the log on the computer where the issue occurs. Complete the
steps below on the appropriate computer.
1. Right-click the Start icon and select Event Viewer from the context menu.
The Event Viewer window is opened.
2. Expand Windows Logs.
3. Click Application.
4. Click Filter Current Log on the Actions pane.
The Filter Current Log dialog is opened.
5. Open the Event sources drop-down menu and select M-Files and any other applications related to MFiles, such as M-Files Compliance Kit or MFClient.
6. Click OK to close the Filter Current Log dialog.
7. Click Save Filtered Log File As on the Actions pane.
8. Specify a location and a file name, and then click Save.
A copy of the filtered application event log is saved to the location that you have specified. The copy
contains only the errors that are related to M-Files.
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